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About This Guide

The purpose of this documentation is to help you manage and monitor 
ZENworksTM for Servers (ZfS) 2.0 software. The audience for this 
documentation is experienced network administrators.

This document contains the following chapters:

� Chapter 1, “Introduction,” on page 7 provides an overview of the ZfS 
Management and Monitoring Services.

� Chapter 2, “Planning for the Management and Monitoring Services,” on 
page 17 discusses general planning options for installing Management 
Site Services and some of the ZfS agents on the network.

� Chapter 8, “Server Inventory,” on page 293 introduces ConsoleOneTM 
features that are unique to ZfS. 

� Chapter 4, “Network Discovery and Atlas Management,” on page 39 
describes the discovery process.

� Chapter 1, “Introduction,” on page 7 describes the ZfS Alarm 
Management System and how to enable and disable alarms.

� Chapter , “Setting Up Discovery,” on page 72 describes the ZfS Server 
Management components and how to use them to monitor, configure, and 
control the managed servers and nodes on a network.

� Chapter 7, “Traffic Analysis,” on page 177 describes the ZfS traffic 
analysis tools and how to use them to monitor network traffic, capture 
data, and collect key statistics of monitored segments, nodes, and devices.

� Chapter 8, “Server Inventory,” on page 293 describes how to use the 
inventory scan programs to scan the inventory of servers.

� Chapter 9, “MIB Tools,” on page 317 describes using the MIB tools to 
manage SNMP-manageable devices on the network.
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� Chapter 10, “Monitoring Services,” on page 349 describes how to test the 
connectivity and availability of a service on a network device.

� Chapter 8, “Server Inventory,” on page 293 describes using and 
customizing the ZfS Management and Monitoring Services predefined 
reports.

� Chapter 12, “Database Administration,” on page 373 describes using the 
ZfS centralized database.

� Chapter 13, “Troubleshooting,” on page 389 provides troubleshooting 
help for ZfS Management and Monitoring Services.

� Appendix A, “Customizing Agent Configuration,” on page 479 describes 
customizing the SNMP agents to enhance management functionality.

� Appendix B, “Uninstalling the Management Site Services and Agents,” 
on page 489 covers uninstalling ZfS Site Services and various agents.

� Appendix C, “Protocol Decodes Suite Supported by ZfS,” on page 505 
provides information about decoding support for various protocol suites.

The audience for this documentation is experienced network administrators. 
6 Management and Monitoring Services
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Introduction

ZENworksTM for Servers (ZfS) Management and Monitoring Services provide 
industry standards-based monitoring, management, and reporting for 
heterogeneous network environments, including support for multiprotocol 
LAN/WAN networks and servers. In addition, ZfS Management and 
Monitoring Services help you proactively manage your NetWare® and 
Windows NT* servers by responding faster to network problems and 
increasing overall system availability.

This guide provides information on understanding, planning, managing, and 
monitoring ZfS Management and Monitoring Services. A summary of each 
ZfS management and monitoring component covered in this document 
follows:

� “Management Site Services” on page 7

� “Server Management” on page 12

� “Traffic Analysis” on page 12

� “Remote Control” on page 13

� “Server Inventory” on page 13

� “Management Console” on page 14

Management Site Services

In ZfS, the Management Site Services installed on a NetWare 5.x management 
server provide basic management services. A management site is an object 
that resides in NDS® and defines a collection of discovered network objects 
that collectively make up an identifiable group and services.

The Management Site Services include the following: 
Introduction �
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� “Network Discovery” on page 8

� “Database Administration” on page 8

� “Alarm Management” on page 9

� “Role-Based Services” on page 9

� “Reporting” on page 10

� “Topology Mapping” on page 10

� “MIB Tools Administration” on page 11

� “Monitoring Services” on page 12

Network Discovery

When network autodiscovery is started, all IP and IPXTM networks, devices 
that support bridge Management Information Bases (MIBs) (including 
switches), and end systems are automatically discovered, as well as services 
hosted on the devices. The discovered data is first written to a data file and 
displayed in the atlas maps on the management console.

Maps reflect the scope of discovery set at the management server. By default, 
all devices that the management server is able to establish communication 
with are discovered and stored at the management server. By defining the 
scope of NetExplorerTM, you can limit the number of discovered objects that 
are stored at the management server. 

For more detailed information on network discovery, see Chapter 4, “Network 
Discovery and Atlas Management,” on page 39.

Database Administration

ZfS provides a centralized Common Information Model (CIM)-compliant 
SYBASE* database on the management server. The database serves as a 
repository for server and network data that can be displayed or formatted in 
various ways to provide you with exactly the information you need to manage 
your network. The ZfS data is stored in three logical databases: 

� Topology database containing topology, alarms, and map information

� Inventory database containing server inventory data

� Server application management database logging successes and failures 
for server policy and Tiered Electronic Distribution (TED) components
� Management and Monitoring Services
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For more information about TED components, see Policy and 
Distribution Services.

Most database functions are automatic and require very little administration. 
For more detailed information on ZfS databases, see Chapter 12, “Database 
Administration,” on page 373. 

Alarm Management

Alarms recognized by ZfS include Simple Network Management Protocol 
(SNMP) traps, connectivity testing, and threshold profiling. Alarm 
management processes traps and proprietary alarms; and forwards the alarms 
to management consoles subscribing to the alarms.   

You can perform specific actions on an alarm by specifying the action in an 
alarm disposition. Some actions can be automatically launched, including 
executing a program, sending an e-mail notification, and creating an archive. 
You can set specific processed alarms to be forwarded to other ZfS 
management servers, as well as forward unprocessed SNMP traps directly to 
a target address of third-party enterprise management applications.

For more detailed information on managing alarms, see Chapter 1, 
“Introduction,” on page 7.

Role-Based Services

ZfS Management and Monitoring Services support role-based administration 
and task management through NDS. ZfS uses role-based services (RBS) to 
organize ZfS Management and Monitoring Services tasks into roles and to 
assign scope information to a role.

RBS roles specify the tasks that users are authorized to perform. Defining an 
RBS role includes creating an RBS role object and specifying the tasks that 
the role can perform. 

For general information on creating RBS role objects or specifying tasks that 
RBS roles can perform, see "Configuring Role-Based Administration" in the 
ConsoleOne User Guide (http://www.novell.com/documentation/lg/
consol12c/docui/index.html).

For information on how ZfS implements role-based services, see “Role-Based 
Administration” on page 21.
Introduction �
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Reporting

ZfS provides reporting services for the generation of statistical reports. These 
reports can be displayed on the management consoles or exported to popular 
database and Web formats. ZfS allows you to generate the following types of 
reports: 

� Health reports

� Topology reports

� Alarm reports

� Server inventory reports

� Server policies reports

� TED reports

For more detailed information on ZfS Management and Monitoring Services 
reports, see Chapter , “Setting Up Discovery,” on page 72.

Topology Mapping

Topology mapping lets you display maps in the ZfS hierarchical atlas as 
shown in the figure below. Maps reflect the scope of discovery set at the 
management server.
�� Management and Monitoring Services
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For more detailed information on topology mapping, see “Managing the 
Atlas” on page 80.

MIB Tools Administration

ZfS includes several MIB tools, including the MIB compiler and MIB browser 
to manage SNMP devices.

The MIB tools let you do the following:

� Set alarm templates for receiving SNMP traps

� Display and set values on SNMP devices

� Update trap definitions in the alarm template database

� Annotate third-party MIBs 

For more detailed information on the MIB tools, see Chapter 9, “MIB Tools,” 
on page 317.
Introduction ��
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Monitoring Services

Monitoring, or SNMP, services include testing the connectivity and 
availability of a service on a network device. The management console is 
notified whenever the status of the service changes. The services that can be 
monitored include:

For more detailed information on monitoring services, see Chapter 10, 
“Monitoring Services,” on page 349.

Server Management

The server management component enables you to monitor all the servers in 
your network. This component must be installed on each server you want to 
monitor using ConsoleOneTM. During the ZfS installation, you select the 
servers to install to from a list.

You can deploy some or all of the server monitoring software components to 
best meet your management needs. For more detailed information on server 
management, see Chapter , “Setting Up Discovery,” on page 72.

Traffic Analysis

The traffic management component provides the traffic analysis service that 
enables a NetWare or Windows NT server to monitor all traffic on an Ethernet, 
Token Ring, or Fiber Distributed Data Interface (FDDI) network segment. 
This includes:

� Standard and enterprise-specific RFC 1757 MIB descriptions for remote 
network monitoring

� Extensions added to NDS, including Remote Monitor (RMON) agent 
configuration

� Network traffic trending and analysis tools

DHCP DNS Echo

FTP HTTP HTTPS

IP IPX NFS

NNTP SMPT SNMP

Time Service TFTP
�� Management and Monitoring Services
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� Canned network health report templates

� Integration with topology maps

� Performance threshold configuration and profiling

� A view of conversations on network segment and utilization

� Packet capture tools and view

You can deploy some or all of the traffic analysis software components to best 
meet your management needs. For more detailed information on analyzing the 
network traffic, see Chapter 7, “Traffic Analysis,” on page 177.

Remote Control

The remote control component enables remote server management through 
the management console. The remote control agent is installed on each 
NetWare or Windows NT server that you want to remotely control from the 
management console.

NetWare 5 provides a Java*-based remote console utility that lets you use a 
network workstation to manage a remote NetWare server. You can use the 
RCONSOLEJ utility to remotely control a NetWare server from the 
management console.

You can remotely access a Windows NT server console from any workstation 
that runs the management console. Before you begin to remotely control a 
Windows NT server, ensure that the remote management agent is up and 
running on that server. The remote management agent is installed during ZfS 
installation and ensures that remote control sessions are secure.

For more detailed information on remote control, see “Setting Up Discovery” 
on page 72.

Server Inventory

The server inventory component allows you to view the complete hardware 
and software inventory of the managed servers. You can also query the 
centralized database of the managed servers.

The scan program identifies each managed server by its distinguished name 
(DN) and the tree name. The scan data is saved in the Inventory database.
Introduction ��
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After collecting data from the servers, the scan program sends the scan data 
report to the inventory components on the inventory server.

For more detailed information on server inventory management, see Chapter 
8, “Server Inventory,” on page 293.

Management Console

The management console component, Novell ConsoleOne, provides the 
interface from which you manage and administer your network. ConsoleOne 
hosts programs (snap-ins) for integrating network administration and 
management snap-ins, letting administrators manage their network through a 
single interface. 

ZfS provides a graphical user interface (GUI) snap-in to the Novell 
ConsoleOne management console under the ZENworks for Servers 
namespace, as shown in the following figure. It provides access to the unique 
functions provided by ZfS.    
�� Management and Monitoring Services
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For more information on Novell ConsoleOne, see Chapter 8, “Server 
Inventory,” on page 293 and the ConsoleOne Web site  (http://
www.novell.com/products/netconsole/consoleone).
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Planning for the Management and 
Monitoring Services

This section discusses general planning options for installing the Management 
Site Services and some of the ZENworksTM for Servers (ZfS) agents (alarms, 
servers, and traffic) on your network. This section also discusses how to plan 
and implement role-based administration. Before installing the ZfS 
Management and Monitoring Services software, you must decide what 
information you need to manage your network effectively. This section 
contains the following topics:

� “Defining Management Information Needs” on page 17

� “Planning a Strategy to Manage Your Network” on page 18

� “Configuring Your Network” on page 19

� “Role-Based Administration” on page 21

This guide also contains specific information on planning server management 
and segment monitoring in the following sections: 

� “Planning for Server Management” on page 117

� “Planning for Segment Monitoring” on page 193

Defining Management Information Needs

ZfS is flexible enough to fit the business needs of many different network 
configurations. You need to understand which information is needed by the 
groups in your organization and deploy the software to meet those needs.

The groups in your company consist of front-line help desk people, back-end 
information system administrators, and management-level coordinators who 
Planning for the Management and Monitoring Services ��
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need specific information for planning, budgeting, troubleshooting, and other 
concerns.

Once you have identified the groups that need access to network information, 
you can begin to define the needs of each group to determine which 
information they will use and how they will use it. An example of this could 
be a set of critical servers that need to be monitored around the clock. You 
would want real-time monitoring of these servers and notification of serious 
faults occurring on these servers. Another example could be a weekly report 
generated on server trends for a group of defined servers. 

ZfS Management and Monitoring Services are suited for role-based and task-
based access designs that look to the roles users have within an organization. 
The access permissions for users or groups of users change as their roles 
within an organization change. Network information and access is designed to 
assist you in establishing management roles that correlate to the network 
information and management tasks required by users or groups of users. 

When you install ZfS Management and Monitoring Services, a management 
site and a system administrator role are created in NDS®. A management site 
defines the scope of objects (networks, segments, routers, bridges, switches, 
servers, workstations, and so on) discovered on your network. You can create 
a single site or multiple sites, depending on the size of your network or 
network management requirements.   

Planning a Strategy to Manage Your Network

In order for ZfS to monitor and manage devices on your network, it must 
actively poll your network segments and devices on your network. ZfS 
performs polling of these network objects using standard protocols (SNMP, 
TCP/IP, and IPXTM); network traffic is generated for each managed segment 
or device and needs to be considered when planning system roll-out. 

The design of the ZfS components minimizes the impact on network 
performance by storing trending information on the servers hosting the Simple 
Network Management Protocol (SNMP) and Remote Monitor (RMON) 
agents. Polling is directly performed only by the management server based on 
requests coming from connected management consoles. 

The ZfS system administrator should configure the polling frequency to 
provide an appropriate level of monitoring for your network environment. A 
good rule for setting appropriate levels of monitoring is to access the needs of 
your business on the network and begin by identifying systems that are critical 
�� Management and Monitoring Services
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for operation. You can then group systems and segments into three basic 
management categories: 

� Mission critical—Segments and devices that need to be actively 
monitored. Monitoring should be set at a high polling frequency.

� Important—Segments and devices that require less monitoring. These 
might be systems that host certain services that require a balance between 
polling overhead and performance. You should set the polling frequency 
to every few minutes, hours, or days.

� Less important—Segments and devices that require no active monitoring. 
Polling can be done on-demand to monitor segments and devices, or set 
to poll infrequently.

Devices that are not polled or are polled infrequently can and should be 
configured to send alarms (traps) to the management server. In this way, you 
will be notified of errors occurring on the system but you will not incur the 
performance impact from aggressive polling.

Configuring Your Network

The ZfS Management and Monitoring Services components rely on standard 
network protocols to communicate with devices on your network. In order to 
discover and accurately monitor your network and its devices, you need to 
ensure that the communication channels are consistent and well-configured. 

The following sections discuss important aspects of your network 
configuration: 

� “IP Addressing Strategy” on page 19

� “IPX Transport Software” on page 20

� “NDS and DNS Name Resolution” on page 20

� “SNMP Configuration” on page 20 

IP Addressing Strategy

All devices communicating over IP that you want to have discovered and 
managed need to be configured with a valid IP address. TCP/IP must be bound 
on the designated management console workstations and IP must be bound on 
the management server. You can use Dynamic Host Configuration Protocol 
Planning for the Management and Monitoring Services ��
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(DHCP) addressing on the management console workstation, but a static 
address must be assigned to the management server.

To discover routers on your network, you need to verify that the device’s 
address is defined in either its Management Information Base (MIB) or seed 
router table. Initially, router IP addresses are discovered using the Routing 
Information Protocol (RIP), but in general, routers must have static addresses.   

Subnet Masks

To get expected results when your network is being discovered, you must 
verify that the subnet mask configurations on all your IP networks are correct.   
If the subnet mask is too restrictive, you may not be able to discover all the 
devices in your management site. The discovery does not support 
noncontiguous subnet masks, such as 255.255.0.255.

IPX Transport Software

All devices communicating over IPX that you want to have discovered and 
managed need to be configured with an IPX/SPXTM-compatible transport 
network software stack. NetWare® and Windows* drivers are included with 
the operating system installation software. ZfS is fully compatible with the 
Novell® IP Compatibility Mode Driver.

NDS and DNS Name Resolution

You must verify that your NetWare and Windows NT* servers and network 
device names are in place before you begin discovering your network. If 
server names or host names are set, they are used for display in maps and 
configuration views rather than in IP or IPX addresses. Server names and host 
names are generally more useful for identifying the discovered devices. Name 
resolution can be in the form of local host files, an NDS name, or a bindery 
table. 

SNMP Configuration

The SNMP agents and RMON agents for Novell NetWare and Windows NT 
servers and other SNMP-enabled network devices require a community name 
(community string) to be identified on the device. You need to configure each 
SNMP-enabled device with a community name and trap target destination that 
includes that ZfS management server. 
�� Management and Monitoring Services
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The SNMP agents for NetWare and Windows NT servers are part of the server 
management component of ZfS. For information on these agents, see 
“Network Discovery and Atlas Management” on page 39. The SNMP or 
RMON agents for NetWare and Windows NT servers are part of the traffic 
analysis component of ZfS. For information on these agents, see Chapter 7, 
“Traffic Analysis,” on page 177. For other devices, if an SNMP agent is not 
installed on a particular device that you want to manage, you will need to 
contact the vendor for an agent. For more information about managing third-
party SNMP devices, see Chapter 9, “MIB Tools,” on page 317.

Community Names for GET and SET Requests

The ZfS network management system communicates with SNMP agents 
through community names. Community names secure communication 
channels between the manager and agent from intruders. In order for the ZfS 
system to communicate with an agent, the community name on the manager 
and agent must match and use the same port. By default, the ZfS components 
are set to use the PUBLIC community name for GET and SET requests. You 
must configure the community name to something other than the default to 
prevent outside intruders from accessing information and to prevent unwanted 
modifications from being made to system configurations.

If the GET and SET community names are changed from PUBLIC, you will 
need to change settings at the management console and on the management 
server (load nxpcon > SNMP > Add/Edit Community Name) to match your 
network. For details on how to change the community names, after installing 
the Management Services, see “Changing SNMP Community Names” on 
page 77. For information on configuring the NetWare and Windows NT server 
agents, see “Traffic Analysis” on page 177.

Role-Based Administration

The management console for ZfS is implemented in ConsoleOneTM, a 
directory-enabled framework for running Novell network administration 
utilities. The ZfS snap-ins to ConsoleOne fully leverage NDS to enable role-
based administration and greater levels of security.

The system administrator can be assigned specific, defined roles by your 
organization, which allow you to delegate tasks without compromising 
network security. This ability helps in environments where you have multiple 
users with specialized responsibilities and differing scopes of control. 
Planning for the Management and Monitoring Services ��
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Through NDS, users will be able to log in once and have access to the 
management components specific to their jobs. 

ConsoleOne allows you to divide the task of network administration among 
several people. Just as users are assigned rights on the network, administration 
personnel can be given rights to perform only the duties required by their 
roles. With ConsoleOne, the functions and tasks of ZfS are organized into 
different, customized "views" based on each administrator’s role in your 
organization. For details, see "Configuring Role-Based Administration" in the 
ConsoleOne User Guide (http://www.novell.com/documentation/lg/
consol12c/docui/index.html). 

The following sections discuss role-based administration:

� “ZfS Management Site” on page 22

� “General ZfS Roles” on page 24

ZfS Management Site

The ZfS management site sets boundaries for access to object data on the 
management server through the role-based services. From within the network 
container space, you can create roles and tasks that utilize the management 
functions of ZfS and further define the level of access to network objects and 
information.

A management site is an object that resides in NDS and defines a collection of 
discovered network objects that collectively make up an identifiable group 
and system services. A management site could include a single local network 
configuration or could encompass your entire network. The boundaries of a 
site are defined by the scope of network discovery. By default, network 
discovery is set to discover all connected networks and network nodes. Single 
or multiple management sites can be created in any container object in NDS.

During installation, a default management site is created as shown below, and 
a single administration role is established with rights and permissions to all 
configuration and management tasks in the management system. 
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You will need to develop a strategy for creating roles in a management site that 
reflects your network management organization. Some default roles are 
available that manage printers, monitor network traffic, handle alarms, and 
manage server systems to which you can add users and base your new role 
creations. 

In the ZfS role-based services (RBS), permissions required to access network 
objects, configurations, and information are associated with roles. NDS User 
or Group objects can be assigned to appropriate roles, thereby acquiring the 
permissions of the role. The following list describes levels of abstractions in a 
role:

� Roles—Created for the various network management (job) functions in 
your organization to simplify granting of permissions and restrict access 
to management tools and data. 

� Tasks—Actions performed that utilize components of the management 
system based on assigned responsibilities.

� Component/module—A software tool that provides a network 
management function. ZfS includes components for managing servers, 
monitoring segment traffic, and providing common services such as 
database management, alarm handling, and report generation.

The users added to a role retain the NDS access rights, permissions, and 
policies granted through the NDS user account. For example, a user may be 
granted permission to access and configure a server through NDS, but may be 
denied access to manage the server through the RBS in ZfS. This means that 
the management role that the user is assigned has limited access to the 
management services or components/modules in the ZfS management system. 

Management Server Site1.Novell

ZENworks for Servers Site

Management Server Site2.Novell

Atlas

WAN
Zone

Segment 1Islands

Devices

Services
Operating System

Segment 2
Node

Segment X
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General ZfS Roles

ZfS components support role-based services (RBS) and task management 
through NDS. ZfS uses RBS to organize ZfS tasks into roles and to assign 
scope information to a role and user or group.

The schema extensions are required for service location in the ZfS 
environment. From the User object, the application can locate the accounts to 
which the user has access. From the accounts, it can trace the services and the 
hosts. In ZfS, the service being accessed is the database engine. 

RBS roles specify the tasks that users are authorized to perform. Defining an 
RBS role includes creating an RBS role object and specifying the tasks that 
the role can perform. 

The tasks that RBS roles can perform are exposed as RBS Task objects in your 
NDS tree. These objects are organized into one or more RBS modules, which 
are containers that correspond to the different ZfS components. As shown in 
the figure below, ZfS provides predefined modules and RBS role objects.

You can create any role using the modules and tasks. Each module can have 
one or more tasks. RBS defines the task for Monitoring Services as Enable 
Remote Ping. If this task is assigned to your role, you can use the Monitoring 
Services facility.

For more information on creating role objects using tasks and modules, see 
"Configuring Role-Based Administration" in the ConsoleOne User Guide 
(http://www.novell.com/documentation/lg/consol12c/docui/index.html).
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Getting Started with the ZfS Console

The ZENworksTM for Servers (ZfS) console is a snap-in to the ConsoleOneTM 
management tool. ZfS expands ConsoleOne management capabilities by 
adding menu options, property pages for existing NDS® objects, and ways to 
browse and organize network resources. This section introduces the 
ConsoleOne features that are unique to ZfS, including: 

� “Navigating the ZfS Namespace” on page 25

� “Selecting ZfS Options” on page 27

� “Working with Views” on page 29

For more information on basic ConsoleOne capabilities, see the ConsoleOne 
User Guide (http://www.novell.com/documentation/lg/consol12c/docui/
index.html).

Navigating the ZfS Namespace

In ConsoleOne, your network and its resources are presented as a set of objects 
that are arranged in various containers. Each top-level object is referred to as 
a namespace. The ZfS management console snaps in to the ConsoleOne 
management console under the ZfS Sites namespace, as shown in the 
following figure:
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In general, you perform administration tasks by browsing to an object in the 
left frame, right-clicking it, and clicking an option. Objects within the ZfS 
namespace are arranged in the following hierarchy:

1.  ZENworks for Servers sites object: This is the ZfS namespace 
container. It is the top of the ZfS namespace hierarchy. You expand this 
object to display a list of ZfS management sites.

2.  ZfS Site: This object represents a ZfS management server. It 
represents an NDS object that defines a collection of discovered objects 
that collectively make up a group of services. You expand this object to 
display the atlas for the site.

3.  Atlas: This is the container object for all discovered topology objects. 
The Atlas may contain the following types of pages:

�  WAN page: Summarizes the entire network.

�  Area page: Displays segments on the network. There may be 
more than one Area page, depending on how your network is 
organized.

�  Islands page: Displays segments with undetermined 
connectivity.

4.  Segments: Within each Atlas page is a listing of the segment objects 
that are included in that section of the Atlas.

5.  Nodes: Within each segment object is a listing of server and node 
objects that reside on the segment. Note that the icon that is displayed 
varies by node type.
�
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6. Node Details: You can expand a node object to display a list of system 
internal components. Server data is grouped into the following three 
categories:

�  Devices 

�  Operating System 

�  Services

You can drill down into the server configuration farther by clicking the 
plus signs next to the Devices, Operating System, and Services objects to 
display more details about the internal components of the server, such as 
the processors, installed software, volumes, kernel, and adapters. For 
more details about the node objects, see “Object Hierarchy” on page 152. 

The following figure illustrates the ZfS namespace hierarchy:

Selecting ZfS Options

After you locate the object you want to monitor or manage in the left frame, 
you can right-click the object to display the available options. ZfS provides 
three main options:

� “Views” on page 28

� “Properties” on page 28

� “Actions” on page 29
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Views

Views are different ways of looking at information. ZfS provides a variety of 
views designed to help you monitor and manage your network. The main 
views ZfS provides are:

� Atlas: Provides a graphical representation of the discovered network 
topology, the physical location of nodes, node configuration, and alarm 
information.

� Console: Displays the objects contained in the selected container object. 
This view is useful in navigating the ZfS site.

� Trend: Provides a graphical representation of current and historical trend 
data by hour, day, week, month, or year. Monitoring trend data helps you 
with tasks such as determining who is using the server, determining 
which server is used heavily, troubleshooting problems, balancing loads 
across multiple servers, and planning resources.

� Active Alarms: Provides a tabular display of alarm statistics for all 
current alarms received from segments or devices, per management site. 
This view is updated whenever a new alarm occurs on the network.

� Alarm History: Provides a tabular display of all archived alarms, 
including the handling status of each alarm.

� Summary: Provides a tabular information about the selected object’s 
configuration. For example, the summary view for a server object 
displays information about NLMTM files (NetWare®), memory usage, 
adapters, network interfaces, disks and disk controllers, volumes, queues, 
users, connections, open files, alarms, and installed software.

In addition to these main views, ZfS provides additional views for many of the 
objects in the hierarchy. For example, if you select a memory object, you can 
select a disk cache view that displays utilization for disk cache memory. 
Similarly, if you select a Connections object, you can display an Open Files 
View that displays information and statistics for the connections on the server. 
For more information on the available views and the specific information 
displayed in an object view, see “Object View Details” on page 153.

Properties

The ZfS management console provides several property pages that allow you 
to control ZfS-specific settings. You access the ZfS property pages the same 
way you access other ConsoleOne property pages: you right-click an object 
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Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
and then click Properties. The ZfS product provides property pages at the site 
level and at the server level as follows:

� At the site level, ZfS provides property pages that allow you to edit global 
properties including, Alarm Dispositions, ZfS Database settings, SNMP 
settings, MIB Pool entries, and health report profiles.

� At the server level, ZfS provides property pages that allow you to modify 
SNMP settings.

For information on using a specific property page, click the Help button on the 
page. For general information on using ConsoleOne property pages, see the 
ConsoleOne User Guide (http://www.novell.com/documentation/lg/
consol12c/docui/index.html).

Actions

Some objects you browse to provide one or more actions that you can perform 
on the object. For example, if you right-click a server object, the Actions menu 
provides options for restarting or shutting down the server. However, if you 
right-click a volume object, the Actions menu provides options for mounting 
or dismounting the volume. For more information on performing actions on a 
managed object, see “Executing Server Commands” on page 145.

Working with Views

The ZfS management console provides two types of views: tabular (list) views 
and graphical views. The Console, Active Alarms, and Alarm History views 
are all tabular views. The Atlas and Trend views are both graphical views. The 
Summary view may contain both tabular and graphical elements.

There are many characteristics that are common to all views. This section 
describes the common tasks you can perform on the ZfS views, including:

� “Changing the Appearance of a View” on page 30

� “Modifying Columns” on page 31

� “Filtering Views” on page 33

� “Sorting Views” on page 34

� “Printing a View” on page 35

� “Exporting a View” on page 35
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� “Saving Views” on page 36

� “Deleting and Renaming Custom Views” on page 37

Changing the Appearance of a View 

There are many things you can do to change how a view looks, including:

� “Changing the Display Font” on page 30

� “Customizing Grid Lines” on page 30

� “Displaying the View Title” on page 31

Changing the Display Font

To change the font used to display text on a tabular view’s headings or rows:

� Click View > Settings > Appearance.

The Appearance dialog box is displayed.

� To change the header or row font, click the appropriate button as follows:

� To change the header font, click the Header Font button.

� To change the row font, click the Row Font button.

The Fonts dialog box is displayed.

� To change the font:

�� Select a font from the Font Name list.

�� If you want the font to be displayed in bold or italic, check the 
appropriate check box.

�� Select the font size from the Size drop-down list.

�� Click OK to close the Fonts dialog box.

� Click OK to close the Appearance dialog box.

	 If you want to save the changes you’ve made to the view, click View > 
Saving > Save.

Customizing Grid Lines

By default, the views displayed by ZfS do not contain grid lines. To display 
horizontal and/or vertical grid lines and to select a color for the grid lines:
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� Click View > Settings > Appearance.

The Appearance dialog box is displayed.

� Select the grid line style you want to use from the Style drop-down list. 
You can choose to have:

� No grid lines (default)

� Horizontal grid lines only

� Vertical grid lines only

� Vertical and horizontal lines

� If you want to select a color for the grid lines, click the Color button.

The Color Chooser dialog box is displayed. This dialog box includes 
three tab pages—Color Swatches, HSB, or RGB—allowing three 
methods of color selection.

� Select the color you want to use for the grid lines using one of the three 
tab pages > click OK to close the Color Chooser dialog box.

	 Click OK to close the Appearance dialog box.


 If you want to save the changes you’ve made to the view, click View > 
Saving > Save.

Displaying the View Title

To help you keep track of where you are within the ZfS management console, 
you may find it useful to display the view name at the top of the right frame. 

To display the view title:

� Click View > Show View Title.

Modifying Columns

In a tabular view, you can modify how columns are displayed, including:

� “Resizing Columns” on page 32

� “Adding and Removing Columns” on page 32

� “Changing the Column Order” on page 32
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Resizing Columns

To resize a column:

� Move the mouse pointer to the margin between the columns you want to 
adjust.

� When the pointer changes to a sizing arrow, drag the column to the width 
you want.

� If you want to save the changes you’ve made, click View > Saving > 
Save.

Adding and Removing Columns

To add or remove columns from a view:

� Click View > Settings > Column Selector.

� To add a column, select the column name from the Available Fields list > 
click Add.

� To remove a column, select the column name from the Show These Fields 
in This Order list > click Remove.

� Click OK.

	 If you want to save the changes you’ve made to the view, click View > 
Saving > Save.

Changing the Column Order

To change the order in which columns are displayed:

� Click View > Settings > Column Selector.

� Select the column you want to move from the Show These Fields in This 
Order list > click the Move Up or Move Down button to change the 
location of the column.

� Click OK.

� If you want to save the changes you’ve made to the view, click View > 
Saving > Save.
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Filtering Views

You can limit the number of alarms displayed in a tabular view by setting up 
a filter. The filter applies only to the current management session; exiting the 
management console clears the filter selections. 

You set up a filter by selecting criteria from four drop-down lists. You can set 
up simple filters that require only one line. Or, you can set up more complex 
filters composed of multiple lines or groups of lines. If you set up a filter using 
more than one line, you must also specify the logical relationship between the 
line and or group of lines. For example, you must specify whether all of the 
filter lines must be true in order for an entry to be displayed or if only one of 
the lines must be true. 

To set up a filter:

� Go to the view you want to filter.

� Click View > Settings > Filter.

� Select the column by which you want to filter alarms from the first drop-
down list. 

� Select an operator from the second drop-down list. 

The operator defines how to constrain the column you’ve selected to a 
value. For example, you can specify that the selected category must be 
equal to, not equal to, greater than, less than, greater than or equal to, less 
than or equal to, contain, or start with the value you select in the third 
drop-down list in order for an alarm to be displayed. Keep in mind that 
the list of available operators depends on what column you’ve selected.

	 Select a value from the third drop-down list.


 Specify how this filter statement relates to other statements you plan to 
define by selecting a value from the fourth drop-down list.

� If this is the only filter statement or if it is the last statement in a 
group, select End.

� If you want to add a line below the current filter statement, select 
New Row. A new line is added. You must then go back and define 
the logical relationship between the previous line and the new line by 
selecting another option from the fourth drop-down list of the 
preceding line. If both of the filter statements must be met in order 
for an alarm to be displayed, select And. If one of the filter statements 
must be met in order for an alarm to be displayed, select Or.
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� If you want to add one or more lines that are unrelated to the 
preceding line(s), select New Group. A new line is added, separated 
from the preceding line(s) by an additional drop-down list. You must 
specify how the groups of filter statements are to be related by 
selecting a value from this additional menu. If the filter statements in 
both groups must be satisfied in order for an alarm to be displayed, 
select And. If the filter statements in one of the groups must be 
satisfied in order for an alarm to be displayed, select Or. Keep in 
mind that when you add a new group, you must go back to the last 
line in the preceding group and select End from the fourth drop-down 
list.

� When you have finished setting up filter statements, click OK.

The view is updated to display only those entries that meet the filter 
criteria you defined.

Sorting Views

You can modify the order in which the entries in a tabular view are displayed 
using the sorting feature. You can sort the entries by a single column, or you 
can sort by multiple columns as follows:

� “Sorting the View Using a Single Column” on page 34

� “Sorting the View Using Multiple Columns” on page 34

Note that the procedure for sorting Alarm views is slightly different. For 
instructions on sorting alarms, see “Sorting Alarms” on page 96.

Sorting the View Using a Single Column

To sort the entries displayed in the view by a single column:

� Double-click the column header for the column by which you want to sort 
the entries.

When you double-click the column header, the entries in the view are 
sorted by that column in descending order (the most recent entries first). 
To sort the entries by ascending order (oldest entries first), simply double-
click the column header again. You can continue to toggle between 
ascending and descending order by double-clicking the column head. 

Sorting the View Using Multiple Columns

To sort the view using multiple columns: 
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� Click View > Settings > Sort.

� Select the first column you want the entries sorted by from the Sort Items 
By field. 

� Indicate whether you want the entries sorted in ascending (oldest first) or 
descending (the most recent first) order by selecting the appropriate radio 
button.

� Select the second column by which you want entries sorted from the Then 
By field > click the ascending or descending radio button to specify the 
sort order. 

	 Repeat Step 4 for each subsequent column for which you want entries 
sorted.


 Click OK.

The entries are now sorted according to the criteria you specified.

Printing a View

To print a view:

� Go to the view you want to print.

� Click File > Print.

� In the Print dialog box, select the print options you want > click OK.

� In the next Print dialog box, click OK. 

Exporting a View

You can export a tabular or graphical view to one of the following file formats:

� HTML

� Comma-delimited text files (.CSV) 

� Tab-delimited text files (.TXT)

� Blank-space-delimited text files (.TXT)

To export a view:

� Go to the view you want to export.

� Click File > Export.
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� Select the format to which to export the view from the Export File Type 
drop-down list.

� Enter the path and name of the file you want to save in the File Name field 
or click Browse to search for a location to which to export the file.

	 Click OK.

Saving Views

By default, any of the changes you make to the appearance, content, sorting, 
or filtering of a view are discarded when you exit the management console. If 
you want to retain the changes you’ve made, you can save the view. 

This section includes the following topics:

� “Saving the Existing View” on page 36

� “Creating a New View” on page 36

� “Deleting and Renaming Custom Views” on page 37

Saving the Existing View

If you want to permanently modify the existing view to reflect the changes you 
made, you can simply save the view as follows:

� Modify the view as desired.

� Click View > Saving > Save.

The next time you display the view, your changes will be retained.

Creating a New View

In some cases, you might find it useful to create a new view that includes the 
changes you’ve made. In this case, the existing view is left unmodified and a 
new view is saved under a different name. To save the changes you’ve made 
to a view under a new name:

� Modify the view as desired.

� Click View > Saving > Save As.

� Enter a name for the view in the Enter New View Name field > click OK.
�
 Management and Monitoring Services

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
Deleting and Renaming Custom Views

The ZfS management console allows you to rename and delete the custom 
views you have saved as follows:

� Click View > Saving.

� To rename a custom view, select the view from the Saved Views list > 
click Rename.

or

To delete a custom view, select the view from the Saved Views list > click 
Delete.

� When you’ve finished modifying your saved views, click Close.
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Network Discovery and Atlas 
Management

Discovery is the process of determining the topology of your network so you 
can display, monitor, and manage your network from the management 
console. Discovery involves three major components of the ZENworksTM for 
Servers (ZfS) software:

� Discovery software: A set of NetWare® Loadable ModuleTM (NLMTM) 
files that runs on a management server and discovers the network 
topology

� Consolidator software: Software that runs on the management server, 
reads the data discovered by Discovery, and populates the ZfS database

� Atlas Manager or Topology Manager software: Software that reads the 
database, creates an atlas database, and displays the network topology in 
an atlas on the management console 

The following figure shows a high-level view of the discovery components: 
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This section contains information about the following topics:

� “Understanding Network Discovery” on page 40

� “Setting Up Discovery” on page 72

� “Managing the Atlas” on page 80

Understanding Network Discovery

The Discovery components of the ZfS software discover network topology 
and display that topology in the atlas on the management console. The 
NetExplorerTM software drives the discovery process on the management 
server. The Atlas Manager reads the database and displays the network 
topology in an atlas on the management console. 

The following sections will help you understand the network discovery 
process:

� “Discovery Components” on page 41

� “Discovery Process” on page 48

� “What Is Discovered?” on page 56

� “Effects of Discovery on Maps” on page 68
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Discovery Components

The NetExplorer and Consolidator software run on the management server 
and cooperate in discovering your network and updating the database. 

NetExplorer on the management server discovers your network topology 
automatically when you start it for the first time. The following illustration 
shows the Discovery components on the server:

The NetExplorer system consists of the following interdependent 
components:

� “Discovery” on page 42

� “Consolidator” on page 44

� “Atlas Manager” on page 46

� “Management Console Software” on page 47

� “Additional ZfS Components” on page 47

Database

DatabaseConsolidator

NetExplorer

Bridge Agent

NXPIP IPGroper NXPLANZ

IPCache LANZNTNLA
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NetExplor.DAT file

SN3 Agent

Atlas
Manager
Network Discovery and Atlas Management ��

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
Discovery

The Discovery software resides on the management server and uses the 
discovery NLM software to discover various network devices, as follows: 

� NXPIP.NLM discovers IP routers on IP networks and sends IP router 
information to Discovery. It communicates directly with IPCACHE and 
indirectly with IPGROPER. 

� IPGROPER detects IP host addresses and services: Domain Name 
System (DNS) names, Dynamic Host Configuration Protocol (DHCP) 
services, Telnet, Hypertext Transfer Protocol (HTTP), Simple Mail 
Transfer Protocol (SMTP), and File Transfer Protocol (FTP).

� NXPIPX.NLM discovers various NetWare systems on IPXTM networks 
and sends information about systems to NetExplorer.

� NXPLANZ.NLM communicates with traffic analysis agents 
(LANalyzer®) for NetWare and Windows NT* to gather information 
about all systems communicating on the segments they monitor, and 
sends this information to Discovery.

The following figure illustrates the architecture of the Discovery system and 
shows the roles of the various components, network systems, and agent 
software.

,03257$17��Discovery uses the server and traffic management agents to obtain 
certain discovery information. Using these agents throughout your network 
enhances the accuracy and detail of logical maps displayed by the management 
console; however, they are not required.
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Supported Protocols 

ZfS software supports the Service Link Protocol (SLP) on NetWare 5.x 
networks to enhance the discovery speed. 

The server management and traffic analysis agents for NetWare use the 
Service Advertising Protocol (SAP) to identify themselves to other 
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components. SAP filtering prevents routers from passing SAP packets. To 
enable the management server and management console to receive the SAP 
packets that identify manageable servers, Hub Management Interface (HMI) 
hubs, and other servers, configure the router that is filtering SAP packets to 
list the specific SAP numbers that it should pass. NetWare systems and ZfS 
components use the SAP numbers listed in the table below.

Consolidator

The Consolidator software resides on the management server and performs 
the following tasks:

� Reads the NETXPLOR.DAT file, which contains all the discovered 
information. 

� Interprets the records in the NETXPLOR.DAT file.

� Checks to see whether the system has already been discovered.

� Uses the Bridge agent to query the Bridge Management Information Base 
(MIB) on IP networks and discover the Media Access Control (MAC) 
addresses of all systems on a port. 

� Uses the SN3 agent to get the NDS® name for a network object (NetWare 
3.x and NetWare 4.x servers). The SN3 agent enhances the performance 
of discovery by using SLP to discover NetWare 5.x servers. 

� Uses a set of rules to determine any additional attributes of the discovered 
system.

Component SAP Number (Decimal) SAP Number (Hexadecimal)

NetExplorer NLM 567 237

NetWare Management 
Agent 

635 27B

ManageWise AgentTM for 
Windows NT server

651 28B

NetWare LANalyzer Agent 
(traffic analysis agent)

570 23A

Print server 7 7

NetWare file server 4 4
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� Writes discovery information to the ZfS database. 

The following figure shows the tasks of the Consolidator. NETXPLOR.NLM 
creates the NETXPLOR.DAT file and the Consolidator starts reading the 
records from the file. If NetExplorer processes are restarted, the 
NETXPLOR.DAT file is recreated and the Consolidator requests the first 
record in the new file.

When the Consolidator retrieves a record from the NETEXPLOR.DAT file, it 
searches the database to determine whether the system referred to by the 
record is in the database. If the system is not in the database, the Consolidator 
inserts it. When the Consolidator updates the database, it notifies the Atlas 
Manager of the change. Atlas Manager records the change in the atlas 
database and marks maps as Changed in their window titles.

Consolidator first applies rules that are permanently built in to ZfS, and then 
applies rules that have been added by applications that snap in to ZfS, such as 
third-party applications.

Command Line Options

If you want to manually operate the Consolidator, use the command line 
options shown in the following table.

+,17� The command line options are implemented using role-based 
administration. This means that the command line options operate based on your 
role when you log in to the NDS tree.
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Atlas Manager

The Atlas Manager software consists of a server and a client component. The 
server component resides on the management server along with the ZfS 
topology database. The Atlas Manager server component retrieves discovery 
data from the database and creates its own atlas database. 

The client component of the Atlas Manager resides on the management 
console. The server component can communicate with several console 
components at any given time. Any changes made to the maps on the console 
(for example, rename, import, and layout) are communicated to the Atlas 
Manager server component, which then updates the atlas database. 

The following figure shows the Atlas Manager server and client software:

The Atlas Manager looks for a rule in its rules table to help classify the system. 
The rules help the Atlas Manager make decisions, such as which icon should 

Option Allows the Consolidator to

-atlas Notify the Atlas Manager that it has 
updated the database.

-ba ip_address Enable notification. If this option is 
disabled, the Consolidator does not send 
any information to the agents. 

-d data_path Notify the Atlas Manager of the specific 
location of the database file from which to 
start reading. 
�
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be used to display the system on the maps. If the system in the record matches 
one of the rules, the Atlas Manager updates the database according to the rule. 

,03257$17��Modifications to the atlas are updated in the database only when 
you save the database. 

Management Console Software

The management console software snaps in to ConsoleOneTM. Management 
sites are created in ConsoleOne. In each site, an atlas is created that maintains 
the integrity of the discovery information. You cannot add or delete objects 
from the atlas; however, you can rename objects. 

Additional ZfS Components

NXPIP.NLM, NXPIPX.NLM, and NXPLANZ.NLM operate in conjunction 
with the following ZfS components:

� “Traffic Analysis Agent for NetWare Servers” on page 47

� “Server Management Agent for NetWare Servers” on page 48

� “NetWare Servers” on page 48

Traffic Analysis Agent for NetWare Servers

The traffic analysis (LANalyzer) agent for NetWare is a set of NLM files that 
provides traffic analysis of Ethernet, Token Ring, or Fiber Distributed Data 
Interface (FDDI) segments. The traffic analysis agent discovers all systems on 
the segments it monitors, regardless of the protocols the systems use. You can 
monitor multiple segments by putting agents on each segment or by using the 
multisegment version of the software. 

The NXPLANZ.NLM software on the management server uses SNMP to 
query servers running the traffic analysis agent for information about each 
system that resides on their segments. 

,03257$17��For the discovery process to be most effective, you should have the 
traffic analysis agent monitoring each source-routed Token Ring segment.

By default, the traffic analysis agent continues to report systems for seven 
days after they are discovered. If you decrease this time to one day, you will 
detect devices that move more quickly from one segment to another.
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Server Management Agent for NetWare Servers

Managed servers are any NetWare 3.11, NetWare 3.12, NetWare 4.x, or 
NetWare 5.x servers with the server management agent installed. Server 
management agents respond to SNMP queries from NXPIPX.NLM with the 
username and address of those workstations that are logged in to the server. 
NXPIPX.NLM obtains SFT IIITM server information from the server 
management agent. For best results, you should install a management agent on 
every NetWare 3.x, NetWare 4.x, or NetWare 5.x server on your network. 

NetWare Servers

NXPIPX.NLM queries all NetWare servers for information in their tables. All 
NetWare servers allow their binderies to be examined by the discovery 
process when their security settings are set to the default values.

+,17� For the NetExplorer NLM software to discover the login names of 
workstations attached to a NetWare server, a server management agent must be 
installed on the server.

Discovery Process

NetExplorer discovers your network continually. The following sections 
discuss the discovery processes:

� “Discovery Cycles” on page 48

� “Continuous Discovery” on page 53

Discovery Cycles

When you first start discovery, you should let it run as long as necessary to 
build the baseline data. Very small networks might take one or two hours, 
while very large networks (several thousand nodes) might require a day or 
two.

The discovery process occurs in cycles. A cycle is the process by which a 
discovery module identifies every node it can, one time. A cycle can be 
shortened by configuring discovery on the server to discover only certain 
addresses. For more information, see “Changing the Discovery Scope” on 
page 78.

The initial cycle continues until no additional devices are discovered. This 
initial cycle gathers information that might be insufficient to classify certain 
devices or to identify the correct segment for each device. Further discovery 
�� Management and Monitoring Services
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cycles provide additional, new, and changed information. As discovery cycles 
proceed, the information becomes more accurate.

Four independent discovery modules run in the following order during each 
discovery cycle. As described in the sections that follow, each Discovery 
process queries the network using different methods to discover systems:

1. IP router discovery on IP networks only.

This process, run by the NXPIP module, starts from the local router. 
Using the local router’s routing table information, NXPIP discovers other 
routers on the network. It then uses the routing table information from 
each of the other routers to further discover the network. This process is 
repeated for each router discovered. 

The NXPIP module stores the router address information and information 
about any IP-bound network device in the IPCACHE module. 

NXPIP.NLM is installed on the management server. It uses SNMP to 
discover IP routers. To use this NLM, your management server must also 
be running TCP/IP, which must be bound to at least one of your network’s 
interface boards. NXPIP.NLM uses MIB-II information, such as the 
system table, routing table, interface table, interface data-link type and 
frame type, and segment data-link type. Note that because there are 
different versions of MIB-II implementations for different vendors, the 
information you receive might differ, depending on which vendor you 
use.

,03257$17��Even if you are not running TCP/IP on your entire network, you 
must have IP running between the management console and the management 
server. 

2. IP discovery of workstations and servers.

The IPGROPER module queries each router address in IPCACHE and 
gets all network addresses from the routing table. It then queries each 
network address for information on services hosted: FTP, HTTP, DHCP, 
Telnet, SMTP, and DNS. IPGROPER also tries to ping all potential 
addresses on all networks that have been found, and in the process 
discovers all IP hosts. 

3. IPX discovery on all networks, including NetWare/IPTM networks.

This process, run by the NXPIPX module, starts at the management 
server itself to discover its IPX address, the LAN type of each adapter, 
and SAP information about other known devices and their services. After 
gathering this information, NXPIPX requests the same types of 
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information from each device listed in the bindery (for NetWare 3.12 
servers) or directory (for NetWare 4.x and NetWare 5.x servers). This 
process is repeated each time NXPIPX discovers a new device. 

NXPIPX.NLM uses a variety of NetWare, SNMP, and IPX protocols, 
such as IPX diagnostics, to discover NetWare servers, IPX routers, and 
IPX workstations.

,03257$17��When NXPIPX.NLM is loaded, a working directory named 
NXPWORK is created by default under the 
SYS:install_volume\install_dir\MWSERVER\NMDISK subdirectory. During 
installation, you may specify a different path to create the NXPWORK subdirectory. 
NXPIPX puts all of its temporary files in this directory. Do not read, modify, or delete 
any file in this directory. Any of these actions might cause some discovery process 
to not function. 

4. Protocol-independent discovery by the traffic analysis agent 
software.

This process, run by the NXPLANZ module, starts by identifying all the 
remote agents: the traffic analysis (LANalyzer) agents for NetWare and 
Windows NT. The traffic analysis agents on a segment discover devices 
by the MAC address data contained in packets transmitted on the 
segment. The NXPLANZ module on the management server retrieves the 
data by using SNMP to communicate with traffic analysis agents.

If you do not have traffic analysis agents installed, you do not need to run 
NXPLANZ.

NXPLANZ.NLM, installed on the management server, queries traffic 
analysis agents for information about all the systems on their network 
segments, regardless of protocol. 

The following figure shows NXPLANZ querying traffic analysis agents 
software on segments B and C, respectively. 
	� Management and Monitoring Services
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,03257$17��If you have source-routed Token Ring networks, make sure that 
you run traffic analysis agent software on every Token Ring in your network to 
discover your network topology correctly. 

During the initial discovery cycle, these modules run sequentially. As a result, 
information about the traffic analysis agent software is discovered late in the 
initial cycle.

In later discovery cycles, the four modules run concurrently. They continue 
their discovery processes, but send only new or changed data to 
NETXPLOR.NLM. As additional data arrives, segments can be consolidated, 
devices can be placed on the appropriate segments, and new devices can be 
discovered.

Each succeeding cycle has the potential to provide key information that finally 
identifies a device and provides sufficient data for NetExplorer to consolidate 
the data provided by the different discovery NLM files.

Management Server

Traffic Analysis Agent 
for

Windows NT

NetWare Server

Segment A

Segment B

Segment C

Windows NT Server

¥ Traffic Analysis Agent
  for NetWare
¥ NXPLANZ

Traffic Analysis Agent
for NetWare
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These NLM processes communicate to the management console through 
NETXPLOR.NLM. The following figure shows the relationship of the 
discovery NLM processes, NetExplorer, and the management console. See 
“Discovery Process” on page 48 for a description of how these pieces operate 
together to discover the contents and topology of a network. 

The following table summarizes the default seed and scope and user-definable 
changes for each discovery module: 

Discovery Module Default Seed Information Default Scope User-Definable Changes

NXPIP Examines the 
management server 
routing table. 

Places the router 
addresses in the 
IPCACHE module. 

Entire network if 
community string 
matches. 

Reduce scope by 
specifying IP scope 
information in NXPCON.

If public SNMP 
community name is not 
used, list SNMP 
community names of 
routers in NXPCON.
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Continuous Discovery 

NetExplorer discovers the internetwork on which it resides through a process 
initiated and controlled by NETXPLOR.NLM. Initially, each discovery NLM 
identifies itself to NETXPLOR.NLM, which then begins the initial discovery 
cycle, starting with NXPIP discovery, followed by NXPIPX discovery, and 
finally NXPLANZ discovery. Information gathered by NetExplorer is stored 
in the NETXPLOR.DAT file on the management server.

IPCACHE Supporting module for 
NXPIP. Contains all 
router addresses on the 
network. 

IPGROPER 1. Queries each 
router address in 
IPCACHE for the 
workstation and 
servers that it 
knows about. 

2. Queries each 
network device 
for the services it 
hosts (FTP, HTTP, 
Telnet, SMTP, 
DNS, and 
DHCP).

NXPIPX Examines the 
management server’s 
configuration.

Entire IPX internetwork. Reduce scope by 
specifying IPX scope 
information in NXPCON.

NXPLANZ Examines the list of 
servers running traffic 
analysis agent software 
listed in NXPCON. 

All segments with traffic 
analysis agent software.

Specify name and IP 
addresses of traffic 
analysis agent for 
Windows NT in 
NXPCON. If SLP is 
disabled or SAP is being 
filtered, specify the 
name and address in 
NXPCON for the traffic 
analysis agent for 
NetWare.

Discovery Module Default Seed Information Default Scope User-Definable Changes
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In the following figure, each of the discovery processes is shown in 
relationship to time. As shown, after NXPIP finishes its first pass, NXPIPX 
begins and NXPIP starts over. After NXPIPX finishes its first pass, 
NXPLANZ begins and NXPIPX starts its second pass. All three of the 
discovery processes run continually to detect changes to the network, unless 
otherwise directed. Any changes to the network are saved as records in the 
NETXPLOR.DAT file. When all three discovery processes have completed 
one pass, the initial discovery cycle is complete. 

The following sections describe each sequence in greater detail:

� “NXPIP” on page 54

� “NXPIPX” on page 55

� “NXPLANZ” on page 55

� “NETXPLOR” on page 55

� “SNMP Community Name Discovery” on page 56

NXPIP

The first sequence in the NetExplorer discovery cycle involves the discovery 
of IP routers. NXPIP locates its local router using TCP/IP configuration 
information and queries the router for the identity of other routers on the 
network. NXPIP then queries the MIBs on the routers using SNMP. The 
following information is then collected: IP addresses, interface types, and 
MAC addresses. 

By default, NXPIP attempts to discover your entire IP network. You can 
restrict the scope of the IP discovery by specifying scoping information in 
NXPCON.
	� Management and Monitoring Services
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NXPIPX

After NXPIP completes its first pass, NXPIPX begins discovery. Discovery 
begins at the management server. NXPIPX uses a series of techniques, 
including SNMP, RIP, IPX, and SPXTM diagnostics to discover the attached 
IPX or NetWare/IP internetwork. NXPIPX begins by examining its own 
server and discovers the names of other servers. It then queries each of these 
servers to discover more servers and repeats this process until no more servers 
are found.

In addition, NXPIPX reads the connection table of each NetWare server to 
determine which NetWare clients are logged in to the server. NXPIPX sends 
IPX diagnostic packets to each client to collect additional information. Any 
clients that do not appear in the connection table because they have not been 
logged in recently are not discovered by NXPIPX. Any clients that have IPX 
diagnostics turned off are not discovered by NXPIPX. It is also important to 
leave IPX diagnostics enabled on NetWare clients. 

NXPIPX also discovers IPX routers in your network. Third-party IPX routers 
are discovered only if there is a NetWare server on the routed segment. 
NXPIPX does not discover interface information when routed segments do 
not have NetWare servers.

By default, NXPIPX attempts to discover your entire IPX internetwork. You 
can restrict the scope of discovery by specifying a list of IPX network numbers 
using NXPCON. Note that one of the IPX numbers must be bound to the 
management server for NXPIPX to discover other IPX nodes.

NXPLANZ

The traffic analysis agent for NetWare monitors every packet on the network 
segment it is installed on, creating a list in local memory of all the physical 
(MAC) addresses and IP addresses of all the systems communicating on the 
segment. After NXPIPX completes its first pass, NXPLANZ uses SNMP to 
query all servers with traffic analysis agents installed to read the list of 
workstations the servers have observed communicating on the network. 
NXPLANZ obtains a list of the agents running on the servers from NXPIPX. 

NETXPLOR

As the discovery processes gather information about systems on the network, 
they forward packets of related data to NETXPLOR.NLM. 
NETXPLOR.NLM places these packets, along with a record number and a 
time stamp, into the NETXPLOR.DAT file, as shown in the figure below.
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127(��Discovery recreates the NETXPLOR.DAT file each time you load 
NETXPLOR.NLM. Therefore, the discovery data stored at the management server 
from previous runs of the NetExplorer NLM processes is not retained when you 
restart NETXPLOR.NLM.

SNMP Community Name Discovery

Each time NetExplorer tries to access a system using SNMP, it uses the 
community names that have been configured using the NXPCON utility on 
the management server. When it encounters a new system, it tries each of the 
configured community names, in turn, until it finds one that results in a 
successful response. After it has found a community name for a particular IP 
or IPX address, it records this name in a file so that in subsequent cycles it does 
not need to retry with the other configured names. 

You can view these community names using NXPCON. The community 
names are used in the order specified. Therefore, the most-used community 
name should be configured first in the list.

,03257$17��An SNMP query with an invalid SNMP community name results in 
no response from the target system and the request times out.

What Is Discovered?

NXPIP, NXPIPX, and NXPLANZ use a variety of techniques to discover the 
following categories of network objects and present them in the atlas:

� “Systems” on page 57

� “Network Segments” on page 65
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In most instances, information gathered by NXPIP and NXPIPX is sufficient 
to place systems on the network maps correctly. However, when NXPIP and 
NXPIPX do not gather enough information, NXPLANZ retrieves MAC 
addresses collected by the traffic analysis agent software. If NXPIP and 
NXPIPX have not discovered systems using these MAC addresses, the new 
systems are added to the database. Consequently, all systems are discovered 
on segments monitored by the traffic analysis agents. 

Systems

The following table shows the different types of systems discovered:

System Comment

NetWare File Server Service type of 4 (file server). NXPIPX discovers 
all NetWare 3.x, 4.x, and 5.x servers.

IPX Router System with more than one adapter connected 
to different IPX networks.

IP Router System that is configured as an IP router in MIB-
II (IP forwarding enabled).

NetWare Print ServerTM Service type of 71 or 7 decimal.

NetWare ClientTM 
Workstation

System that responds to IPX diagnostics 
requests as an IPX workstation (has the 
NetWare Shell loaded).

SFT III IOEngine Discovered by the IPX discovery module; 
responds with diagnostic information.

SFT III MSEngine Discovered by the IPX discovery module.

NetWare Management Agent Service type of 563 decimal (NetWare 
Management Agent 1.5 or 1.6) or 635 decimal 
(NetWare Management Agent 2.6).

NetWare LANalyzer Agent Service type of 570 decimal.

NetWare Management Agent 
for Windows NT

—

Network Printers Discovered if the printer generates a well-known 
service type.

NetWare ConnectTM Service type of 590 decimal.
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The following table shows the different types of services discovered:

The following sections contain more information about the various systems 
that are discovered:

� “NetWare Client Workstations” on page 59

� “IP Routers” on page 59

� “NetWare SFT III Servers” on page 60

� “Systems Monitored by the Traffic Analysis Agent for NetWare” on page 
61

� “Systems Not Equipped with the IPX Diagnostic Responder” on page 62

� “Routers that Use Duplicate MAC Addresses” on page 62

� “Third-Party Routers” on page 62

� “NetWare MultiProtocol Router with WAN Ports” on page 63

� “IPX Networks” on page 63

� “IP Networks” on page 64

� “On-Demand Links” on page 64

� “Third-Party Routers with WAN Ports” on page 64

� “NetWare Connect Servers” on page 65

NetWare Communications 
Server

Used by the NetWare for SAA* services 
manager products; has a service type of 304 
decimal.

Management Server Running discovery NLM files; has a service type 
of 567 decimal.

Any System Any system is discovered if it is connected to a 
LAN segment being monitored by a traffic 
analysis agent.

Telnet HTTP DNS

SMTP DHCP Routers

NDS SFT III SMP

System Comment
	� Management and Monitoring Services
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� “Virtual Switches” on page 65

NetWare Client Workstations

NXPIPX discovers all NetWare Clients attached to discovered NetWare 3.x, 
4.x, and 5.x servers. Clients that are turned off or are not attached to a server 
are not discovered. For this reason, a NetExplorer process that is run at night 
or on a weekend might not yield a complete map. Note that NetWare Clients 
must have IPX diagnostics enabled.

When you configure a NetWare Client to perform a bindery login, consider the 
scenarios in the following table:

When you configure the client to perform a directory login, NetExplorer 
discovers the system only when it is logged in to an NDS tree. NetExplorer 
does not discover the system when it is just attached to the NDS tree. NXPIPX 
uses SNMP to query the management agent on all NetWare servers for the 
username. To communicate with the management agent, NetExplorer must 
have knowledge of the SNMP community name.

After NetExplorer discovers a NetWare Client, NXPIPX queries the client 
using the IPX diagnostic protocol to confirm the discovery and gather more 
information about it. If IPX diagnostics are turned off, NXPIPX does not 
report the system. This applies to printers as well.

IP Routers

NXPIP uses SNMP to query all IP routers on the network. To communicate 
with a router, NetExplorer must have knowledge of the SNMP community 
name it uses. You must enter the list of community names used by your routers 
using NXPCON. 

If you configure router information such as the system name and location in 
the router’s SNMP MIB, the discovery process records it in the database, 

Server Bindery Login—What Is Discovered

NetWare 3.x, 4.x, or 5.x with server 
management agent installed

Workstation discovered; name is 
discovered only if logged in with IPX as 
the transport for NetWare 4.x and 
NetWare 5.x

NetWare 3.x, 4.x, or 5.x Workstation discovered; name is not 
discovered
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allowing IP routers to be displayed on maps with meaningful names. You can 
configure this information into the router’s MIB using any SNMP 
configuration tool, including the SNMP MIB browser. 

The following figure shows how ZfS discovers IP routers:

By default, IP discovery discovers the entire network. The exploration can be 
restricted by specifying network numbers using the NXPCON Discovery 
Scope > IP Discovery Scope option. For example, if the management server 
IP address is 130.57.12.0, the IP discovery NLM discovers the entire 
10.57.85.0 network and its subnets. Also, if there are redundant IP routers, use 
the NXPCON IP Discovery > IP Routers option to specify the redundant IP 
router address; otherwise, NXPIP does not discover it.

NetWare SFT III Servers

A NetWare SFT III server usually consists of two computer systems, each 
containing an input/output engine (IO Engine) and a mirrored server engine 
(MS Engine). Therefore, physically there are two IO Engines and two MS 
Engines; logically there are two IO Engines and one MS Engine. 

Management
Server

130.57.12.0

130.57.85.0

What is
discovered
by default

You can
restrict the

discovery by
 configuring

NX PCON
130.57.0.0

137.65.3.1 137.65.3.3

137.65.1.3

137.65.2.7

137.65.3.2

137.65.1.4

130.57.13.0
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If NetWare Management Agent is loaded on an SFT III server, the MS Engine 
and both IO Engines are discovered correctly with their names. Both IO 
Engines are placed in the correct segment in the atlas. However, the MS 
Engine is placed in the Island page. This happens because the two MS Engines 
are associated with only one logical server on the network, and the location of 
the MS Engine might change depending on which copy of the MS Engine is 
the primary at any given time. 

The following figure illustrates NetWare SFT III server discovery:

If the server management agent is not loaded on the MS Engine, Discovery 
discovers only the MS Engine and the IO Engine that are primary at the time 
of discovery. The primary IO Engine is labeled Noname in the area page. To 
change the name of an IO Engine on a segment map, right-click the icon and 
click Rename.

Systems Monitored by the Traffic Analysis Agent for NetWare

Discovery discovers all systems communicating on segments monitored by 
the traffic analysis agent. For information about this agent, see “Traffic 
Analysis Agent for NetWare Servers” on page 47.
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Systems Not Equipped with the IPX Diagnostic Responder

NXPIPX discovers the following systems, but does not necessarily place them 
correctly in the atlas:

� NetWare for UNIX* servers 

� Portable NetWare servers

� Access servers

� Modem servers

� Print servers

Because these systems do not respond to IPX diagnostics, they cannot answer 
queries from NXPIPX. Consequently, the LAN information required to place 
them on the maps might not be available. In this situation, NetExplorer places 
these systems in the Island page of the atlas. In most cases, the presence of a 
traffic analysis agent on each segment on which these systems appear enables 
NetExplorer to obtain the missing information and correctly locate the 
systems in the maps. 

+,17� If these systems are running IP, they will be discovered and placed correctly 
in the maps.

Routers that Use Duplicate MAC Addresses

NetExplorer can experience difficulties in discovering some routers because 
of the method the routers use to identify their adapters. In some cases, the 
same MAC address is used on several network interfaces of a router. In these 
cases, it appears to NetExplorer that one adapter is connected to multiple 
segments. Unless otherwise specified, NetExplorer interprets that the multiple 
adapters are one adapter. 

Therefore, the multiple segments that the adapters are connected to are seen 
as one segment and NetExplorer mistakenly consolidates the multiple 
segments. 

Third-Party Routers

NXPIP discovers IP-bound interfaces only. When IP is not being run on a 
router, NetExplorer discovers the IPX-bound interfaces, which results in the 
following on the maps:

� A separate router icon is shown for each interface in the router.

� Management and Monitoring Services
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� Discovered interfaces are not placed in the same router in the atlas. 
Consequently, the interconnections are not correct on the internetwork 
map and the router appears as multiple, separate routers, each containing 
one network interface from the real router.

The following diagram illustrates a router with IPX running on Network 
Interfaces 2 and 3 but not on Network Interface 1. NetExplorer would 
mistakenly place this router on the internetwork map as two separate systems. 
As shown, the connection to Segment 1 is not displayed, and the connections 
to Segments 2 and 3 are shown attached to two separate systems.

NetWare MultiProtocol Router with WAN Ports

NetWare MultiProtocol RouterTM (MPRTM) 3.0 is now bundled with NetWare 
5.x.

IPX Networks

NetWare MPR 3.0 correctly reports the segment type of the WAN links. 
NetExplorer detects these correctly and displays them with the appropriate 
icon.
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IPXWANTM links between NetWare MPR 3.0 systems do not have an IPX 
network associated with them. When NetExplorer discovers such a link, it 
creates a name for the WAN segment of the form #UNNUM -n, where n is an 
integer assigned to make the segment name unique. On multi-access 
networks, such as frame relay and X.25, each connection in the network adds 
another #UNNUM -n to the segment name.

IP Networks

With NetWare MPR 3.0, you can configure both numbered and unnumbered 
IP links. NetExplorer discovers numbered links correctly. NetExplorer does 
not discover unnumbered IP links, resulting in the Island (the link is missing) 
page. 

If IP is running on a third-party router and NXPIP is running on the 
management server, NetExplorer discovers only the IP-bound interfaces. The 
router is shown correctly in the atlas. If IP is not running on a third-party router 
but NXPIPX is running on the management server, NetExplorer discovers the 
IPX-bound interfaces. However, these IPX-bound interfaces are not placed in 
the same router icon in the atlas.

On-Demand Links

An on-demand link is a WAN connection between two routers in which only 
user data (no routing traffic) is exchanged across the link. The link is brought 
up only when there is data to send.

NetExplorer discovers on-demand IP and IPX links correctly if sufficient 
static routing information has been configured to allow the management 
server to reach the other side of the on-demand link.

However, if a link is an on-demand and unnumbered IP link, the entire 
topology on the remote end of the link is not discovered. Click IP Discovery 
> Additional IP Routers in the NXPCON utility to configure an additional IP 
router address for the missing router.

Third-Party Routers with WAN Ports

NetExplorer discovers third-party routers correctly if they support MIB-II 
SNMP. Certain third-party routers can have a WAN link with no IP or IPX 
network number on the link itself. In this case, the WAN link is not discovered.

� Management and Monitoring Services
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NetWare Connect Servers

NetExplorer discovers NetWare Connect servers; however, if you have more 
than one NetWare Connect server on the network, NetExplorer consolidates 
them and they appear as one server. To properly identify the servers, you must 
specify a duplicate MAC address entry in the NMS.INI file.

Virtual Switches

A virtual switch is represented by the same icon used for a switch or bridge in 
the Atlas maps. The display name of a virtual switch is always shown as the 
"switch on IP address of network". It is primarily used in Atlas maps to display 
a meaningful network topology when available discovery information is 
incomplete. 

A virtual switch is shown in Atlas maps under the following conditions:

� When two or more different physical media are connected by a switch, 
but the switch is not yet discovered. The virtual switch will disappear as 
soon as the real switch is discovered.

� When two or more different physical media are connected by a switch, the 
switch is configured with SNMP community names other than public, 
and the SNMP community names of the switch were not provided 
through NXPCON before starting discovery.

� When two or more different physical media are connected by a 
nonmanageable switch or a hub.

Network Segments

NetExplorer discovers the following network segments:

� “LAN and WAN Segment Types” on page 65 

� “Source-Route Bridged Token Rings” on page 66

NetExplorer cannot fully discover the following:

� “Transparent Bridges” on page 67

� “Configuration Changes” on page 67

LAN and WAN Segment Types

NetExplorer discovers the LAN and WAN segment types shown in the 
following table:
Network Discovery and Atlas Management 
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These values are discovered correctly if a system connected to the segment 
responds with an interface type from MIB-II RFC 1573.

Source-Route Bridged Token Rings

How Atlas Manager displays source-route bridged Token Rings depends on 
whether you have traffic analysis agent for NetWare installed on each ring, as 
follows: 

� If you do not have traffic analysis agent for NetWare installed on each 
source-route bridged Token Ring in your network, NetExplorer discovers 
the network but consolidates all source-route bridged Token Rings that 
share the same IPX network number or IP subnet into a single segment. 
For example, in the following figure, rings R1, R2, and R3 are displayed 
as one segment, and rings R4 and R5 are displayed as another segment on 
the internetwork map.

� If you have traffic analysis agent for NetWare installed on each source-
route bridged Token Ring, each traffic analysis agent for NetWare 
discovers its own ring (segment) and every system on it. Atlas Manager 
displays the ring as an unconnected segment on the internetwork map.

� If you have traffic analysis agent for NetWare installed on a source-route 
bridged Token Ring connected to a router, the WAN page in the atlas 
shows the correct connections. However, if two networks each have 
several rings and only one ring in each network is connected to a router, 
the WAN page shows the correct connections of only the rings that are 
directly connected to the router. The other source-route bridged Token 

Known Segments in CIM Database Unknown Segments in CIM Database

ATM

LAN: FDDI

LAN: Ethernet

LAN: Token Ring

WAN: X.25

WAN: PPP

WAN: Frame_Relay

LAN: ARCnet

LAN: LocalTalk*

SMDS

WAN: ISDN

WAN: SDLC

WAN: Serial

WAN: T1

WAN: T3
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Rings in each network are displayed as disconnected segments on the 
WAN page. The following figure illustrates this second case.

In all cases, bridge information is not discovered. As a result, Discovery treats 
each interface of a source-route bridge as a separate system on the network. 
One icon appears in the atlas for each interface of the source-route bridge. 

When you have the traffic analysis agent for NetWare installed on one server 
on each ring of an IPX source-route bridged network, the segment names 
displayed on the WAN page consist of the IPX network number followed by 
the MAC address of that server’s interface to the ring. If the traffic analysis 
agent for NetWare is monitoring more than one interface, the address shown 
for a ring is the MAC address of the interface monitoring that ring.

Transparent Bridges

Discovery cannot fully discover transparent bridges. It consolidates groups of 
transparently bridged segments running the same network number into a 
single segment on the maps. 

Configuration Changes

Discovery detects most changes in the network topology, such as the addition, 
reconfiguration, or deletion of interfaces, resulting in changes being made to 
Network Discovery and Atlas Management 
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the atlas. However, if you remove the system from the network, it is not 
detected unless you move it to another location in the network. 

Effects of Discovery on Maps

As information comes into the database, the Atlas Manager on the 
management server creates an atlas database and displays the atlas on the 
management console, showing segments connected by routers on the WAN 
page and objects in the appropriate segments in the Area pages.

Most discovered systems are placed immediately on the correct pages of the 
atlas. However, if too little information arrives to identify a system, it appears 
in a special page called the Island page. This page contains partially 
discovered systems.

In some cases, the Atlas Manager places systems in the Islands page during 
the early discovery processes of the initial discovery cycle and relocates them 
to their correct segment when a later process provides additional information. 
For example, when a router is configured to filter IPX diagnostic packets, any 
IPX system on the other side of the router is placed in the Islands page. 

The Atlas Manager moves the systems from the Islands page to the correct 
segment if an IP or IPX address is discovered.

You can move these systems to the correct segment by configuring them with 
the appropriate network address information.

Some specific devices and situations pose difficulties for NetExplorer. For 
example, some devices do not respond to IPX diagnostics packets, and some 
routing protocols require routers to duplicate the MAC address on all 
interfaces in each router. 

Review the following sections for more information on the effects of 
discovery on maps:

� “Name Source Priority” on page 68

� “General Information About Naming” on page 70

� “Representation of Systems in the Atlas” on page 70

Name Source Priority

Naming is a complex process. As discovery cycles proceed and more 
information arrives, the names displayed in the maps and other windows can 
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change. Also, different priorities are given to names, depending on the source 
of the name information. 

This section provides information about the final name displayed after 
discovery is complete. The various sources of name information and their 
priorities are shown in the following table:

Source Priority Comments

User 1 Names you enter in the 
database take precedence 
over discovered names. 

Bindery 2 � Server name—IPX 
server names are 
located in the server 
AUTOEXEC.NCF file; 
the NetExplorer 
component obtains them 
from the bindery. 

� Username—Logged in 
or attached usernames 
are retrieved from the 
NetWare Management 
Agent.

� Service name—Service 
names are located in the 
bindery; systems send 
them in SAP packets.

MIB-II 2 If you do not configure the 
name in the MIB, NXPIP leaves 
it blank. 

NetWare Management 
Agent

2 Discovered through NXPIPX. 

Names created during 
discovery

3 If NetExplorer cannot find any 
other name, it creates a name 
using the MAC address of the 
system.
Network Discovery and Atlas Management 
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General Information About Naming

The following are not rules, but general statements that might help you 
understand the names displayed in the atlas: 

� NetExplorer never changes names of systems you enter.

� Names shown in the atlas and other windows are sensitive to discovery 
order.

� The name of a workstation logged in to multiple servers under different 
usernames can alternate (toggle) between the different usernames if you 
restart NETXPLOR.NLM.

Representation of Systems in the Atlas

When representing a system in a map, the Atlas Manager refers to the 
following list of services in the order shown. As soon as it associates the first 
service with the node, it displays it without looking for further matches. The 
icon may change if a service with a higher priority is detected later during 
discovery.

Priority 
Number

Icon Description

1. Router running IP service

2. Router running IPX service

3. Switch or a bridge

4. Server running the discovery process

5. NetWare server running the server 
management agent software

6. Windows NT server running the server 
management agent software
�� Management and Monitoring Services
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If a system has either an IPX or IP router service, the Atlas Manager considers 
it a router and shows it on the WAN page. 

7. NetWare or Windows NT server running 
the traffic analysis (LANalyzer) agent 
software

8. Server running file server software

9. Server running print server software

10. Server running IP software

11. SFT III server running the MS engine

12. Server running NetWare Connect 
software

13. IP workstation

14. IPX workstation

15. Server running the topology database

16. Server running the Remote Monitoring

17. Server running the Remote Monitoring II

18. Router

19. Printer

Priority 
Number

Icon Description
Network Discovery and Atlas Management ��
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To determine how to display the discovered object, the Atlas Manager uses the 
following list in the order shown: 

1. Computer name

2. IP address

3. IPX address

4. MAC address

For example, if the Atlas Manager finds that the discovered object has a 
computer name, then it displays the object immediately; otherwise, it looks for 
an IP address. If it doesn’t find an IP address, it looks for an IPX address. 
Finally, if the object doesn’t have a computer name, IP address, or IPX 
address, it displays the object by its MAC address.

Setting Up Discovery 

The discovery software on a management server automatically discovers the 
nodes on your network. Network nodes include servers, desktops, routers, 
hubs, switches, and any other networked devices. The Consolidator on the 
server populates the database with the discovered data. The Atlas Manager on 
the server reads the database and creates the atlas.

ZfS allows discovery in two different environments:

� IP only—NDS/SLP agent for a pure IP environment 

� IP/IPX environment

You must have IP enabled between the management console and the 
management server.

The following tasks will start discovery initially and help you customize 
discovery to meet your organization’s needs:

� “Starting Discovery” on page 73

� “Checking the Status of Initial Discovery” on page 73

� “Checking the Results of Discovery” on page 74

� “Changing the Default Configuration” on page 75

� “Unloading the Management Server” on page 80
�� Management and Monitoring Services
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Starting Discovery

Discovery starts automatically when the Discovery software is loaded on the 
management server. 

To manually start auto-discovery and load the back-end services (management 
site services), refer to the steps in ZENworks for Servers Installation and 
Setup.

Restarting the Management Server

If you bring down the management server (for example, for maintenance), the 
restart affects discovery in the following ways: 

� Each time you reload the discovery modules, a new version of 
NETXPLOR.DAT is created.

� The initial discovery cycle starts again.

� The Consolidator processes all the discovery data again as ZfS 
rediscovers the network.

To unload the Discovery files:

� At the NetExplorer server, enter unxp.

To load the Discovery modules:

� At the NetExplorer server, enter netxplor.

Checking the Status of Initial Discovery

As discovery progresses, your topology maps in the management console 
reflect the discovery data. However, in a large network, it might take a day or 
two before the initial discovery is complete.

The easiest way to determine whether initial discovery is complete is to use 
the NXPCON utility on the management server to look at the status of each 
NetExplorer module. Each module must complete at least one full cycle to 
draw a complete map. 

To view the discovery status, look at the discovery status fields at the top of 
the NXPCON screen. See “Using the Discovery Configuration Utility” on 
page 76 for information about how to access this screen.

The NXPCON main screen gives you the information you can use to monitor 
the status of discovery.
Network Discovery and Atlas Management ��
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The following information is displayed:

� NetExplorer Up Time: Shows the time since NetExplorer started 
running.

� NetExplorer System Status: Shows the overall status. It can have one of 
the following values:

� Initial Cycle in Progress—One or more of the discovery modules 
(NXPIP, NXPIPX, or NXPLANZ) has not yet completed its first 
cycle.

� Initial Cycle Complete—All modules have completed at least one 
pass.

� Module Status: Shows the status of each module and the number of 
cycles each module has completed. The module status can be one of the 
following values:

� Not Loaded—Module is not loaded.

� Waiting to Start—Module is loaded but not started.

� Running—Module is running and collecting data.

� Suspended—Module is suspended because it reached the end of the 
schedule in which it was running. 

� Completed—Module completed a discovery cycle.

� Unknown—NetExplorer cannot obtain the module status. (This is 
usually seen if the module is not loaded.)

Checking the Results of Discovery

After the initial discovery and after the Consolidator has finished updating the 
database, you should check your atlas to determine whether your network 
topology is accurately represented on the maps.

If a node is not on the map, it might be of a type that NetExplorer cannot 
discover. If a node does not appear in the correct segment, NetExplorer may 
not have received sufficient information to place it correctly. NetExplorer 
discovers all servers, desktops, switches, and routers. For more information, 
see “What Is Discovered?” on page 56. The following characteristics of the 
discovered objects are captured:

� IP—Discovers IP routers; IP hosts; IP services such as HTTP, Telnet, 
SMTP, DNS, FTP; and DHCP.
�� Management and Monitoring Services
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� IPX—Discovers IPX workstations, IPX routers, and IPX services (file, 
print, any other Service Advertising Protocol [SAP]).

� Subnet mask

� Services

� NDS names and tree

NetExplorer also discovers all the NetWare services.

The Consolidator on the management server communicates with NetExplorer 
to obtain network discovery data. The Consolidator reads the 
NETEXPLOR.DAT file and populates the database. 

,03257$17��The NETEXPLOR.DAT is reset every time you restart NetExplorer.

The Consolidator communicates with two Java* components: the Bridge 
Agent and the SN3 agent. The Bridge agent queries the Bridge MIB and 
confirms the topology for the Consolidator. The SN3 agent does SLP-based 
discovery for NetWare 5.x servers and gets the corresponding NDS name for 
each IP and IPX address discovered.

,03257$17��NetExplorer and the Consolidator can run independent of each 
other on the management server. 

NetWare 5.x servers are discovered faster because NetWare 5.x supports the 
Service Link Protocol (SLP). 

Ensuring Complete Discovery

IPX workstations are discovered with a username if the user is logged in to or 
attached to a NetWare server running management agent software. To ensure 
that the usernames for IPX devices and workstations on your network can be 
discovered, install a management agent on all NetWare servers where users 
log in. 

If you have AppleTalk* devices that you want NetExplorer to discover, you 
need to install the NetWare LANalyzer Agent on one server on each segment.

Changing the Default Configuration

The discovery software is installed with configuration defaults designed to 
work in most environments. However, if Discovery is not discovering the data 
you want in your database, or if your network is not fully discovered, you need 
to reconfigure Discovery. 
Network Discovery and Atlas Management �	
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If your organization uses SNMP community names other than PUBLIC, or 
you want to change the default discovery scope, you must change the default 
configuration of the software.

The following sections contain more information:

� “Using the Discovery Configuration Utility” on page 76

� “Choosing Which Discovery Modules to Load” on page 77

� “Changing SNMP Community Names” on page 77

� “Changing the Discovery Scope” on page 78

Using the Discovery Configuration Utility

You can use the NXPCON utility on the management server to change the 
discovery configuration. For example, you can change the scope of discovery 
or view the status of the initial discovery process. 

To access the NXPCON utility:

� Access the server console on the management server either directly from 
the server prompt or remotely.

� If the discovery modules are already loaded on the server, click the 
NetExplorer Console Utility option in the Available Screens window.

or

If the discovery modules are not loaded, enter netxplor at the server 
prompt.

You use the Discovery console, NXPCON, to configure and monitor 
Discovery on the management server. 

NXPCON is loaded automatically when NetExplorer is loaded and is 
accessible at the management server. 

If NXPCON is not loaded on your management server, check to see that 
NetExplorer is running. If NetExplorer is running, enter load nxpcon at 
the system console prompt. If NetExplorer is not running, enter netxplor 
at the system console prompt. 
�
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Choosing Which Discovery Modules to Load

By default, the ZfS installation loads the NXPCON utility with all modules 
running. If you are not using IPX on your network, you can configure 
NXPCON to not load the NXIPX module. 

,03257$17��Make sure TCP/IP is bound to at least one of your server’s network 
boards. 

To view or modify which modules are being loaded:

� In NXPCON, click Configuration Options > NetExplorer Modules.

� Select the field you want to change > press Enter. 

� Select Yes or No to load or unload the module > press Enter.

� Press Esc to exit the NetExplorer Modules dialog box.

	 Click Yes.


 At the management server prompt, unload NetExplorer by entering 
unxp.

� Reload NetExplorer modules by entering netxplor.

Changing SNMP Community Names

In ZfS, the default community name is PUBLIC. If your organization uses 
SNMP community names other than PUBLIC, reconfigure the SNMP 
community name in NXPCON.

127(��In order to prevent burdening the routers, most large IT organizations add 
one more level of control by allowing only certain IP addresses to do SNMP queries 
to the routers. If this is the case in your environment, make sure that the IP address 
given to the ZFS sever is privileged to query the routers in the network. Otherwise, 
the discovery will not be complete and incomplete network information will appear 
under "islands" in the Atlas.

To view, add, modify, or delete SNMP configuration information, such as 
community names used for IP and IPX discovery: 

� In NXPCON, click Configuration Options > SNMP.

� In the SNMP dialog box, click Edit Community Name List.

� To add a community name, press Insert.

or

To modify a community name, click the community name > press Enter.
Network Discovery and Atlas Management ��
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or

To delete a community name, click the community name > press Delete.

� Press Esc > click Activate Changes from the Configuration Options 
window. 

	 Respond to the prompts accordingly.

For information about other configuration options in the SNMP window, see 
“Using the Discovery Configuration Utility” on page 76, or the management 
console online help.

Changing the Discovery Scope

By default, NXPCON is set to discover all IPX and IP networks. You can, 
however, limit the discovery scope. 

You could, for example, limit discovery to only the IPX addresses you set 
NetExplorer to discover and the IP subnet addresses you configure. If you 
monitor only a section of a large network, you might want to limit discovery 
to that section, which would reduce network traffic and make your atlas more 
manageable. 

After initial discovery, nodes remain in the database until you reset the 
database, even if they have been removed from the network. If you limit the 
discovery scope after initial discovery, you must reset the database to remove 
the nodes that you no longer want in your database.

,03257$17��If you change the discovery scope, you must also unload and 
reload NetExplorer files on the NetExplorer server. If you do not, segments outside 
of the scope might appear in the atlas. 

To view or restrict the IP or IPX scope:

� In NXPCON, from the Configuration Options window, click Discovery 
Scope.

� Select IP Discovery Scope or IPX Discovery Scope.

� Press Enter to view or configure the scope of your discovery.

� Press Insert to add a new IP or IPX discovery scope entry.

or

Press Enter to modify a discovery scope entry.

or
�� Management and Monitoring Services
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Press Delete to delete a discovery scope entry.

You can restrict the scope of IP or IPX discovery by entering the IPX 
network numbers or IP address ranges specified by the mask fields you 
want to discover. 

For IP Networks: Restrict the scope by entering the IP address of your 
local network, together with the mask you want to use. You might want 
to specify the subnet mask of the subnet to which you are connected if you 
want to discover only this subnet.

The mask indicates which part of the address needs to match for 
discovery to proceed on a network segment. If you entered a number in 
the mask, the corresponding number in the IP address must match. The 
number 0 (zero) means that no match is required. 

For example, IP address 10.5.0.0 and mask 255.255.0.0 allow discovery 
to proceed for any segment with an IP address starting with 10.5. 
NetExplorer discovers IP addresses 10.5.0.0 through 10.5.255.255.

If you do not specify a mask, the default mask (based on the network 
number class) is used.

For IPX Networks: Restrict the scope to the IPX networks to be 
discovered by entering a single IPX network number and a mask. 

The mask indicates which part of the network number needs to match in 
order to match a discovered network. An F in the mask means that the 
corresponding digit must match; a 0 (zero) means that no match is 
required.

For example, network number 12340000 and mask FFFF0000 match any 
network number starting with 1234.

Network number C00000FF and mask FF0000FF match any network 
number starting with C0 and ending with FF, such as C01234FF or 
C00000FF.

	 Enter the address and mask for your discovery scope.


 Press Esc > click Yes to save changes to the configuration file. 

� Press Esc to return to the Discovery Scope window.

� Unload and reload the NetExplorer modules or restart your management 
server for the changes to take effect. 
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Unloading the Management Server

To unload the management server:

� If restarting the server is not feasible, make sure all "ServiceLoader" 
processes are exited. At the server console prompt, enter 

stopService.ncf  

java -show 

+,17� There are times you may see a process displaying the status of "exiting" in 
the java -show display. If this condition persists, the only solution is to restart the 
server.

You may use java -exit if you can terminate all other Java processes. 
Unload Java, if all the services are not closed.

� Enter unmw to unload all ZfS components.

� Switch to the SYBASE* process by pressing Ctrl+Esc > enter q to 
terminate the SYBASE database engine.

Managing the Atlas

After the initial discovery, you can stop Discovery running on the 
management server. You can, however, continue to access the database 
through the Atlas Manager. The next time you bring up NetExplorer, the 
discovery cycle starts again. The Consolidator populates the database and the 
Atlas Manager automatically updates the atlas pages. 

Depending on the size of your network, writing data from the initial discovery 
cycle can take a few minutes or as long as several days. Subsequent discovery 
updates to the database require substantially less time.

This section contains the following topics:

� “Running the Atlas Manager” on page 80

� “Using the Atlas” on page 81

Running the Atlas Manager

After the initial discovery, you can stop the Atlas Manager software on the 
management server or let it run in the background. If you close Atlas Manager, 
you should run it periodically to update your atlas. 
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After the initial discovery is complete, you might want to schedule the Atlas 
Manager to run periodically rather than continually. By running the Atlas 
Manager periodically, you can update the database at times that do not 
interfere with other management activities.

Using the Atlas

ConsoleOne, the Novell directory-enabled, Java-based network management 
and administration tool, is the management console component. ZfS snaps in 
to ConsoleOne and expands the ConsoleOne capabilities by adding menu 
options, property pages for existing NDS objects, and ways to browse and 
organize network resources. ConsoleOne provides an intuitive, graphical user 
interface for ZfS components. For more information on ConsoleOne, see 
Chapter 8, “Server Inventory,” on page 293.

When ZfS is first installed, the server module of the Atlas Manager is 
automatically installed on the management server, and the client module of the 
Atlas Manager is installed on the management console. The Atlas Manager on 
the management server creates a system atlas and provides a graphical view 
of the database at the console. 

The Atlas Manager on the server reads the database and provides two different 
views of the database at the management console: the Console view and Atlas 
view. Both views provide information about the discovered network topology, 
the physical location of nodes, node configuration information, and alarm 
information. 

To learn more about using the atlas, review the following sections:

� “Accessing the Atlas” on page 81

� “Assigning Roles to Help You Manage the Atlas” on page 82

� “Using the Atlas to Troubleshoot” on page 83

� “Using Command Line Options for Atlas Manager” on page 84

� “Customizing the Colors” on page 85

Accessing the Atlas

You access the ZfS atlas from ConsoleOne. At the management console, open 
ConsoleOne and double-click the ZfS Domains name space, then expand the 
domain. The system atlas appears.

A ZfS atlas consists of three different pages, as shown in the following table: 
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Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
,03257$17��The atlas maintains the integrity of the discovery. You can rename 
objects in the atlas, but you cannot add or delete objects. 

Customizing Your Atlas View

You can customize your atlas view in four different ways:

� Randomly select network objects that you would like to manage and save 
them in a custom view. 

� Insert a custom bitmap as the background on an atlas page.

� Change the position of a node on an atlas page by dragging it. 

� Display objects by an alternate name. For example, you can specify the 
atlas to display server objects by NDS name instead of by IP address.   

Assigning Roles to Help You Manage the Atlas

ZfS lets you assign roles to manage the atlas. For example, you can assign a 
role to a user to add objects, but not delete objects, from an area page. Based 
on the role selection, you can restrict the user from performing specific 
operations on that object. The object can be an atlas, a page in the atlas, a 
segment, or a node. 

+,17� The atlas displays pages based on your role on the network. For example, 
if your role is restricted to managing segment A and B, your atlas contains objects 
discovered in segments A and B only.   

Atlas Pages Icon Description

WAN page Summarizes the entire network, illustrating the WAN-
related network topology. Your atlas typically has a single 
WAN page.

Area page Displays segments on your network. An atlas can have 
several area pages. For example, areas can be divided 
based on the geographic location of the network. If a 
company in San Jose has an overseas branch in 
Germany, you can divide your network into Area1 for the 
San Jose network and Area2 for the Germany network.

Island 
page

Consists of segments with an undetermined connectivity. 
During discovery, the Island page is a placeholder for 
network objects that are not completely discovered. An 
atlas has a single Island page.
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You can perform the following tasks on any atlas page (WAN, Islands, or Area 
page):

Using the Atlas to Troubleshoot

ZfS maps can alert you to alarm conditions on the network. To do this, you 
must set the alarm disposition to save alarms in the database. Upon 
recognizing a critical, major, or minor alarm on a segment or node, the ZfS 
management console displays a bell-shaped alarm icon above the object. For 
information about alarms, see “Changing Alarm Dispositions” on page 137.

The following figure shows the Atlas name space on ConsoleOne:

Tasks Comments

Open Opens the page

Import Inserts a custom wallpaper

Save Updates the changes in the database 

Print Prints the page

Rename Renames the page 

Layout Displays the page with a different focal point
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Using Command Line Options for Atlas Manager

The following table shows the command line options for tasks at the 
management server:

Options Atlas Manager

-no Notifier Ignores database notifications and stops 
notifying consoles (low overhead). 

-no Manager Stops topology updates from the database. 
Changes made at the console (such as 
renaming, adding, or deleting an object) are 
updated. 

-no cmdServer Stops communicating with the client module on 
the management console. 

-rebuild Recreates the map topology (after deleting the 
existing topology).
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Customizing the Colors

You can change the colors in your atlas by editing the COLOR.TXT file in the 
\install_directory\MWSERVER\BIN subdirectory. The Java color values are 
represented by their RGB numbers.

You can change the colors in the atlas by reordering the color values in the 
COLOR.TXT file.

RGB # Color

2442200 Blue

16711680 Red

4442400 Green

5442200 Purple

36711680 Black

6442400 Dark blue
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Alarm Management

The ZENworks™ for Servers (ZfS) Alarm Management System (AMS) alerts 
you of important events occurring on your network. Events include SNMP 
traps, threshold alarms, network discovery events, and ping and connectivity 
testing faults. This lets you proactively resolve network problems and stay up-
to-date on network events occurring throughout your network. 

Events are reported in the Active Alarm view, and alarm icons are anchored 
to objects displayed in the management console. Each event is categorized and 
displayed with a corresponding alarm icon when an event occurs. Alarm icons 
change color to depict the level of severity, keeping you updated with real-
time notification of potential problems.

Any device on the network that supports SNMP-standard trap notification can 
be processed by the AMS. For example, for all NetWare® servers on which 
the management agent for NetWare is installed, all notifications of server 
breakdowns, overloads, and configuration changes are sent to the 
management server for processing and then made available for viewing at a 
ZfS management console.

You can enable and disable alarms and set alarm thresholds on baseline 
statistics for segments and servers (for example, segment alarms for utilization 
and the total number of packets per second) so that when the threshold for a 
statistic is reached, an alarm is generated. You can also set actions to be 
performed when an alarm or event occurs. The actions assigned to an alarm or 
event are specified in the alarm disposition. 

This section contains information on the following topics:

� “Understanding the Alarm Management System” on page 88

� “Managing the Alarm Management System” on page 92

� “Maintaining the Alarm Management System” on page 111
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� “Troubleshooting the Alarm Management System” on page 112

Understanding the Alarm Management System

AMS alerts you to network conditions and events that are useful to know 
about or that require action to resolve a network problem. AMS provides you 
with tools and back-end services to help you use, distribute, and manage this 
information. The AMS component is also fully integrated with other ZfS 
components to provide access control through the role-based services (RBS) 
component and report generation through the reporting functions. AMS 
provides a centralized location for processing and viewing the events and 
alarms generated by devices and systems throughout your network.

You can view tabular lists of statistical data for active and historical alarms 
received by AMS from any management console. This makes it easy to handle 
alarms and track network events and recurring alarm conditions. In addition, 
real-time notification of alarms occurring on your network is provided by the 
following:

� Severity level, as displayed by the changing color of the alarm indicators

� Audible notification 

� Status bar ticker-tape messages

You can also assign an action, such as automatically launching a program 
when an alarm is received, or sending an e-mail message to notify remote 
users of events. 

Alarm Management System Components

AMS is comprised of multiple components for processing, storing, and 
viewing alarms. All alarms that are received by AMS are processed and sent 
to all applications that subscribe to them. The ZfS management console, by 
default, subscribes to AMS and receives updates as soon as an alarm is 
processed. 

The following figure illustrates the AMS components:
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The main components that make up AMS are as follows:

� “SNMP Trap Receiver” on page 90

� “SNMP Trap Forwarder” on page 90

� “SNMP Trap Injector” on page 90

� “Alarm Injector” on page 90

� “Alarm Processors” on page 90

� “Alarm Manager Database” on page 90

� “Archivers” on page 91

� “Alarm Viewers” on page 92
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SNMP Trap Receiver

SNMP receives traps from network management agents and passes them to 
the SNMP trap forwarder and the SNMP trap injector.

SNMP Trap Forwarder

After the SNMP trap forwarder receives a trap, it checks the alarm manager 
database to determine whether the trap has an SNMP trap forwarding 
disposition. If the trap has a forwarding disposition, the SNMP trap forwarder 
forwards the trap. Otherwise, the SNMP trap forwarder ignores the trap.

SNMP Trap Injector

The SNMP trap injector converts the trap to an alarm and passes the alarm to 
the alarm injector.

Alarm Injector

The alarm injector receives alarms from the SNMP trap injector as well as 
from other applications and passes them to the inbound processor.

Alarm Processors

The alarm processors include processors for receiving, archiving, and 
dispatching alarms to subscribers. The inbound processor applies alarm 
templates to incoming alarms. The alarm template is based on SNMP trap 
definitions or other proprietary definitions for handling the AMS management 
and display criteria. After inbound processing is completed, the alarm is sent 
to the archive processor, which facilitates logging and storage of the processed 
alarm data in the alarm manager database. The archive processor sends the 
alarm to the outbound processor, which sends the alarms to the subscription 
server and disposition server. 

Alarm Manager Database

The alarm manager database is a repository for alarm information, including 
the following:

� “Processed Alarms” on page 91

� “Alarm Templates” on page 91

� “Alarm Dispositions” on page 91
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Processed Alarms

The processed alarm data that is stored in the alarm manager database is 
supplied to management consoles through the alarm query server. The alarm 
data is used for alarm presentation and reporting.   

Alarm Templates

Templates are applied to each alarm received by the inbound processor. Alarm 
templates are created for SNMP traps from the trap definitions in the MIB. 
When you compile a MIB, the trap definitions are used to create an alarm 
template that provides a method for presenting and managing alarm data. 
Proprietary alarms are handled in a similar way; the templates are based on 
proprietary definitions. For example, when a user tries to log in to a server 
with an incorrect password, an alarm is generated and forwarded to the 
management server. The management server processes the alarm by 
identifying the trap object identifier (OID) and assigning the associated alarm 
template. 

An SNMP trap sent by a device that does not have a recognizable OID is 
assigned a default template and is categorized as unknown. In order for a trap 
OID to be recognized by AMS, you need to compile the device’s MIB into the 
MIB Pool on the management server. See ZENworks for Servers Installation 
and Setup for more information. 

Alarm Dispositions

AMS allows you to configure the automatic handling of an alarm by defining 
it in the alarm disposition. Alarm dispositions govern the handling 
characteristics for each type of SNMP trap or proprietary alarm. The 
automatic handling functions include specifying an application to launch 
when an alarm is received, sending e-mail notification, forwarding processed 
alarms to other ZfS management servers, or forwarding SNMP traps to other 
network management systems. You can also set options for alarms, such as 
audible beeps.

Archivers

The following three archivers add data to the alarm manager database:

� “Alarm Archiver” on page 92

� “Disposition Archiver” on page 92

� “Template Archiver” on page 92
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Alarm Archiver

The alarm archiver stores alarm statistics and data in the alarm database. By 
default, all alarms are archived. If you do not want an alarm archived, you 
must edit the alarm disposition to disable archiving of the alarm. See 
“Archiving Alarm Statistics” on page 111 for more information.

Disposition Archiver

The disposition archiver receives the alarm disposition from the Disposition 
Console and saves it to the alarm manager database.

Template Archiver

The template archiver receives alarm templates from a MIB compiler and 
saves them to the alarm manager database.

Alarm Viewers

The management console shows two views of alarm data: the Active Alarm 
view and the Historical Alarm view. Active alarms are also displayed in the 
Summary view when a server is selected from the left pane of ConsoleOneTM. 

The Active Alarm view displays statistics in the management console for 
events occurring on your network. Alarms displayed in the Active Alarm view 
can either be owned by you or assigned to a group. The tasks that you can 
perform on an alarm from this view depend on the access rights allowed 
through the role-based services. The Active Alarm view continually appends 
incoming alarms to the list, providing you with the most current alarms. After 
an alarm is acknowledged, it is removed from the Active Alarm list. 

The Alarm History view allows you to track alarms received by AMS to verify 
their handling status. Information about assignments and ownership is also 
available from this view.

Managing the Alarm Management System

The ZfS management console provides a central location for monitoring 
critical events on your network. You can manage the events and traps 
forwarded to the AMS by controlling which events are monitored and which 
traps are considered important. You can configure AMS to alert you to errors 
on critical systems and noteworthy events to assist you in maintaining the 
health of your network. This section contains the following information: 
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� “Recognizing Alarm Indicators” on page 93

� “Viewing Alarms” on page 94

� “Enabling and Disabling Alarms” on page 99

� “Resolving Alarms” on page 99

� “Deleting Alarms” on page 101

� “Performing Actions on Alarms” on page 104

Recognizing Alarm Indicators

You can monitor the network for alarm-triggering events by observing nodes 
on topology maps or Atlas views and in the server/node summary, Active 
Alarm, and Alarm History views. The following table lists the alarm 
indicators and explains the type of alarm to which each indicator applies.

Alarm Indicator Applies To

Alarm icons anchored to the 
affected object 

Alarms with critical, major, and minor severity 
are displayed in the Atlas and Console views 
and the left pane of the management console. 
An alarm icon remains anchored to a segment or 
device object until you handle all alarms 
outstanding against that object. Alarm icons 
differ based on the severity level of the alarm. 
See “Interpreting Alarms” on page 95 for details 
on alarm severity and the associated icons. 
Keep in mind that if a segment or device has 
multiple alarms logged against it, the alarm icon 
always depicts the highest level of severity.

Ticker-tape message on the 
status bar

AMS can automatically display alarm messages 
on the status bar. By default, this option is 
enabled. You can configure each individual 
alarm disposition to disable display of the ticker-
tape message. Upon recognizing an alarm-
triggering event, AMS displays a message in the 
status bar describing the alarm. For information 
on setting this option, see “Displaying a Ticker-
Tape Message” on page 109.
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Viewing Alarms

Access to both active and historical alarm data is available from any 
management console. As administrator, you can define access restrictions to 
alarm data and management functions through the role-based services to 
further define the data presented based on the roles in your organization. 

You can modify the presentation of the alarm data displayed in the Active 
Alarms and Alarm History view by filtering the displayed data, changing the 
column layout, and changing the sorting order. All options for changing the 
presentation are under the View menu in the management console.

The following sections describe the various ways you can view and use 
alarms:

� “Viewing Active Alarms” on page 94

� “Viewing Historical Alarms” on page 95

� “Interpreting Alarms” on page 95

� “Sorting Alarms” on page 96

� “Filtering Alarms” on page 97

Viewing Active Alarms

The ZfS management console Active Alarm view displays alarm statistics for 
all current alarms received from segments or devices, per management 
domain. You can see alarms specific to a server or node by displaying the 
Summary view on a selected server or node object. The Summary view shows 
a list of all active alarms for that server or node. 

The Active Alarms view and Server Summary view display a table of detailed 
information about active alarms. These views are updated whenever a new 

Audible beep AMS can be configured to produce an audible 
beep on the management console when an 
alarm occurs. By default, this option is disabled. 
You can configure each individual alarm 
disposition to enable the audible notification. For 
information on setting this option, see “Making 
an Audible Beep” on page 110.

Alarm Indicator Applies To
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alarm occurs and is archived on your network. New alarms are appended to 
the list. 

To display the Active Alarm view:

� Click the ZENworks for Servers site object in the left frame of 
ConsoleOne.

� Click View > Active Alarms.

The Active Alarm view is displayed. You can perform the following 
alarm handling activities from this view: 

� “Assigning Alarms” on page 100

� “Owning Alarms” on page 101

� “Handling Alarms” on page 101

Viewing Historical Alarms

The Alarm History view displays information about all archived alarms, 
including the handling status of each alarm. You can access the Alarm History 
view only if you have been granted access through the role-based services. 

To display the Alarm History view:

� Click the ZENworks for Servers site object in the left frame of 
ConsoleOne.

� Click View > Alarm History.

The Active Alarm view is displayed. You can perform the following 
alarm handling activities from this view: 

� “Assigning Alarms” on page 100

� “Owning Alarms” on page 101

� “Deleting Alarms” on page 101

Interpreting Alarms

The Active Alarm and Alarm History views display lists of alarms that have 
been archived to the alarm manager database. The alarms are displayed on a 
tabular list. The following table lists and describes the types of data displayed 
in each column.
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You can filter the data displayed in the alarm views based on criteria from 
statistics displayed in each view; see “Filtering Alarms” on page 97 for details. 
After selecting one or more alarm entries in an alarm view, you can perform 
operations by right-clicking them.

Sorting Alarms

You can modify the order in which the alarms are displayed on the Active 
Alarm or Alarm History views by sorting the alarms. By default, the alarms 
are sorted in ascending order by received time. 

To edit the sort settings: 

Data Type (Column) Contents

Severity Alarm icon that indicates the severity level 
attributed to the trap. The color of the alarm icon 
indicates the level of alarm severity, as follows:

 Red = Critical

 Magenta = Major

 Yellow = Minor

 Blue = Informational

 White = Unknown

From Network address of the device that sent the 
alarm to AMS.

Summary Summary of the event, often including the name 
or address of the object affected by the alarm.

Owner Person or group responsible for handling the 
alarm. The default owner is SYSTEM.

Received Time Date and time when the alarm management 
system received the alarm.

Type Generic description of the alarm. For example, 
volume out of disk space.

Category Category identified in the MIB associated with 
the trap-type object.
�
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� Click View > Settings > Sort.

� Select the criteria by which you want the alarms sorted. You can sort by

� Type

� Severity

� Category

� Received time

� Indicate whether you want the alarms sorted in ascending (oldest first) or 
descending (the most recent alarms first) order by selecting the 
appropriate radio button from the Sort Order box.

� Click OK.

The alarms are now sorted according to the criteria you specified.

Filtering Alarms

You can limit the number of alarms displayed in the Active Alarm and Alarm 
History views by setting up a filter. You can use the filter to generate lists for 
export to HTML or other popular formats or to aid in troubleshooting a fault. 
The alarm filter only applies to the current management session; exiting the 
management console clears the filter selections. 

You set up a filter by selecting criteria from four drop-down lists. You can set 
up simple filters that require only one line. Or, you can set up more complex 
filters composed of multiple lines or groups of lines. If you set up a filter using 
more than one line, you must also specify the logical relationship between the 
line and or group of lines. For example, you must specify whether all of the 
filter lines must be true in order for an alarm to be displayed or if only one of 
the lines must be true. 

To set up a filter:

� Go to the view you want to filter.

� Click View > Settings > Filter.

The Alarm Filter screen is displayed.

� Select the column by which you want AMS to filter alarms from the first 
drop-down list. You can filter alarms using the following columns:

� Severity: Filters the alarms based on the alarm severity. Alarm 
severity is assigned to an alarm type.
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� Type: Filters alarms based on the alarm type. The alarm type is set 
by the SNMP trap-type defined in the MIB or the proprietary alarm 
definition.

� Category: Filters alarms based on the category of the alarm. Alarm 
categories are based on the MIB that defines the trap-type objects.

� Generator Type: Filters alarms based on the type of agent or system 
generating the alarms.

� Select an operator from the second drop-down list. 

The operator defines how to constrain the column you’ve selected to a 
value. For example, you can specify that the selected category must be 
equal to, not equal to, greater than, less than, greater than or equal to, less 
than or equal to, contain, or start with the value you select in the third 
drop-down list in order for an alarm to be displayed. Keep in mind that 
the list of available operators depends on what column you’ve selected.

	 Select a value from the third drop-down list.


 Specify how this filter statement relates to other statements you plan to 
define by selecting a value from the fourth drop-down list.

� If this is the only filter statement or if it is the last statement in a 
group, select End.

� If you want to add a line below the current filter statement, select 
New Row. A new line is added. You must then go back and define 
the logical relationship between the previous line and the new line by 
selecting another option from the fourth drop-down list of the 
preceding line. If both of the filter statements must be met in order 
for an alarm to be displayed, select And. If one of the filter statements 
must be met in order for an alarm to be displayed, select Or.

� If you want to add one or more lines that are unrelated to the 
preceding line(s), select New Group. A new line is added, separated 
from the preceding line(s) by an additional drop-down list. You must 
specify how the groups of filter statements are to be related by 
selecting a value from this additional menu. If the filter statements in 
both groups must be satisfied in order for an alarm to be displayed, 
select And. If the filter statements in one of the groups must be 
satisfied in order for an alarm to be displayed, select Or. Keep in 
mind that when you add a new group, you must go back to the last 
line in the preceding group and select End from the fourth drop-down 
list.
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� When you have finished setting up filter statements, click OK.

The alarm list is updated to display only those alarms that meet the filter 
criteria you defined.

Enabling and Disabling Alarms

ZfS provides default threshold values for managed NetWare and Windows 
NT* servers and network segments hosting the traffic analysis agents for 
NetWare or Windows NT on a station connected to a segment. If any value is 
exceeded, an alarm is generated. Server threshold alarms are enabled by 
default; segment threshold alarms are not. You will need to enable the 
threshold alarms to receive network alarms. 

,03257$17��You must have the traffic analysis agents for NetWare or Windows 
NT hosted on a station connected to the segment in order to modify the segment 
properties.

To enable or disable segment threshold alarms:

� Right-click the segment object > click Properties.

� If it’s not already displayed, select the Segment Alarms tab.

� Select the alarm you want to enable or disable > click Edit.

� Enter the threshold value after which an alarm should be generated in the 
Value field.

	 Enter the amount of time (in seconds) that the threshold value must be 
exceeded in order to generate an alarm in the Sampling Interval field.


 Check the Enable check box.

� Click OK.

Resolving Alarms

Alarms that occur on segments and devices on your network are added to the 
alarm manager database and are presented in the Active Alarms and Alarm 
History views. Entries in the alarm manager database remain in the database 
until the alarm is deleted. The database records the status of the alarm from 
first acknowledging the alarm, assigning it to a group or user, owning the 
alarm, and finally deleting it from the database once the owner has resolved 
the problem. 
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Resolution operations for alarms are displayed when you right-click a single 
entry or multiple entries in an alarm view and click any of the following 
actions:

� “Assigning Alarms” on page 100

� “Owning Alarms” on page 101

� “Handling Alarms” on page 101

You can also access the alarm action menu items from the View menu in the 
management console.

The order in which you perform the handling, assigning, and owning of an 
alarm or multiple alarms depends on your organization. Keep in mind that 
once you handle an alarm, it is removed from the Active Alarms list and only 
appears in the Alarm History list. A suggested course for resolving an alarm 
is for you to first assign the alarm to a group or team member, then have 
someone from the group take ownership of the alarm. When the network 
problem or event has been resolved, the team member can handle the alarm to 
remove it from the Active Alarms list. By following this process, you can 
track the alarm status through resolution, and finally delete the alarm from the 
Alarm History list. 

Assigning Alarms

You can specify the group or user that is assigned to handle an alarm. This 
allows you to use any team assignments you already have within your 
organization. For example, you may have a group or team member assigned 
to handle all alarms relating to NetWare servers. You can assign one or more 
alarms to a group or user. Note, however, that you must have been granted 
access to assign alarms through the role-based services. You can use an alarm 
filter to help you determine groups based on certain filtering criteria. See 
“Filtering Alarms” on page 97 for information on filtering options. 

+,17� This is optional and is provided for tracking the status of alarm resolution.

To assign an alarm:

� Select the alarm you want to assign from the Active Alarm or Alarm 
History list.

� Click View > Assign.

� Enter the name of the person or group to which you want to assign the 
alarm in the User Name field.
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The name you enter does not correlate to users in NDS and can represent 
the organization structure you already have in place.

� Click OK.

Owning Alarms

A user can take ownership of one or more alarms. If a user is a member of a 
group assigned to resolve a network problem, the team member can take 
ownership of the alarm and finally delete the alarm to remove it from the alarm 
manager database.

+,17� This is optional and is provided for tracking the status of alarm resolution.

To take ownership of an alarm:

� Select the alarm from the Active Alarm or Alarm History view.

� Click View > Own.

The value in the Owner field changes to the NDS name you are logged in 
as. Note that you cannot customize this option; the user logged in to 
ConsoleOne will always become the owner of the alarm when this action 
is used. 

Handling Alarms

Alarms displayed in the Active Alarm view have not been handled by anyone. 
After the alarm is handled, it is removed from the Active Alarm list, and any 
alarm indicators shown in other views in the management console are 
removed. See “Recognizing Alarm Indicators” on page 93 for information on 
different types of alarm indicators. Note that the alarm is still displayed in the 
Alarm History view.

To handle an alarm:

� Select the alarm from the Active Alarm list.

� Click View > Handle.

The alarm is removed from the Active Alarm list. You can still display 
information about the alarm by switching to the Alarm History view.

Deleting Alarms

Alarms displayed in the Alarm History view can be deleted from the alarm list 
after problem resolution. You can delete one or more alarm entries to remove 
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the alarm from the list. Note that to delete an alarm, you must have been 
granted access to view alarm history and to delete alarms through the role-
based services.

There are two ways to delete alarms:

� You can delete alarms manually from the Alarm History view. See 
“Deleting Alarms from the Management Console” on page 102.

� You can delete alarms automatically using the AMS purge utility. See 
“Deleting Alarms Using the Purge Utility” on page 102.

,03257$17��The alarm manager database, located on the management server, 
records the status of every alarm instance received by the AMS. You must be 
diligent in deleting alarms once a problem is resolved in order to keep the database 
from taking up excessive disk space. Currently, the alarm manager database uses 
the Alarm purge utility (on by default) to automatically trim entries after a period of 
time or based on the size of the database. 

Deleting Alarms from the Management Console

You can manually delete alarms one at a time from the management console. 

To delete an alarm:

� Select the alarm you want to delete from the Alarm History list.

� Click View > Delete.

The alarm is removed from the Alarm History view.

Deleting Alarms Using the Purge Utility

You can delete alarms automatically using the AMS purge utility. Before you 
can use this utility, you must set up the utility’s configuration file, 
AMPURGE.PROPERTIES, which is located in the properties directory on the 
server and volume where you installed the alarm manager database. Then you 
can schedule the utility to run automatically at a specified time of day. Or, you 
can run the utility manually from the server console. The following sections 
describe how to set up and use the AMS purge utility:

� “Setting Up the Purge Utility Configuration File” on page 103

� “Setting up the Purge Utility to Run Automatically” on page 103

� “Running the Purge Utility from the Server Console” on page 104
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Setting Up the Purge Utility Configuration File

The AMS purge utility configuration file, AMPURGE.PROPERTIES, defines 
the criteria for selecting the alarms to be purged as well as the time of day the 
process should run. This file is located in the properties directory on the server 
and volume where you installed the alarm manager database. Before you can 
run the purge utility, you must set up the configuration file as follows:

� Open the AMPURGE.PROPERTIES file using a text editor.

� Set the criteria for purging alarms by editing the values of the following 
lines in the file: 

� SeverityInformationalPurgeWait: The number of days 
before informational alarms will be purged.

� SeverityMinorPurgeWait: The number of days before minor 
alarms will be purged. 

� SeverityMajorPurgeWait: The number of days before major 
alarms will be purged.

� SeverityCriticalPurgeWait: The number of days before 
critical alarms will be purged.

� SeverityUnknownPurgeWait: The number of days before 
unknown alarms will be purged.

By default, alarms of all severity levels are purged after seven days.

� Save the configuration file.

Setting up the Purge Utility to Run Automatically

You can schedule the purge utility to run daily to ensure that the alarm 
manager database does not consume excessive disk space. Before you can set 
up the utility to run automatically, you must make sure to set up the file with 
your preferences for deleting alarms of various severities. See “Setting Up the 
Purge Utility Configuration File” on page 103. 

To set up the utility to run automatically:

� Open the AMPURGE.PROPERTIES file using a text editor.

� Set the time of day you want the utility to run by editing the 
PurgeStartTime entry.

Valid values are 0 to 23, where 0 is midnight and 23 is 11:00 p.m. Keep 
in mind that the purge utility is memory intensive and can occupy the 
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server for several minutes. Therefore, you should set the utility to run 
during off-peak hours.

� Save and close the file.

� Open the ALARMMANAGER.PROPERTIES file and verify that the 
following line exists:

AlarmPurgeService=yes

If the line does not exist, add it to the end of the file.

	 Save and close the file.


 Restart the server.

Running the Purge Utility from the Server Console

You can run the purge utility from the server console to force an immediate 
purge of the alarm manager database. Before you can run the utility, you must 
set up the AMPURGE.PROPERTIES configuration file as described in 
“Setting Up the Purge Utility Configuration File” on page 103. Keep in mind 
that the purge utility is memory intensive and can occupy the server for some 
time, especially if there are many alarms to be purged. Therefore, you should 
only run this utility during off-peak hours.

To run the utility:

� Go to the server console on the NetWare server where the alarm manager 
database is installed and execute the following command:

ampurge.ncf

Performing Actions on Alarms

You can configure an alarm to automatically perform an action when an alarm 
occurs. You do this by editing the alarm dispositions associated with each 
alarm template. Alarm dispositions are created for each alarm template in the 
Alarm Manager database and default settings are assigned. You can edit the 
alarm dispositions to enable the following actions:

� “Sending SMTP Mail Notification” on page 105

� “Launching an External Program” on page 106

� “Forwarding SNMP Traps to Other Management Systems” on page 108

� “Forwarding Alarms to Other Management Servers” on page 108
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� “Displaying a Ticker-Tape Message” on page 109

� “Making an Audible Beep” on page 110

� “Archiving Alarm Statistics” on page 111

Sending SMTP Mail Notification

You can send SMTP messages to recipients who are specified to receive e-
mail notification. 

To modify an alarm disposition to automatically send SMTP mail notification:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the SMTP Mail Notification tab.

	 Check the Notify through SMTP Mail check box.


 Enter the IP address of the SMTP host server that handles incoming and 
outgoing e-mail in the SMTP Host field. 

� Enter the name of the person sending the notification in the From field. 

� Enter the names of the e-mail recipients in the To field.

 Enter the subject of the e-mail in the Subject field.

�� Enter a message for the e-mail, if any, in the Message field.

�� Click OK.

Note that the subject and message text strings can contain any of the variables 
listed in the following table. These variables allow you to add details to your 
message about the segment or device generating the fault or event. All 
variables must be preceded by a percent sign (%). For example, the subject 
line could include the %v variable to display the severity of the alarm. 

Variable Parameter Name Description

a Alarm ID Identification number of the alarm 
as it is stored in the database.
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Launching an External Program

As part of editing the disposition of an alarm, you can set options to launch an 
NLM automatically when an alarm is received. For example, you might want 
an alarm to launch a program that sends a message to the system 
administrator’s pager. 

In addition to specifying the program to launch, you can also specify 
arguments and variables to be passed to the program.

+,17� Although ZfS provides the capability to launch applications, the product 
does not supply any predefined programs. However, you can launch an NLM and 
run scripting routines or use third-party programs.

To set up automatic application launching:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

c Affected class Class of equipment that sent the 
alarm. This can be any portion of 
the network and is categorized in 
the database for indexing.

o Affected object number Identification number of the node 
that generated the alarm as it is 
stored in the database.

s Alarm summary string Message describing the alarm. 
(This is the same as the status bar 
ticker-tape message.)

t Alarm type string Description of the alarm. This 
matches the description in the 
Alarm Type column in the Alarm 
Summary window.

v Severity number Alarm severity can be
1 = critical
2 = major

3 = minor
4 = informational

All others are unknown.

Variable Parameter Name Description
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� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the Launching Application tab.

	 Check the Launch Application check box.


 Enter the path and name of the application in the Application Name field.

� Enter any necessary execution arguments or script variables in the 
Argument field > click OK.

Arguments are passed directly to the program; text is not parsed, but is 
read as literal text strings. Variables must be preceded with a percent sign 
(%). The percent sign can be followed by an optional length field that 
limits the length to which the parameter can expand.

Keep in mind that total length of the Program field cannot exceed 126 
characters. The total length of the Parameters field cannot exceed 119 
characters after replacement. The combined total of the Program and 
Parameter fields cannot exceed 139 characters before replacement.

The following table lists the variables you can use when launching a 
program.

Variable Name Description

a Alarm ID Identification number of the 
alarm as it is stored in the 
database.

c Affected class Class of equipment that sent 
the alarm. This can be any 
portion of the network and is 
categorized in the database for 
indexing.

o Affected object number Identification number of the 
node that generated the alarm 
as it is stored in the database.

s Alarm summary string Message describing the alarm. 
(This is the same as the status 
bar ticker-tape message.)
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Forwarding SNMP Traps to Other Management Systems

AMS can be configured to forward an unmodified SNMP trap. Specify the IP 
address of the target management station or server in the alarm disposition and 
the trap is automatically forwarded. 

To forward SNMP traps:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the SNMP Trap Forwarding tab.

	 Enter the IP address of the server to which you want to forward traps in 
the SNMP Target Address field > click Add.

The server is added to the List of Targets. Repeat this step for all servers 
you want to receive the traps.


 Click OK.

Forwarding Alarms to Other Management Servers

AMS can be configured to forward a processed alarm to other ZfS 
management servers. You specify the IP address or server name of the target 

t Alarm type string Description of the alarm. This 
matches the description in the 
Alarm Type column in the 
Alarm Summary window.

v Severity number Alarm severity can be
1 = critical

2 = major
3 = minor
4 = informational

All others are unknown.

Variable Name Description
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management server in the alarm disposition and the alarm is automatically 
forwarded. 

To forward alarms:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the Alarm Forwarding tab.

	 To add a target server to receive the alarms:

	� Select the ZfS site to which you want to forward alarms in the Site 
Name field.

	� Select the ZfS host to which you want to forward alarms in the Site 
Host field.

	� Click Add.

The server is added to the List of Targets. Repeat this step for all servers 
to which you want to forward alarms.


 Click OK.

Displaying a Ticker-Tape Message

The alarm disposition includes other configuration settings that include 
displaying a ticker-tape message in the status bar of the management console. 
The message provides a summary of the most recent alarm or network event. 

This option is enabled by default. You may want to edit your alarm 
dispositions so that only important alarms that you want to monitor display a 
ticker-tape message. 

To disable or enable a ticker-tape message:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.
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The Edit Alarm Disposition screen is displayed.

� Click the Other Configuration tab.

	 To disable the ticker-tape message, uncheck the Show on Ticker Bar 
check box.

or

To enable the ticker-tape message, check the Show on Ticker Bar check 
box.


 Click OK.

Making an Audible Beep

The alarm disposition includes other configuration settings that include 
making an audible beep at the management console. The sound alerts the user 
of an occurrence of an alarm. Useful applications of this function include: 

� Server abend 

� System: Server downed by user

� File system full

This option is disabled by default. You should enable this option for important 
alarms that you wish to monitor. 

To enable or disable an audible beep: 

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the Other Configuration tab. 

	 To enable the audible beep function, check the Beep on Console check 
box.

or

To disable the audible beep function, uncheck the Beep on Console check 
box.


 Click OK.
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Archiving Alarm Statistics

The AMS system provides data to the reporting tools to generate detailed 
reports on alarms and network events. Enabling the Archive option stores the 
statistical data for the alarm instance in the alarm manager database on the 
management server. This option is enabled by default. You should disable this 
option only on the types of alarms that you do not want to track and analyze. 

To enable or disable alarm archiving:

� Right-click the ZENworks for Servers site object in the left frame of 
ConsoleOne > click Properties.

� Click the Alarm Disposition tab.

� Select the alarm that you want to edit from the Alarm Templates list > 
click Edit.

The Edit Alarm Disposition screen is displayed.

� Click the Other Configuration tab.

	 To disable alarm archiving, uncheck the Archive check box.

or

To enable alarm archiving, check the Archive check box.


 Click OK.

Maintaining the Alarm Management System

The alarm manager database on the ZfS management server increases in size 
each time AMS logs an alarm. 

,03257$17��If you do not control the size of this database, it can increase until 
it fills the hard disk on the management server.

A proactive step that you can take to prevent the alarm manager database from 
getting too large is to regularly delete alarms that have been resolved or you 
are not interested in. Doing so deletes the instance of the alarm record from 
the alarm manager database. You can delete alarms from the Alarm History 
view in the management console under the View menu. For more information, 
see “Deleting Alarms” on page 101.
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Troubleshooting the Alarm Management System

When AMS receives an unsolicited SNMP trap from an agent, it locates the 
appropriate alarm template for the trap-type object that is defined in the 
device’s MIB. If the alarm template is not available, the alarm is not logged. 

To resolve this problem you need to add the device’s MIB to the MIB Pool on 
the management server. The MIB contains the trap definitions for traps sent 
from the device. If the trap-type object is undefined by AMS, it cannot resolve 
the type of alarm received from the trap object identifier (OID), and the alarm 
is unknown. See Chapter 9, “MIB Tools,” on page 317 for information on 
compiling MIBs and adding MIBs to the MIB Pool.

If you add a new device to your network, you must add the MIB to the MIB 
Pool. If the SNMP agent is a proxy agent hosted on a station and the software 
is updated, you need to update the MIB in the MIB Pool.
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Server Management 

The ZENworksTM for Servers (ZfS) Server Management components allow 
you to monitor, configure, and control the managed servers and nodes on your 
network. The SNMP-based server management agents for NetWare® and 
Windows NT* servers provide real-time server performance data and 
information about server alarms and events to network management consoles. 
By selecting a server or node from Atlas page maps or hierarchical lists in the 
left pane of the management console, you can access three main views of 
information:

� Console View: Provides details about the selected server or node. You 
can drill down into the server configuration to display information about 
the internal components of the machine, such as the devices, operating 
system, and services available on the machine.

� Summary View: Provides details about the server performance, such as 
alarms generated by the server, CPU utilization, and available disk space. 
By drilling down into the server configuration, you can also view 
summary information about other components, such as processors, 
threads, memory, and volumes.

� Trend View: Displays graphical representations of trend parameters, 
allowing you to monitor the state of a server over various periods of time. 
Using trend data, you can track the health status of servers allowing you 
to predict potential problems and plan for future expansion of server 
configurations.

In addition to viewing information about the servers on your network, the 
server management components also enable you to configure your managed 
NetWare servers and execute frequently used commands from the 
management console.
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The following figure displays a functional view of the ZfS Server 
Management components. It illustrates the management agent for NetWare 
and management agent for Windows NT distributed throughout a network.

This section contains the following topics to help you understand the server 
management components:

� “Understanding Server Management” on page 114

� “Planning for Server Management” on page 117

� “Optimizing Server Management” on page 120

� “Managing Servers” on page 137

� “Object Hierarchy and View Details” on page 151

Understanding Server Management

The management agent for NetWare and management agent for Windows NT 
include features that offer benefits over server management functionality 
included with NetWare and Windows NT server software. 
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This section includes the following topics:

� “SNMP-Based Server Management” on page 115

� “SNMP Agent Functions” on page 116

SNMP-Based Server Management

The main advantage of the management agent for NetWare and management 
agent for Windows NT is that they support the industry standard Simple 
Network Management Protocol (SNMP). SNMP is the protocol governing 
network management and the monitoring of network devices and their 
functions. 

The ZfS SNMP agents support UDP/IP, IPXTM, and NCP implementations for 
accepting and sending packets (datagrams). This standard mechanism allows 
any SNMP console or manager to request information from the ZfS Server 
Management SNMP agents. An SNMP console can be any console that 
supports SNMP; the ZfS management console fully supports SNMP v.1 
communication.

SNMP Agents

The ZfS server management SNMP agents run on NetWare and Windows NT 
servers in your network. The agents monitor servers, collecting historical data 
and dynamic data in response to requests from the management console. An 
administrator at the ZfS management console can request data simply by 
clicking a representative icon for any device, operating system, or service 
discovered on a server.

The following figure illustrates an internetwork using the management agent 
for NetWare and management agent for Windows NT and the ZfS 
management console.
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SNMP Agent Functions

The functionality of the management agent for NetWare and management 
agent for Windows NT (the Novell SNMP-based agents for NetWare and 
Windows NT servers) can be divided into the following areas: 

� Collecting Statistics

� Monitoring: Server monitoring provides instant information about 
various monitored elements of the server, such as CPU utilization, 
memory size, cache buffers, connected users, volumes, disks, disk 
space usage per user, network adapters, print queues, print jobs, and 
loaded NetWare Loadable ModulesTM (NLMsTM) on NetWare or 
Windows NT servers.

� Trending: Trends provide historical data about various server objects 
and can be displayed in a diagram on the SNMP console. Trends are 
stored at the server side, which eliminates the need for continuous 
polling from an SNMP manager, and this data can be accessed via 
SNMP by any ZfS management console or other SNMP-based 
console.

� Alarm Notification: More than 580 different types of alarms or events 
(SNMP traps) can be sent from any NetWare server to the ZfS 
management system or to any other SNMP-based console.
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Any Windows NT system, security, or application event is converted to 
an SNMP trap and sent to the ZfS management system or to any other 
SNMP-based console. 

The alarms inform the administrator about events that have occurred or 
thresholds which have been crossed. 

� Configuration Management: The management agent for NetWare enables 
network administrators to remotely configure NetWare servers. There are 
187 SET parameters on the NetWare server that can be used to tune the 
server’s performance. Administrators can view settings and change all 
parameters from any ZfS management console.

The SNMP agents must be installed on any server that you want to manage. 
For information on installing the SNMP agents, or if you have already 
installed the agent software to servers that you want to manage, see ZENworks 
for Servers Installation and Setup. 

Planning for Server Management

A baseline defines the typical activity of your network servers. Keeping a 
baseline document of activity on a server lets you determine when the activity 
is atypical. To create a baseline activity, you should gather statistical 
information when the server is functioning typically.

This section contains the following information to help you plan your server 
management strategy:

� “Creating a Baseline of Typical Server Activity” on page 117

� “Using the Baseline Document” on page 118

� “Server Baseline Document Tips” on page 119

Creating a Baseline of Typical Server Activity

For server statistics such as CPU utilization, you should create a trend graph 
that plots information over a period of time. Statistics sampling that gathers 
data over a short period of time can be misleading. If you modify the server’s 
configuration, it is useful to create another baseline against which you can 
compare future activity.

There are two ways to create baseline documents. The first is to create them 
manually by printing the various trend graphs for which you want to maintain 
baselines. The other way is to use the server management health reports as 
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your baseline documents. For more information on creating and generating 
health reports, see “Managing the Server Management Health Reports” on 
page 367. In either case, the data gathered can be exported into programs, such 
as spreadsheets, for further analysis and to maintain records over time.

Using the Baseline Document

The following sections will help you plan and use the baseline document:

� “Using Baseline Documents to Set Alarm Thresholds Appropriately” on 
page 118

� “Using Baseline Documents to Track Server Utilization” on page 118

� “Use Baseline Documents in Troubleshooting” on page 118

Using Baseline Documents to Set Alarm Thresholds Appropriately

You should set alarm thresholds for statistics on servers monitored by the 
SNMP agent software, so that if the threshold is exceeded, you are notified at 
the management console. Setting alarm threshold values for statistics on a 
server eliminates the need for you to constantly monitor polled server statistics 
for problems.

Server Management components provide default values for thresholds set on 
server statistics; rising and falling statistics generate an alarm when a 
threshold is surpassed.

Using Baseline Documents to Track Server Utilization

By comparing current server performance statistics against the performance 
recorded in your baseline document, you can determine how performance is 
affected by server configuration changes. This comparison also helps you plan 
for growth and justify upgrades and expansion. You can view graphs of real-
time trends and historical trends over hourly, daily, weekly, monthly, and 
yearly periods.

Use Baseline Documents in Troubleshooting

By knowing what the typical server activity is, you can recognize atypical 
activity, which might help you isolate the cause of a problem.
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Server Baseline Document Tips

You should include the following key characteristics in each server baseline 
document:

� “CPU Utilization” on page 119

� “Cache Buffers” on page 119

� “File Reads and Writes” on page 119

� “Volume Utilization” on page 120

� “Running Software” on page 120

CPU Utilization

The CPU Utilization statistic indicates how busy the microprocessor is. High 
CPU utilization can cause slow network response time. Utilization is likely to 
be higher at some times during the day (for example, when users log in to the 
network in the morning, or access e-mail), week, or month. Tracking CPU 
utilization helps you track the load on the server processor at peak and low 
times. This information helps you determine the effect of current system and 
application processor demands and analyze the impact on performance.

Cache Buffers

Virtually all processes are handled through server cache, a block of server 
memory (RAM) in which files are temporarily stored. Cache buffers greatly 
increase server performance and enable workstations to access data quicker 
because reading from and writing to memory is much faster than reading from 
or writing to disk. The optimum cache buffer is 65% to 75% of total server 
memory (more does not hinder performance). Low cache buffers can cause 
slow server performance and abends. Service degrades noticeably at 45% of 
total server memory.

File Reads and Writes

By including data about file reads and writes in your baseline and tracking it, 
you might be able to determine whether a bottleneck is caused by the disk I/O 
channel. For example, if an increasing number of “server busy” packets are 
sent to users and there is also an increase in the file read and write number, the 
cause of the bottleneck might be a slow disk I/O channel or bad disk adapter 
driver. 
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Volume Utilization

Tracking volume utilization is primarily for capacity planning. By tracking the 
volume space used over time, you can accurately predict when you must 
purchase additional storage. Tracking volume utilization can also help you 
prevent the server from running out of disk space.

Running Software

By including information about running software in your baseline, it is easier 
to spot a problem application when comparing software on different servers. 
It is useful to also include the memory each application uses. Then, if the 
server is running short of memory, you can quickly see which applications are 
using the most memory. 

Optimizing Server Management

Examine each of the configuration options in the sections that follow to 
determine whether you require any of the functionality provided:

� “Securing SNMP Transactions” on page 120

� “Setting Default Trends and Thresholds” on page 127

� “Controlling Alarm Generation” on page 133

� “Defining Recipients for SNMP Alarms” on page 136

Securing SNMP Transactions

Because Management Agent for NetWare and ManageWise® AgentTM are 
based on SNMP, all actions that are directed from network management 
consoles to a server involve SNMP SET and GET requests from the manager 
to the agent. Any management console requesting data from a managed server 
does so by issuing an SNMP GET request. An SNMP SET command is 
required to set server alarm thresholds or configuration parameters. In most 
cases, you are unaware of the underlying SNMP commands required to carry 
out requests you make from a management console, unless you are issuing 
requests on an SNMP-enabled device through the MIB Browser. 

Conducting these management operations from a remote management 
console, such as ConsoleOneTM, raises the issue of ensuring security. In 
particular, if unchecked, unauthorized users setting configuration parameters 
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on a server could cause severe performance problems or even sabotage 
network operations.

For these reasons, you should establish a scheme for changing the default 
community name PUBLIC to a proprietary community name used for 
communication between the management system and your SNMP agents.

You can configure the SNMP SET and SNMP GET commands separately. 
For example, you might want to allow PUBLIC access to configuration 
information on your server, but allow only limited access for changing 
configuration parameters. For more information, see “Securing SNMP 
Transactions on a Managed Server” on page 121.

You set this option at NetWare servers using the LOAD SNMP command, as 
described in “Configuring Community Name Options Using SNMP LOAD 
Commands” on page 122. You can also set this option using the 
Internetworking Configuration utility (INETCFG) on NetWare 4.x or 
NetWare 5.x servers, as described in “Configuring Community Name Options 
Using INETCFG” on page 123. 

You set this option at Windows NT servers using the Network applet in the 
Control Panel, as described in “Setting SNMP Community Name: Windows 
NT” on page 127. 

,03257$17��On SFT IIITM servers, you must set the ControlCommunity string on 
the IO Engine to the community name the MS Engine uses.

Securing SNMP Transactions on a Managed Server

Security for SNMP management is often provided through use of the SNMP 
community name. Both the NetWare and Windows NT servers support the 
SNMP lightweight security by providing a mechanism that enables you to set 
a community name for SNMP communication.

Community names are used to authenticate SNMP commands received at the 
NetWare Management Agent server. The community name in a message 
requesting a given access type must match the name defined by that access 
type by one of the SNMP community options.

To accomplish this, set a unique community name at NetWare servers where 
NetWare Management Agent is installed and at Windows NT servers where 
the ManageWise Agent is installed. Any management console requesting 
access to the server must use the same community name or access is denied. 
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Community names are arbitrary ASCII strings of up to 64 characters. They 
can include any character except a space, tab, open square bracket ([), equals 
sign (=), colon (:), semicolon (;), or number sign (#).

The community name can be set to any of the following options:

� Read access or read/write access by anyone

� Read access or read/write access by management consoles specifying the 
correct community name

This security mechanism is limited and insufficient for networks where 
security is highly valued. This is because the community name is not 
encrypted and can be read easily using a network protocol analyzer. 

Detailed information on setting the SNMP community name is included for:

� “Setting SNMP Community Name: NetWare Server” on page 122

� “Setting SNMP Community Name: Windows NT” on page 127

� “Setting SNMP Community Name: Management Consoles” on page 127

Setting SNMP Community Name: NetWare Server

You configure security access for SNMP communications using either SNMP 
LOAD command line parameters (NetWare 3.x/4.x/5.x servers) or through 
INETCFG (NetWare 4.x/5.x servers, or servers with NetWare MultiProtocol 
RouterTM software installed).

The following sections contain additional information to help you configure 
your NetWare servers:

� “Configuring Community Name Options Using SNMP LOAD 
Commands” on page 122

� “Configuring Community Name Options Using INETCFG” on page 123

Configuring Community Name Options Using SNMP LOAD 
Commands

The LOAD command accepts the following SNMP option parameters:

� MonitorCommunity: Sets the community name for read-only (GET) 
access. The default value is PUBLIC. The syntax is as follows:

LOAD SNMP MonitorCommunity=community_name
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� ControlCommunity: Sets the community name for read and write (GET 
and SET) access. By default, this community name is disabled.

The syntax is as follows:

LOAD SNMP ControlCommunity=community_name

These options set the community name for the indicated community. The 
following table shows examples of available settings:

,03257$17��Community names are case-sensitive. 

Configuring Community Name Options Using INETCFG

To configure the community name options using INETCFG:

� At the server prompt, enter LOAD INETCFG.

Access Available to 
Requester

Read Only Read/Write

Any community name Load SNMP 
MonitorCommunity= “”

or

LOAD SNMP 
ControlCommunity=””"

LOAD SNMP 
ControlCommunity=""

Community name: 
"secret"

Load SNMP 
MonitorCommunity=
secret

or

LOAD SNMP 
ControlCommunity=
secret

LOAD SNMP 
ControlCommunity=
secret

Community name: 
"str1" or "str2"

Load SNMP 
MonitorCommunity=
str1

and

LOAD SNMP 
ControlCommunity=
str2
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� From the Internetworking Configuration menu, click Manage 
Configuration > Configure SNMP Parameters > Monitor State.

� Select one of the following options:

These options let you indicate how SNMP handles SNMP read operations 
coming from outside this server.

Option Description

Any Community May Read Allows all GET (read) commands no 
matter what community name is 
provided in the incoming read request.

Leave as Default Setting Avoids changing the Monitor 
Community name from its default 
(which is usually PUBLIC). The default 
Monitor Community can still be 
changed manually through SNMP 
command line options, as described in 
“Configuring Community Name 
Options Using SNMP LOAD 
Commands” on page 122.
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� Press Enter.

	 Click Control State.


 Select one of the following options.

These options allow you to indicate how SNMP handles SNMP write 
operations coming from outside this server.

No Community May Read Allows GET (read) commands only for 
requests that are made by 
management consoles that have 
logged in to the server with 
SUPERVISOR or OPERATOR 
privileges. Any community name 
provided in an incoming read request is 
ignored.

Specified Community May Read Allows only GET (read) commands for 
requests that contain the name 
specified in the Monitor Community 
field. If you selected this option, type a 
name in the Monitor Community field, 
then press Enter. Enter the name of the 
community that is allowed to read 
management information. SNMP 
management stations that belong to 
this community can read the network 
management database.

Option Description

Any Community May Write Allows all SET (write) commands no 
matter what community name is 
provided in the incoming write request.

Option Description
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� Press Enter.

� When you are finished, press Esc. If prompted, click Yes to save changes 
to the SNMP parameters > press Enter.

 To return to the Internetworking Configuration menu, press Esc.

�� To exit INTECFG, press Esc.

,03257$17��Changes made in INETCFG are not active immediately. To make 
these changes take effect, bring down the server and restart it, or on NetWare 5 
servers, reinitialize the system.

Leave as Default Setting Avoids changing Control Community 
from its default, which usually allows 
write requests only for management 
consoles that have logged in to the 
server with Supervisor or Operator 
privileges. You can change the default 
manually through SNMP command line 
options, as described in “Configuring 
Community Name Options Using 
SNMP LOAD Commands” on page 
122.

No Community May Write Allows SET (write) commands only for 
requests that are made by 
management consoles that have 
logged in to the server with Supervisor 
or Operator privileges. Any community 
name provided in an incoming write 
request is ignored.

Specified Community May Write Allows only SET (write) commands for 
requests that contain the name 
specified in the Control Community 
field. If you selected this option, type a 
name in the Control Community field, 
then press Enter. Enter the name of the 
community that is allowed to write 
management information. SNMP 
management stations that belong to 
this community can read the network 
management database.

Option Description
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Setting SNMP Community Name: Windows NT

You configure security access for SNMP communications on Windows NT 
servers using the Network applet in the Windows NT Control Panel. For 
detailed information, refer to your Windows NT documentation or online 
help.

You must load the Microsoft* SNMP Service on your Windows NT servers. 
The SNMP community string setting must be the same as the SNMP 
community string setting on your management console. If you change the 
SNMP community string setting on your management console, you must 
change the setting on all your managed Windows NT servers. Use the Control 
Panel on each server to change the setting.

You must also load NWLink IPX/SPX* Compatible Transport driver on your 
Windows NT server. After loading this driver, configure the Manual Frame 
Type Detection setting and specify a unique number in the Internal Network 
Number input field if your server meets one of the following conditions:

� It is connected to multiple network cards.

� It supports multiple protocols.

Setting SNMP Community Name: Management Consoles

You set global community and trap target information using the SNMP 
property page associated with the site-level object. You can also customize the 
setting for a specific device using the SNMP property page of the device itself. 

Setting Default Trends and Thresholds

You can modify the default trends and threshold values from within the 
management console or manually modify files on servers that have the 
management agent for NetWare or management agent for Windows NT 
software installed.

When server agents are first loaded, the initial (default) values for trends and 
thresholds are read from the NTREND.INI file (NetWare) or the 
N_NTTREN.INI file (Windows NT). The initial values are also used 
whenever a new trend file is created. A new trend file is created when an 
instance of a monitored object (volume, disk, interface, and so on) is 
discovered on the server. The following is a sample excerpt from an 
NTREND.INI file:
Server Management ���

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
After the management agent for NetWare and management agent for 
Windows NT software is running, trend and threshold values can be changed 
(using the management console) by making use of the threshold-setting 
features of ZfS. If the server is brought down, it retains the last trend and 
threshold settings that were set. Initial values are reset when any of the 
following situations occurs:

� Trend files have been deleted manually.

� If the server configuration is modified, for example, by adding a new 
volume, disk, or interface.

,03257$17��Trends are not maintained for CD volumes. Therefore, changing 
trend parameters for CD volumes has no effect.

The following sections contain information to help you modify initial trend 
and threshold values:

� “Changing the Initial Trend Values” on page 129

� “Changing the Initial Threshold Values” on page 132
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Changing the Initial Trend Values

The trend values in the NTREND.INI file (NetWare) and N_NTTREN.INI 
file (Windows NT) specify the time interval (Sample Interval) at which a 
particular trend parameter is sampled, the duration of time for which those 
samples are kept (Trend Buckets), and whether this sampling parameter is 
enabled (Enbl). For each value specified by a line in the NTREND.INI file or 
N_NTTREN.INI file, a trend record is stored in a separate file in the 
SYS:\NTREND directory on a NetWare server and the \TRENFILE directory 
on a Windows NT server.

The following is an example of a line in the NTREND.INI file for the 
NUMBER_LOGGED_IN_USERS trend parameter with a Sample Interval of 
5, Trend Buckets specified at 60, and the enable parameter specified at 1 
(enabled).

The following sections describe how to set or alter each of the parameters 
required for a trend file:

� “Setting the Sample Interval” on page 129

� “Setting the Trend Buckets” on page 130

� “Enabling or Disabling a Trend File” on page 132

� “Backing Up Trend Data” on page 132

You can specify more than one sampling interval or duration for any trend 
parameter by creating another line in the NTREND.INI file or 
N_NTTREN.INI file.

Setting the Sample Interval

The trending software enables you to collect samples of a specified parameter 
at any of 12 possible time intervals (Sample Interval), from 5 seconds to 1 day.

Each of these sample intervals is specified by a code number in the 
NTREND.INI file and the N_NTTREN.INI file. The following table specifies 
the codes used in the NTREND.INI and N_NTREND.INI files for the 
permitted sample intervals. For example, if you want to sample a particular 
trend parameter once every hour, you would use the code 9.
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Setting the Trend Buckets

After you have determined a sample interval for collecting samples, you must 
set a duration of time for which you want to collect samples. For example, if 
you selected a sample interval of one hour for a particular parameter, you 
might decide that you want to be able to review the state of that parameter for 
every hour over the duration of a day.

You determine the duration of time for which a parameter is collected by the 
number of trend buckets you specify. You must specify a trend bucket for each 
sample that is collected over a specific period of time. For example, to review 
the state every hour for 1 day, 24 trend buckets (1 per hour x 24 hours in a day) 
are required.

The number of trend buckets required for any particular time duration and 
sample interval is calculated easily. However, for your convenience, the 
following table shows the number of trend buckets required for each sample 
interval allowed, for each of seven possible time durations of from 1 hour to 
1 year.

Sample Interval Code

5 seconds 1

10 seconds 2

15 seconds 3

30 seconds 4

1 minute 5

5 minutes 6

15 minutes 7

30 minutes 8

1 hour 9

4 hours 10

8 hours 11

1 day 12
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After you set the sample interval and the time duration for trend collection, 
you can compute the size of trend files. The number of trend buckets possible, 
and the approximate size in kilobytes (in parentheses), for a given sample 
interval and time duration are also given in the following table. The size of 
each trend bucket is 4 bytes plus 512 bytes for the header file. For example, if 
the sampling interval is 5 seconds for a period of 1 hour, the file size would be 
720 trend buckets x 4 bytes long (rounded to the closest 4 KB boundary) plus 
512 bytes for a total of 4.5 KB. There are always as many trend files as there 
are enabled trends.

After a particular time duration is exceeded for a file (all the trend buckets 
have been filled), the oldest samples are overwritten by the most recent 
samples. This means that the file contains the most recent duration recorded. 
For example, if you select a sample interval of 1 hour for a duration of 24 
hours (using 24 trend buckets), the associated file contains the trend data for 
the last 24 hours.

Sample Interval 1 Hour Duration 1 Day Duration 1 Week Duration 1 Month 
Duration

3 Months 
Duration

0 seconds 720 17280 120960 535680 1607040

1.0 seconds 360 8640 60480 267840 803520

15 seconds 240 5760 40320 178560 535680

30 seconds 120 2880 20160 89280 267840

1 minute 60 1440 10080 44640 133920

5 minutes 12 288 2016 8929 26784

15 minutes 4 96 672 2975 8928

30 minutes 2 48 336 1488 4464

1 hour 1 24 168 744 2232

4 hours 6 42 186 558

8 hours 3 21 93 279

1 Day 1 7 31 93
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Enabling or Disabling a Trend File

Each line in the NTREND.INI file and the N_NTTREN.INI file contains a 
parameter that either enables or disables the trending value to begin creating 
a trend file at startup. To enable the collection of data for a trend file, set this 
parameter to 1. To disable the collection of data for a trend file at startup, set 
this parameter to 0.

Backing Up Trend Data

Trend data is not automatically backed up. If you feel the need to back up this 
data, you must do so manually.

Changing the Initial Threshold Values

The default threshold values in the NTREND.INI file and the 
N_NTTREN.INI file specify when a trap is generated. User-defined values 
are stored in the trend file header. If the parameter rises above or falls below 
the set threshold value, a rising or falling trap type is sent. 

The following sections describe how to set or alter each of the parameters 
required for a threshold value:

� “Setting Rising and Falling Thresholds” on page 132

� “Enabling or Disabling a Threshold Trap” on page 133

Setting Rising and Falling Thresholds

Each line in the NTREND.INI file and the N_NTTREN.INI file contains a 
parameter for the rising threshold and the falling threshold. For each sample 
interval, a rising or falling trap can be generated as specified. After a trap is 
generated, another such trap is not generated until the sampled value falls 
below this threshold and reaches the falling threshold. The following figure 
provides an example of this process for a rising threshold trap.

In this example, Trap 1 is generated because it is the first time that the 
parameter value rises above the Rising Threshold. The next two times the 
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parameter value rises above the Rising Threshold, a trap is not generated 
because the parameter did not fall below the Falling Threshold. Trap 2 and 
Trap 3 are generated because the parameter value dropped below the Falling 
Threshold before exceeding the Rising Threshold.

Enabling or Disabling a Threshold Trap

Each line in the NTREND.INI file and N_NTTREN.INI file contains a 
parameter that enables or disables the NTREND.NLM software to send traps 
as determined by the rising and falling thresholds. This parameter is set to 1 to 
enable the software to send a trap for the values given, or to 0 to disable the 
software from sending a trap for this parameter.

Controlling Alarm Generation

Each managed server has a file that specifies which system events result in a 
trap. On NetWare, this file is NWTRAP.CFG, which is stored in the 
SYS:\ETC directory. On Windows NT, this file is NTTRAP.INI, which is 
stored in the MW\INI directory. Note that on NetWare, the trap configuration 
file is read only when NWTRAP.NLM is loaded; therefore, any changes made 
to the file do not take effect until the next time you load NWTRAP.NLM.

,03257$17��On a NetWare 3.x server, EDIT.NLM does not have a large enough 
buffer to edit the NWTRAP.CFG file. To edit the NWTRAP.CFG file, map a drive to 
the server SYS: volume and proceed from there.

You can modify the NWTRAP.CFG file or NTTRAP.INI file to modify the 
following:

� Types of alarms forwarded to management consoles 

� Community strings used for sending SNMP traps

� List of traps to be disabled, using the mask keyword

� Specific alarms that you want to prevent from forwarding

The configuration file consists of keywords and their associated data (case is 
ignored). Each keyword must be on a line by itself (except for mask values, 
where they might span several lines), and must be followed by one or more 
lines of associated data.

You can place comments anywhere in the file, even between a keyword and 
its associated information. A comment starts with a number sign (#), and 
continues to the end of the line.

The following is an example of an NWTRAP.CFG file:
Server Management ���

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
The following sections contain information to help you control alarm 
generation:

� “Defining the Community String (Management Agent for NetWare 
Only)” on page 134

� “Setting the Time Interval (Management Agent for NetWare Only)” on 
page 135

� “Configuring Alarm Severity Levels” on page 135

Defining the Community String (Management Agent for NetWare Only)

Use the community keyword to define the community string to be used in the 
generated traps. The length of the community string is restricted to 32 bytes 
and cannot contain a space (except between quotes), tab, square bracket, 
equals sign, colon, semicolon, or number sign (#) characters.

The default community string is public.
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Setting the Time Interval (Management Agent for NetWare Only)

Sometimes an alarm repeats rapidly (several times per second or per minute) 
with identical or nearly identical parameters. When this occurs, the second and 
later alarms within a time interval are usually not as interesting as the first 
alarm. 

To prevent the network and the management console from being inundated 
with identical alarms, you can specify a time interval to be applied to every 
alarm generated. During this interval, alarms that are identical to an initial 
alarm are discarded. 

You can define the time interval in the configuration file as follows:

Time Interval

n

where n can take any value from 0 to 232 to indicate the number of seconds 
that must elapse before a later alarm is not discarded. 

The default time interval is 10 seconds.

Configuring Alarm Severity Levels

Use the severity keyword to set a minimum alarm severity level so that traps 
for lesser severity alarms are not sent.

The severity levels you can set in the NWTRAP.CFG and NTTRAP.INI files 
are informational, warning, recoverable, critical, and fatal. 

NetWare Severity Level SNMP Severity Level ZfS Severity Level

0 - Informational Informational Informational

1 - Warning Minor Minor

2 - Recoverable Major Major

3 - Critical Critical Critical

4 - Fatal Fatal Critical

5 - Operation Aborted Fatal Critical

Unrecoverable Fatal Critical
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The default keyword is warning. Under the default, all alarms with a severity 
level of warning or greater are forwarded.

Defining Recipients for SNMP Alarms

You can configure the management agent for NetWare to send SNMP traps 
(alarms) to the ZfS management server or to other management nodes. 

127(��For setting trap destinations on Windows NT servers, see the 
documentation on the SNMP Service provided with the Microsoft Windows NT 
operating system software. 

Steps for designating trap target destinations are described in the following 
section.

Editing the TRAPTARG.CFG File Manually (Management Agent for NetWare Only)

You can configure trap recipients by manually adding them to the 
TRAPTARG.CFG file. This is useful for sending traps to third-party 
management consoles other than the ZfS management server.

You must add trap recipients manually by specifying their addresses in the 
TRAPTARG.CFG file, which is located in the SYS:\ETC directory of all 
NetWare servers.

The TRAPTARG.CFG file defines the recipients of SNMP traps. You can use 
this file to define recipients of SNMP traps over IPX and UDP/IP. The file is 
fully annotated to show you how to divide the file into IPX and UDP/IP 
sections and how to write the IPX and IP addresses of recipients.

The TRAPTARG.CFG file is read only when SNMP is loaded. In most cases, 
this means bringing the server down and restarting it because a variety of 
modules must be unloaded and reloaded as well. Thus, any changes made to 
the TRAPTARG.CFG file do not take effect until the next time you load 
NWTRAP.NLM.

If you are sending traps to third-party management stations, you might need 
to integrate the NetWare Server trap MIB into those management stations. The 
MIB can be found in the 
MWIT\MWSERVER\MIBCSERVER\MIBSERVERPOOL\MIBPOOL 
directory on the volume where you installed ZfS. 

,03257$17��The NWALARM.MIB file imports symbols from the Host Resources 
MIB (RFC1514.MIB), which can also be found in 
SYS:MWIT\MWSERVER\MIBCSERVER\MIBSERVERPOOL\MIBPOOL.
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Managing Servers

With the management agent for NetWare and management agent for 
Windows NT software installed on your NetWare and Windows NT servers, 
respectively, you can begin collecting data, receive alarm notifications, 
remotely manage configuration, and generate reports for managed servers.

Server Management tasks you can perform with ZfS include:

� “Displaying Server Configuration Information” on page 137

� “Displaying Summary Data” on page 138

� “Viewing Trend Data” on page 140

� “Managing Trend Samplings” on page 143

� “Configuring Server Parameters” on page 144

� “Executing Server Commands” on page 145

� “Managing Remote Servers” on page 147

Displaying Server Configuration Information

Server configuration data is organized in a hierarchical listing expanding 
down from the server object. You can view information about the server's 
configuration, memory usage, adapters, network interfaces, disks and disk 
controllers, volumes, queues, users, connections, open files, NLM files 
(NetWare), and installed software. 

To display server configuration information:

� Locate the server object you want to expand.

Servers are represented in Atlas page maps and in the hierarchical list in 
the left pane of the management console by the following icons: 

�  Server container

�  NetWare server

�  Windows NT server

�  Generic server

� Click the plus sign (+) next to the server object.
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The server object opens in the left pane under its parent object and the 
server contents are displayed. Server data is grouped into the following 
three categories:

�  Devices 

�  Operating System 

�  Services

� You can drill down into the server configuration farther by clicking the 
plus signs next to the Devices, Operating System, and Services objects as 
in the following example. 

Displaying Summary Data

The Summary View contains tables of statistics obtained by SNMP GET 
requests to the management agent for NetWare and management agent for 
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Windows NT software hosted on managed servers. Statistics are updated 
dynamically as the server is continually polled for data. Polling utilizes SNMP 
GET and GET NEXT requests to update the data. You can also control the 
polling of a selected object by using the stop and refresh functions. 

You can view summary data for server, processors, LAN adapters, disk 
adapters, storage devices, threads, interrupts, memory, address spaces, 
interfaces, connections, users, installed software, NLMs (NetWare), and 
volumes. For detailed information about a specific Summary view, see 
“Object Hierarchy and View Details” on page 151.

To display summary information:

� Right-click the object for which you want to view summary data > click 
Views > click Summary.

The Summary View is displayed. The following example shows the 
Summary View for a server object. The server summary provides 
descriptive information including the server’s NDS name and tree, IP 
address, RAM, operating system and version, IPX address, subnetwork 
mask, up time, logged-in users, open files, and status. In addition, the 
server summary lists all alarms for the server and displays graphical 
indicators of the CPU utilization and volume disk space as well as trend 
graphs for cache hits and cache buffers.
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Viewing Trend Data

On a server managed by management agent for NetWare or management 
agent for Windows NT, the agents automatically gather trend data on CPU 
usage, memory usage, and network interface traffic. You can then view 
current trend data, or historical trend data by hour, day, week, month, or year 
from the management console. In this view, the time interval that is being 
sampled is displayed on the x-axis. The parameter value over the sample 
period is plotted on the y-axis. Note that the values on the y-axis use the 
standard abbreviations K (for kilo), M (for mega), and G (for giga). Therefore, 
a value of 1K would equal 1000; similarly, a value of 1M would equal 
1,000,000.

Monitoring trend data helps you with tasks such as setting trend alarm 
thresholds, determining who is using the server and when the server is used 
heavily, troubleshooting problems, balancing loads across multiple servers, 
and planning resources. You can also export trend view data to popular 
spreadsheet formats for sharing data with others. 

You can view trend data for processors, LAN adapters, storage devices, 
memory, connections, users, and volumes. For information about a specific 
trend view, see “Object View Details” on page 153.

To view trend statistics:

� Right-click the object for which you want to view trend data > click 
Views > click Trend.

The Trend View is displayed. The following sections describe the tasks 
you can perform using the Trend View:

� “Displaying the Legend” on page 140

� “Modifying the Time Span” on page 141

� “Customizing the Trend View Display” on page 141

� “Modifying the Trend View Profile” on page 142

Displaying the Legend

The Trend View legend indicates what each color in the graph represents. 

To display the legend:

� Click the Legend button  in the Trend View toolbar.
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Modifying the Time Span

The Trend View time span specifies what time period the trend graphs 
represent. By default, a one-hour history is displayed. 

To modify the time span:

� Select a time span from the drop-down list in the Trend View toolbar. You 
can select from the following time spans:

� 1 Hour

� 1 Day

� 1 Week

� 1 Month

� 1 Year

Customizing the Trend View Display

The Trend View provides several options for customizing the look of the 
screen. In customizing the view, you can choose from the following options:

� “Displaying Grid Lines” on page 141.

� “Stacking and Unstacking Graphs” on page 142.

� “Scaling the Y Axis” on page 142.

Displaying Grid Lines

By default, the trend charts do not include grid lines. 

To display horizontal and/or vertical grid lines:

� To display horizontal grid lines, select the Horizontal Grid  button in 
the Trend View toolbar.

� To display vertical grid lines, select the Vertical Grid  button in the 
Trend View toolbar.

Note that you remove the horizontal or vertical grid lines by clicking the 
same buttons.
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Stacking and Unstacking Graphs

By default, all trends are displayed on a single graph with one vertical axis. 
However, you can customize the view so that each trend is displayed in its 
own separate graph. 

To stack and unstack graphs:

� To display the trends on separate graphs, click the Strip Chart  button 
on the Trend View toolbar.

� To display trends on the same graph, click the Stack Chart  button on 
the Trend View toolbar.

Scaling the Y Axis

To display more useful information on your trend graphs, you may find that 
you need to modify the scale on the Y axis as follows:

� To increase the scale on the Y axis, click the Increase Y Axis  button, 
which is located to the left of the graph(s).

� To decrease the scale on the Y axis, click the Decrease Y Axis  
button, which is located to the left of the graph(s).

� To scale the Y axis to fit in the window, click the Scale to Fit  button 
on the Trend View toolbar.

Modifying the Trend View Profile

The Trend View profile represents the set of parameters that are displayed 
graphically when the Trend View is invoked. You can modify which 
parameters are displayed in the Trend View by editing the profile.

To edit the profile:

� Click the Profile button  in the Trend View toolbar.

The Profile dialog box is displayed. The parameters that are currently 
displayed in the Trend View for the object are selected.

� Edit the profile by clicking a parameter name to select or deselect it.

You can Shift+click multiple, consecutive parameters and Ctrl+click 
multiple, non-consecutive parameters.

� Click OK.
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Managing Trend Samplings

You can customize the parameters of the trend data displayed using the 
following options: 

� “Modifying Trend Sampling and Intervals” on page 143.

� “Modifying Threshold Alarm Settings” on page 143.

Modifying Trend Sampling and Intervals

For each trend for which the server agents collect data, you can set sampling 
intervals and the number of samples stored on the server as follows: 

� Right-click the object > click Properties.

� Click the Trend tab.

� Select the trend parameter you want to modify > click Edit.

The Edit Trend dialog box is displayed. The trend sampling and interval 
settings are displayed in the Sampling Parameters section of the screen.

� To enable or disable the sampling parameter, select the appropriate value 
from the State drop-down list.

	 To modify the time interval (Sample Interval) at which the trend 
parameter is sampled, select a value from the Frequency drop-down list.

You can select one of 12 possible time intervals from five seconds to one 
day.


 Specify the duration of time for which to collect samples by entering a 
value in the Number of Samples field.

You determine the duration of time for which a parameter is collected by 
the number of samples (trend buckets) you specify. You must specify a 
trend bucket for each sample that is collected over a specific period of 
time. For more information on setting the number of samples required, 
see “Setting the Trend Buckets” on page 130.

� When you are done modifying the alarm threshold settings, click OK. 

Modifying Threshold Alarm Settings

You can set an alarm threshold for each trend parameter for which the 
management agent for NetWare collects data. Once you set the alarm 
threshold, the management agent for NetWare sends an alarm to the 
management console if the trend crosses the threshold you set.
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The management agent for NetWare tracks both rising and falling alarm 
thresholds. Each trend parameter has either a rising or a falling threshold 
associated with it; the type of threshold cannot be changed. 

To change alarm thresholds through the management console:

� Right-click the object > click Properties.

� Click the Trend tab.

� Select the trend parameter for which you want to modify threshold 
settings > click Edit.

The Edit Trend dialog box is displayed. The threshold alarm settings are 
displayed in the Rising Alarm Parameters section of the screen.

� To enable or disable the alarm parameter, select the appropriate value 
from the State drop-down list.

	 To set or modify the rising threshold, enter a value in the Rising 
Threshold field.


 To set or modify the falling threshold, enter a value in the Falling 
Threshold field.

� When you are done modifying the alarm threshold settings, click OK.

Configuring Server Parameters

In order to correct an alarm condition, fine-tune server performance, or fix 
other problems detected on a server, you need to modify the server 
configuration. Server configuration can be adjusted from the management 
console on any NetWare server hosting the management agent for NetWare. 
SET parameters, usually set at the server console or through a remote console, 
can be configured from the management console interface. From the 
management console, you can see the current settings, change one or more 
settings, and confirm your settings before adjustments are sent to the server. 

For parameter values and descriptions, see the NetWare server 
documentation. This information is generally found in the Utilities Reference 
document. 

To view or modify the NetWare SET parameters from the management 
console:

� Drill down into the server you want to configure by clicking the plus sign 
(+) next to the server object.
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� Right-click the Operating System object > click Properties.

The Set Parameters tab is displayed. This tab page lists the NetWare SET 
parameters and their current values.

� Click the down-arrow icon on the Set Parameters tab > click the category 
of SET parameters you want to display.

You can choose from the following categories: Communications, 
Directory Caching, Directory Services, Disk, Error Handling, File 
Caching, File System, Licensing Services, Locks, Memory, 
Miscellaneous, Multiprocessor, NCP, Service Location Protocol, Time, 
or Transaction Tracking.

� Select the parameter you want to modify > click Edit.

The Edit Parameters dialog box is displayed.

	 Enter the new parameter value in the appropriate field.


 Indicate when you want the parameter change to take effect by selecting 
the appropriate radio button from the Apply Value box. You can choose 
to apply the change at the following times:

� Now, until reboot

� Only after reboot

� Now, and after reboot

� Click OK.

Executing Server Commands

You can execute the following frequently used NetWare server commands 
from the management console.

� “Loading and Unloading NLMs” on page 145

� “Mounting and Dismounting Volumes” on page 146

� “Clearing a Server Connection” on page 146

� “Restarting a Server” on page 146

� “Shutting Down a Server” on page 146

Loading and Unloading NLMs

To load or unload an NLM from the management console:
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� Right-click the NLM object > select a command from the menu as 
follows:

� To load the NLM, select Load nlm

� To unload the NLM, select Unload nlm

Mounting and Dismounting Volumes

To mount or dismount a volume:

� Right-click the volume object > click Mount Volume.

or
Right-click the volume object > click Dismount Volume.

The system displays a confirmation box.

� Click OK.

Clearing a Server Connection

You can clear a server connection when the server has crashed and left open 
files on the server or before bringing down the server. This is equivalent to the 
CLEAR STATION command that you can execute from the server console. 

To clear a server connection from the management console: 

� Locate the connection you want to close by expanding the following 
objects: Server > Operating System > Network > Connections.

� Right-click the connection you want to close > click Clear Connection.

Restarting a Server

To restart a server from the management console:

� Right-click the server object > click Restart Server.

Shutting Down a Server

To shut down a server from the management console:

� Right-click the server object > click Down Server.
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Managing Remote Servers

The following sections provide information about remotely managing 
NetWare and Windows NT servers on your network.

� “Managing Remote NetWare Servers” on page 147

� “Managing Remote Windows NT Servers” on page 148

Managing Remote NetWare Servers

You can manage NetWare servers remotely from the management console for 
greater server security. You can lock servers in a safe place, remove the 
keyboards and monitors, then start a remote console session from a 
workstation to access a server console.

NetWare 5.x provides a Java*-based (RCONSOLEJ) remote console utility 
that lets you use a network workstation to manage a remote NetWare server. 
For details, see “Managing Remote Servers” on page 147. RCONSOLEJ can 
be used to control NetWare servers from the management console.

You can remotely manage NetWare servers based on your role in the 
organization and the tasks assigned to you. From the management console, 
you can perform the following role-based remote management tasks on 
remote NetWare servers on your network:

� Use console commands as you would at the server console

� Scan directories and edit text files in NetWare and DOS partitions on a 
server

� Install or upgrade NetWare

To remotely control NetWare servers from the ZfS Management Console:

� During ZfS installation, choose the Install Site Management Services and 
Agents option.

� From the list of components that you can install, choose Remote 
Management.

� When prompted, provide a password for the agent that you will need 
when you use the agent services from the management console during the 
remote control session.

� Select the server on which you want to install the agent.

	 Complete the installation and reboot the server on which you have 
installed the agent.
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 From the management console, right-click the NetWare server on which 
you have installed the NetWare remote control agent > click Remote 
Console.

� Select the address to which you want to connect.

� When prompted, enter the agent password.

The remote console session is now open. The workstation screen displays the 
same information you would see on the server console screen.

Changing the Agent Password for a Remote NetWare Server

To change the agent password for a remotely managed NetWare server:

� At the NetWare Console prompt, enter unload rconagp to unload 
RCONAGP.NLM.

� Enter load rconagp encrypt.

� Enter a new password.

� Enter the TCP port number. The default is 2037.

	 Enter the SPX port number. The default is 16801.


 Enter y when prompted to save the following command line in the 
LDFCAGNT.NCF file.

LOAD RCONAGP - file RCONAG6.CFG <TCP port number> 
<SPX port number> 

The new password takes effect when the agent is loaded.

Managing Remote Windows NT Servers

You can remotely manage a Windows NT server console from any 
workstation that runs the management console. The Remote Management 
Agent is installed during ZfS installation. For more information, see 
ZENworks for Servers Installation and Setup. 

You can remotely manage Windows NT servers from the management 
console if you have been assigned the remote management tasks. The 
following role-based remote management tasks can be performed on 
Windows NT servers connected to your network:

� Remotely control the Windows NT server to resolve software-related 
problems on the server
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� Remotely view the desktop of the Windows NT server and see when an 
action is performed incorrectly

To remotely manage a Windows NT server:

� Right-click the remote server from the management console.

�� To remotely control the server, click Remote Operation > Control.

�� To remotely view the server, click Remote Operation > View.

�� Select the address to which you want to connect.

The agent is pinged. If it is up and running, you will be prompted for the 
agent password.

� Enter the password that you established when you installed the agent on 
the server.

The remote console session is now open. The Viewing Window displays on 
the management console representing the desktop of the remote Windows NT 
server. Use the following Viewing window control options to manage the 
remote server.

Viewing Window Control 
Option

Description

Accelerator Keys 
Enabled

Enables the accelerator keys on the management 
console so that default accelerator key sequences are 
always available during the remote session.

System Key Pass-
Through

Passes Alt-key sequences on the management 
console to the remote Windows NT server.

During a Remote View session, the System Key 
Pass-Through option is not enabled.

Suppress Wallpaper Suppresses any wallpaper displayed on the managed 
workstation.

Force 16-Color Viewing Forces the use of 16-color palette on the remote 
Windows NT sever during a remote session. This 
enhances the remote session performance.

Use this option only if you are performing a remote 
session over a slow WAN.
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Use the following Viewing window toolbar buttons to manage the remote 
server.

,03257$17��During a Remote View session, only the Navigate button is 
displayed in the Viewing window.

You can change the agent password from the Security option of the Remote 
Management Agent icon. For details, see “Changing the Agent Password for 
a Remote Windows NT Server” on page 151. You can also change the default 
security settings for remote control and remote view sessions with the 
Windows NT server. For details, see “Editing Security Parameters” on page 
151.

Viewing Window 
Toolbar Button

Description

Start Opens the taskbar with the Start button on a remote 
Windows NT server.

Application Switcher Switches applications on a remote Windows NT server. 
If this option is on, press only the Tab key on the 
management console to select applications, and then 
switch the button off.

CTRL-ALT-DEL/
Reboot

Displays the Security window on a remote Windows NT 
server.

System Key Pass-
Through

Passes Alt-key sequences on the management 
console to the remote Windows NT server.

Certain key sequences such as Ctrl+Esc, Alt+Tab, 
Ctrl+Alt+Del, and Alt+PrintScreen are not allowed, 
even when the System Key Pass-Through is set to On. 
However, you can use the toolbar buttons on the 
Viewing window for the Ctrl+Esc, Alt+Tab, and 
Ctrl+Alt+Del keystrokes.

Navigate Displays the different areas of the desktop of the 
remote Windows NT server. You can move the red 
frame on the Viewing window to focus on a particular 
area of the remote server desktop.
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Changing the Agent Password for a Remote Windows NT Server

During the ZfS installation, you can choose to install the Remote Management 
Agent. When you do so, you are prompted to establish a password that you 
will need in order to use the agent services.

You should change the agent password frequently to ensure that remote 
control and remote view sessions are secure.

To change the agent password:

� Right-click the Remote Management agent icon from the taskbar of the 
Windows NT server that you want to remotely manage.

� Click Security > click Change Password.

Editing Security Parameters

The following default security settings are provided for remote control and 
remote view sessions.

� Every 1 second (the default), the user receives an audible signal from the 
console indicating that the server is being accessed.

� Every 2 seconds (the default), the user receives a visible signal from the 
console, indicating that the server is being accessed. The visible signal 
displays the name of the user accessing the remote server.

� The Remote Management Agent icon is displayed in the taskbar of the 
server that is being accessed.

You can change the default security settings based on your security 
requirements.

To change security settings:

� Right-click the Remote Management Agent icon from the taskbar of the 
remote server.

� Click Edit Security Parameters.

Object Hierarchy and View Details

When you expand a managed server object, you can view details about the 
contents of the server. The following sections detail the available objects on a 
managed server and provide information about the statistical information 
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available in the views for each object. This topic contains the following 
sections:

� “Object Hierarchy” on page 152

� “Object View Details” on page 153

Object Hierarchy

The following table shows the hierarchy of available objects on a managed 
server along with their associated icons. For more information about the 
available views associated with an object, follow the corresponding link.

Category Container Sub-category Containers Object Containers Objects

 Devices  “Processors” on 
page 154

 Processor

 “Adapters” on 
page 158

 LAN Adapters  Adapter

 Disk Adapters  Adapter

 “Storage Devices” 
on page 155

 Storage Device

 Operating System  Kernel  “Threads” on page 
159

 Thread

 “Interrupts” on 
page 160

 Interrupt

 “Memory” on page 
162

 Memory

 “Address Spaces” 
on page 166

 Address Space

 “Network” on page 
167

 “Interfaces” on 
page 167

 Interface

 “Connections” on 
page 168

 Connection

 “Users” on page 
170

 User
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Object View Details

The following sections provide details about the statistical information 
available in each object view:

� “Processors” on page 154

� “Storage Devices” on page 155

� “Adapters” on page 158

� “Threads” on page 159

� “Interrupts” on page 160

� “Memory” on page 162

� “Address Spaces” on page 166

� “Network” on page 167

� “Interfaces” on page 167

� “Connections” on page 168

� “Users” on page 170

� “Installed Software” on page 171

� “NLMs” on page 171

� “Volumes” on page 172

� “Queues” on page 175

 “Installed 
Software” on page 171

 Software

 “NLMs” on page 
171

 NLM

 Services  File  “Volumes” on 
page 172

 Volume

Print “Queues” on page 
175

Queue

Category Container Sub-category Containers Object Containers Objects
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Processors

Viewing processor speed helps you analyze and balance loads across servers. 
Viewing processor utilization data helps you detect problems with utilization 
and determine when server load is light enough to schedule tasks such as 
server backups. The server operating system (OS) automatically determines 
the CPU speed and is reported based on the OS data.

Processor speed is a major determinant of server performance. Therefore, it is 
important to know the processor speed of your servers when analyzing server 
load and balancing load across multiple servers. For example, one server 
might be handling twice as many users as another, but if the processor is twice 
as fast, the load might still be distributed correctly.

You should maintain a baseline of processor utilization for a server so that you 
can recognize when a server’s processor utilization is higher than normal.

You can display the following views of information about the processors on 
your managed servers:

� “Processors Summary View” on page 154

� “Processor Summary View” on page 155

� “Processors Trend View” on page 155

Processors Summary View

You can access the Summary View for the Processors object container after 
expanding the following server objects: Devices > Processors. This view 
displays the following information for each processor object in the container:

� Processor Number: A unique number assigned to the processor.

� Status: The status of the processor is either online or offline.

The following statistics are displayed only if the processor is online:

� Utilization %: Processing load on this processor for the last second, 
expressed as a percentage.

� Interrupts Processed: Number of interrupts fired on this processor in the 
last second. 

� Time Spent in Interrupts Last Second, in Microseconds: The amount 
of time in microseconds that the processor spent processing interrupts in 
the last second.
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� Number of Bound Threads: The number of threads that have been 
bound to this processor. Threads that are bound to a processor run only on 
that processor. Unbound threads can be migrated from one processor to 
another when required.

Processor Summary View

You can select the Summary View for an individual processor after expanding 
the following server objects: Devices > Processors > processor #x. This view 
displays the following information:

� Processor Number and Status: A unique number assigned to the 
processor along with its current status. The status can be online or offline.

The following statistics are displayed only if the processor is online.

� Utilization %: The processing load on this processor for the last second, 
expressed as a percentage. 

� Interrupts Processed: The number of interrupts fired on this processor 
in the last second. 

� Time Spent in Interrupts Last Second, in Microseconds: The amount 
of time in microseconds that the processor spent processing interrupts in 
the last second. 

� Number of Bound Threads: The number of threads that have been 
bound to this processor. Threads that are bound to a processor run only on 
that processor. Unbound threads can be migrated from one processor to 
another when required.

Processors Trend View

You can access the Trend View for the Processors object container after 
expanding the following server objects: Devices > Processors. This view 
displays the following graph for each processor:

� CPU Utilization (avg. %): The processing load on the processor for the 
last second, expressed as a percentage. This information is displayed only 
if the processor is online.

Storage Devices

You can get detailed information about the disk drives in a managed server, 
including disk size in megabytes, disk types, block size, and so on.
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You can also view partition information for each disk drive. Partition 
information is especially informative because you can determine whether a 
partition is fault tolerant and whether the hard disk is losing data integrity.

Fault tolerance of a NetWare partition is part of the detailed information 
provided by ZfS server management. To determine whether a hard disk is 
losing data integrity, examine the redirected area. A number in the redirected 
area indicates the number of data blocks that have been redirected to the Hot 
Fix Redirection Area to maintain data integrity. The higher the redirected area 
number, the more faulty blocks there are on the hard disk. A redirected area 
growing over a period of time indicates a hard disk going bad. 

On a NetWare server managed by the management agent for NetWare or a 
Windows NT server managed by the ZfS management agent, the Agent 
automatically gathers trend data on CPU usage, memory usage, and network 
interface traffic. In ZfS, you can view current trend data, or historical trend 
data by hour, day, month, or year. Monitoring trend data helps you with tasks 
such as setting alarm thresholds, determining who is using the server and 
when the server is used heavily, troubleshooting problems, balancing loads 
across multiple servers, and planning resources.

You can display the following views of information about the storage devices 
on your managed servers:

� “Storage Devices Summary View” on page 156

� “Storage Device Summary View” on page 157

� “Storage Devices Trend View” on page 157

Storage Devices Summary View

You can select the Summary View for the Storage Devices container object 
after expanding the following server objects: Devices > Storage Devices. This 
view provides the following information for each storage device on the server:

� Disk Name: The name of the disk drive.

� Size (KB): The total size of the disk drive in kilobytes.

� Access: Whether the disk drive is readable and writable or just readable.

� Status: Whether the disk drive is operational.

� Type: The type of media. Media types can include hard disk, floppy disk, 
tape, optical disk (read-only, write once read many, and read/write), or 
RAM disk. If unidentifiable, other or unknown is listed in this field.
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� Driver Description: The name of the driver used by the disk drive.

� Block Size: The number of blocks used on the disk in kilobytes.

� Heads: the number of read/write heads on the disk drive.

� Cylinders: The number of cylinders on the disk drive.

� Sectors/Track: The number of sectors per track on the disk drive.

� SCSI Target ID: The target address for SCSI controllers or the unit 
number for other devices and the logical unit number for SCSI devices or 
the number zero for other devices.

Storage Device Summary View

You can display the Summary View for an individual processor by expanding 
the following server objects: Devices > Storage Devices > storage_device_x. 
This view displays the following information:

� Disk Name: Name of the disk drive.

� Logical ID: The number assigned to a logical partition for identification.

� Physical ID: The number assigned to a physical partition for 
identification.

� Type Partition: The type of partition, including DOS, NetWare, and 
UNIX partitions.

� Size (KB): The size of the partition, in kilobytes.

� Redirection Area: The size of the entire Hot Fix Redirection Area.

� Redirected Area: The number of bad blocks Hot Fix found.

� Reserved Area: The number of Hot Fix redirection blocks reserved for 
system use.

� Fault Tolerance: The type of fault tolerance used. The possible fault 
tolerance types are duplex and mirrored. If there is no fault tolerance, this 
field contains the value None.

Storage Devices Trend View

You can select the Storage Devices Trend View after expanding the following 
server objects: Devices > Storage Devices. This view provides the following 
information:

� File System Reads (#/min): Depicts the number of file system reads 
made per minute on multiple or single storage devices.
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� File System Writes (#/min): Depicts the number of file system writes 
made per minute on multiple or single storage devices.

� File System Reads (KB/min): Depicts the number of file system reads 
per kilobyte volume made on multiple or single storage devices.

� File System Writes (KB/min) Depicts the number of file system writes 
per kilobyte volume made on multiple or single storage devices.

� Free Redirection Area (%): Depicts the percentage of total volume 
allocated to the disk redirection area.

Adapters

You can get detailed information about the network and disk adapters in a 
managed server, including I/O port, memory address, and interrupt 
configuration.

You can use this data to detect configuration problems such as the same 
address or interrupt is configured for two boards inside the server, or for a 
board and a component of the server’s hardware. No two boards can use the 
same I/O port, memory address, and interrupt. 

Problems with LAN adapters cause network problems, such as servers and 
workstations not being able to communicate. You can use the data collected 
on the LAN adapter to determine whether the frame type used by a network 
board is bound to a supported protocol. (A single network board might be 
bound to several protocols.) You can immediately tell whether a problem is 
due to something as simple as using the wrong frame type on the workstation 
(for example, an Ethernet_II frame type on the server and the Ethernet_802.2 
frame type on the workstation).

You can display the following views of information about the adapters on your 
managed servers:

� “Adapters Summary View” on page 158

� “Adapters Trend View” on page 159

Adapters Summary View

You can select the Adapters Summary View after expanding the following 
server objects: Devices > Adapters > adapter_x. This view provides the 
following information:

� Description: The type of adapter hardware. This field can include the 
following types of information: manufacturer, model, and version. Or, for 
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network boards, this field may contain a short board name and the board’s 
burned-in MAC address.

� Type: The type of adapter (for example, network card or disk storage).

� Devices Attached: The number of devices associated with an adapter (for 
example, the number of drives attached to the disk controller).

� Driver Description: Description of the driver for this adapter.

� Version: The version number of the driver software.

� Interrupt Number: The unique interrupt number used by the adapter.

� I/O Port: The unique I/O port block used by the adapter.

� Memory: The unique memory address space used by the adapter.

� DMA: The Direct Memory Access (DMA) Channel used by the adapter.

� Slot: The slot in which the adapter is installed.

Adapters Trend View

You can select the Adapters Trend View after expanding the following server 
objects: Devices > Adapters > adapter_ x. This view provides the following 
graphs:

� LSL Packets Received: Depicts the number of LSL packets received by 
the adapter.

� LSL Packets Transmitted: Depicts the number of LSL packets 
transmitted by the adapter.

� Packets Received: Depicts the total number of packets received by the 
adapter.

� Packets Transmitted: Depicts the total number of packets transmitted 
by the adapter.

Threads

You can display information for all threads currently running on a managed 
server. A thread is recognized as an independent unit of execution. 

You can display the following view of information about the threads on your 
managed servers:

� “Threads Summary View” on page 160
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Threads Summary View

You can select the Threads Summary View after expanding the following 
server objects: Operating System > Kernel > Threads. This view provides the 
following information:

� Name: The application thread name.

� Share Group: The Application share groups and their associated threads 
and shares.

� Parent Module: Module (NLM) associated with this thread.

� State: The state of the thread, which can be one of the following: 
initializing, invalid, ready, running, suspended, terminated, or zombie.

� Suspended Due To: Reason the thread is suspended. If the thread is not 
in a suspended state, this field is blank.

� Execution Time, Microseconds: Amount of time in the last second that 
the processor spent executing the thread’s code.

� Stack Size, Bytes: Size of the thread’s stack.

� Soft Affinity: Processor on which the thread preferentially executes, but 
from which it can migrate when necessary.

� Hard Affinity: Indicates whether the thread is explicitly bound to a 
specified processor for the thread’s lifetime. If the thread runs only on a 
specified processor, it is able to exploit the processor’s cache state. If the 
thread is allowed to run on any available processor, the field value is zero.

Interrupts

You can display information for the registered interrupts on a managed server. 
On a multiprocessing system, interrupt information is displayed for all 
processors combined and individually for each online processor.

You can display the following views of information about the interrupts on 
your managed servers:

� “Interrupts Summary View” on page 161

� “Interrupts Service Routines View” on page 161
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Interrupts Summary View

You can select the Interrupts Summary View after expanding the following 
server objects: Operating System > Kernel > Interrupts. This view provides 
the following information:

� Name: The name of the interrupt routine.

� Interrupt Number: Number for this service routine.

� Processor: Number of the processor.

� Type: The type of interrupt service routine. It can be one of the following:

� Bus: A device I/O interrupt that is used (for example, by disk or LAN 
drivers).

� Local: A hardware platform-specific interrupt local to an individual 
processor.

� System: An interrupt category that is reserved for systems with 
unique interrupt requirements.

� Interprocessor: An interrupt that is generated by one processor to 
affect another processor.

� Timer: An interrupt that provides timer services for the OS as well 
as preemption support. (In multiprocessing systems, timer interrupts 
are local to a processor.)

� Service Routines: Number of service routines that are launched when 
this interrupt occurs.

� Interrupt Occurrences: Number of times in the last second that the 
interrupt occurred and was processed.

� Execution Time: Amount of time in the last second that the processor 
spent processing this interrupt.

� Spurious Interrupts: Number of times since the server started that an 
interrupt fired that should not have occurred.

Interrupts Service Routines View

The Interrupts Service Routines View provides information about the memory 
address spaces defined on the server. 

NetWare runs in the OS address space (kernel), along with LAN drivers, 
storage device drivers, MONITOR, and network management agents 
(NMAs). OS address space is backed by physical memory. 
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All other address spaces are user space (ring 3) and are backed by virtual 
memory. Applications running in user space cannot cause the server to abend 
if the address space faults.

You can select the Service Routines View after expanding the following 
server objects: Operating System > Kernel > Interrupts. This view provides 
the following information:

� Name: The name of the interrupt service routine.

� Service Routine Number: Service Routine Number associated with this 
service routine.

� Processor Number: Processor number this routine is running on.

� Interrupt Number: Interrupt number associated with this service 
routine.

� Interrupts Processed Last Second: Number of interrupts that were 
processed by the ISR during the last second.

Memory

You can display the following views of information about the memory on your 
managed servers:

� “Memory Summary View” on page 162

� “Memory Trend View” on page 163

� “Disk Cache View” on page 163

� “Virtual Memory View” on page 165

Memory Summary View

You can select the Memory Summary View after expanding the following 
server objects: Operating System > Kernel > Memory. This view provides the 
following information:

� Type: The type of memory (for example, DOS, allocated memory, cache 
buffers, or code and data memory).

� Unit Size (bytes): The size of the memory allocation. 

� Total (KB): The number of memory units × the unit size.

� Units Used: The number of memory units that have been allocated.

� Used (KB): The number of KB of memory that has been allocated.
�
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The Memory Summary View also provides a pie chart depicting memory 
usage on the system.

Memory Trend View

You can select the Memory Trend View after expanding the following server 
objects: Operating System > Kernel > Memory. This view provides the 
following graphs:

� Cache Buffers (%): The percentage of memory allocated to cache 
buffers.

� Code and Data Memory (%): The percentage of memory allocated to 
code and data.

� Allocated memory (%): The amount of allocated memory.

� Dirty Cache Buffers (%): The amount of dirty cache buffer memory.

Disk Cache View

This view displays utilization for disk cache memory. Use cache utilization 
statistics to determine when you need to install more RAM for cache. You can 
select this view after expanding the following server objects: Operating 
System > Kernel > Memory. It provides the following information:

� Short Term Cache Hits %: Percentage of requests in the last second for 
disk blocks that were already in cache memory. When the requested data 
is already in memory, disk reads don’t need to be made. If this value falls 
below 98%, consider installing more RAM for cache. Also compare with 
Long Term Cache Hits.

� Short Term Cache Dirty Hits %: Percentage of requests in the last 
second for disk blocks that were already in cache memory but were dirty. 
Dirty cache must be written to disk before being used. Also check Long 
Term Dirty Cache Hits and LRU Sitting Time.

� Long Term Cache Hits %: Cumulative percentage of requests for disk 
blocks that were already in cache. When the requested data is already in 
memory, disk reads don’t need to be made. Use this cumulative 
percentage to assess overall disk cache utilization. If this value falls 
below 90%, install more RAM for cache.

� Long Term Cache Dirty Hits %: Cumulative percentage of requests for 
disk blocks that were already in cache memory but were dirty. (Before 
dirty cache can be used, it must be written to disk.) Use this cumulative 
percentage to assess overall disk cache utilization. If this value is high or 
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steadily incrementing, add more RAM for cache. Also check LRU Sitting 
Time.

� Total Cache Blocks Allocated: Cumulative number of requests for disk 
cache blocks that have been made since the server was started or 
rebooted. This value is the sum of the values of Allocated from Available 
List and Allocated from Least Recently Used (LRU). If the value of 
Allocated from Available is much higher, the server has sufficient RAM 
for cache. If the value of Allocated from LRU is high, install more RAM 
for cache.

� Cache Blocks Allocated from Available List: Number of requests for 
disk cache blocks that were filled by blocks in the available list (blocks 
that were not being used). When there are no free blocks available, 
requests are filled from the LRU list of cache blocks. If this value is much 
higher than the Allocated from LRU value, the server has sufficient RAM 
for cache.

� Cache Blocks Allocated from LRU: Number of requests for disk cache 
blocks that were filled by blocks from the Least Recently Used cache 
blocks. The system writes pending requests from the LRU cache block to 
disk then frees the block for the current request. Because LRU caches 
used only when no other cache is available, a steadily incrementing count 
indicates more RAM is needed.

� Number of Times in Last 10 Minutes that the OS Had to Wait: 
Number of times in the last 10 minutes that the OS waited for an LRU 
block in order to fulfill a request. If this value is greater than 7, install 
more RAM for cache.

� Number of Times OS Had to Wait: Number of times that the OS waited 
for an LRU block in order to fulfill a request.

� Total Number of Times the Write Request Was Delayed: Number of 
times a write request was delayed because there were too many writes to 
perform or because the disk channel was busy. A high value indicates 
either that the disk channel has too much I/O traffic or that you need to 
install more RAM for cache.

� Number of Times the Request Was Re-tried: Number of times a disk 
cache request had to be retired because the target block was being used. 
If this value is high or steadily incrementing, install more RAM for cache.
�
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Virtual Memory View

This view displays information about the virtual memory system. Use these 
statistics to monitor the efficiency of server memory usage. If these values are 
fairly stable over time and if server performance is satisfactory, the server has 
adequate memory for its load. For example, if the value of Page faults 
increases, this indicates that the server performance is degrading. Conversely, 
if the Free swap pages value increases, it is an indication of better server 
performance.

You can select this view after expanding the following server objects: 
Operating System > Kernel > Memory. It provides the following information:

� Total Page-in Requests: Number of requests that were made to move 
virtual memory from swap files since the server was started (server up 
time).

� Page-in Requests in Last 5 Seconds: Number of requests to move 4 KB 
virtual memory pages from swap files.

� Total Page-out Requests: Number of requests that were made to move 
virtual memory to swap files since the server was started (server up time).

� Page-out Requests in Last 5 Seconds: Number of requests to move 4 
KB virtual memory pages to swap files.

� Total Swap Pages: Number of 4 KB pages in this server’s virtual 
memory system. (The size of the swap file in memory pages is the total 
number of bytes divided by 4 KB.) The size of the swap file grows or 
shrinks dynamically to match the memory requirements of the server’s 
load.

� Free Swap Pages: Number of 4 KB pages that are available for use by 
the virtual memory system.

� Reserved Swap Pages: Number of 4 KB pages that are reserved by the 
virtual memory system.

� Total Page Faults: Number of times the virtual memory system retrieved 
from the swap file since the server was started (server up time).

� Page Faults in Last 5 Seconds: Number of times in the last five seconds 
that the virtual memory system retrieved from the swap file. (This means 
that accessed memory wasn’t backed by physical memory.)
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Address Spaces

NetWare runs in the OS address space (kernel) along with LAN drivers, 
storage device drives, MONITOR, and network management agents (NMAs). 
OS address space is backed by physical memory. 

All other address spaces are user space (ring 3) and are backed by virtual 
memory. Applications running in user space cannot cause the server to abend 
if the address space faults.

You can display the following view of information about address spaces on 
your managed servers: 

� “Address Spaces Summary View” on page 166

Address Spaces Summary View

You can select the Address Spaces Summary View after expanding the 
following server objects: Operating System > Kernel > Address Spaces. This 
view provides the following information:

� Name: Name of the virtual memory address space where this module 
runs.    

� Number of NLMs Loaded: Count of NLM programs loaded in this 
address space. NetWare, LAN drivers, storage device drivers, 
MONITOR, and Network Management Agents (NMAs) are loaded in OS 
address space (kernel). A server application, such as GroupWise®, Lotus 
Notes*, or an Oracle* database, can be loaded in its own address space 
(user space or ring 3).

� Mapped Pages: Total number of physical memory pages backing this 
address space. Note that the OS address space (kernel) is the only address 
space backed by physical memory.

� Restarted: Total number of times this address space faulted and restarted 
automatically. A value of zero (0) indicates that no fault has occurred. A 
non-zero value indicates that an address space has faulted and recovered. 
Follow online Troubleshooting documentation for core dump instructions 
for address spaces.

� Memory in Use, Bytes: Amount of allocated memory in use.

� Memory Not in Use, Bytes: Amount of unused allocated memory.

� Memory As Overhead, Bytes: Amount of memory used for managing 
the allocation pool plus the amount of memory fragmentation.
�
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� Total Blocks: Number of memory blocks that are in use and that are 
available at the request of the NLM.

� Blocks in Use: Number of memory blocks that were allocated and used.

� Block Not Used: Number of memory blocks that were allocated but not 
used.

Network

You can display the following view of information about the network activity 
on your managed server:

� “Network Trend View” on page 167

Network Trend View

You can access the Trend View for the Network object container after 
expanding the following server objects: Operating System > Network. This 
view displays the following graph for each network adapter:

� Packets Received (KB/min): The number of kilobytes received by the 
adapter for the last minute.

Interfaces

You can display the following view of information about the network 
interfaces on your managed server:

� “Interfaces Summary View” on page 167

Interfaces Summary View

You can access the Summary View for the Network object container after 
expanding the following server objects: Operating System > Network > 
Interfaces. This view displays the following information:

� Frame Type: The frame type that is bound to this logical board.

� MAC Address: The MAC address of the interface.

� Description: Text describing the interface board. 

� Line Speed: The number of bits per second transmitted on this board.

� Type: The type of interface (for example, Ethernet CSMACD).

� Logical Board #: The number assigned to this logical board.

� Logical Board Name: The name assigned to this logical board.
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� Protocols: The protocols to which the logical board is bound (for 
example, IP, ARP, or IPX).

Connections

You can display the following views of information about the connections on 
your managed server:

� “Connections Summary View” on page 168

� “Connections Trend View” on page 169

� “Open Files View” on page 169

Connections Summary View

The Connections Summary View displays information and statistics for the 
connections on the selected server. For example, this view displays the 
number of files currently being accessed by the server and by other clients. 
Certain files, such as hidden files that support NDS®, are always open. You 
can select this view after expanding the following server objects: Operating 
System > Network > Connections > connection_x. This view provides the 
following information:

� Connection# Login Name: A string indicating the connection number 
and login name. Note that connection 0 (zero) is used by the system. The 
login name is the NDS full distinguished name where applicable.

� Client Address:

IP: xxx.xxx.xxx.xxx:port number

IPX: network:node:socket

� Connection Time: The date and time the connection was established.

� Privileges: A connection can have one or more of the following 
privileges:

� Supervisor

� Operator

� Auditor

� High_Privilege

� Second_Authentication

� Second_High_Privilege
�
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� Status: The status can be one of the following:

� Not logged in

� Logged in

� Need security change

� MacStation

� Connection abort

� Audited

� Authenticated temporary

� Audit connection recorded

� DS audit connection recorded

� Logout in progress

� Read (bytes): Number of Bytes the connection has read since it was 
established.

� Written (bytes): Number of Bytes the connection has written since it was 
established.

� NCP Requests: Number of NCP requests the connection has made since 
it was established.

� Open Files: Number of files that are currently opened by the connection.

� Locked Records: Number of file records that are currently locked by the 
connection.

Connections Trend View

You can select Connections Trend View after expanding the following server 
objects: Operating System > Network > Connections > connection_x. This 
view provides the following graphs:

� Connections (avg. #): The average number of connections over the last 
sample interval.

Open Files View

The Connection Open Files View displays information and statistics for the 
connection on the server. For example, this view displays the number of files 
currently being accessed by the server and by other clients. Certain files, such 
as hidden files that support NDS, are always open. You can select this view 
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after expanding the following server objects: Operating System > Network > 
Connections > connection_x. This view provides the following information:

� File Name: The name of the open file, including the directory path.

� Login Name: The name of the user (if any) who opened the file. If the 
file was opened by the system or by an NLM, the Login Name will be a 
zero-length string.

� Volume Name: The physical name of the NetWare volume containing 
the open file.

� Directory Number: A number that uniquely identifies an open file 
within a NetWare volume.

� Volume ID: A number that uniquely identifies a NetWare volume. The 
value of this object for a particular volume has the same value as the 
nwVolID object for the same volume.

Users

You can display the following views of information about the users on a 
selected server:

� “Users Summary View” on page 170

� “Users Trend View” on page 171

Users Summary View

The Users Summary View provides information about the users who access 
the selected server. You can select this view after expanding the following 
server objects: Operating System > Users. This view provides the following 
information about each user:

� Login Name: The login name of the user.

� Disk Usage: The amount of disk space the user has used. 

� Last Login: The date the user last logged in to the server.

� Account Status: Indicates whether the user account is valid.

� Password: Indicates whether the user’s password is valid.

� Real Name: The user’s NDS real name.

� Bad Login: The number of failed login attempts for the user.
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� Bad Login Address: The network address of the location from which the 
user login failed, if any.

Users Trend View

The Users Trend View provides information about the users who access the 
selected server. You can select this view after expanding the following server 
objects: Operating System > Users. This view provides the following graph:

� Logged-In Users (avg. #): Depicts the average number of users logged 
in to the server.

Installed Software

You can display the following view of information about the software that is 
installed on a selected server:

� “Installed Software Summary View” on page 171

Installed Software Summary View

The Installed Software Summary View provides information about the 
software installed on the selected server. You can select this view after 
expanding the following server objects: Operating System > Installed 
Software. This view provides the following information:

� Name: The name of the installed software module.

� Type: The type of software (for example, device drivers, applications, or 
operating system).

� Date Installed: The date the software was installed.

NLMs

You can display the following views of information about the NLMs on a 
managed server:

� “NLM Summary View” on page 171

� “Resource Tag View” on page 172

NLM Summary View

The NLM Summary View provides information about a selected NLM. You 
can select this view after expanding the following server objects: Operating 
System > NLMs > nlm_x. This view provides the following information:
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� Name: The name of the NLM.

� Version: The version number of the NLM.

� Released: The date and time the NLM was released.

� Memory (bytes): The total memory in bytes used by this NLM. This is a 
composite total of short term memory, semi-permanent memory, and 
non-movable memory, cache memory allocated by the NLM plus the 
sizes of the code, and data sections of this instance of an NLM.

� Description: A text string that describes the NLM.

� Copyright: The copyright string for the NLM.

Resource Tag View

You can select the NLM Resource Tag View after expanding the following 
server objects: Operating System > NLMs > nlm_x. This view provides the 
following information:

� Description: The name that the owning module assigned to this resource 
tag.

� Number in Use: The number of instances of the resource tag.

� Resource Type: The type of resource tag that is being tracked (for 
example, semaphores or processors).

� Address Space: Name of the address space where the module that owns 
the resource tag is running.

Volumes

NetWare server disk storage space is divided into volumes. You can view 
various data about the volumes mounted on a server, such as size, free space, 
how the volumes are distributed across disks, and which users are using the 
space. For individual volumes you can view data on configuration, open files, 
segments, and usage. The available views of data include:

� “Volume Summary View” on page 173

� “Volume Trend View” on page 174

� “Open Files View” on page 174

� “Volume Segment View” on page 174

� “Volume Usage View” on page 175
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Volume Summary View

The Volume Summary View provides details about a single volume. You can 
select this view after expanding the following server objects: Services > File 
> Volumes > volume_x. This view provides the following information:

� Size (KB): The size of the volume in kilobytes.

� Free (KB): The amount of free space on the volume in kilobytes. As files 
are added or expanded, this number approaches zero. A pie chart shows 
you how much of the total volume size is free.

� Used (KB): The amount of space, which is determined by subtracting the 
free disk space from the total volume size.

� Status: Whether the volume is mounted. If the volume is not mounted, 
only the volume name is listed.

� Name Spaces: Name spaces that are supported on the volume. Name 
spaces supported are DOS, Macintosh*, NFS*, FTAM, OS/2*, and NT.

� Attributes: Attributes of the volume. Possible attributes are block 
suballocation, file compression, data migration, auditing, and read-only. 
A volume can have a combination of attributes, such as read-only volume 
with block suballocation.

� # Logical Segment: The number of segments comprising this volume.

� DS Name: The volume’s full Directory Services distinguished name or a 
zero-length string if not applicable.

� Non-Purgable: The amount of space (in kilobytes) taken by the deleted 
files whose purge dates have not yet expired. Non-purgable space can be 
reclaimed as free space when the deleted files become eligible to be 
purged. 

� Block Size: The block size on the volume in bytes.

� Dir Slots: The total number of directory table entries available on the 
volume.

� Used Dir Slots: The number of directory table entries that are currently 
in use.

� File System Name: The type of file system on the volume is either 
remote or local. The File System Name value is listed only if the volume 
is remote. In this case, the file system name is the remote mount point; for 
example, SITE1:/usr/x.
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Volume Trend View

You can select the Volumes Trend View after expanding the following server 
objects: Services > File > Volumes > volume_x. This view provides the 
following graph:

� Volume % Free Space: The percentage of space still available on the 
volume.

Open Files View

The Volume Open Files View displays a table of all open files on the volume. 
If it is opened by more than one connection, multiple entries for the same file 
will appear in the table. You can select the Open Files View after expanding 
the following server objects: Services > File > Volumes > volume_x. This 
view provides the following information:

� File Name: The name of the open file, including the directory path.

� Connection #: The number of the connection that opened the file.

� Login Name: The name of the user (if any) who opened the file. If the 
file was opened by the system or by an NLM, the Login Name will be a 
zero-length string.

� Directory Number: A number that uniquely identifies an open file 
within a NetWare volume.

� Volume ID: A number that uniquely identifies a NetWare volume.

Volume Segment View

The Volume Segment View provides information about the segments on a 
volume. You can select this view after expanding the following server objects: 
Services > File > Volume > volume_x. As long as the Volume Segment View 
is displayed, the server is polled for data and the view is constantly updated 
with real-time information. This view provides the following information 
about each segment on the selected volume:

� ID: The number assigned to the volume segment for identification.

� Logical Partition ID: The number assigned to a logical partition for 
identification.

� Physical Partition ID: The number assigned to a physical partition for 
identification.

� Size: The size of the segment.
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� Fault Tolerance: The type of fault tolerance used on the segment. 
Possible types are duplex and mirrored. If there is no fault tolerance, the 
value is None.

� Disk Drive: The name of the disk drive on which the segment resides.

Volume Usage View

The Volume Usage View provides information about the amount of volume 
space in use per user. As long as the Volume Usage View is displayed, the 
server is polled for data and the view is constantly updated with real-time 
information.You can select this view after expanding the following server 
objects: Services > File > Volumes > volume_x. This view provides the 
following information per volume user:

� Used KB: Number of kilobytes currently in use.

� Limit KB: Number of kilobytes to which a user is limited.

� User Name: The user’s login name.

Queues

You can display the following views of information about the NLMs on a 
managed server:

� “Queues Summary View” on page 175

� “Queue Summary View” on page 176

� “Queue Trend View” on page 176

Queues Summary View

The Queues Summary View provides the following information about the 
print queues on the managed server:

� Queue Name: The name of the queue.

� Type: The type of queue (for example, archive queue, job queue, or print 
queue).

� # Jobs: The number of print jobs in the queue currently.

� # Print Servers: The number of print servers serviced by the queue.

� Volume: The volume where the queue resides.

� Add Job State: Indicates whether or not the queue can add jobs.
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� Attach State: Indicates whether or not the queue can attach.

Queue Summary View

The Queue Summary View provides the following information about the print 
jobs in the selected queue:

� Job #: A unique number assigned to the print job.

� Position: The print job’s order in the print queue.

� Bytes: The number of bytes to be printed.

� Description: A description of the print job.

� User: The username of the user who submitted the job.

� Entry Time: The time the job was added to the queue.

� Control Flags: A value representing the control flags for the job. For 
example, some possible control flags are service auto start, execute, user 
hold, or operator hold.

� Target Time: The date and time the job is to be printed.

� Target Server: The target server for the job.

� Actual Server: The name of the server currently processing the job.

Queue Trend View

The Queues Trend View provides the following graph for each queue on the 
managed server:

� Wait Time of Next Ready Job (sec): The average length of time the next 
job waits in the queue.
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Traffic Analysis

ZENworksTM for Servers (ZfS) provides traffic analysis tools that monitor 
network traffic, capture data, and collect key statistics of monitored segments 
nodes, and devices, allowing you to obtain, review, and analyze vital 
information to effectively troubleshoot and manage your LAN and keep your 
network operating at peak performance. 

This section contains the following topics:

� “Understanding Traffic Analysis” on page 177

� “Planning for Segment Monitoring” on page 193

� “Preparing to Analyze Network Traffic” on page 197

� “Analyzing Network Traffic” on page 200

� “Optimizing Traffic Analysis” on page 241

� “Understanding the Traffic Analysis Agents” on page 258

� “Using the Traffic Analysis Agent for NetWare” on page 260

� “Using the Traffic Analysis Agent for Windows NT/2000” on page 280

Understanding Traffic Analysis

This section contains basic information to help you understand traffic analysis 
and describes the ZfS traffic analysis components.

� “Traffic Analysis Components” on page 178

� “Communication Between Traffic Analysis Components” on page 179

� “Traffic Analysis Features” on page 180

� “Traffic Analysis Fundamentals” on page 181
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Traffic Analysis Components

The ZfS traffic analysis components include:

� “Management Server” on page 178

� “Management Console” on page 178

� “Monitoring Agent Server” on page 178

Management Server

The management server comes with the robust and highly scalable Sybase* 
Adaptive Server Anywhere that stores static information, such as the names 
and addresses of the nodes and devices in your network. The management 
server components include the NetExplorerTM, management database, 
Consolidator, and Atlas Manager. NetExplorer discovers the objects in your 
network and stores them in the management server. The Consolidator takes 
the information about network objects discovered by NetExplorer and builds 
the management database. For details about the functionality of NetExplorer, 
see “Understanding Network Discovery” on page 40.

The management database is comprised of the Common Information Model 
(CIM) schema that is used to establish the topology of the network. The CIM 
schema extension capabilities provide the ability to organize the information 
in the database and give this information the shape of a network map. The 
Atlas Manager obtains information from the management database and 
displays the network map on the management console.

Management Console

ConsoleOneTM, the Novell® directory-enabled, Java*-based network 
management and administration tool is the management console component. 
ZfS snaps in to ConsoleOne and expands ConsoleOne’s capabilities by adding 
menu options, property pages for existing NDS® objects, and ways to browse 
and organize network resources. ConsoleOne provides an intuitive, graphical 
user interface for ZfS traffic analysis. For details about the functionality of 
ConsoleOne, see “Managing the Atlas” on page 80.

Monitoring Agent Server

Before you start analyzing segments or devices on your network, you need to 
ensure that they are monitored. To enable monitoring, make sure you have 
installed the network monitoring agent software either on the management 
server or on an independent server in your network. See ZENworks for Servers 
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Installation and Setup for more information. Network monitoring agents 
gather information or provide services that help you monitor your network.

An agent program using parameters you have provided searches all or part of 
your network, gathers information you query, and presents it to you when you 
require it. You can use the information gathered by the agent to analyze the 
traffic on your network. The agent also warns you of problems, such as 
duplicate IP addresses, by sending an alert to the management console to help 
you solve problems before network performance is impacted. For details 
about managing alarms, see “Managing the Alarm Management System” on 
page 92.

Network monitoring agents observe traffic and capture frames to build a 
database of network objects and information to help you detect network 
aberrations. With the network monitoring agent software installed on a server 
on each of your segments, you can use the traffic analysis tools to help you 
monitor the traffic on your network, identify the source of network problems, 
and maintain optimum performance. For details, see “About Network 
Monitoring Agents” on page 182. The traffic analysis agents for NetWare® 
and Windows NT/2000* are part of ZfS that you can use to monitor Ethernet, 
FDDI, or Token Ring networks.

Communication Between Traffic Analysis Components

The management console communicates with the management server using 
common object request broker architecture (CORBA) to procure dynamic and 
static information about the nodes and devices in your network. When the 
management console requests static information from the management server, 
the management server communicates with the management database using 
Java Database Connectivity (JDBC), gathers the required static information 
from the database, and provides it to the management console. When the 
management console requests dynamic information from the management 
server, the management server communicates with the network monitoring 
agent using SNMP, gathers the required dynamic information, and provides it 
to the management console. The following diagram illustrates this 
communication:
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Traffic Analysis Features

The ZfS traffic analysis components provide the following features:

� “Analyze Traffic Generated by Segments” on page 180

� “Analyze Traffic Generated by Nodes Connected to Segments” on page 
180

� “Capture Packets, Decode Captured Packets, and Display Captured 
Information” on page 181

� “Analyze Traffic Generated by Protocols” on page 181

� “Analyze Traffic Generated by Switches” on page 181

Analyze Traffic Generated by Segments

You can use the traffic analysis tools to collect current and historical segment 
statistics that can be displayed in real time, stored for later display, or 
transferred to a database, spreadsheet, or management reporting system. For 
details, see “Analyzing Traffic on Segments” on page 200.

Analyze Traffic Generated by Nodes Connected to Segments

The traffic analysis tools allow you to obtain statistical information about 
nodes on monitored Ethernet, FDDI, or Token Ring segments, and determine 
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the top nodes on a segment. You can monitor the status of nodes in your 
network so that you are alerted when a node becomes inactive. You can also 
view alarms that are generated when preset threshold parameters are 
exceeded. Alarms that require immediate attention can be forwarded via e-
mail to remote users. For details, see “Analyzing Traffic on Nodes Connected 
to a Segment” on page 212.

Capture Packets, Decode Captured Packets, and Display Captured Information

You can use the traffic analysis tools to capture packets between nodes on a 
monitored segment, and you can quickly define a capture filter based on which 
you want the packets to be captured. Once packets are captured, protocols are 
decoded and displayed in color-coded summary, decode, and hex panes. The 
information obtained from the captured packets can be used to examine the 
traffic on the segment and to analyze it. By providing analysis capabilities and 
advanced protocol decodes, the traffic analysis tools allow you to identify 
network aberrations and resolve network performance problems. For details, 
see “Capturing Packets” on page 221, “Protocol Decodes Suite Supported by 
ZfS” on page 192, and “Displaying Captured Packets” on page 225.

Analyze Traffic Generated by Protocols

You can use the traffic analysis tools to determine the distribution of protocols 
in the network, transport, and application layer of your network, and obtain 
statistical information of protocols discovered by the network monitoring 
agent. For details, see “Analyzing Traffic Generated by Protocols in Your 
Network” on page 234.

Analyze Traffic Generated by Switches

You can analyze switch traffic by using the traffic analysis tools to determine 
port statistics of monitored switches. For details, see “Analyzing Traffic on 
Switches” on page 239.

Traffic Analysis Fundamentals

ZfS provides tools to let you obtain statistical information about segments, 
nodes, and devices on your network. You can use this information to analyze 
and manage the performance of traffic on your network to help you keep the 
network operating smoothly. ZfS also provides tools to capture and decode 
packets between nodes. You can use the decoded information obtained from 
captured packets to analyze the traffic between nodes.
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To be able to analyze the segments and nodes connected to a segment, you 
need to ensure that the segment is monitored by a network monitoring agent. 
You choose the agent based on the type of your network. The ZfS traffic 
analysis tools include the traffic analysis agent for NetWare and traffic 
analysis agent for Windows NT/2000 that you can use to monitor segments in 
your network. NetWare 5.x, the management server for ZfS, includes NDS 
that is leveraged by ConsoleOne, the management console for ZfS, to enable 
role-based administration.

The following sections provide information that will help you understand the 
ZfS traffic analysis functionality:

� “About Network Monitoring Agents” on page 182

� “Role-Based Traffic Analysis Tasks” on page 190

� “Protocol Decodes Suite Supported by ZfS” on page 192

About Network Monitoring Agents

Network monitoring agents provide the functionality to remotely monitor 
segments and devices on your network using SNMP. The agents collect and 
store statistical and trend information about nodes and devices on the network 
to provide real-time information about the status of your network. From your 
desktop, the agents let you troubleshoot and optimize Ethernet, FDDI, and 
Token Ring segments.

Based on the size and type of your network, you can use RMON, RMON Lite, 
RMON Plus, RMON2, or Bridge agents to monitor traffic. The following 
sections provide information to help you understand the functionality of 
agents:

� “Functionality of RMON Agents” on page 182

� “Functionality of RMON Lite Agents” on page 184

� “Functionality of RMON Plus Agents” on page 185

� “Functionality of RMON2 Agents” on page 186

� “Functionality of Bridge Agents” on page 188

� “Viewing the Summarized RMON Information” on page 189

Functionality of RMON Agents

RMON agents use a standard monitoring specification that allows various 
nodes and console systems on your network to exchange network data. This 
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data can be used by a network administrator to monitor, analyze, and 
troubleshoot a group of distributed LANs from a central site. RMON is 
specified as part of the MIB in RFC 1757 (http://www.isi.edu/in-notes/
rfc1757.txt) as an extension of the SNMP.

RMON agents are ideally used for monitoring Ethernet, FDDI, and Token 
Ring segments.

RMON agents collect information in the following nine RMON groups of 
monitoring elements, each providing specific sets of data to meet network 
monitoring requirements. For details, see RFC 1757 (http://www.isi.edu/in-
notes/rfc1757.txt).

RMON Group Description

Statistics Contains statistics measured by the agent for each 
monitored interface on the device.

History Records periodic statistical samples from a network and 
stores them for later retrieval.

Alarm Periodically takes statistical samples from variables in the 
agent and compares them with previously configured 
thresholds. If the monitored variable crosses a threshold, an 
event is generated.

Host Contains statistics associated with each host discovered on 
the network.

HostTopN Prepares tables that describe the hosts that top a list 
ordered by one of their statistics.

Matrix Stores statistics for conversations between sets of two 
nodes. As the device detects a new conversation, it creates 
a new entry in its table.

Filters Allows packets to be matched by a filter. These matched 
packets form a data stream that may be captured or 
generate events.

Packet Capture Allows packets to be captured after they flow through a 
channel.

Events Controls the generation and notification of events from the 
device.
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The following figure illustrates the ZfS views that you can display when you 
use an RMON agent to monitor the nodes and devices on your network.

Functionality of RMON Lite Agents

RMON Lite agents are ideally used for monitoring devices not dedicated for 
network management. For example, RMON Lite agents can be used to 
monitor a switch in your network.

RMON Lite agents support the following four RMON groups:

� Statistics

� History

� Alarm

� Event

Refer to the table in “Functionality of RMON Agents” on page 182 for a brief 
description of each group.

The following figure illustrates the ZfS views that you can display when you 
use an RMON Lite agent to monitor the nodes and devices on your network.
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Functionality of RMON Plus Agents

RMON Plus agents are proprietary agents that extend the functionality of the 
RMON agent by providing data collected from the RMON groups, explained 
in “Functionality of RMON Agents” on page 182, and the groups explained in 
the following table.

RMON Plus Group Description

Buffer Records the number of octets (excluding framing bits but 
including frame check sequence [FCS] octets and overhead) 
in packets which are captured in the buffer.

Admin Collects information specific to the agent, such as the 
version number.

HostMonitor Monitors a set of nodes for a particular host table and sets 
traps when a host becomes active or inactive.

DuplicateIP Records and updates a list of packets arriving with duplicate 
IP addresses.

MacToIP Stores records of the IP addresses associated with a host 
address for an individual host table.

BoardStatus Records the status of each logical interface of the RMON 
agent.
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RMON Plus agents are ideally used for monitoring Ethernet, FDDI, and 
Token Ring segments. Data from different media types can be collected based 
on the version of the RMON Plus agent that is used to monitor traffic on your 
network. Refer to the following table to determine the media type support 
based on the version of the RMON Plus agent.

The following figure illustrates the ZfS views that you can display when you 
use an RMON Plus agent to monitor the nodes and devices on your network.

Functionality of RMON2 Agents

While RMON agents can be used to collect data from nodes and devices in the 
physical and the data link layers, RMON2 agents can be used to collect data 
from nodes and devices in the network and application layers of your network. 
RMON2 agents can also determine network usage based on the protocol and 

RMON Plus Agent Media Support

Traffic analysis agent for NetWare 1.1 Ethernet and Token Ring

Traffic analysis agent for NetWare 1.21 
or later

Ethernet, FDDI, and Token Ring 

Traffic analysis agent (version 1.30) for 
Windows NT/2000

Ethernet, FDDI, and Token Ring
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application used by the nodes in your network. The following RMON2 groups 
make it possible to view traffic patterns above the data link layer. For details, 
see RFC 2021 (http://www.isi.edu/in-notes/rfc2021.txt).

,03257$17��Console supports only the Protocol Directory and Protocol 
Distribution groups.

The following figure illustrates the ZfS views that you can display when you 
use an RMON2 agent to monitor the nodes and devices on your network.

RMON2 Group Description

Protocol Directory Provides a table of all identifiable protocols and their 
descriptions.

Protocol Distribution Provides statistics for each protocol that the agent is 
configured to track.

Address Map Maps a network layer address to the corresponding 
Media Access Control (MAC) address.

Network-Layer Host Provides statistics for each host by network layer 
address.

Network-Layer Matrix Provides statistics for each network conversation 
between pairs of network layer addresses.

Application-Layer 
Host

Provides statistics on traffic generated by each host for a 
specified application layer protocol. Traffic broken down 
by protocols can be recognized by the Protocol Directory 
group.

Application-Layer 
Matrix

Provides statistics on conversations between pairs of 
network layer addresses for a specified application layer 
protocol. Traffic broken down by protocols can be 
recognized by the Protocol Directory group.

User History Enables the agent to save samples of RMON2 data for 
any MIB object at specified intervals.

Probe Configuration Provides remote capability for configuring and querying 
agent parameters such as resets, software updates, IP 
address changes, and trap destinations.

RMON Conformance Provides information to management software regarding 
the status of support for the groups.
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Functionality of Bridge Agents

Bridges are used to connect LAN segments below the network layer. A bridge 
connects two or more physical networks, forwarding packets between 
networks based on the information in the data link header.

Bridge agents collect information in the following five Bridge groups. You 
can use this information to monitor switched networks. For details, see RFC 
1493 (http://www.isi.edu/in-notes/rfc1493.txt).

Group Description

Base Stores information about objects that are applicable 
to all types of bridges.

Spanning Tree Protocol Stores information regarding the status of the bridge 
with respect to the Spanning Tree Protocol.

Source Route Bridging Provides information that describes the status of the 
device with respect to source route bridging.

Transparent Bridging Provides information that describes the entity’s state 
with respect to transparent bridging.

Static Collects information that describes the entity’s state 
with respect to destination address filtering.
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The following figure illustrates the ZfS views that you can display when you 
use a Bridge agent to monitor the nodes and devices on your network.

Viewing the Summarized RMON Information

The RMON Summary view provides brief information about RMON service 
on a selected node. It displays static information about the RMON agent and 
details of the resources requested by the user from the agent. The resource 
requests that are displayed in the RMON Summary view are Packet Capture 
and Host TopN requests.

To view the summarized RMON information:

� Click RMON under Services within a node.

� Click View > RMON Summary.

The following table describes the static information displayed in the RMON 
Summary view.

Statistic Explanation

Agent Name Name of the RMON agent monitoring the selected 
segment

IP Address IP address of the node on which the RMON agent is 
installed

IPXTM Address Internetwork Packet ExchangeTM (IPX) address of the 
node on which the RMON agent is installed
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The RMON Summary view displays the resource information described in the 
following table.

To delete a resource:

� Select a row from the Resource table.

� Click Delete.

When you delete a resource, the entry on the agent corresponding to the 
selected row is deleted.

Role-Based Traffic Analysis Tasks

ZfS lets you perform the following traffic monitoring tasks based on your role:

� Add nodes to be monitored for inactivity.

 For details, see “Monitoring Nodes for Inactivity” on page 219.

� Add protocols to the protocol directory tree.

Number of Interfaces Number of logical interfaces for the management 
server on which the RMON agent is installed

Version Version number of the RMON Plus agent

Type of RMON Service Type of the RMON agent: RMON, RMON Plus, or 
RMON2

Status of the Agent Status of the RMON agent

Statistic Explanation

Resource Name Type of resource requested:

� Packet Capture

� Host TopN

Owner Owner string corresponding to the control entry of the row

Index Channel, Filter, or Buffer control indices for the Packet 
Capture resource and Control index for the Host TopN 
resource

Statistic Explanation
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For details, see “Displaying a List of Protocols Used in Your Network” 
on page 235.

� Capture packets.

For details, see “Capturing Packets” on page 221.

� Disable nodes from being monitored for inactivity.

For details, see “Monitoring Nodes for Inactivity” on page 219.

� Delete protocols from the protocol directory tree.

For details, see “Displaying a List of Protocols Used in Your Network” 
on page 235.

� Free agent resources.

For details, see “Viewing the Summarized RMON Information” on page 
189.

� Set segment alarms.

For details, see “Configuring Alarm Options from the Set Alarm Dialog 
Box” on page 251. 

� View conversations.

For details, see “Viewing Conversations (Traffic) Between Nodes” on 
page 218.

� View traffic analysis agents.

For details, see “Selecting the Preferred RMON Agent” on page 197.

� View protocol directory.

For details, see “Determining the Distribution of Protocols in a Segment” 
on page 237.

� View RMON summary.

For details, see “Viewing the Summarized RMON Information” on page 
189.

� View segment alarms.

For details, see “Viewing Alarm Statistics for a Segment” on page 209.

� View segment dashboard.

For details, see “Determining the Performance of Individual Segments” 
on page 202.
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� View segments monitored for inactivity.

For details, see “Monitoring Nodes for Inactivity” on page 219.

� View segment protocol distribution.

For details, see “Determining the Distribution of Protocols in a Segment” 
on page 237.

� View segment stations.

For details, see “Listing Statistics for Segments” on page 201.

� View segment summary.

For details, see “Viewing the Summarized Segment Information” on page 
209.

� View segment trends.

For details, see “Analyzing Traffic on Segments” on page 200.

� View switch or port traffic.

For details, see “Viewing Statistics for Ports in a Switch” on page 239.

� View switch summary.

For details, see “Viewing the Summarized Switch Information” on page 
240.

For more information about role-based services, see “Role-Based 
Administration” on page 21.

Protocol Decodes Suite Supported by ZfS

ZfS decodes several protocol suites. Using ZfS, you can analyze and 
troubleshoot problems in the following protocol suites:

� NetWare Protocol Suite

� NetWork File System Protocol Suite

� Systems Network Architecture Protocol Suite

� AppleTalk* Protocol Suite

� TCP/IP Protocol Suite

You need to understand these protocols in order to set up packet capture and 
interpret the results in the Trace Display window. For more information about 
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these protocol suites and decoding support, see Appendix C, “Protocol 
Decodes Suite Supported by ZfS,” on page 505

ZfS also enables you to analyze and troubleshoot problems in the following 
media:

� Standard Ethernet

� IEEE 802.3

� Token Ring

� FDDI

Planning for Segment Monitoring

A baseline defines the typical activity of your network. Keeping a baseline 
document of activity on a segment lets you determine when the activity is 
atypical. Atypical activity might be caused by a problem or network growth. 
To create a baseline activity, you should gather statistical information when 
the network is functioning typically.

The following sections provide information about creating and using a 
baseline: 

� “Creating a Baseline of Typical Segment Activity” on page 193

� “Using the Baseline Document” on page 194

� “Segment Baseline Document Tips” on page 195

Creating a Baseline of Typical Segment Activity

For segment statistics such as bandwidth utilization, you should create a trend 
graph that plots information over a period of time. Statistics sampling that 
gathers data over a short period of time can be misleading. If you have added 
one or more network components, it is useful to create another baseline 
against which you can compare future activity.

You can export the data you gather in ZfS into programs, such as spreadsheets, 
for further analysis and to maintain records over time.

,03257$17��This section introduces the concept of creating baselines for the 
operation of your network and provides pointers to ZfS features that help you 
create baselines. We recommend that you consult a book about LAN analysis, 
such as Novell’s Guide to NetWare LAN Analysis by Laura Chappell, for detailed 
information about creating baseline documents.
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Using the Baseline Document

You can use the baseline document for the following purposes:

� “Using Baseline Documents to Set Alarm Thresholds Appropriately” on 
page 194

� “Using Baseline Documents to Track Network Growth and Its Effect on 
Performance” on page 194

� “Using Baseline Documents to Troubleshoot Atypical Segment Activity” 
on page 195

Using Baseline Documents to Set Alarm Thresholds Appropriately

ZfS lets you set alarm thresholds for statistics on segments monitored by the 
network monitoring agent software, so that if the threshold is exceeded, you 
are notified at the management console. Setting alarm threshold values for 
statistics on a segment eliminates the need for you to constantly monitor 
segments for problems.

ZfS provides default values for thresholds of various alarms on Ethernet, 
FDDI, and Token Ring segments. Refer to the table in “Configuring Alarm 
Options from the Set Alarm Dialog Box” on page 251 for a list of alarm 
statistics tracked by ZfS. By creating a baseline of activity on the segment, you 
can determine whether the default values are appropriate for segments in your 
network. For example, after tracking segment utilization, you would set an 
alarm threshold for bandwidth utilization at about 5% to 10% higher than 
typical utilization. You are then alerted if utilization is greater than usual for 
that segment.

,03257$17��If you want to use this alarm notification feature, you must enable 
segment alarms.

Using Baseline Documents to Track Network Growth and Its Effect on Performance

By comparing current network performance against the performance recorded 
in your baseline document, you can determine how performance is affected by 
network changes. This comparison also helps you plan for network growth 
and justify network upgrades and expansion. You can view graphs of real-time 
trends for various Ethernet, FDDI, and Token Ring statistics. If an RMON2 
agent is installed on a segment, you can also view historical trends for those 
statistics over hourly, daily, weekly, monthly, and yearly periods. Refer to 
“Analyzing Trend Data for a Segment” on page 204 for details about how to 
view a trend of segment performance. Refer to the table in “Choosing Options 
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to Display Stations on a Segment” on page 242 for a list of statistics based on 
which you can display a trend of segment performance.

Using Baseline Documents to Troubleshoot Atypical Segment Activity

By knowing what the typical network activity is, you can recognize atypical 
activity, which might help you isolate the cause of a problem.

Segment Baseline Document Tips

You should include the following key characteristics in each network baseline 
document:

� “Bandwidth Utilization” on page 195

� “Packets Per Second” on page 195

� “Network Error Rates” on page 196

� “Kilobytes Per Second” on page 196

� “Most Active Servers on the Segment” on page 196

Bandwidth Utilization

The bandwidth utilization statistic indicates the percentage of network 
bandwidth used. Bandwidth utilization is likely to be higher at certain times 
during the day (for example, when users log in to the network in the morning), 
week, or month. Tracking bandwidth utilization helps you balance traffic 
loads among network segments, servers, and routers for a more efficient 
network. This information also helps you determine the effect of network 
growth on performance. As new workstations and applications are added to a 
network, bandwidth utilization typically increases.

Packets Per Second

Monitoring the number of packets on the wire provides information about the 
traffic on the segment. By looking at the change in the packets per second after 
a user launches a new application, you can calculate what the increase in 
packets per second will be when all the users you expect to use the application 
start using it. Packets per second differs from utilization. Utilization is based 
on the number of kilobytes on the segment per second, but packets can range 
in size. Therefore, utilization can increase as a result of an increase in the size 
or number of packets. If the number of packets increases but utilization does 
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not, it is likely that the number of small packets increased but the increase did 
not affect utilization.

Network Error Rates

By including error rates in your baseline, you can determine when error rates 
on the network are atypical. This is important because network errors can 
bring down the network. A higher error rate can result from a hardware 
problem or network growth. If errors increase but utilization does not, there 
might be a problem with a component, for example a faulty network board or 
transceiver.

Kilobytes Per Second

Tracking kilobytes per second lets you determine the throughput of your 
network. From this information, you can determine the percentage of the total 
possible bandwidth that is in use. For Ethernet networks, the maximum 
possible utilization is 10 Mbps. For Token Ring networks, the maximum 
possible utilization is 4 or 16 Mbps (depending on the hardware).

Most Active Servers on the Segment

Keeping track of the top three servers on the network helps you distribute the 
load among them as you add new users and applications. See “Viewing 
Statistics of the Top 20 Nodes” on page 212 for details about how to display a 
list of top nodes on a monitored segment. You should also monitor the number 
of Request Being Processed packets. A constantly increasing number of these 
packets indicates a server overload condition. You can monitor these packets 
by doing a packet capture and decode. See “Capturing Packets” on page 221 
and “Displaying Captured Packets” on page 225 for details about how to 
capture and display decoded packets. 

With the Segment Trends view, you can view many segment statistics and 
export that data into another application (such as a spreadsheet) for later 
analysis. The data is saved as a text file that stores statistical values of the trend 
you display. To export the trend data to a file, click the Export button in the 
toolbar of the Segment Trends view. For details, see “Analyzing Trend Data 
for a Segment” on page 204.

You can view current utilization for a segment through the Segment 
Dashboard view. To access this view, select a segment, click View > click 
Segment Dashboard. For details, see “Determining the Performance of 
Individual Segments” on page 202.
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Preparing to Analyze Network Traffic

The ZfS software components include the traffic analysis agent for NetWare 
and traffic analysis agent for Windows NT/2000. You can install the network 
monitoring agent on the management server or on an independent NetWare or 
Windows NT/2000 server. The agent monitors the traffic on the segment it is 
connected to, gathers information about the nodes and devices on that 
segment, and makes this information available to the management server, 
which provides it to the management console. The agent also sends traps to 
the management server that are forwarded to the management console. The 
management server and the monitoring agent communicate using SNMP. ZfS 
provides default values for SNMP parameters. 

The following sections provide information about specifying a preferred agent 
for monitoring traffic on the segment and changing the default SNMP settings:

� “Selecting the Preferred RMON Agent” on page 197

� “Setting Up SNMP Parameters” on page 198

Selecting the Preferred RMON Agent

If more than one remote monitor (RMON) agent exists on a selected segment, 
you can choose which agent is to monitor the nodes on the segment from the 
RMON Agent property page. This page displays a list of servers on which the 
RMON Agent is installed. The agent installed on the server that you choose 
from this list becomes the preferred agent. The preferred agent is the primary 
agent that monitors the segment and sends information about segment activity 
to the management console.

To display the RMON Agent property page:

� Select a segment from the management console.

� Click File > Properties > the RMON Agent tab.

The following table describes the statistics displayed in the RMON Agent 
property page.

Statistic Explanation

Preferred Displays a check mark if the selected server is 
chosen to be the preferred RMON agent server.
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To choose an RMON agent as the preferred agent:

� Choose a server or workstation name from the list of names displayed in 
the property page.

The server and workstation names displayed are those on which the 
RMON agent is installed.

� Click Apply.

Setting Up SNMP Parameters

When you request dynamic information to be displayed in the management 
console, the management console seeks the information from the management 
server. The management server communicates with the network monitoring 
agent using SNMP, obtains the required information from the agent, and 
provides it to the management console. SNMP communications between the 
server and the agent are based on default SNMP settings provided by ZfS. You 
can change the default SNMP settings using the SNMP dialog box, which 

Agent Name Displays a list of all the servers on which the RMON 
agent is installed.

Version Displays the version of the RMON agent installed 
on the server.

The version is dynamically obtained. If ZfS cannot 
connect to the remote agent, or if a third-party agent 
is installed on the selected segment, this field is 
blank.

Status Displays the status of the RMON agent on the 
segment.

MAC Address Displays the physical Media Access Control (MAC) 
address of the node.

Interface Index Displays the number of interface indexes in which 
each interface corresponds to a segment that the 
node can connect through the network board.

Available RMON Services Displays the list of RMON services available from 
the selected agent: RMON, RMON Plus, or 
RMON2.

Statistic Explanation
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displays at the management console if an error occurs when the management 
server is communicating with the monitoring agent.

You can use the SNMP dialog box to specify the community strings and 
security settings for SNMP communication. You can change the default time-
out value for the server to connect with the agent. If the default time-out value 
is exceeded before the server can communicate with the agent or if the 
community string of the server does not match that of the agent, the SNMP 
dialog box displays at the management console with the current settings. You 
can use the dialog box to change the current time-out value, the community 
string, and other SNMP parameters. The changed values are saved in the ZfS 
database and will be applied for all subsequent traffic management sessions.

To change the SNMP settings for all monitoring agents in your network:

� Right-click the ZfS domain from the management console > click Global 
SNMP Parameters.

To change the SNMP settings for a specific agent:

� Right-click the node on which the agent is installed from the management 
console > click Properties > click SNMP Settings.

The following table describes the SNMP parameters displayed in the SNMP 
Settings property page.

+,17� If the network monitoring agent is running on NetWare 4.x and your network 
is IPX enabled, use the SNMP dialog box to communicate with the agent using IPX. 
This will significantly improve the performance of ZfS traffic analysis components.

Parameter Explanation

Community String Community name of the node requesting dynamic 
data from the agent

Timeout Maximum duration for which the server should wait 
for a response from the agent

Retry Number of times the server should try to connect 
with the agent

Secure Set Encrypts the packet sent by the management 
server to the monitoring agent

Secure Get Encrypts the packet sent by the monitoring agent to 
the management server
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Analyzing Network Traffic

You can use ZfS to monitor your network and collect information such as a 
summary of real-time statistics to determine the performance of your network, 
or detailed real-time statistics to determine the performance of segments in 
your network.

Information about the activity of nodes and segments in your network is 
presented in views containing tables, dials, and graphs. You can use the 
information to perform various traffic management tasks such as establishing 
a baseline on your network to help you identify typical traffic loads and 
control network problems, and analyze real-time performance to help you 
balance traffic loads among network segments, servers, and routers. You can 
also collect node information to help you focus on specific entities that might 
be the source of problems.

The following sections provide detailed information about how you can use 
ZfS to manage your network monitoring activities:

� “Analyzing Traffic on Segments” on page 200

� “Analyzing Traffic on Nodes Connected to a Segment” on page 212

� “Capturing Packets” on page 221

� “Displaying Captured Packets” on page 225

� “Analyzing Traffic Generated by Protocols in Your Network” on page 
234

� “Analyzing Traffic on Switches” on page 239

Analyzing Traffic on Segments

Monitoring the segments on your network helps you keep the network 
operating cost effectively, consistently, and smoothly. Based on the kind of 
information you want to obtain, you can choose the agent that will monitor the 
segments on your network. For details, see “About Network Monitoring 
Agents” on page 182. The agent monitoring the segments will collect traffic 
data and provide real-time or historical information to you when you require 
it.

ZfS provides various views you can use to obtain statistical information about 
monitored segments. You can choose to view statistical information for all 
segments in your network or for individual segments. You can view a trend of 
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segment performance and a list of alarms generated on a segment. The 
Segment Summary view provides a summary of segment performance.

The following sections provide information to help you analyze the 
performance of segments in your network:

� “Listing Statistics for Segments” on page 201

� “Determining the Performance of Individual Segments” on page 202

� “Analyzing Trend Data for a Segment” on page 204

� “Viewing Alarm Statistics for a Segment” on page 209

� “Viewing the Summarized Segment Information” on page 209

+,17� Servers running the remote monitor (RMON) agent can notify you when 
nodes you selected for monitoring become inactive. For details, see “Monitoring 
Nodes for Inactivity” on page 219. Sometimes the RMON agent server must be 
taken off the network for maintenance. To prevent the segment from going 
unmonitored, you can choose a different RMON agent on the segment. For details, 
see “Selecting the Preferred RMON Agent” on page 197.

Listing Statistics for Segments

The List Segments view displays a list of segments and statistical information 
for each segment on your network. Statistics are displayed in columns of the 
table in the view. The view displays a list of segments associated with the 
object or node you selected from the management console.

See “Analyzing Traffic on Nodes Connected to a Segment” on page 212 for 
details about how to use ZfS to get information about nodes on individual 
segments.

To view statistical information of all segments:

� Select an Area or a node from the management console.

� Click View > List Segments.

If you select an Area, the List Segments view displays statistics for all 
segments found within that Area. If you select a node, statistics for all 
segments connected to that node will be displayed.

The following table describes the statistics displayed for each segment. The 
sampling interval for updating statistics on segments is 15 seconds. 

+,17� Statistics of segments are displayed in the List Segments view only if the 
segments are monitored by a traffic analysis agent for NetWare or traffic analysis 
agent for Windows NT/2000.
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As ZfS polls segments, messages in the Messages column vary. These 
messages display the status of the preferred RMON agent on the segment.

The preferred RMON agent is the node you selected to send information about 
the segment to the management console. You can make this selection from the 
RMON Agent property page. For details, see “Selecting the Preferred RMON 
Agent” on page 197.

You can modify the view to show fields; format columns; sort and group 
items; change the font of text fields; or display grid lines in the table view by 
selecting the required option from View > Settings. For details, see Chapter 4, 
“Network Discovery and Atlas Management,” on page 39.

Statistic Explanation

Segment Name Segment name or address.

Type Physical segment type: Ethernet, FDDI, Token Ring, PPP, 
and unknown. Unknown indicates the segment whose 
physical segment type is other than the one listed.

Speed (Mbps) The speed of the segment, as determined by the speed of the 
network board that attaches the RMON agent to the segment 
and factors such as the cable type of the segment. The value 
in this column appears only if you have at least one RMON 
agent connected to at least one server on your network.

Utilization% Average percentage of the bandwidth currently used by all 
traffic on the segment.

Packets/s Average number of packets per second currently transmitted 
on the segment.

KBytes/s Average number of kilobytes per second currently 
transmitted on the segment.

Errors/s Average number of errors per second currently appearing on 
the segment.

Message Status of the RMON Agent on the segment. For details, see 
“Selecting the Preferred RMON Agent” on page 197.
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Determining the Performance of Individual Segments

ZfS provides real-time statistical information about the monitored segment on 
your network. This information is displayed in the Segment Dashboard view. 
The information displayed in this view is useful if you want to troubleshoot a 
segment.

The Segment Dashboard view displays four gauges that display the real-time 
statistics for a monitored segment. The lower portion of the view displays a 
bar graph of the top eight nodes, based on the value selected from the drop-
down list. By default, it is based on packets out per second. See “Viewing 
Statistics of the Top 20 Nodes” on page 212 for details about how to display a 
list of the most active nodes on a monitored segment.

You can configure the Segment Dashboard view to display the top eight nodes 
based on a different statistic. You can also choose to display or disable the top 
nodes graph. For details, see “Choosing Options to Display Stations on a 
Segment” on page 242.

You can set alarm threshold values on segment alarms for packets per second, 
broadcasts per second, and utilization percentage statistics displayed in the 
Segment Dashboard view. For details, see “Defining Alarm Thresholds for 
Statistics Displayed in the Segment Dashboard View” on page 204.

To view statistical information of an individual segment:

� Select a segment from the management console. 

� Click View > Segment Dashboard.

The Segment Dashboard view displays four gauges that display real-time 
statistics for a monitored segment. The peak value is indicated by a line on 
each bar in the graph. The following table describes the statistics displayed in 
the Segment Dashboard view.

Statistic Explanation

Packets/s Number of packets per second currently transmitted on the 
segment

Utilization% Percentage of maximum network capacity currently consumed 
by packet traffic on the segment

Error/s Number of error packets per second currently transmitted on the 
segment
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Statistics are updated every five seconds. The numeric value of each statistic 
is displayed in the gauge.

Defining Alarm Thresholds for Statistics Displayed in the Segment 
Dashboard View

To set alarm threshold values for statistics displayed in the Segment 
Dashboard view:

� Click the black ring outlining the gauge.

� Drag the ring to increase or decrease the default values.

As you drag the ring, the color of the ring changes to red.

� Stop at the value you want to set as the threshold value for the statistic.

The color of the ring is displayed in red up to the selected threshold value.

If the statistic on the monitored segment exceeds the threshold value, the 
RMON agent sends a trap to the management server, which forwards it to 
the management console and an alarm is generated.

Viewing the Graph of the Top Nodes on a Monitored Segment

The lower portion of the Segment Dashboard view displays a bar graph of the 
top eight nodes on a monitored segment. The default statistic on which the 
graph is based is packets out per second. You can change the statistic on which 
the graph is based. For details, see “Choosing the Statistic Based on which Top 
Nodes Graph Is Displayed” on page 249. You can also choose to display or 
disable the top nodes graph. For details, see “Choosing Options to Display the 
Top Nodes Graph” on page 248.

Statistics for the graph are updated every five seconds. Every 60 seconds, the 
graph is resorted and the new top nodes are displayed. At this point, new nodes 
might be added and existing nodes might be discarded from the list.

Broadcasts/s Number of broadcast packets per second currently transmitted 
on the segment (a broadcast packet is sent to all addresses on 
the segment)

Statistic Explanation
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Analyzing Trend Data for a Segment

ZfS allows you to determine trends of traffic patterns on the monitored 
segment. You can view the trend of segment performance from the Segment 
Trends view. You can use trend information to create a baseline of typical 
activity on segments. Having a baseline helps you set appropriate thresholds 
for segment alarms and plan maintenance activities and backups. 
Additionally, if problems occur on the segment, you can compare the typical 
traffic level against the atypical traffic level to help you discover the cause of 
the problem. For details, see “Creating a Baseline of Typical Segment 
Activity” on page 193.

The following topics will help you analyze trend data:

� “Understanding the Trend Display” on page 205

� “Viewing Trend Statistics” on page 206

Understanding the Trend Display

Segment trend data is displayed depending on the type and settings of the 
RMON agent monitoring the selected segment. The dependencies are 
explained below.

� If RMON Plus is the segment’s preferred RMON agent, you can view 
current trends gathered every 30 seconds over the last hour and historical 
trends displayed over hourly, daily, weekly, monthly, or yearly periods.

,03257$17��If an RMON agent is installed on more than one node on a 
segment, the node you select in the RMON Agent property page as the node to 
send information about the segment to the management console is the preferred 
RMON agent server. For more details, see “Selecting the Preferred RMON Agent” 
on page 197.

� If RMON Plus is not selected as the preferred RMON agent for the 
segment, you can view only the current trends for the selected segment. 
Current trends are gathered every 30 seconds over the last hour. Select an 
RMON Plus agent as the preferred RMON agent for the segment to be 
able to view historical trends.

� If the preferred RMON agent is traffic analysis agent for NetWare version 
earlier than 1.30, you can view current trends gathered over the past hour 
and trends for the past day.

� Real-time trends will not be displayed if memory usage is excessive or if 
configuration settings in the RMON agent are unacceptable.
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� If the RMON agent is down or is experiencing problems, the trend for a 
monitored segment will be displayed as a broken graph.

� If the preferred RMON agent is a Novell Traffic Analysis Agent (version 
1.30 or greater) or a third-party agent that implements the Token Ring 
Extensions to the Remote Network Monitoring MIB (RFC 1513), the 
segment bandwidth utilization graph displays slightly lower values than 
the actual utilization in the trend for the Token Ring Segment view. This 
is because the MAC layer statistics are not taken into consideration for the 
utilization calculation.

Viewing Trend Statistics

To view the trend statistics for a segment:

� Select a segment from the management console.

� Click View > Segment Trends.

Trend graphs are displayed for Ethernet, FDDI, and Token Ring segments. 
The default statistics, based on which graphs are displayed for the three types 
of segments, are as follows:

The toolbar options let you change the time span of the trend you view, select 
statistics based on which you want the graph to be displayed, and export data 
to a file. The following table describes the toolbar options in detail.

Segment Type Default Statistic

Ethernet Total packets, good packets, and error packets

FDDI ring Total packets

Token Ring Total packets
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Option Explanation

Profile Button Displays the Profile dialog box from which 
you can select a default profile. The default 
profile displays a trend with statistical 
information for total packets, good packets, 
and error packets on the monitored 
segment.

If you choose not to use the profiles listed in 
the Select Profile list, you can select the 
required statistics from the Select Statistics 
list. You can save the selected statistics if 
you want to display the trend of a different 
segment based on the statistics you 
selected. The default profile will be enabled 
the next time you launch the Segment 
Trends view.

Legend Button Shows what each color in the graph 
represents. The Legend can be resized.

Stack Button Stacks the trends in a single graph 
representing all selected statistics, on a 
single vertical axis.

Unstack Button Unstacks the trends and displays the graph 
as a separate strip for each statistic.

Horizontal Grid Displays horizontal grid lines in the graph 
area of the Segment Trend view.

Vertical Grid Displays vertical grid lines in the graph area 
of the Segment Trends view.

Scale To Fit Maximizes or minimizes the graph to fit the 
trend entirely in the graph area of the view.

Export Copies the information in the Segment 
Trends view to a file. The file stores the 
statistical values displayed by the trend. You 
can save the data for later analysis.
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The File menu of the Segment Trends view can be used to print the statistical 
information of the current trend or to export the statistical information of a 
trend to a file and store the data in text format. You can later import the file 
into a spreadsheet for analysis.

You can view earlier or ensuing trends and change the size of the graph by 
using the options available in the graph area of the Segment Trends view, as 
shown in the following table.

Time Scale 
drop-down list

� Real Time: Displays a current trend 
graph. The default sampling time for 
this graph is once every minute. This 
graph updates in real time.

� One Hour: Displays a historical graph 
of the selected trend with a time span 
of one hour.

� One Day: Displays a historical graph 
of the selected trend with a time span 
of one day.

� One Week: Displays a historical graph 
of the selected trend with a time span 
of one week.

� One Month: Displays a historical 
graph of the selected trend with a time 
span of one month.

� One Year: Displays a historical graph 
of the selected trend with a time span 
of one year.

Historical trends such as hourly, daily, 
weekly, monthly, and yearly trends are 
available only when traffic analysis agent 
for NetWare version 1.1 or later is 
installed on the segment’s preferred 
traffic analysis agent server. 

Option Description

Scale Up Increments the Y-axis of the graph by half the current size 
with each click.

Option Explanation
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Viewing Alarm Statistics for a Segment

ZfS tracks alarm statistics for segments. Alarms are generated when threshold 
values for statistics on a segment are exceeded. You can view a list of all the 
alarms for the monitored segment in the Segment Alarms property page.

To view alarm statistics for a segment:

� Select a segment from the management console.

� Click File > Properties > the Segment Alarms tab.

ZfS provides default threshold values for various segment alarms. You can 
enable or disable the default values for a monitored segment. If you choose not 
to use the default values, you can set the threshold value using the Set Alarm 
dialog box. See “Configuring Alarm Options from the Set Alarm Dialog Box” 
on page 251 for details about how to set segment alarms.

If a segment does not have an RMON agent connected to it, an error message 
is displayed.

Viewing the Summarized Segment Information

The Segment Summary view provides brief information about a monitored 
segment in your network. It displays static information about the monitored 
segment, whether the segment is monitored or not, and information about the 
alarms generated on the segment. At a glance, you can determine the 
utilization of network capacity by nodes on the monitored segment, view a 
trend based on packets transmitted by nodes on the segment, and see the 
distribution of protocols on the segment.

To view the summarized segment information:

Scale Down Decrements the Y-axis of the graph by half the current 
size with each click.

Previous Displays the preceding graph based on the profile or 
statistics chosen. 

Enabled only when historical trends are displayed. 

Next Displays the subsequent graph.

Enabled only when historical trends are displayed.

Option Description
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� Select a segment from the management console.

� Click View > Segment Summary.

The following table describes the static information displayed in the Segment 
Summary view.

The Segment Summary view displays information about alarms generated on 
a monitored segment, as described in the following table.

Statistic Explanation

Name Name of the segment

Type Media type of the segment: Ethernet, FDDI, or Token 
Ring

IP Address IP addresses of the segment

IPX Address IPX address of the segment

Primary Agent Name of the preferred agent monitoring the nodes and 
traffic on the segment

Agent Status Status of the preferred agent monitoring the nodes and 
traffic on the segment

Nodes Number of nodes on the segment

IP Nodes Number of nodes on the segment that have an IP 
address

IPX Nodes Number of nodes on the segment that have an IPX 
address

Servers Number of NetWare servers on the segments

Workstations/Others Number of nodes on the selected segment that are not 
NetWare servers

Network Probes Number of monitoring agents on the selected segment

Switches Number of switches on the segment

Routers Number of routers used to connect nodes and devices on 
the segment

Hubs Number of hubs on the segment
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The Segment Summary view displays dynamic information about a monitored 
segment, as described in the following table.

Statistic Explanation

Severity Severity level attributed to the trap.

From Network address of the device that sent the alarm to the alarm 
management system.

Summary Summary of the event, often including the name or address of 
the object affected by the alarm.

Owner Segment or device affected by the alarm.

Received Time Date and time when the alarm management system received 
the alarm.

Type Generic description of the alarm, for example, Volume out of 
disk space.

Category Displays the category of the alarm based on the MIB that 
defines the trap-type objects. The category is directly related to 
the MIBs included in the management server MIB pool. For 
example, the category for NetWare servers is based on the 
NetWare Server Alarm MIB.

Statistic Explanation

Utilization% Displays a dial representing the real-time values of the 
network capacity consumed by packet traffic on the 
segment.

Packets Displays the trend based on packets transmitted on the 
segment. Displays real-time trends for segments 
monitored by RMON agents and daily trends for 
segments monitored by RMON Plus agents.
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Analyzing Traffic on Nodes Connected to a Segment

ZfS provides various views you can use to obtain information about nodes 
connected to the monitored segments in your network.

The following sections provide information that will help you monitor the 
performance of nodes connected to the segments in your network:

� “Viewing Statistics of the Top 20 Nodes” on page 212

� “Viewing Statistics of Nodes on an FDDI Ring Segment” on page 214

� “Viewing Statistics of Nodes on a Token Ring Segment” on page 215

� “Viewing Conversations (Traffic) Between Nodes” on page 218

� “Monitoring Nodes for Inactivity” on page 219

Viewing Statistics of the Top 20 Nodes

You can use ZfS to determine the statistics of the most active nodes on a 
segment for a wide range of performance statistics. This is useful if you want 
to discover which node is generating the most traffic based on a particular 
statistic. For example, you can find the heaviest source of broadcast traffic.

The Stations view displays a list of all nodes on a monitored segment. You can 
use this view to determine the top 20 nodes on a monitored segment. The view 
lists the top 20 stations sorted by packets out per second. You can choose a 
different statistic based on which you want the top 20 nodes to display. For 
details, see “Choosing a Statistic Based on which Top 20 Nodes Are 
Displayed” on page 243. If there are fewer than 20 top nodes, only the 
available number of top nodes are listed.

To view the statistics of the top 20 nodes on a segment:

� Select a segment from the management console.

Protocol Distribution Displays a pie chart representing the distribution of 
application layer protocols for which the agent 
monitoring the segment can collect data. Each slice 
represents a protocol suite. Click a slice to view the 
names of protocols.

Enabled if the agent monitoring the selected segment is 
an RMON2 agent.

Statistic Explanation
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� Click View > Stations.

� From the Stations view, click View > Show Top N Stations.

The Stations view displays columns that provide statistical information for 
each station. The following table describes the statistics displayed in the 
Stations view.

Stations statistics are updated periodically. Every 60 seconds, the table is 
resorted and new top nodes are displayed. At this point, new nodes might be 
added and existing nodes might be discarded from the list.

Statistic Explanation

MAC Address Physical Media Access Control (MAC) address of a node

Node Name of the node (or address, if the name is not in the 
database)

Util.% Percentage of maximum network capacity consumed by 
packets sent by a node

Packets/s In Packets per second received by a node

Packets/s Out Packets per second transmitted by a node

Bytes/s In Bytes per second received by a node

Bytes/s Out Bytes per second transmitted by a node

Errors/s Errors per second transmitted by a node

Broadcasts/s Broadcast packets per second transmitted by a node

Multicasts/s Multicast packets per second transmitted by a node (packets 
transmitted to a specific group of nodes)

Protocols Types of protocols used by a node

First Transmit Date and time a node first transmitted since the traffic analysis 
agent was started

Last Transmit Date and time a node last transmitted since the traffic analysis 
agent was started
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Viewing Statistics of Nodes on an FDDI Ring Segment

ZfS lets you display data for nodes on monitored FDDI ring segments to help 
troubleshoot problems.

The FDDI Ring Stations view displays statistics for individual nodes on the 
monitored FDDI ring segment. The view lists the nodes on the segment and 
shows the order of each node on the ring and which node is the active monitor.

To view the statistics of nodes on an FDDI ring segment:

� Select an FDDI ring segment from the management console.

� Click View > FDDI Stations.

The statistics shown for each node are cumulative since the traffic analysis 
agent for NetWare was last started and are updated every ten seconds.

Statistic Explanation

Order Relative position of the node on the FDDI ring from the 
traffic analysis agent.

Name Name of the node or, if the name is not in the database, 
the physical (MAC) address of the node.

MAC Address Physical (MAC) address of the node.

Status Status of the node:

� On—The node is actively participating in ring poll.

� Off—The node is not participating in ring poll.

Duration Time elapsed since the node was On or Off.

UpStream Neighbor MAC address of the node upstream to this station on 
the logical ring.

DownStream 
Neighbor

MAC address of the node downstream to this station on 
the logical ring.

Last Entered Time Date and time the node last entered the ring.

Last Exit Time Date and time the node last exited the ring.
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Viewing Statistics of Nodes on a Token Ring Segment

The Token Ring Stations view displays statistics for individual nodes on the 
monitored Token Ring segment. The view lists the nodes on the segment and 
shows the order of each node on the ring and which node is the active monitor.

To view the statistics of nodes on a Token Ring segment:

� Select a Token Ring segment from the management console.

SMT Request Type The SMT request to which the node is responding. 
Indicates if the node was able to successfully respond 
to the request. In case of a failure, the response code 
indicates the reason.

SMT Response Type The SMT response generated by the node on receiving 
an SMT request. If the node was unable to respond, the 
response code indicates the reason.

Request Denied The cumulative total of request denied responses 
generated by the node. A request denied frame is 
generated when the responding node does not support 
the SMT version number of the requesting node, when 
a set fails, or when a request for synchronous 
bandwidth allocation by a node cannot be honored.

In CRC Error Total number of cyclic redundancy check (CRC) line 
errors reported by this node.

Out CRC Error Total number of CRC errors reported by the nearest 
active downstream neighbor of this station and detected 
by the probe.

Lost Frames Total number of lost frame errors received on the 
network. A lost frame error indicates that the end 
delimiter of a frame was lost in the network.

In Beacons Total number of beacon frames detected by the probe 
that named this station as its upstream neighbor.

Out Beacons Total number of beacon frames sent by this station and 
detected by the probe.

Insertions Number of times the probe detected this station 
inserting onto the ring.

Statistic Explanation
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� Click View > Token Ring Stations.

The view displays statistical information as described in the following table. 
Statistics are cumulative since the RMON agent was started and are updated 
every ten seconds.

Statistic Explanation

Order Relative position of the node on the Token Ring from the 
RMON agent.

Name Name of the node or, if the name is not in the database, 
the physical (MAC) address of the node.

MAC Address Physical (MAC) address of the node.

Status Status of the node:

� On—The node is on the ring.

� Off—The node is off the ring.

� On (Monitor)—The node is on the ring and is the 
active monitor.

Duration How long this node has been on or off.

Last Entered Time Date and time the node last entered the ring.

Last Exit Time Date and time the node last exited the ring.

Duplicate Address Total number of duplicate address errors reported, 
generated when this node detects other nodes using its 
own address.

Soft Errors Number of soft errors in packets transmitted by this 
node.

Inline Errors The total number of line errors reported by this station in 
error reporting packets to the ring error monitor and 
detected by the probe.

Outline Errors The total number of line errors reported in error reporting 
packets sent by the nearest active downstream neighbor 
of this station and detected by the probe.

Internal Errors Number of internal errors this node has reported. Internal 
errors generally indicate a recoverable failure of a 
network adapter board.
��
 Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
In Burst Errors The total number of burst errors reported to the Ring 
Error Monitor and detected by the probe.

Out Burst Errors The total number of burst errors reported in error 
reporting packets sent by the nearest active downstream 
neighbor of this station and detected by the probe.

AC Errors Number of times this node could not interpret the 
Address Recognized Indicator (ARI) and the Frame 
Copied Indicator (FCI) during the ring process.

Abort Errors Number of times a node transmitted an abort sequence. 
Abort sequences are usually transmitted when a node 
detects an error in frames it is currently transmitting.

Lost Frame Errors Number of times a node transmitted a frame but failed to 
receive it back in its entirety.

Congestion Errors Number of times the node detected a frame addressed 
to its specific address but could not copy it (generally due 
to insufficient buffers).

Frame Copied Errors Number of times a node detected a frame addressed to 
its specific address with either or both the ARI and FCI 
bits set to 1. (Indicates that another node is using its 
address.)

Frequency Errors Number of times a node’s internal clock differed from the 
ring clock.

Token Errors Number of token errors. These occur when the token 
gets corrupted or when the Active Monitor does not see 
a new frame transmitted in the required amount of time. 
Only the Active Monitor can report this error.

In Beacon Errors The total number of beacon frames sent by this station 
and detected by the probe.

Out Beacon Errors Total number of beacon frames sent by this station and 
detected by the probe.

Insertions Number of times the probe detected this station inserting 
onto the ring.

Last NAUN The station that was last named by the probe as the Next 
Active Upstream Neighbor (NAUN).

Statistic Explanation
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Viewing Conversations (Traffic) Between Nodes

ZfS provides real-time data about all the network traffic between a selected 
node and one or more other nodes on a segment. This data can be viewed from 
the Conversations view. You can use the data displayed in this view to 
determine specific information about node communication. For example, it 
can show which nodes communicate with a router or server, determine the 
load on a server, or examine the traffic flowing to or from a node that is 
reporting difficulties.

To view conversations between nodes:

� Select a node from the management console.

� Click View > Conversations.

If the selected node is connected to more than one segment, the Select 
Segment dialog box displays.

�� Select the segment to which the node you want to examine traffic is 
connected, click View > click Conversations.

The Conversations view lists the percentage of traffic that each destination 
node contributes to the load on the source node. However, due to sample 
skewing (samples not taking place at the same time) and rounding up of 
statistics, the numbers in the columns do not always add up to 100%.

The statistics displayed in the Conversations view are updated every 5 
seconds. The following table describes the statistics displayed in the 
Conversations view.

Statistic Explanation

Node Name of the destination nodes with which the source node is 
communicating

% Pkt Load Percentage of the packet load between a destination node and 
the source node

% Byte Load Percentage of the byte load between a destination node and 
the source node

Pkts/s In Packets per second received by a destination node from the 
source node

Pkts/s Out Packets per second transmitted by a destination node to the 
source node
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Monitoring Nodes for Inactivity

For segments on which at least one traffic analysis agent for NetWare version 
1.0 or later is installed, you can specify the nodes on the segment you want to 
monitor so that you are alerted if they become inactive. You can do this using 
the Monitor Nodes for Inactivity view.

Monitoring nodes for inactivity has the following advantages:

� You can monitor any node on the segment, regardless of the protocol the 
node uses.

� This feature does not impact network traffic because the traffic analysis 
agent does not poll the nodes to obtain their status.

To view a list of nodes monitored for inactivity:

Bytes/s In Bytes per second received by a destination node from the 
source node

Bytes/s Out Bytes per second transmitted by a destination node to the 
source node

Pkts In Number of packets received by a destination node from the 
source node since the view was opened

Pkts Out Number of packets transmitted by a destination node to the 
source node since the view was opened

KBytes In Total kilobytes received by a destination node from the source 
node since the view was opened

KBytes Out Total kilobytes transmitted by a destination node to the source 
node since the view was opened

Protocols Protocol packet types used by the destination node in this 
conversation

First Transmit Date and time that the destination node first transmitted on the 
network since the traffic analysis agent was loaded

Last Transmit Date and time that the destination node last transmitted since 
the traffic analysis agent was loaded

MAC Address Physical (MAC) address of the destination node

Statistic Explanation
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� Select a segment from the management console.

� Click View > Monitor Nodes for Inactivity.

+,17�  Another way to monitor connectivity is to specify the target in the Ping 
window and test the status of the specified node. The Connectivity Test window 
displays statistics that enable you to determine the status of the specified target. 
For details, see Chapter 10, “Monitoring Services,” on page 349.

By default, the poll interval for refreshing the Monitor Nodes for Inactivity 
view is zero seconds. You can configure the poll interval based on which you 
want the view to be refreshed. For details, see “Specifying the Poll Interval for 
Refreshing the Monitor Nodes for Inactivity View” on page 256. You can also 
change the duration for the agent to verify the node before declaring it 
inactive. For details, see “Specifying the Duration for the Agent to Determine 
if a Node Is Inactive” on page 256.

,03257$17��You do not need to keep the Monitor Nodes for Inactivity view open 
or the management console running for the nodes to be monitored because the 
RMON agent is doing the monitoring, not the management console. The Alarm 
Manager must be running to record an inactive node in the Alarm Report. If the 
management console is not running, check for alarms after you restart it.

To monitor a node for inactivity:

� Right-click a node from the management console or from any view that 
displays a list of nodes > click Monitor Nodes for Inactivity > click Add.

To disable a node from being monitored for inactivity:

� Right-click the node that is monitored for inactivity > click Monitor 
Nodes for Inactivity > click Delete.

,03257$17��After the addition of any node for inactivity, if the NIC card of the 
node is changed, you will be able to see the node in the Monitor Node for Inactivity 
view but will not be able to delete it because of the change of MAC address.

Statistics displayed in the Monitor Nodes for Inactivity view are described in 
the following table.

Statistic Explanation

Name Displays a list of nodes on the segment that are being monitored 
for inactivity

MAC Address Displays the MAC address of the network interface

Status Displays the status of a node as active or inactive
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You can open the Monitor Nodes for Inactivity view to check the Status 
column any time the management console is running. To do this, complete the 
following steps:

� Select a segment from the management console.

� Click View > Monitor Nodes for Inactivity.

The Status column displays if the selected node is active or inactive.

Capturing Packets

ZfS provides packet capture and decoding tools that help you analyze your 
network activity and identify the source of network problems. Capturing and 
decoding packets can help you troubleshoot network problems by giving you 
detailed information about what is actually happening on a segment.

The management console can request packet capture on any monitored 
segment. Each RMON agent captures packets on the segment it monitors and 
stores information in its local buffer.

The following sections contain detailed information about capturing packets:

� “Defining a Capture Filter” on page 221

� “Starting Packet Capture” on page 224

� “Creating Simultaneous Packet Capture” on page 224

� “Stopping Packet Capture” on page 225

� “Restarting a Stopped Packet Capture” on page 225

� “Saving and Viewing the Captured Packets” on page 225

Defining a Capture Filter

ZfS provides a capture filter with default values you can use to capture packets 
on any monitored segment. You can modify the values by defining a filter. For 
example, if you want to capture only NetWare packets sent by a certain node, 
you can define a filter to capture only those packets. As a result, the buffer has 
more space to store your selected packets.

When you specify a capture filter, you are specifying the packets to capture 
(include) in the buffer on the RMON agent, not the packets to exclude. When 
you specify both a node and a protocol, packets must meet both criteria to be 
captured. If you select more than one protocol family, packets can meet either 
protocol criterion to be captured.
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To define a capture filter:

� Select a node or a segment from the management console.

� Click File > Actions > Capture Packets.

� Type a name in the Buffer Name text box, if you do not want to use the 
default name.

The buffer name helps you keep track of multiple captures on the same 
segment.

� Type or select the source and destination nodes from the Stations box. 
You can also click on the Find Node icon to select the node from the Find 
dialog box, an Atlas component. 

The Stations box displays a list of nodes on the segment from which the 
user can capture packets.

If you choose ANY in both the source and destination node list, all 
packets sent by or received from any node are captured.

	 Select the direction of traffic flow between the nodes.

Click an arrow option button to select the direction of traffic flow. The 
available node and traffic flow directions are shown in the following 
table.

Node Arrow Node Effect

node1 <==> node2 Capture packets that node1 sends to node2 
and packets that node2 sends to node1.

node1 <==> ANY Capture packets that node1 sends to any node 
and packets that node1 receives from any 
node. This is equivalent to ANY <==> node1.

ANY <==> ANY Capture all packets sent by or received from 
any node.

node1 ==> node2 Capture packets that node1 sends to node2. 
This is equivalent to node2 <== node1.

node1 ==> ANY Capture packets that node1 sends to any other 
node. This is equivalent to ANY <== node1.

node1 <== node2 Capture packets that node2 sends to node1. 
This is equivalent to node2 ==> node1.
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 If you want to filter on protocols used, add the protocol suites you want 
to the Selected list box.

To add a protocol to the Selected list box, select it from the Available list 
box > click Add.

or

To delete a protocol from the Selected list box, select it > click Remove.

All protocols are selected by default when you first use ZfS. If no 
protocols are listed in the Selected list box, all protocols are captured.

See “Protocol Decodes Suite Supported by ZfS” on page 192 for details 
about the protocol decoding support that ZfS provides.

� Specify what kind of packets to capture on Ethernet, FDDI ring, or Token 
Ring segments.

The default statistics for the segments are listed in the following table.

� Specify whether to stop packet capture or to overwrite the oldest packets 
in the buffer with newer ones when the buffer is full.

Continuing packet capture means that a stop criteria does not exist and 
new packets will overwrite those already captured. You will need to 
manually stop packet capture if you select to overwrite the oldest packets.

 Specify a buffer size.

node1 <== ANY Capture packets that any node sends to 
node1. This is equivalent to ANY<== node1.

Segment Type Available Statistics Default Statistics

Ethernet Only good packets, only error packets, 
or both good and error packets.

Good packets 
and error packets

FDDI ring All packets, LLC packets, MAC 
packets, or SMT packets.

All packets

Token Ring All packets, non-MAC packets, or MAC 
packets. MAC packets are used to 
manage the operation of the Token 
Ring.

All packets

Node Arrow Node Effect
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Select a buffer size from the drop-down list or specify the size you want. 
The default buffer size is 32 KB.

The RMON agent will attempt to provide the buffer size requested. If not 
enough space is available in server memory for a large buffer, the RMON 
agent cannot create the requested size.

�� Select a slice size.

A slice specifies the maximum number of bytes of each packet, counting 
from the packet header, to keep in the buffer. This helps maximize the 
number of packets you can store in your buffer space, as well as reduce 
the load on the RMON agent to process captured packets. If you want to 
decode protocol header information, you need only 100 to 150 bytes. The 
rest is typically data that you need only if you suspect a data corruption 
problem. However, on certain very large packets, slicing can cause 
incorrect decodes by truncating information.

Your capture filter is now set up. If you decide not to capture packets, click 
the Cancel button.

Starting Packet Capture

To start packet capture:

� Define a capture filter. See “Defining a Capture Filter” on page 221 for 
the procedure.

� Click OK to apply the filter settings on the preferred RMON agent of the 
segment.

� Click Start in the Capture Status dialog box.

When you start packet capture, the Start button in the Capture Status dialog 
box toggles to read Stop and the activity indicator reflects the capture buffer 
storage as it progresses. As packets that meet the filter criteria are captured, 
the capture buffer will begin to store the packet data, and a box below it will 
display the number of packets captured. The needle stops turning when the 
capture buffer is full.

Creating Simultaneous Packet Capture

You can create simultaneous packet captures by repeating the procedure you 
followed to start the first capture. This lets you set up and run captures with 
different capture criteria.

You can run a maximum of 20 packet captures with different capture criteria.
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Stopping Packet Capture

When you set up a capture filter, you choose whether to stop packet capture 
when the capture buffer is full or to continue to capture packets but overwrite 
the oldest packets in the buffer.

By default, the packet capture will stop when the capture buffer is full. If you 
select to overwrite when the buffer is full, you must stop packet capture 
manually.

To stop packet capture manually, click the Close button in the Capture Status 
dialog box.

,03257$17��If you restart packet capture from the Packet Capture Setup 
window, the existing buffer is deleted and refreshed.

Restarting a Stopped Packet Capture

When the Packet Capture Setup window is open, you can start and stop 
capturing packets using the Start/Stop toggle button in the Capture Status 
dialog box. If ZfS is capturing packets, the button is labeled Stop; if it is not 
capturing packets, the button is labeled Restart. The RMON agent buffer is 
cleared when you restart.

Saving and Viewing the Captured Packets

You can save captured packets to a file and view as many files as you want, 
either while you are viewing a capture buffer or independently.

To view the saved packet capture files:

� Click Tools > View Packet File.

The File Open dialog box is displayed. 

� Browse and select the packet capture file.

The .TR1 file extension will be appended automatically.

Displaying Captured Packets

You can display and view decoded packets stored in the capture buffer from 
the Trace Display window by clicking the View button in the Capture Status 
dialog box. If you display this window while packets are being captured, 
capture automatically stops.
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ZfS retrieves packet data from the RMON agent only as necessary for the 
management console to decode and display the packets as you view them. 
This minimizes the amount of packet data transferred between the RMON 
agent and ZfS. If you prefer not to display all the packets you captured, you 
can create a display filter to display only a defined group of captured packets. 
For details, see “Defining the Display Filter” on page 229.

The following sections provide information on how you can view captured 
packets and perform trace display operations:

� “Viewing Captured Packets” on page 226

� “Filtering Packets for Display” on page 229

� “Defining the Display Filter” on page 229

� “Selecting and Decoding a Different Packet” on page 232

� “Highlighting Protocol Fields and Hexadecimal Bytes” on page 232

� “Saving Packet Files” on page 233

� “Opening Packet Files” on page 234

� “Printing Packets” on page 234

ZfS provides default settings based on which captured packets are displayed 
in the Trace Display window. To change the default values provided for 
displaying captured packet, see “Choosing Options to Display a Captured 
Packet” on page 251. 

Viewing Captured Packets

You can use the Trace Display view to view the decoded packet capture 
information, the packet data in hexadecimal format, and a summary of the 
captured packets:

To view a captured packet:

� Select a node or a segment from the management console.

� Click File > Actions > Capture Packet.

� Capture packets using the capture filter of your choice. See “Defining a 
Capture Filter” on page 221 for details.

� Click the View button in the Capture Status dialog box.

The Trace Display window contains three panes that display captured and 
decoded packets, as described in the following sections:
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� “Viewing the Packet Decode” on page 227

� “Viewing Packet Data in Hexadecimal Format” on page 227

� “Viewing a Summary of Captured Packets” on page 228

When you view packets initially, the first packet in the Summary pane is 
highlighted and selected. The contents of that packet are displayed in the 
Decode pane. If you select a different packet in the Summary pane, it is 
highlighted and the Decode pane displays its decoded contents.

You can change the size of the Trace Display panes by dragging the divider 
between windows.

Viewing the Packet Decode

The Decode pane displays detailed information about the contents of a 
selected packet. The packet contents are interpreted (decoded) and displayed 
by protocol fields.

By default, the Decode pane displays fully decoded packet data. You can 
configure the Trace Display window to display the decoded packets either as 
full protocol decodes or by one line per protocol layer. See “Choosing Options 
to Display a Captured Packet” on page 251 for details about how to change the 
default settings.

Viewing Packet Data in Hexadecimal Format

The Hexadecimal pane shows uninterpreted packet data in hexadecimal 
format. The ASCII or EBCDIC portion of the Hexadecimal pane (to the right) 
displays a dot for every hexadecimal byte that has no ASCII or EBCDIC 
equivalent.

The first column in the pane indicates the offset in hexadecimal bytes. The 
offset is the number of bytes counting from the beginning of the header. For 
example, the first three lines have the following offset:

� Hexadecimal 0—indicates zero offset

� Hexadecimal 10—indicates decimal 16 offset (16 bytes precede this)

� Hexadecimal 20—indicates decimal 32 offset (32 bytes precede this)

Regardless of whether you choose to display one-line decoded or fully 
decoded packets in the Decode pane, entire packets are displayed in the 
Hexadecimal pane. The Hexadecimal pane and the highlighting tool are 
especially helpful with the full-decode display when you are trying to 
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associate protocol fields with specific bytes in a packet. For details, see 
“Highlighting Protocol Fields and Hexadecimal Bytes” on page 232.

Viewing a Summary of Captured Packets

The Summary pane gives you an overview of the conversation between the 
source and the destination nodes. You can select a packet in this pane for 
further decoding and display in the other panes. You can scroll the pane 
horizontally, and you can change the size and position of the columns in the 
pane.

Statistical information about the captured packets displayed by the Summary 
pane is described in the following table.

Statistic Explanation

No. Numbers the packets in order of arrival at the traffic analysis 
agent.

Source Name or the physical (MAC) address of the node that sent the 
packet.

Names are stored in the database. If no name is found in the 
database, the MAC address is displayed.

Destination Node to which the packet was sent. The node is displayed as 
the name or the physical (MAC) address of the node.

Layer Abbreviation of the highest protocol layer in the packet. It 
might display ncp for NetWare Core ProtocolTM (NCPTM) 
software, ether for the Ethernet data link layer, rtmp for the 
AppleTalk Routing Table Maintenance Protocol layer, or 
802.2 for the IEEE 802.2 Logical Link Control layer. If you 
choose the full decode option, the Decode pane displays the 
full name of the protocol layer and all its fields. The 
Hexadecimal pane shows the entire packet.

Summary Brief description of the contents of the highest protocol layer.

Error Type of errors, if any, in the packet. This column is displayed 
only for Ethernet media.

Size Number of bytes in the packet. Packet size always excludes 
the packet preamble and the CRC.

Absolute Time Clock time on your computer when the packet arrived.
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Filtering Packets for Display

After you have captured packets, you can apply a display filter to the capture 
buffer and view only the packets that interest you. You can filter on node 
names or addresses, protocol families or protocol layers, or contents of a 
selected field. This is useful in situations when, after you have captured 
packets, you realize there is a problem with a specific workstation and you 
want to display only the packets it has sent or received.

+,17� Display filtering requires the transfer of a portion of every captured packet 
from the RMON agent to the management console. For large captures, this 
consumes time and network bandwidth. We recommend that you define very 
specific capture filters rather than filtering during display. However, subsequent 
filtering of the same capture does not result in additional data transfer from the 
traffic analysis agent because the data is already transferred to the management 
console. Therefore, it is much quicker to filter the same packet capture a second 
time.

Display filters affect only the display; they do not change the capture buffer. 
All captured packets remain in the capture buffer and are available for viewing 
with a different display filter or without any display filter.

You can define a display filter in either of two ways:

� From the Trace Display window, click View > Filter.

The Display Filter dialog box is displayed. For details, see “Defining the 
Display Filter” on page 229.

� Double-click a packet in the Summary pane or double-click a selected 
protocol layer or field in the Decode or Hexadecimal pane.

A filter is set based on what you selected. You can also modify the filter 
information as needed. For details, see “Point-and-Click Filtering” on 
page 231.

Defining the Display Filter

To define a display filter:

Interpacket 
Time

Time elapsed from the end of the preceding packet to the end 
of the current packet.

Relative Time Time that elapsed since the arrival of the first packet still in the 
buffer.

Statistic Explanation
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� Select a segment from the management console.

� Click File > Actions > Packet Capture.

� Capture packets using the capture filter of your choice. See “Defining a 
Capture Filter” on page 221 for details.

� Click the View button in the Capture Status dialog box.

	 With the Trace Display window displayed and active, click View > Filter.


 Select the nodes from the drop-down lists.

Alternatively, you can enter a node name or address in place of ANY in 
either or both of the drop-down list boxes.

� Select the direction of the traffic flow from the arrow options available.

� To display all the packets of a specific protocol layer:

�� Double-click a protocol suite name from the list of protocols to 
display a list of all the protocols in the suite.

�� Scroll through the list to find the protocol you want.

�� Select the protocol.

 To display all the packets that have the same contents in a specific field:

� Enter the offset in hexadecimal bytes.

You can count the offset in the Hexadecimal pane when the packet is 
decoded, using the offset column for guidance. See “Viewing Packet 
Data in Hexadecimal Format” on page 227 for details.

� Specify whether the offset is counted from the beginning of the 
packet or from the beginning of a protocol layer.

If you choose the protocol layer option, you must select a specific 
protocol in the Protocol box.

� Enter the data that you want to include in the filter.

� Specify the format in which you want the data to be displayed. Select 
from hexadecimal, ASCII, or EBCDIC format options.

You can also fill in the values using point-and-click filtering. See 
“Point-and-Click Filtering” on page 231.

�� Click OK.

The dialog box closes and ZfS begins to select the required packets from 
the capture buffer.
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If you have a large capture buffer, ZfS displays the initial packets that 
pass the filter. ZfS continues to filter in the background while you 
examine these packets.

The Summary pane shows the list of filtered packets that met the criteria 
in the display filter. You can view and decode them as described earlier 
in this section.

Point-and-Click Filtering

You can define a display filter using the point-and-click method by double-
clicking a field in the Trace Display window.

To define a display filter using the point-and-click method:

� To display only packets in one conversation (for example, between a node 
and a server), double-click a packet in that conversation in the Summary 
pane.

The Display Filter dialog box displays the source and destination of the 
selected packet. You can also modify the addresses, if needed. For 
example, you can change the destination address to ANY, the broadcast 
address, or a specific node address.

or

To display all the packets containing a specific protocol layer, double-
click the protocol line in the Decode pane.

The Display Filter dialog box displays the protocol you selected.

or

To display all packets with the same contents as a specific field, double-
click the field in the Decode pane.

The Display Filter dialog box displays the field, data, and type of data for 
the selected field.

or

To display all packets with the same content as a specific offset, click the 
field in the Hexadecimal pane.

The Display Filter dialog box displays the offset and the type of data for 
the selected field.

� Click OK.
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The dialog box closes and ZfS begins to select the packets from the 
capture buffer. 

The Summary pane displays the list of packets that met the display filter 
criteria.

Selecting and Decoding a Different Packet

To select a different packet for decoding:

� Select View > Go To.

You can also use the arrow keys on your keyboard to highlight a different 
packet.

� Enter the packet number.

If the packet number specified is more than the total number of captured 
packets, an error message displays. If a display filter is set and the 
specified packet number has not passed the filter, then a packet closest to 
the specified packet is displayed.

Packets are retrieved from the RMON agent as you select their headers in the 
Summary pane using the mouse or the arrow keys. Using the Go To dialog box 
avoids transferring unwanted packet data from the RMON agent. Similarly, 
scrolling the Summary pane with the scroll button retrieves only the packet 
header data when creating the decode summary, whereas using the arrow keys 
retrieves all packet data.

Highlighting Protocol Fields and Hexadecimal Bytes

ZfS provides a highlighting tool that helps you associate protocol fields and 
hexadecimal bytes. Highlighting can be a useful training tool for new network 
managers who want to learn about protocol decoding.

You can use this tool in the following ways:

� Highlight a protocol layer in the Decode pane.

All bytes are highlighted in the selected protocol layer of the 
Hexadecimal pane.

� Click a field in any of the protocol layers in the Decode pane.

Associated bytes are highlighted in the Hexadecimal pane.

� Click hexadecimal bytes in the Hexadecimal pane.
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All hexadecimal and ASCII or EBCDIC bytes of this field in the 
Hexadecimal pane are highlighted, and the associated field is highlighted 
in the Decode pane.

� Click ASCII or EBCDIC text in the Hexadecimal pane.

All hexadecimal and ASCII or EBCDIC bytes that belong to the field are 
highlighted in the Hexadecimal pane, and the associated field is 
highlighted in the Decode pane.

Saving Packet Files

You can save captured packets to a file and open the file later to analyze or 
print. When you save packets to a file, ZfS creates a binary file with the name 
you specify. You might want to save packets to a file in the following 
situations:

� To transfer the packets to another system or to send them for analysis.

� To apply a display filter to decoded captured packets so you can view 
only the packets that interest you. After you apply the display filter, you 
can save the filtered packets to a file.

� To compare packets saved from your buffer with other packets. You can 
either save the other packets as well, or view them from the capture 
buffer. You can view only one active capture buffer at a time. However, 
after you have saved packets to a file, you can open as many files as you 
want, and simultaneously view a capture buffer, if desired.

Packet files are compatible with traffic analysis agent for Windows NT/2000 
and earlier versions of ManageWise. Hence, packets captured and saved using 
traffic analysis agent for Windows NT/2000 can be viewed using ZfS.

To save captured packets to a file while viewing the capture buffer:

� Click File > Save As.

The Save Filtered Packets or Save Unfiltered Packets dialog box is 
displayed, depending on whether you filtered your packets.

� Enter the name in the File Name text box.

The .TR1 file extension is appended automatically.

� Click OK.

,03257$17��Filter out the captured packets you want to save. (See “Filtering 
Packets for Display” on page 229.) When you save packets, you save only those 
that pass the display filter. If you did not filter the display, all packets are saved.
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Opening Packet Files

To open a packet file:

� From the main menu of the management console, click Tools > View 
Packet File.

� Double-click the file you want to open.

Printing Packets

To print packets:

� Open a Trace Display window, either by capturing packets or by opening 
a packet file.

� Click File > Print.

� Select the print options you want.

You can select the destination, format, and the packets you want to print.

� Choose whether to print to your default printer or to a file. If you 
choose a file, enter its name and specify whether the current packet 
data should overwrite the file or be appended to it.

� Choose whether you want a summary of the packet information, only 
the hexadecimal information, a full decode, or a brief decode. These 
formats correspond to the three panes described in “Viewing 
Captured Packets” on page 226.

� Choose whether to print all packets, a range of packets, or only the 
filtered packets.

� Click OK.

Analyzing Traffic Generated by Protocols in Your Network

ZfS lets you determine the distribution of protocols in your network and 
provides statistical information of the protocols discovered by the RMON2 
agent in the network, as well as transport and application layers. You can also 
add supported and custom protocols to your network. Supported protocols are 
those that the RMON2 agent is able to decode and count the number of packets 
transmitted in your network using the protocol. Custom protocols are not 
supported by the RMON2 agent but are used by nodes in your network.

The following sections explain how you can use ZfS to manage protocols in 
your network:
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� “Displaying a List of Protocols Used in Your Network” on page 235

� “Determining the Distribution of Protocols in a Segment” on page 237

Displaying a List of Protocols Used in Your Network

You can use the Protocol Directory property page to view a hierarchical 
representation of supported and custom protocols used in the network, 
transport, and application layers in your network. By default, the page 
displays the Protocol Directory Tree that displays a collapsed list of protocols. 
The protocols used in the data link layer are displayed at the top level. You can 
expand each protocol to display the list of supported and custom protocols 
under the selected protocol.

You can also use the Protocol Directory property page to add, delete, or 
configure the protocols supported by the RMON2 agent. For details, see 
“Adding Supported Protocols to the Protocol Directory Tree” on page 236. 
The custom protocols that are used by the nodes in your network but are not 
supported by the RMON2 agent can also be added using the limited 
extensibility feature of RMON2. For details, see “Adding Custom Protocols 
to a Supported Protocol Tree” on page 236. For details about the limited 
extensibility feature, see RFC 2021 (http://www.isi.edu/in-notes/rfc2021.txt).

For a selected protocol, you can specify the RMON2 groups you want the 
RMON2 agent to support. This will let you obtain the RMON2 details of the 
groups that you specify the agent to support. You can enable the agent support 
for the Host group, Matrix group, and Address Map group for a selected 
protocol either while adding the protocol or by editing an existing protocol. 
The Groups Supported box in the lower portion of the property page indicates 
whether the agent support for the Host and Matrix groups in the network layer 
and application layer, and support for the Address Map group are enabled, 
disabled, or not supported for the selected protocol. You can configure the 
values displayed in the Groups Supported box. For details, see “Choosing the 
Groups You Want the RMON2 Agent to Support for a Protocol” on page 257.

The Add, Edit, and Remove buttons are enabled only when you select a 
protocol in the Protocol Directory tree.

,03257$17��The traffic analysis agent for NetWare and traffic analysis agent for 
Windows NT/2000 do not support enabling of the Address Map, Host, and Matrix 
groups for protocols in the Protocol Directory.

To open the Protocol Directory property page:

� Click RMON2 under Service within a node from the management 
console.
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� Click File > Properties > the Protocol Directory tab.

Refer to the following sections:

� “Adding Supported Protocols to the Protocol Directory Tree” on page 
236

� “Adding Custom Protocols to a Supported Protocol Tree” on page 236

Adding Supported Protocols to the Protocol Directory Tree

Supported protocols are those that the RMON2 agent is able to decode and 
count the number of packets transmitted in your network using the protocol.

Default values are provided for the parameters of protocols supported by the 
RMON2 agent. When you enter the name of a protocol, the default values are 
displayed if the protocol is supported.

To add a protocol to the Protocol Directory tree:

� Open the Protocol Directory property page.

� Select a protocol from the Protocol Directory tree.

� Click Add.

� Enter the name of the protocol in the Protocol Name field.

If the protocol name you enter or select from the Protocol Name list is 
supported by the RMON2 agent, the default parameters for the protocol 
are displayed in the appropriate fields of the Add Protocol dialog box. 
You can configure the parameters if you do not want to use the default 
values. For details, see “Choosing the Groups You Want the RMON2 
Agent to Support for a Protocol” on page 257.

	 Click OK.

The new protocol is added as a child protocol of the selected protocol.

Adding Custom Protocols to a Supported Protocol Tree

Custom protocols are those that are not supported by the RMON2 agent but 
are used by nodes in your network. If the RMON2 agent supports the limited 
extensibility feature of RMON2 for a selected protocol, you can add custom 
protocols under the selected protocol. See RFC 2021 (http://www.isi.edu/in-
notes/rfc2021.txt) for more information. If the RMON2 agent does not 
support the limited extensibility feature for a protocol, you cannot add custom 
protocols under that protocol. A custom protocol cannot have child protocols.
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Because default values are not provided for custom protocols, you must enter 
the appropriate values if you are adding a protocol that is not supported by the 
RMON2 agent.

To add a custom protocol to the Protocol Directory tree:

� Select a supported protocol from the Protocol Directory tree.

� Click Add.

� In the Protocol Name field, enter the name of the protocol.

� In the Protocol ID field, enter the port number for an application layer 
protocol or a protocol code for protocols in other layers.

,03257$17��The port number or protocol code should be a decimal value.

	 From the Groups Supported box, select the groups you want the RMON2 
agent to support for the protocol.

The custom protocol is added as a child protocol of the supported 
protocol.

To remove a protocol from the Protocol Directory tree:

� Select a protocol from the Protocol Directory tree.

� Click Remove.

,03257$17��If you remove a protocol that has child protocols, all the child 
protocols are also removed from the Protocol Directory tree.

Determining the Distribution of Protocols in a Segment

ZfS lets you determine the distribution of protocols discovered by the 
RMON2 agent. You can use the information displayed in this view to analyze 
the traffic in your network and to troubleshoot network problems. Use the 
Protocol Directory property page to add, delete, or edit a protocol. See 
“Adding Supported Protocols to the Protocol Directory Tree” on page 236, 
“Adding Custom Protocols to a Supported Protocol Tree” on page 236, and 
“Choosing the Groups You Want the RMON2 Agent to Support for a 
Protocol” on page 257 for details.

The distribution of protocols discovered by the RMON2 agent is displayed in 
the Protocol Distribution view based on the layer in which the protocols are 
discovered.

To view the distribution of protocols in the selected segment:

� Select a segment from the management console.
Traffic Analysis ���
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� Click View > Protocol Distribution.

The view displays the following three tables that list the protocols discovered 
in the network:

� Network layer table

� Transport layer table

� Application layer table

The protocols discovered by the RMON2 agent are placed in the appropriate 
table in the Protocol Distribution view depending on the layer in which they 
were discovered. Each table displays protocol statistics that are updated every 
15 seconds.

The following table describes the protocol statistics displayed in the Protocol 
Distribution view.

,03257$17��Only one entry of each protocol is displayed in the Protocol 
Distribution view. Consolidated statistics are displayed for a supported protocol in 
more than one protocol suite.

Statistic Description

Protocol Name The name of the protocol

Packets/s The average number of packets transmitted per second using 
the protocol discovered by the agent on the monitored 
segment

Bytes/s The average number of bytes transmitted per second using the 
protocol discovered by the agent discovered on the monitored 
segment

Packet Rate % The percentage of packets transmitted using the protocol; this 
is relative to the total percentage of packets transmitted using 
all protocols discovered by the agent

Byte Rate % The percentage of bytes transmitted using the protocol; this is 
relative to the total percentage of bytes transmitted using all 
protocols discovered by the agent
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Analyzing Traffic on Switches

ZfS provides statistical information about ports in a monitored switch and a 
list of nodes connected to each port in your switched network. This 
information is displayed in the Unified Port Traffic view. You can use the 
view to determine the load on the desktop and workgroup switches in your 
switched network. When only one node can be connected to each port in a 
switch, the switch is known as a desktop switch. When one port of a switch is 
connected to a connecting device to which more than one node is connected, 
the switch is called a Workgroup switch.

Ports and nodes connected to ports of a switch can be monitored using an 
embedded RMON agent or external RMON agent. An embedded RMON 
agent is installed on the port of a switch. An external RMON agent is installed 
on a node connected to a switch.

The following sections explain how you can obtain information about switch 
ports and nodes connected to ports in your switched network:

� “Viewing Statistics for Ports in a Switch” on page 239

� “Viewing the Summarized Switch Information” on page 240

Viewing Statistics for Ports in a Switch

You can use the Unified Port Traffic view to obtain statistical information 
about every switch port in your network. The view also displays a drop-down 
list of nodes connected to each port. The information displayed in this view is 
useful if you want to troubleshoot a port.

The Unified Port Traffic view displays a list of nodes connected to ports on 
the switch and statistics for each port. You can view Ethernet specific statistics 
for Ethernet ports on a switch. Statistics specific to FDDI ring and Token Ring 
ports are not displayed with this version of ZfS, although general port statistics 
are displayed for all ports on a switch regardless of the media type. You can 
choose to display all statistics or configure the Unified Port Traffic view to 
display selected statistics. For details, see “Choosing Statistics to Display in 
the Unified Port Traffic View” on page 249.

To display the statistics of ports in a switch:

� Select Switch/Bridge under Services within a switch from the 
management console.

� Click View > Port Traffic.
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Viewing the Summarized Switch Information

The Switch Summary view provides brief information about a selected switch. 
You can view static information about a selected switch and information about 
alarms generated on the switch. You can also determine the packets and 
broadcasts received by the switch per second.

To view the summarized switch information:

� Select Switch/Bridge under Services within a switch from the 
management console.

� Click View > Switch Summary.

The Switch Summary view displays static information about a selected 
switch, as described in the following table.

The Switch Summary view displays information about alarms generated on a 
selected switch, as described in the following table.

Statistic Explanation

Vendor Name of the switch vendor

Switch Type Type of switch: Transparent or Source Route

Number of Ports Active Number of active ports on the switch

Forwarding Table 
Overflow Count

Number of times the forwarding table has exceeded 
its capacity

Up Time Time since the switch was last rebooted

Number of Ports Present Number of ports present on the selected switch

Number of MAC 
Addresses Learned

Number of MAC addresses dynamically discovered 
by the switch

Statistic Explanation

Severity Severity level attributed to the trap.

From Network address of the device that sent the alarm to the 
alarm management system.

Owner Segment or device affected by the alarm.
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The Switch Summary view displays dynamic information about a selected 
switch, as described in the following table.

Optimizing Traffic Analysis

The tools provided by ZfS to analyze your network performance have default 
settings. You can change the default settings of various views to display only 
the information you require.

The following sections provide information about how you can configure the 
ZfS tools to suit your networking environment:

� “Choosing Options to Display Stations on a Segment” on page 242

� “Choosing Options to Display Trend Statistics” on page 243

� “Choosing Options to Display the Top Nodes Graph” on page 248

Summary Summary of the event, often including the name or address 
of the object affected by the alarm.

Received Time Date and time when the alarm management system received 
the alarm.

Type Generic description of the alarm. For example, Volume out of 
disk space.

Category Displays the category of the alarm based on the MIB that 
defines the trap-type objects. The category is directly related 
to the MIBs included in the management server MIB pool. For 
example, the category for NetWare servers is based on the 
NetWare Server Alarm MIB.

Statistics Explanation

Switch Load (pkts/sec) The load on the switch based on packets received 
by the switch per second

Frames Dropped/sec The number of received packets discarded per 
minute

Broadcasts/sec The number of broadcasts received by the switch 
from the nodes connected to ports of the switch

Statistic Explanation
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� “Choosing Statistics to Display in the Unified Port Traffic View” on page 
249

� “Choosing Options to Display a Captured Packet” on page 251

� “Configuring Alarm Options from the Set Alarm Dialog Box” on page 
251

� “Configuring the Monitor Nodes for Inactivity View” on page 256

� “Choosing the Groups You Want the RMON2 Agent to Support for a 
Protocol” on page 257

Choosing Options to Display Stations on a Segment

You can configure the Stations view to display only the top 20 nodes or all 
nodes on the monitored segment. You can also choose the statistic based on 
which you want to display the top 20 nodes.

The following configuring options are available:

� “Displaying Statistics of All Nodes on a Segment” on page 242

� “Displaying Statistics for the Top 20 Nodes on a Segment” on page 242

� “Choosing a Statistic Based on which Top 20 Nodes Are Displayed” on 
page 243

Displaying Statistics of All Nodes on a Segment

To display statistics for all nodes on a segment:

� Select a segment from the management console.

� Click View > Stations.

+,17� To display all nodes on a segment, more time is required and more network 
traffic is generated.

� From the Stations view, click View > Show All Stations.

Displaying Statistics for the Top 20 Nodes on a Segment

To display statistics for the top 20 nodes on a segment:

� Select a segment from the management console.

� Click View > Stations.

� From the Stations view, click View > Show Top N Stations.
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Choosing a Statistic Based on which Top 20 Nodes Are Displayed 

Packets out per second is the default statistic based on which top 20 nodes are 
displayed in the Stations view. To choose a different statistic based on which 
you want the top 20 nodes to be displayed, do either of the following:

� From the Stations view, click View > Show Top N Stations > choose a 
statistic from the list of statistics displayed.

� Click the Top Nodes Statistics drop-down box in the toolbar of the 
Stations view > choose a statistic from those displayed.

The available statistics are described in the following table.

+,17� If you close the Stations view after changing the default settings, you will 
be prompted to save the changes made to the default settings. If you want the 
Stations view to be displayed based on the statistic you chose, you can save the 
setting. The next time you open the management console and launch the Stations 
view, you will be able to view the nodes on the monitored segment based on the 
statistic you specified.

Choosing Options to Display Trend Statistics

You can change the default settings based on which the segment performance 
trends are displayed in the Segment Trends view.

The following configuration options are available:

� “Choosing Statistics Based on which Trend is Displayed” on page 244

Statistic Explanation

Packets/s In Packets per second received by a node

Packets/s Out Packets per second transmitted by a node

Bytes/s In Bytes per second received by a node

Bytes/s Out Bytes per second transmitted by a node

Errors/s Errors per second transmitted by a node

Broadcasts/s Broadcast packets per second transmitted by a node

Multicasts/s Multicast packets per second transmitted by a node 
(packets transmitted to a specific group of nodes)
Traffic Analysis ���
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� “Setting the Time-Scale Options” on page 248

Choosing Statistics Based on which Trend is Displayed 

To change the statistics based on which segment performance trend is 
displayed:

� Click the Profile button in the Segment Trends view.

� Select a profile from the Select Profile list.

The default profile will display a trend with statistical information of total 
packets, good packets, and error packets on the monitored segment.

If you choose not to use the profiles listed in the Select Profile list, you 
can select the required statistics from the Select Statistics list.

The statistics list lets you examine the Ethernet, FDDI, and Token Ring 
statistics described in the following table.

Statistic Media Support Explanation

Abort Delimiter 
Errors/s

Token Ring Average number of abort 
delimiter errors observed per 
second. This error indicates that 
a node aborts a transmission.

AC Errors/s Token Ring Average number of AC errors 
observed per second. This error 
is reported when an intended 
recipient of a packet fails to mark 
it as received or flags an error on 
it.

Beacons FDDI ring and 
Token Ring

Average number of beacons per 
second observed in the sampling 
interval. A station transmits these 
packets when it detects a hard 
failure upstream.

Broadcast Packets/s Ethernet, FDDI 
ring, and Token 
Ring

Number of broadcast packets per 
second.
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
Burst Errors/s Token Ring Average number of burst errors 
observed per second. This error 
indicates that a node detects the 
absence of transitions for the 
required time.

Claim Tokens/s FDDI ring Average number of times that the 
ring enters the claim token state 
from the normal ring state or ring 
purge state per second.

CRC/Alignment 
Errors/s

Ethernet and 
FDDI ring

Number of cyclic redundancy 
check (CRC)/alignment errors 
per second.

Echo Pkts/s FDDI ring Average number of echo frames 
received on the network per 
second.

Elasticity Buffer 
Errors/s

FDDI ring Average number of elasticity 
buffer overflow errors reported by 
this station per second. This is 
due to the difference in the clock 
frequency between the 
transmitting and receiving 
stations.

Error Packets/s Ethernet Number of error packets per 
second.

Fragments/s Ethernet Number of fragments per second.

Frame Copied 
Errors/s

FDDI ring Average number of frame copied 
error frames reported per second 
by the station.

Frequency Errors/s Token Ring Average number of frequency 
errors observed per second. This 
error indicates that a Token Ring 
clock on a node differs too much 
from the clock on the active 
monitor.

Good Packets/s Ethernet Number of good packets per 
second.

Statistic Media Support Explanation
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Internal Errors/s Token Ring Average number of internal errors 
observed per second. These 
errors generally indicate a 
network board failure.

Jabbers/s Ethernet Number of jabbers per second.

Line Errors/s Token Ring Average number of line errors 
observed per second. These 
packets are of valid size but have 
a faulty Frame Check Sequence 
(FCS) and do not end on an 8-bit 
boundary.

Lost Frames/s FDDI ring and 
Token Ring

Average number of lost frame 
errors on the network observed 
per second.

Monitor
Contentions/s

Token Ring Average number of monitor 
contentions observed per 
second; these packets are 
transmitted by all active nodes 
when no active monitor is 
detected on the ring.

Multicast Packets/s Ethernet, FDDI 
ring, and Token 
Ring

Number of multicast packets per 
second.

Oversize Packets/s Ethernet Number of oversize packets per 
second.

Packets FDDI ring and 
Token Ring

Average number of packets 
observed per second in the 
sampling interval.

Receive Congestion 
Errors/s

Token Ring Average number of receive 
congestion errors observed per 
second. This error indicates that 
a node recognizes a frame 
addressed to its address, but has 
no available buffer space.

Statistic Media Support Explanation
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+,17� If you close the Segment Trends view after changing the default statistics 
based on which trend is displayed, you will be prompted to save the changes made 
to the default settings. If you want the segment performance trend to be displayed 
based on the profile or statistics you chose, you can save the settings that you 
define. The next time you open the management console and launch the Segment 
Trends view, you will be able to view the trend based on the profile or statistics you 
defined.

Ring Wraps/s FDDI ring Average number of times a 
wraparound condition has been 
detected at this interface per 
second. This entry does not 
indicate the number of times the 
ring has actually wrapped 
around. It only indicates the 
number of times the ring has 
wrapped around this physical 
path.

Token Errors/s Token Ring Average number of token errors 
observed per second. This error 
indicates that a token is corrupted 
or the active monitor did not see a 
new frame in the required amount 
of time.

Total Bytes/s Ethernet Average number of total bytes 
per second.

Total Packets/s Ethernet Average number of total packets 
per second.

Undersize Packets/s Ethernet Number of undersize packets per 
second.

Unicast Packets/s Ethernet Number of unicast packets per 
second.

Utilization% Ethernet, FDDI 
ring, and Token 
Ring

Percentage of maximum network 
capacity used by all packets in 
the sampling interval.

Statistic Media Support Explanation
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Setting the Time-Scale Options

The segment performance trend is updated once every minute. You can set a 
different time scale based on which you want to update a graph. Select from 
the following time-scale options: 

� Real Time

� One Hour

� One Day

� One Week

� One Month

� One Year

+,17� If you close the Segment Trends view after changing the default time-scale 
option based on which trend is displayed, you will be prompted to save the changes 
made to the default settings. If you do not want the trend to be updated in real time, 
you can save the time-scale setting you choose. The next time you open the 
management console and launch the Segment Trends view, the trend will be 
updated based on the time-scale option you selected.

Choosing Options to Display the Top Nodes Graph

You can configure the Segment Dashboard view to display or disable the top 
nodes graph. For details, see “Viewing the Graph of the Top Nodes on a 
Monitored Segment” on page 204. The top nodes graph is displayed in the 
lower portion of the Segment Dashboard view. Packets out per second is the 
default statistic based on which the graph is displayed. You can choose a 
different statistic based on which you want the graph to be displayed.

The following configuring options are available:

� “Displaying the Top Nodes Graph in the Segment Dashboard View” on 
page 248

� “Choosing the Statistic Based on which Top Nodes Graph Is Displayed” 
on page 249

� “Disabling the Top Nodes Graph in the Segment Dashboard View” on 
page 249

Displaying the Top Nodes Graph in the Segment Dashboard View

To display the top nodes graph in the Segment Dashboard view:
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� From the Segment Dashboard view, click View > Show Top N Graph.

Choosing the Statistic Based on which Top Nodes Graph Is Displayed

To display the top nodes graph based on a different statistic, do either of the 
following from the Segment Dashboard view:

� Click View > Show Top N Graph > choose a statistic.

� Click the Top Nodes Statistics drop-down box in the toolbar of the 
Segment Dashboard view > select a statistic.

The statistics are described in the following table.

,03257$17��Errors per minute, broadcasts per minute, and multicasts per 
minute are updated every 60 seconds rather than every 5 seconds.

Disabling the Top Nodes Graph in the Segment Dashboard View

To disable the top nodes graph in the Segment Dashboard view:

� From the Segment Dashboard view, click View > Disable Top N Graph.

Choosing Statistics to Display in the Unified Port Traffic View

ZfS provides statistics for each port on the switch. You can view port statistics 
and a list of nodes connected to each port using the Unified Port Traffic view. 
You can view Ethernet-specific statistics for Ethernet ports on a switch. 
Although statistics specific to FDDI and Token Ring ports will not be 
displayed with this version of ZfS, general port statistics are displayed for all 

Statistic Explanation

Broadcasts/min Broadcast packets per minute transmitted by a node

Bytes/s in Bytes per second received by a node

Bytes/s out Bytes per second transmitted by a node

Errors/min Errors per minute transmitted by a node

Packets/s in Packets per second received by a node

Packets/s out Packets per second transmitted by a node

Multicasts/min Multicast packets per minute transmitted by a node
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ports on a switch regardless of the media type. For details, see “Viewing 
Statistics for Ports in a Switch” on page 239. You can choose to display only 
the selected statistics in the Unified Port Traffic view.

To select statistics to be displayed in the Unified Port Traffic view:

� From the Unified Port Traffic view, click View > Settings.

� Click the statistics from the Available Columns list > click Add.

The following table describes the general port statistics displayed for a port, 
regardless of the media type of the port.

The following table describes the Ethernet-specific statistics displayed for an 
Ethernet port in addition to the general port statistics listed above.

Statistic Explanation

Frames In/sec Number of frames received by the port per second.

Frames Out/sec Number of frames sent by port per second.

Port Link Status Displays if the port is active or inactive. If the port is active, it 
can transmit and receive packets.

Speed The speed at which packets are transmitted or received by 
the port.

Media Type Media type of the selected port.

Local Traffic Rate of traffic going towards nodes on the same port.

Statistic Explanation

Collisions/sec Number of collisions per second

Utilization Percentage of maximum network capacity currently 
consumed by packet traffic on the port

Broadcasts/sec Number of broadcast packets per second currently received 
and sent by the port

Multicasts/sec Multicast packets per second received and sent by the port

Packets/sec Number of packets per second received and sent by the port

CRC Align Error Total number of line errors reported by the port
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Choosing Options to Display a Captured Packet

ZfS provides default settings to display a captured packet in the Trace Display 
window.

To change the default settings and display the trace differently:

� Open the Trace Display window.

� From the Trace Display menu, click View > Options.

� Select how you want to display the decoded packet.

� Full Protocol Decode: Provides information about each field in each 
protocol layer in a selected packet. This is the default decoding.

� One Line Per Protocol Layer: Provides a line of information for each 
protocol layer of a selected packet.

� Select the level at which you want to display the initial highlight position.

� At Highest Protocol Layer: Places the initial highlighting at the 
highest protocol layer in a packet. This is the default.

� At Packet Header: Places the initial highlighting at the packet header.

	 Select the format in which you want to display the decoded packet.

� ASCII: Displays the hex data in ASCII format. This is the default.

� EBCDIC: Displays the hex data in EBCDIC format.

Configuring Alarm Options from the Set Alarm Dialog Box

ZfS provides default alarm threshold values for a segment. You can set 
threshold values for various error conditions on Ethernet, FDDI, and Token 
Ring segments to eliminate the need to constantly monitor the segments.

When a segment alarm is enabled, the RMON agent monitors the segment 
based on the alarm threshold settings. If the configured threshold value is 
exceeded, the RMON agent sends a trap to the management server, which 
forwards it to the management console.

Oversize Pkts Number of oversize packets received and sent by the port

Statistic Explanation
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+,17� You should change the default values for alarm thresholds as appropriate 
for your organization. You can determine the appropriate value by observing 
average and peak traffic levels on your network using the Segment Trends view. 
For details, see “Analyzing Trend Data for a Segment” on page 204. You can do 
this as a part of creating a baseline of typical segment activity on your network.

To set an alarm threshold for a segment:

� Select a segment from the management console.

� Click File > Properties > the Segment Alarms tab.

� Select a segment statistic > click Edit.

� Click Enable to enable the alarms set for the monitored segment.

When you click Enable, the text fields and the Default button will be 
enabled. However, if the default threshold values are not found, the 
Default button will not be enabled.

	 Enter the threshold value.


 Specify the sampling time interval. 

The RMON agent uses the sampling time interval to average the statistic 
to determine whether the alarm threshold was exceeded.

+,17� You can also use the Segment Dashboard view to define alarm threshold 
values for segment statistics. For details, see “Defining Alarm Thresholds for 
Statistics Displayed in the Segment Dashboard View” on page 204. 

The following table describes the alarm statistics that ZfS tracks for Ethernet, 
FDDI, and Token Ring segments.

Statistic Media Support Explanation

Abort Errors Token Ring Average number of abort errors observed 
per second in the sampling interval. These 
errors resemble line errors, but occur in 
the middle of a transmission.

AC Errors Token Ring Average number of Address Recognition 
(and Frame Copied) errors observed per 
second in the sampling interval. This error 
is reported when an intended recipient of a 
packet fails to mark it as received or flags 
an error on it.
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Beacons FDDI ring and 
Token Ring

Average number of beacons per second 
observed in the sampling interval. A 
station transmits these packets when it 
detects a hard failure upstream.

Broadcasts Ethernet, FDDI 
ring, and Token 
Ring

Average number of packets per second 
sent to the broadcast address FF-FF-FF-
FF-FF-FF. Broadcast messages typically 
consist of general requests for information 
or transmission of status information to all 
stations.

Burst Errors Token Ring Average number of burst errors observed 
per second in the sampling interval. A 
burst error is caused by a lack of signal 
transitions between stations for a short 
period of time.

Claim Tokens FDDI ring Average number of times that the ring 
enters the claim token state from the 
normal ring state or ring purge state per 
second.

Congestion 
Errors

Token Ring Average number of congestion errors 
observed per second in the sampling 
interval. The receiving station runs out of 
buffer space to store the packet.

CRC Errors Ethernet and 
FDDI ring

Average number of CRC errors observed 
per second in the sampling interval. These 
packets are of valid size but have a faulty 
FCS.

Echo Pkts FDDI ring Average number of echo frames received 
on the network per second.

Elasticity Buffer 
Errors/s

FDDI ring Average number of elasticity buffer 
overflow errors reported per second by 
this station. This is due to the difference in 
the clock frequency of the transmitting and 
receiving stations.

Statistic Media Support Explanation
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Fragments Ethernet Average number of fragments observed 
per second in the sampling interval. 
Fragments are packets that contain fewer 
than 64 bytes and have a faulty FCS. They 
are typically a result of collisions.

Frame Copied 
Errors

FDDI ring and 
Token Ring

Average number of frame copied errors 
observed per second in the sampling 
interval. This error indicates that a station 
has detected that another station 
accepted a packet addressed to the first 
station.

Frequency Errors Token Ring Average number of frequency errors 
observed per second in the sampling 
interval. This error indicates that a Token 
Ring clock on a station differs from the 
clock on the active monitor.

Internal Errors Token Ring Average number of internal errors 
observed per second in the sampling 
interval. These errors generally indicate a 
network adapter board failure.

Jabbers Ethernet Average number of jabber packets 
observed per second in the sampling 
interval. A jabber consists of packets that 
contain more than 1518 bytes and have a 
faulty FCS.

Line Errors Token Ring Average number of line errors observed 
per second in the sampling interval. These 
packets are of legal size but have a faulty 
FCS and do not end on an 8-bit boundary.

Lost Frames FDDI ring and 
Token Ring

Total number of lost frame errors received 
on the network. A lost frame error 
indicates that the end delimiter of a frame 
is lost in the network.

Monitor 
Contentions

Token Ring Average number of monitor contentions 
observed per second in the sampling 
interval. These packets are transmitted 
when no active monitor is detected on the 
ring.

Statistic Media Support Explanation
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+,17� When you have set the appropriate threshold values for the segments in 
your network, you can use the Save As Default button on the Segment Alarms 
property page to save the values you defined as the default values. However, the 
default threshold values provided by ZfS will not be available once you apply the 
new values.

Multicasts Ethernet, FDDI 
ring, and Token 
Ring

Average number of packets per second 
sent to multicast addresses.

Oversize Ethernet Average number of oversized packets 
observed per second in the sampling 
interval. Oversized packets contain more 
than 1518 bytes, including the FCS.

Packets Ethernet, FDDI 
ring, and Token 
Ring

Total number of packets observed per 
second in the sampling interval.

Ring Wraps/s FDDI ring Average number of times a wraparound 
condition has been detected at this 
interface per second. This entry does not 
indicate the number of times that the ring 
has actually wrapped around. It only 
indicates the number of times the ring has 
wrapped around this physical path.

Token Errors Token Ring Average number of token errors observed 
per second in the sampling interval. This 
error indicates that a token is corrupted or 
the active monitor did not detect a new 
frame transmitted during the current 
sampling interval.

Undersize Ethernet Average number of undersized packets 
observed per second in the sampling 
interval. Undersized errors are shorter 
than 64 bytes.

Utilization(%) Ethernet, FDDI 
ring, and Token 
Ring

Percentage of maximum network capacity 
used by all packets in the sampling 
interval.

Statistic Media Support Explanation
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Configuring the Monitor Nodes for Inactivity View

By default, the poll interval for refreshing the Monitor Nodes for Inactivity 
view is zero seconds. You can configure the poll interval based on which you 
want the view to be refreshed. The agent monitoring nodes on a monitored 
segment declares a node as inactive after verifying it for a specified period of 
time. You can change the time duration for the agent to verify the node before 
declaring it inactive.

The following configuring options are available:

� “Specifying the Poll Interval for Refreshing the Monitor Nodes for 
Inactivity View” on page 256

� “Specifying the Duration for the Agent to Determine if a Node Is 
Inactive” on page 256

Specifying the Poll Interval for Refreshing the Monitor Nodes for Inactivity View

You can modify the PollInterval parameter in the 
LSMPARAMETERS.PROPERTIES file to specify the poll interval for 
refreshing the Monitor Nodes for Inactivity view.

To specify a poll interval for refreshing the Monitor Nodes for Inactivity view:

� Open the LSMPARAMETERS.PROPERTIES file located in the 
operating_system_drive\INSTALL\CONSOLEONE\BIN directory.

� Specify a value for the PollInterval parameter.

The PollInterval value should be a positive value, in seconds. The default 
value is zero (0) seconds.

Specifying the Duration for the Agent to Determine if a Node Is Inactive

When a selected node becomes inactive, the agent monitoring the node 
verifies the state of the node for one minute before declaring it inactive. You 
can modify the HostTimeOut parameter in the 
LSMPARAMETERS.PROPERTIES file to change the duration for the agent 
to verify the selected node before declaring it inactive. The agent verifies the 
inactive node for the specified period of time before declaring it inactive.

To change the duration for the agent to verify a node before declaring it 
inactive:

� Open the LSMPARAMETERS.PROPERTIES file located in the 
ConsoleOne directory.
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� Specify a value for the HostTimeOut parameter.

The HostTimeOut value should be a positive value, in minutes. The 
default value is one (1) minute.

Choosing the Groups You Want the RMON2 Agent to Support for a 
Protocol

The Protocol Directory property page displays a hierarchical representation of 
supported and custom protocols used in the network, transport, and 
application layer in your network. You can use this page to add, delete, or 
configure the protocols supported by the RMON2 agent. For details, see 
“Displaying a List of Protocols Used in Your Network” on page 235.

ZfS provides default parameters for protocols supported by the RMON2 
agent. You can configure the parameters to enable the RMON2 support for the 
Address Map group, Host group, and Matrix group for a selected protocol. 
This will help you obtain information about the RMON2 groups you enabled 
the RMON2 agent to support.

To configure a protocol:

� Select a protocol from the Protocol Directory tree.

� Click Edit.

The following table describes the parameters for a selected protocol.

,03257$17��The Protocol Name parameter cannot be configured. If you 
configure the port number or protocol code of a selected protocol, all child 
protocols of the selected protocol will be deleted.

Parameter Description

Protocol Name Displays the name of the protocol.

Protocol ID Displays the identifier for the protocol. Displays the port 
number for an application layer protocol or the protocol 
code for protocols in other layers. The protocol identifier 
is always a decimal value.

Description Displays a short description of the selected protocol.

Groups 
Supported

Displays whether the agent support of the Address Map 
group, Host group, or Matrix group is enabled for the 
selected protocol.
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Understanding the Traffic Analysis Agents

Traffic analysis agents enable you to monitor a heterogeneous LAN 
environment comprised of Ethernet, FDDI ring, and Token Ring segments 
from the easy-to-use ZfS interface.

Traffic analysis agents are RMON agents that can run on a NetWare server, 
Windows NT/2000 server, or a Windows NT workstation. They implement a 
set of functionality defined by the RMON MIB (RFC 1757 (http://
www.isi.edu/in-notes/rfc1757.txt)). These agents collect information about 
activity on your network and make it available to the management console via 
SNMP.

The following functionality is provided by the traffic analysis agents:

� Monitor the performance of segments and provide vital network 
statistical information to the management console

� Make it easy to set alarm thresholds for proactive network management

� Capture all packets or selected packets to help you diagnose and resolve 
problems on the monitored networks

� Monitor multiple network segments including the Symmetric Multi-
Processing (SMP) architecture

� Monitor network segments for problems, such as high network utilization 
and communication errors

� Track dynamic IP address assignments from the DHCP server to the 
nodes on the network

� Store data to display real-time trends (hourly) and historical trends (daily, 
weekly, monthly, and yearly) for statistics such as Total Bytes, Total 
Packets, Good Packets, Error Packets, and so forth

� Monitor nodes for inactivity, so that you are alerted if the monitored 
nodes becomes inactive

The following figure illustrates the functionality of traffic analysis agents.
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ZfS includes the following traffic analysis agents:

� Traffic analysis agent for NetWare.

For details, see “Using the Traffic Analysis Agent for NetWare” on page 
260.

� Traffic analysis agent for Windows NT/2000.

For details, see “Using the Traffic Analysis Agent for Windows NT/
2000” on page 280.

The ZfS traffic analysis agents are RMON Plus agents. For details, see 
“Functionality of RMON Plus Agents” on page 185. These agents also 
implement the first two RMON2 groups. The first RMON2 group is the 
Protocol Directory group, which provides a table of protocols for which the 
agent will monitor and maintain statistics. The second RMON2 group is the 
Protocol Distribution group, which provides a table of statistics for each 
protocol in the directory. For details, see “Functionality of RMON2 Agents” 
on page 186.
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Using the Traffic Analysis Agent for NetWare

The traffic analysis agent for NetWare (NLA 1.30) runs on a NetWare server. 
It is a set of NLM programs that enable NetWare 4.x and 5.x to monitor traffic 
on Ethernet, FDDI ring, and token ring segments.

The traffic analysis agent for NetWare implements token ring extensions for 
the RMON MIB (RFC 1513 (http://www.isi.edu/in-notes/rfc1513.txt)) for 
token ring media, and a Novell proprietary MIB for FDDI media, in addition 
to implementing an RMON (RFC 1757 (http://www.isi.edu/in-notes/
rfc1757.txt)) for Ethernet media. The traffic analysis agent for NetWare also 
implements the first two groups for RMON2 (RFC 2021 (http://www.isi.edu/
in-notes/rfc2021.txt)).

The following figure illustrates a functional view of the traffic analysis agent 
for NetWare:

The following sections provide information about optimizing and using the 
traffic analysis agent for NetWare:

� “Planning to Install the Traffic Analysis Agent for NetWare” on page 261

� “Optimizing the Traffic Analysis Agent for NetWare Performance” on 
page 262
�
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� “Using the Console Utility of the Traffic Analysis Agent for NetWare” on 
page 271

Planning to Install the Traffic Analysis Agent for NetWare

To successfully install the traffic analysis agent for NetWare on a NetWare 
server, the server must meet the system requirements specified in ZENworks 
for Servers Installation and Setup.

You should configure NetWare SNMP parameters as explained in 
“Configuring NetWare SNMP Parameters” on page 261. This will ensure a 
smooth installation of the traffic analysis agent for NetWare on the server.

127(��Although it is not required, it is recommended that you uninstall previous 
versions of the LANalyzer Agent (referred to as the traffic analysis agent in ZfS). If 
you do not uninstall the previous version of the agent, you must verify that the 
upgraded NetWare servers run the new traffic analysis agent. For specific 
instructions on uninstalling and upgrading, see “Uninstalling and Upgrading the 
ManageWise 2.7 LANalyzer Agent” on page 502.

Configuring NetWare SNMP Parameters

To configure SNMP parameters on NetWare 4.x or 5.x servers:

� At the server prompt, enter load inetcfg.

� From the Internetworking Configuration screen, select Manage 
Configuration > Configure SNMP Parameters.

� From the Monitor Community Handling options, select Specified 
Community May Read > enter the following community name: public.

� From the Control Community Handling options, select Specified 
Community May Write > enter the following community name: 
public.

	 From the Trap Handling options, select Send Traps with Specified 
Community > enter the following community name: public.


 Press Esc to exit the SNMP Parameters screen > save the changes.

� Press Esc to exit the Internetworking Configuration screen > restart the 
server.
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Optimizing the Traffic Analysis Agent for NetWare Performance

The measures described in the following sections can improve the 
performance of your traffic analysis agent for NetWare servers.

You can configure the traffic analysis agent for NetWare functions described 
in the following sections by setting the parameters in the LANZ.NCF file.

� “Contents of the LANZ.NCF File” on page 262

� “Modifying the LANZ.NCF File” on page 267

Contents of the LANZ.NCF File

The LANZ.NCF file loads all the NLM software required for the traffic 
analysis agent for NetWare operation. The LANZ.NCF file resides in the 
SYS:\SYSTEM directory.

The following example displays the complete text of the default LANZ.NCF 
file.

#

# NetWare LANalyzer Agent

# Version 1.3

#

# - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

# LANZ.NCF: NetWare LANalyzer Agent Load File

#

# This NCF file is created by the NetWare LANalyzer Agent 
install program.

# It is used to load the NetWare Loadable Module files that 
make up NetWare LANalyzer Agent.

# WARNING:   You should not modify this file unless you need 
to change one of the configuration

# parameters documented below. Other changes to this file are 
not recommended.

# Should you damage this file, you must reinstall NetWare 
LANalyzer Agent.

#

�
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# NOTE:      To enable or disable the monitoring of network 
adapters by NetWare LANalyzer Agent,

# use the LANZCON utility as described in the NetWare 
LANalyzer Agent Installation and

# Administration guide.

#

# - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

# Load Parameter Descriptions

#

# load LANZSU debug=1

#

# debug=1    Turns on the LANZ Control screen to see the 
transactional messages from the

# NetWare LANalyzer Agent.

#

# load LANZMEM bound=KB age=HHH

#

# bound=KB   This is the upper limit on memory that can be 
allocated

# dynamically by the NetWare LANalyzer Agent.

#

# Increasing this number allows you to create larger packet

# capture buffers and maintain data for inactive stations

# for a longer period of time.

#

# Decreasing this value reduces the amount of memory that

# can be used by NetWare LANalyzer Agent. This leaves more

# memory for the other server tasks.

#

# NetWare LANalyzer Agent automatically purges data for
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# inactive stations as the memory boundary is approached.

# This allows NetWare LANalyzer Agent to adjust to

#

# the memory that is available to it dynamically.

#

# If the boundary is low, purging occurs frequently, saving

# only data for stations that have been recently active on

# the network. If this happens, a message appears on the

# system console indicating that not enough memory has been

# allocated to NetWare LANalyzer Agent.

#

# KB is the memory boundary in kilobytes.

#

# Initial value: Set by the installation program

# based on memory usage

#

# Minimum recommended value:      512

#

# Maximum recommended value:      75% of free server memory

# when NLM files are loaded

#

# Default value:                  If bound=KB is not specified,

# it defaults to 3072.

#

# age=HHH    NetWare LANalyzer Agent purges data for stations 
that have

# not been active on the network recently. This parameter

# controls how long data for inactive stations is maintained.
�
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#

# Memory that is used by the station table is not available

# for other uses, such as capturing packets. Reducing the

# AGE value tends to increase the amount of memory

# available for capturing packets.

#

# If you cannot allocate capture buffers that are large,

# you may need to reduce the AGE value.

#

# HHH is the inactivity period, in hours, before station data

# is purged.

#

# Minimum recommended value:      1

#

# Default value:                  If age=HHH is not specified,

# it defaults to 168 (1 week)

#

# load LANZDI level=1

#

# level=1    It indicates that the LANZDI will stop receiving 
packets

# when CPU utilization gets high.

#

# Default is OFF. LANZDI will continue to receive packets even

# when CPU utilization gets high.

#

# load LANZSM topn=N

#
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# topn=N     The number of concurrent sorts of top N nodes that

#

# NetWare LANalyzer Agent supports for each network adapter.

#

# Recommended value: 4

# Minimum value:     2

# Maximum value:     10

#

# load LANZTR poll = 1

#

# poll=1     Polls token ring source-routed bridges.

#

# load LANZCTL trapreg=1

#

# trapreg=1 Causes SNMP traps to be sent to management 
consoles

# advertising themselves on the network, as well as stations

# listed in SYS:\ETC\TRAPTARG.CFG. Omitting this parameter

# or setting it to 0 causes traps to be sent only to those

# stations listed in the SYS:\ETC\TRAPTARG.CFG file.

#

# - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

load gtrend.nlm

load lanzsu.nlm

load lanzmem.nlm bound = 3072 AGE = 168

load lanzlib.nlm

load lanzdi.nlm

load lanzael.nlm
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load lanzhis.nlm

load lanzfcb.nlm

load lanzsm.nlm topn = 4

load lanztr.nlm

load lanzfddi.nlm

load lanzctl.nlm trapreg = 1

Modifying the LANZ.NCF File

The following sections describe how to modify the parameters of the 
commands in the LANZ.NCF file to configure the traffic analysis agent for 
NetWare functions:

� “Turning On the LANZ Control Screen” on page 267

� “Disabling Packet Capture” on page 268

� “Disabling Generation of Duplicate IP Address Alarms” on page 268

� “Setting Packet Flow Control” on page 268

� “Setting the Upper Limit of Available Memory” on page 269

� “Purging Data from Server Memory” on page 269

� “Sorting Concurrent Top Stations” on page 270

� “Sending Alarms to Management Consoles Automatically” on page 270

� “Polling Source Route Bridges” on page 271

� “Activating Changes in the LANZ.NCF File” on page 271

To make changes in the LANZ.NCF file and modify the configuration of the 
traffic analysis agent for NetWare:

� Open the LANZ.NCF file with a text editor.

� Insert or modify the appropriate parameter as shown and save the file.

� Unload and reload the traffic analysis agent for NetWare, as described in 
“Activating Changes in the LANZ.NCF File” on page 271.

Turning On the LANZ Control Screen

The LANZ control screen reports significant events for the traffic analysis 
agent for NetWare.
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To turn on the LANZ control screen, insert the DEBUG parameter in the 
LOAD LANZSU.NLM statement, as shown below:

LOAD LANZSU.NLM DEBUG=1

The default is Off.

Disabling Packet Capture

You might want to disable packet capture to prevent others from observing 
sensitive data captured in the packets sent on the network segment.

To disable the packet capture, insert a comment mark (#) in the LOAD 
LANZFCB statement, as shown below:

LOAD LANZFCB.NLM

You can also control packet capture during high levels of traffic instead of 
disabling packet capture entirely. For details, see “Setting Packet Flow 
Control” on page 268.

Disabling Generation of Duplicate IP Address Alarms

In the DHCP environment, the IP address is released to the DHCP server when 
a DHCP client is shut down. During the process of releasing the IP address to 
the DHCP server, the client sends a DHCPRELEASE packet. If this packet 
does not reach the agent, false duplicate IP address alarms will be generated.

To disable the generation of duplicate IP address alarms, specify zero (0) as 
the value for the DUPIP parameter, as shown below:

LOAD LANZSM DUPIP=0

If the DUPIP parameter contains a non-zero value or if the parameter is not 
specified, duplicate IP address alarms are generated.

Setting Packet Flow Control

The traffic analysis agent for NetWare typically operates in promiscuous 
mode, receiving all packets on the network. However, if server utilization is 
high and performance becomes degraded, you can set the LEVEL parameter 
to 1, which configures the agent to pause when server traffic is high, and then 
automatically resume operation in promiscuous mode when the traffic level 
returns to normal.

The default is not to specify the LEVEL parameter at all, which allows 
continuous operation in promiscuous mode.
�
� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
To set packet flow control, use the LEVEL parameter setting, as shown below:

LOAD LANZDI LEVEL=1

Setting the Upper Limit of Available Memory

The BOUND parameter sets the upper limit of available memory that can be 
allocated dynamically to the traffic analysis agent for NetWare.

The value of the BOUND parameter is measured in kilobytes (KB). The 
default value is 3072 KB. The minimum recommended value is 512 KB. The 
maximum recommended value is 75% of the memory that is available after all 
NLM files are loaded.

You might receive the message "Insufficient memory available for the traffic 
analysis agent for NetWare" in the following situations:

� The server has too little memory

� The server has sufficient memory, but the memory is not available to the 
traffic analysis agent for NetWare

� You requested a packet capture buffer that is too large, and the agent 
granted you less memory than requested

In each case, you should increase the value of the BOUND parameter and add 
more RAM to your NetWare server.

To change the upper limit of available memory, edit the BOUND parameter, 
with the appropriate value, as shown below:

LOAD LANZMEM BOUND=3072 AGE=168

Purging Data from Server Memory

The traffic analysis agent for NetWare holds its data in server memory. You 
can control the amount of data held in memory by setting the value of the AGE 
parameter. When data reaches the age specified in the parameter, the data is 
purged from memory. The AGE parameter is particularly useful on large, 
bridged networks.

The value of the AGE parameter is measured in hours. The default value is 
168, or one week. The minimum recommended value is one hour.

You should lower the AGE parameter if you receive the message "Insufficient 
memory available for the traffic analysis agent for NetWare" and you have 
allocated sufficient memory for the agent.
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Having insufficient memory is not harmful to the agent or the server. The 
traffic analysis agent for NetWare can run indefinitely, even when the memory 
allocated to it is not sufficient.

To modify the amount of data held in server memory, change the value of the 
AGE parameter, as shown below:

LOAD LANZMEM BOUND=3072 AGE=168

Sorting Concurrent Top Stations

The traffic analysis agent for NetWare sorts stations whenever the top eight 
graphs on the Segment Dashboard view, the Stations view, or both are 
displayed by the management console. The sorts are independent of each other 
and can be computed on the basis of different statistics.

Because each of the sort computations uses server CPU cycles, you should 
limit the number of concurrent computations.

To set the number of concurrent sort computations per network adapter, set the 
TOPN parameter, as shown below:

LOAD LANZSM TOPN=n

The default value is 4. The minimum value is 2. The maximum value is 10.

Sending Alarms to Management Consoles Automatically

The traffic analysis agent for NetWare can automatically send SNMP alarms 
(sometimes referred to as SNMP traps) to management consoles or other 
nodes on the network in the following configurations:

� The traffic analysis agent for NetWare receives the SAP packets sent by 
one or more management consoles

� The management console or other node is listed in the server’s 
TRAPTARG.CFG file. This file can be edited to add other trap targets.

The TRAPTARG.CFG file is stored in the SYS:\ETC directory. The file 
provides instructions for its use. You can edit the file with any ASCII text 
editor.

To enable alarms to be sent automatically, add the TRAPREG parameter 
setting, as shown below:

LOAD LANZCTL TRAPREG=1
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The default is 1. If you omit the TRAPREG parameter or set its value to zero 
(0), the agent sends alarms only to management consoles listed in the 
TRAPTARG.CFG file.

Polling Source Route Bridges

To control source route bridge polling on token ring networks, use the POLL 
parameter, as shown below:

LOAD LANZTR POLL=1

1 = On and 0 = Off.

Setting the POLL parameter to 1 polls source routed bridges once every 
second. You cannot change the polling rate. The default is On.

To turn off this function, set the POLL parameter to zero (0), as shown below:

LOAD LANZTR POLL=0

The default is to omit the POLL parameter. Also, the LOAD LANZTR 
statement is commented out on systems that do not have a token ring adapter 
installed.

Activating Changes in the LANZ.NCF File

To activate the changes you make in the LANZ.NCF file:

� Save the LANZNCF file.

� Enter ULANZ at the server prompt to unload the agent.

� Enter LANZ to reload the agent.

Using the Console Utility of the Traffic Analysis Agent for NetWare

The traffic analysis agent for NetWare 1.3 provides a console utility 
(LANZCON.NLM) that performs the following three tasks:

� Enables or disables network monitoring by the selected network adapters

� Provides a source of detailed troubleshooting information

� Resolves a residual entry (for example, a Host TopN entry created by a 
management console that terminated unexpectedly)

When you install the traffic analysis agent for NetWare, LANZCON.NLM is 
installed automatically in the SYS:\ZFS_AGNT\LANZ directory.
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The following topics are discussed in greater detail in this section:

� “Loading the Console Utility of the Traffic Analysis Agent for NetWare” 
on page 272

� “Enabling or Disabling Network Adapter Monitoring” on page 272

� “Viewing Network Adapter Information” on page 273

� “Viewing the Agent Item Status” on page 274

� “Accessing Detailed Information About Each Item” on page 275

� “Migrating Trend Files” on page 279

Loading the Console Utility of the Traffic Analysis Agent for NetWare

To use LANZCON.NLM, enter the following command at the NetWare 
console prompt:

LOAD LANZCON CONTROLCOMMUNITY = <control community string>

,03257$17��If LANZCON is launched without any command line argument, 
then the default control community string is PUBLIC.

LANZCON.NLM is loaded and displays a list of network adapters, along with 
summary information about the network adapters currently installed on the 
server.

The following information is displayed for each network adapter:

� Number (#): The network adapter entry number in the network interface 
table.

� Description: A brief description of the network adapter.

� Media Type: The type of network connected to the network adapter: 
Ethernet, FDDI, or Token Ring.

� Adapter Address: The physical address of the network adapter.

Enabling or Disabling Network Adapter Monitoring

To enable or disable monitoring of a selected network adapter:

� From the Network Adapters screen, select the appropriate adapter > press 
F3.

� If the selected adapter is currently monitoring an Ethernet or token 
ring network, the console displays the Adapter is Monitoring screen.
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� If the selected adapter is not monitoring an Ethernet or token ring 
network, the console displays the Adapter is not Monitoring screen.

� Select Yes or No to enable or disable monitoring.

If you disable monitoring, all LAN analysis data for the selected adapter 
is deleted.

Using LANZCON, an FDDI adapter cannot be disabled. To disable an FDDI 
adapter:

� Unload LANZCON, if loaded.

� Unload LANZ, if loaded.

� Open LANZ.NCF from SYS:\SYSTEM directory for editing.

� Comment the statement LOAD LANZFDDI.NLM by entering the # 
symbol at the beginning of this statement.

	 Save LANZ.NCF and exit.


 Reload LANZ.

Viewing Network Adapter Information

To bring up detailed information for network adapter items:

� From the Network Adapters screen, select an adapter > press Enter.

� From the Select Information to View screen, select Show Adapter Items.

The LANZCON utility displays the Network Adapter Items screen that 
lists all the items related to the selected network adapter. 

The screen for a token ring adapter includes the information from the Novell 
Token Ring RMON MIB. For details, see “Viewing the Agent Item Status” on 
page 274.

To return to the Select Information to View menu, press Esc.

The following information is provided for the selected adapter:

� Item: The types of items that are currently being monitored by the 
selected adapter. The Network Adapter Items screen shows a set of 
typical items consisting of Token Ring, Statistics, History, Host, Matrix, 
and Host TopN. The traffic analysis agent for NetWare monitors these 
items by default. In the Network Adapter Items screen, the Host TopN 
item, indicating the list of the busiest nodes, has been added by a user. 
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You can add other items to this display from the management console, 
depending on your configuration.

You can select any item to view more information about each topic. To 
view the values for the selected item, select the desired item > press Enter. 
Refer to the following sections for more examples of the screens.

� Index: The entry number of the displayed item in the list of all the items 
of the same type. The related tables are identified by this index.

� Description: A textual description of the entry. This column indicates the 
software entity or user that created the item. The items automatically 
monitored by the traffic analysis agent for NetWare are indicated by the 
monitor.

For a token ring network entry, this column shows the media speed and 
the local ring number.

Viewing the Agent Item Status

When you click the Select Information to View menu > Show Agent Items, 
LANZCON displays all the items for each network adapter being monitored 
by the traffic analysis agent for NetWare.

To view the agent item status for the selected agent:

� From the Network Adapters screen, select an adapter > press Enter.

� From the Select Information to View screen, select Show Agent Items.

The All NetWare LANalyzer Agent Items screen shows all the items related 
to the agent monitoring the segment. For example, if you are using multiple 
adapters to monitor multiple network segments, the screen lists all the items 
being monitored by the agent.

To delete any entry (except the token ring network entry), select the entry > 
click Delete > click Yes.

To return to the Network Adapter Items screen, press Esc.

The following information is provided for the agent:

� Item: The types of items available. The All NetWare LANalyzer Agent 
Items screen shows a set of typical items consisting of Statistics, History, 
Host, Matrix, and Host TopN. Additional items can be displayed, 
depending on your configuration.
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You can select any item for more information about each topic. To view 
the values for an item, select the desired item > press Enter. See the 
following sections for more examples of the screens.

� Index: The entry number of the displayed item in the list of all items of 
the same type. The related tables are identified by this index.

� Description: A textual description of the entry. This column indicates the 
software entity or user that created the item table. The items automatically 
monitored by the traffic analysis agent for NetWare are indicated by the 
monitor.

For a token ring network entry, this column shows the media speed and 
the local ring number.

Accessing Detailed Information About Each Item

This section describes the major categories of information available for both 
the selected network adapter and the traffic analysis agent for NetWare. The 
following topics are covered:

� “Viewing the Token Ring RMON MIB Information” on page 275

� “Viewing the FDDI Ring RMON MIB Information” on page 275

� “Viewing Statistics Information” on page 276

� “Viewing History Information” on page 276

� “Viewing Host Information” on page 277

� “Viewing Matrix Information” on page 278

Viewing the Token Ring RMON MIB Information

To view the token ring RMON MIB information:

� From the Network Adapter Items screen, select the Token Ring item > 
press Enter.

� From the Select Information to View screen, select Show Adapter Items 
> press Enter.

� Press Esc to exit this screen.

Viewing the FDDI Ring RMON MIB Information

To view the FDDI ring RMON MIB information:
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� From the Network Adapter Items screen, select the FDDI Ring item > 
press Enter.

� From the Select Information to View screen, select Show Adapter Items 
> press Enter.

Viewing Statistics Information

The statistics information presents the basic statistics for each monitored 
adapter per segment.

To view the statistics information:

� From the Network Adapter Items screen, select Statistics.

� Press Enter.

For an Ethernet network entry, the LANZCON utility displays the 
Statistics Information screen.

This screen displays the statistical values of the selected network adapter. 
The display is updated periodically with the latest values for each field.

� To exit this screen, press Esc.

Viewing History Information

The history information defines sampling functions for the networks that are 
being monitored. The History Control table defines a set of samples at a 
particular sampling interval for a particular network adapter.

To view the history information:

� From the Network Adapter Items screen, select History.

� Press Enter.

� To exit this screen, press Esc.

The field descriptions are as follows:

� Index: An integer that uniquely identifies a row in the History Control 
table.

� Data Source: Identifies the network adapter and the Ethernet, token ring, 
or FDDI segment that is the source of the data for entries defined by this 
object.
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� Buckets Requested: The requested number of discrete sampling 
intervals over which data will be saved in the portion of the media-
specific table associated with this entry.

� Buckets Granted: The actual number of discrete sampling intervals over 
which data will be saved.

� Interval: The interval, in seconds, over which data is sampled for each 
bucket. The interval can be set to any number between 1 and 3,600 (one 
hour). The default interval for past hour is 30 seconds per sample, and the 
default interval for past day is 30 minutes (or 1,800 seconds) per sample.

The sampling scheme is determined by the buckets granted and the 
control interval.

� Owner: The entity that created the item. "Monitor" indicates that the item 
was created by the traffic analysis agent for NetWare.

� Status: A status of Valid indicates that the agent is operating normally 
under the instructions given by the table.

Viewing Host Information

The host group gathers statistics about specific hosts or nodes on the LAN. 
The traffic analysis agent for NetWare learns of new nodes on the LAN by 
observing the source and destination MAC addresses in good packets. For 
each node known to the agent, a set of statistics is maintained.

To view the host (node) information:

� From the Network Adapter Items screen, select Host.

� Press Enter.

The host group consists of three tables: two data tables and one control table. 
The two data tables are hostTable and hostTimeTable. The control table, 
hostControlTable, includes the following objects, which correspond to the 
fields displayed in the Host Information screen:

� Index: An integer that uniquely identifies a row in the hostControlTable. 
Each row in the control table refers to a unique network adapter, and thus, 
a unique segment.

� Data Source: Identifies the network adapter and the Ethernet, token ring, 
or FDDI segment that is the source of the data for the entries defined by 
this object.

� Table Size: The number of rows in the hostTable associated with this row.
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� Last Delete Time: The value of the sysUpTime MIB object that 
corresponds to the last time an entry was deleted from the portion of the 
hostTable associated with this row. The value is zero (0) if no deletions 
occurred.

� Owner: Indicates the entity or user that created the item. "Monitor" 
indicates that the item was created by the traffic analysis agent for 
NetWare.

� Status: A status of Valid indicates that the agent is operating normally 
under the instructions given by the table.

Viewing Matrix Information

The matrix group records information about the conversations between pairs 
of nodes on a network segment. The information is stored in the form of a 
matrix. This method of organization is useful to retrieve specific pairings of 
traffic information, such as finding out which nodes are making the most use 
of a server.

To view the matrix information:

� From the Network Adapter Items screen, select Matrix.

� Press Enter.

The matrix group consists of three tables: two data tables and one control 
table. The data tables are matrixSDTable and matrixDSTable. The control 
table, matrixControlTable, includes the following objects, which correspond 
to the fields displayed in the Matrix Information screen:

� Index: An integer that uniquely identifies a row in the 
matrixControlTable. Each row in the control table defines a function that 
discovers conversations on a particular network and places statistics 
about them in the two data tables.

� Data Source: Identifies the network adapter, and the Ethernet, token ring, 
or FDDI segment that are the source of the data for the entries defined by 
this object.

� Table Size: The number of rows in the matrixTable associated with this 
row.

� Last Delete Time: The value of the sysUpTime object that corresponds 
to the last time an entry was deleted from the portion of the matrixTable 
associated with this row. The value is zero (0) if no deletions occurred.
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� Owner: Indicates the entity or user that created the item. "Monitor" 
indicates that the item was created by the traffic analysis agent for 
NetWare.

� Status: A status of Valid indicates that the agent is operating normally 
under the instructions given by the table.

Migrating Trend Files

From the management console, you can view trends of traffic patterns on the 
monitored Ethernet, FDDI, and token ring segments. You can use the trend 
data to analyze traffic on the segment. For details, see “Analyzing Trend Data 
for a Segment” on page 204.

Earlier versions of the traffic analysis agent for NetWare (1.20 and 1.21) 
collected trend data that was sampled every one minute. The traffic analysis 
agent for NetWare 1.30 that ships with ZfS collects trend data that are sampled 
every one minute, one hour, and one day. This functionality of the traffic 
analysis agent for NetWare 1.30 ensures minimal communication between the 
agent and the management console, to reduce network traffic.

You can use the migrating tool (GTREND.EXE) to convert the trend data 
collected by earlier versions of the traffic analysis agent for NetWare to trend 
data that can be used by traffic analysis agent for NetWare 1.30 and the 
management console.

To migrate trend files collected by the traffic analysis agent for NetWare 1.20 
or 1.21:

� Copy GTREND.EXE from the Installation CD to a TEMP folder on a 32-
bit Windows NT, Windows 2000, Windows 95, or Windows 98 machine.

� Copy the trend data files collected by earlier versions of the traffic 
analysis agent for NetWare to the TEMP folder.

� Run GTREND.EXE.

This will migrate the existing one-minute trend files to the corresponding 
one-hour and one-day trend files that can be used by the traffic analysis 
agent for NetWare 1.30.

� Copy the migrated trend files to the SYS:\GTREND\ folder on the 
NetWare server and run the traffic analysis agent for NetWare 1.30 on the 
same server.

127(��The migration tool will not migrate older token ring trend data collected by 
the traffic analysis agent for NetWare version 1.20 or 1.21 because the older 
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agents implemented a proprietary Token Ring MIB that enabled the agent to 
collect trend data sampled every one minute. The traffic analysis agent for 
NetWare version 1.3 implements the standard Token Ring MIB that supports 
historical trends (one minute, one hour and one day).

Using the Traffic Analysis Agent for Windows NT/2000

The traffic analysis agent (version 1.30) for Windows NT/2000 runs on a 
Windows NT/2000 server or on a Windows NT workstation. The traffic 
analysis agent for Windows NT/2000 monitors traffic on Ethernet, FDDI ring, 
and token ring segments.

The traffic analysis agent for Windows NT/2000 is an RMON agent that 
implements functionality defined by the RMON MIB. It implements token 
ring extensions for RMON (RFC 1513 (http://www.isi.edu/in-notes/
rfc1513.txt)) for token ring media, and a Novell proprietary MIB for FDDI 
media, in addition to implementing an RMON (RFC 1757 (http://
www.isi.edu/in-notes/rfc1757.txt)) for Ethernet media. The agent collects 
information about activity on your network and makes it available to the 
management console via SNMP. The traffic analysis agent for Windows NT/
2000 also implements the first two groups of RMON2 (RFC 2021 (http://
www.isi.edu/in-notes/rfc2021.txt)).

The following figure illustrates a functional view of the traffic analysis agent 
for Windows NT/2000:
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
Changes Made During Installation 

When you install the traffic analysis agent for Windows NT/2000, the 
following files are copied to Windows NT/2000:

File Name Location Description

LANZNDIS.SYS \WINNT\SYSTEM32\DRIVERS Kernel mode driver 
interface

LANZCTL.DLL \WINNT\SYSTEM32 Control module

LANZMEM.DLL \WINNT\SYSTEM32 Memory manager module

LANZLIB.DLL \WINNT\SYSTEM32 Library module

LANZDI.DLL \WINNT\SYSTEM32 User mode driver interface

LANZSM.DLL \WINNT\SYSTEM32 Monitor module

LANZHIS.DLL \WINNT\SYSTEM32 History module

LANZAEL.DLL \WINNT\SYSTEM32 Alarm, event, and log 
module

LANZFCB.DLL \WINNT\SYSTEM32 Filter capture, buffer 
module

LANZTR.DLL \WINNT\SYSTEM32 Token ring manager 
module

LANZFDDI.DLL \WINNT\SYSTEM32 FDDI manager module

GTREND.DLL \WINNT\SYSTEM32 Trend module

LANZCON.EXE \LANZNT Agent console application

LANZCON.HLP \LANZNT Agent console help

LANZCON.CNT \ZFS_AGNT\LANZCON Required for online help 
from the application

GTREND.EXE \ZFS_AGNT\LANZCON Tool for migration of trend 
data from the older agent.

MGMTAPI.DLL \ZFS_AGNT\LANZCON SNMP application file
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,03257$17��The default directory location for the LANZCON application is 
ZFS_AGNT\LANZCON. You can change the location of LANZCON during 
installation.

The following sections provide information about optimizing and using the 
traffic analysis agent for Windows NT/2000:

� “Planning to Install the Traffic Analysis Agent for Windows NT/2000” 
on page 282

� “Optimizing the Traffic Analysis Agent for Windows NT/2000” on page 
285

� “Using LANZCON” on page 289

Planning to Install the Traffic Analysis Agent for Windows NT/2000

The traffic analysis agent for Windows NT/2000 requires configuration of the 
Windows NT/2000 SNMP service before installing the agent. Perform the 
following tasks to allow communication with the management server:

� “Installing the SNMP Service” on page 282

� “Starting SNMP Service Automatically” on page 283

� “Starting SNMP Trap Service Automatically” on page 283

� “Stopping SNMP Service” on page 283

� “Specifying the SNMP Trap Community Name and Trap Destination 
Address” on page 284

� “Setting SNMP Security Options” on page 284

Installing the SNMP Service

To install the SNMP service on Windows NT/2000:

MSVCP50.DLL \ZFS_AGNT\LANZCON MFC APIs required for 
LANZCON

LANZCTL.DLL \ZFS_AGNT\LANZCON Required for LANZCON

MSFLXGRD.OC
X

%SystemRoot%\System32 Enables ActiveX* Controls 
in LANZCON

File Name Location Description
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� From the Control Panel, double-click Services > click Add.

� Select SNMP Service from the Select Network Service dialog box. 

� Click OK.

� Enter the full path to the Windows NT/2000 distribution files.

	 Click Continue.

Starting SNMP Service Automatically

To configure Windows NT/2000 to start the SNMP service automatically:

� From the Control Panel, double-click Services > click SNMP.

� Click Startup.

� From the Startup Type options, select Automatic.

Starting SNMP Trap Service Automatically

To configure Windows NT/2000 to start the SNMP Trap service 
automatically:

� From the Control Panel, double-click Services > click SNMP Trap 
Service.

� Click Startup.

� From the Startup Type options, select Automatic.

Stopping SNMP Service

Because the traffic analysis agent for Windows NT/2000 runs as a component 
of the SNMP service, you can stop the agent by stopping the SNMP service.

To stop traffic analysis agent for Windows NT/2000, do one of the following:

� At the command prompt, enter net stop snmp.

� From the Control Panel, click Services > SNMP > Stop.

,03257$17��When the SNMP service is stopped, extension agent DLLs are 
unloaded from system memory. Windows NT/2000 will not respond to any SNMP 
request and will stop sending traps to trap destinations. 
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Specifying the SNMP Trap Community Name and Trap Destination Address

To ensure that the traffic analysis agent for Windows NT/2000 sends traps to 
the management server, you need to specify the trap community name and trap 
destination address to which the SNMP service should send traps.

To specify the trap community name and trap destination address:

� From the Control Panel, double-click Network.

� Click the Services tab > select SNMP Services.

� Click Properties.

� Click the Traps tab.

	 From the Accepted Community Names box, click Add.


 In the Service Configuration dialog box, enter public.

� Click Add.

� In the Trap Destinations text box, add the following:

�� The DNS names or IP addresses of the workstations or servers that 
should receive traps.

�� A loopback IP address of 127.0.0.1.

Adding the loopback address will ensure that the traps are also 
received by the traffic analysis agent for Windows NT/2000 that is 
sending the traps to the specified trap destinations. This will help in 
determining if the traps are being sent successfully to the trap 
destinations. If the traffic analysis agent for Windows NT/2000 
receives the traps that it sends but the trap destinations do not receive 
the traps, you can conclude that the traffic analysis agent for 
Windows NT/2000 is functioning appropriately and that you need to 
troubleshoot the workstation or server that is not receiving traps.

 Click Add.

Setting SNMP Security Options

You need to set security options to enable the trap community name 
configuration. You must also ensure that SNMP packets from any host are 
accepted by the agent.

To specify SNMP security options:

� From the Control Panel, double-click Network.
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� Click the Services tab > select SNMP Services.

� Click Properties.

� Click the Security tab.

	 From the Accepted Community Names box, click Add.


 In the Service Configuration dialog box, type public.

The Accepted Community Names list displays the community names 
from which Windows NT/2000 will accept requests.

� Select Accept SNMP Packets from Any Host.

This will ensure that SNMP packets from any host on the network will be 
accepted by the Windows NT/2000 server on which the traffic analysis 
agent for Windows NT/2000 is installed.

Optimizing the Traffic Analysis Agent for Windows NT/2000

The traffic analysis agent for Windows NT/2000 parameters are configured 
for optimal performance on Windows NT/2000. You can optimize the 
performance of the agent to suit your networking environment.

This section explains how to optimize the agent and monitor the functionality 
of the traffic analysis agent for Windows NT/2000 using the agent console 
(LANZCON) for Windows NT/2000. For details, see “Using LANZCON” on 
page 289.

The following sections explain the traffic analysis agent for Windows NT/
2000 configuration options:

� “Configuring the Traffic Analysis Agent for Windows NT/2000” on page 
286

� “Configuring the Modules of the Traffic Analysis Agent for Windows 
NT/2000” on page 286

� “Configuring the Parameters of the Traffic Analysis Agent for Windows 
NT/2000” on page 287

� “Automatic Loading of Agent with the SNMP Service” on page 289
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Configuring the Traffic Analysis Agent for Windows NT/2000

The traffic analysis agent for Windows NT/2000 provides default values for 
modules and parameters. You can change the default values to optimize the 
performance of the traffic analysis agent for Windows NT/2000.

You can configure the following modules of the traffic analysis agent for 
Windows NT/2000:

� Packet Capture

� Station Monitor

� Token Ring Manager

� FDDI Manager

For details, see “Configuring the Modules of the Traffic Analysis Agent 
for Windows NT/2000” on page 286.

You can configure the following parameters of the traffic analysis agent for 
Windows NT/2000:

� Memory Bound

� Memory Age

� Top N Station

� Generate Duplicate IP Address Alarms

� Trend Files Location

For details, see “Configuring the Parameters of the Traffic Analysis 
Agent for Windows NT/2000” on page 287.

Configuring the Modules of the Traffic Analysis Agent for Windows NT/2000

By default, all agent modules are enabled to load. You can choose to disable 
the modules.

To disable the modules of the traffic analysis agent for Windows NT/2000:

� From the LANZCON main menu, click Configure > LANalyzer Agent 
Modules > Disable.

� Deselect the module you want the agent to monitor.
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Configuring the Parameters of the Traffic Analysis Agent for Windows NT/2000

The traffic analysis agent for Windows NT/2000 modules are loaded with 
default parameters. You can modify the parameters to optimize the 
performance of the agent.

The following table describes the parameters of the Memory Manager 
module:

To modify the Memory Bound parameter:

� From the LANZCON main menu, click Configure > LANalyzer Agent 
Parameters.

� Click the Memory Manager tab.

� Move the Memory Bound slider to the point you want to set as the 
memory bound value.

To modify the Memory Age parameter:

� From the LANZCON main menu, click Configure > LANalyzer Agent 
Parameters.

� Click the Memory Manager tab.

� Move the Memory Age slider to the point you want to set as the memory 
age value.

Parameter Default Value Range Description

Memory Bound 4 MB 1 MB - 10 MB Sets the upper limit of 
available memory that 
can be allocated 
dynamically to the traffic 
analysis agent for 
Windows NT/2000.

Memory Age 168 hours 1 hour - 720 hours Controls the duration for 
which the traffic analysis 
agent for Windows NT/
2000 stores data in 
memory.

When the duration 
setting is reached, 
existing data is purged 
from memory.
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,03257$17��Restart the traffic analysis agent for Windows NT/2000 to ensure 
that the agent utilizes the changed parameter values. For details, see ZENworks 
for Servers Installation and Setup. 

The following table describes the parameters of the Station Monitor module:

To specify the number of TopN reports you want the agent to generate:

� From the LANZCON main menu, click Configure > LANalyzer Agent 
Parameters.

� Click the Station Monitor tab.

� Select the number of TopN reports.

To stop generation of duplicate IP address alarms:

� From the LANZCON main menu, click Configure > LANalyzer Agent 
Parameters.

� Click the Station Monitor tab.

� Deselect the Generate Duplicate IP Address Alarms check box.

The following table describes the Network Trend parameter:

,03257$17��If you delete the *.GT file. all the previous trend information will be 
lost.

To specify a path to a location for storing trend data:

Parameter Default Value Range Description

TopN Station 4 reports 2 - 10 reports Controls the number of TopN 
reports the agent can 
generate. 

Generate 
Duplicate IP 
Address Alarms

On - Controls the generation of 
duplicate IP address alarms.

Parameter Default Path Description

Trend Files 
Location

boot_drive\GTREND Specifies the directory path and 
location where trend files (*.GT) 
are created and updated.
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� From the LANZCON main menu, click Configure > LANalyzer Agent 
Parameters.

� Click the Network Trends tab.

� Enter or browse to select the directory path to the location where you want 
the traffic analysis agent for Windows NT/2000 to store trend data.

Automatic Loading of Agent with the SNMP Service

The traffic analysis agent depends on the Microsoft* SNMP service on 
Windows NT/2000. When SNMP starts, it loads agent DLLs in its address 
space. Once the agent is installed, it will be always loaded by the SNMP 
service, by default, whenever the service starts.

You can enable or disable loading of the agent DLLs with SNMP by checking 
the desired options in the Novell Traffic Analysis Agent Loading with SNMP 
dialog box. If you disable the agent, the SNMP service will start normally but 
the traffic analysis agent will not work. The traffic analysis agent will neither 
capture packets by placing the NIC cards into the promiscuous mode nor will 
respond to SNMP requests.

Using LANZCON

This section explains how you can use the LANZCON utility to configure and 
diagnose the traffic analysis agent for Windows NT/2000.

LANZCON for Windows NT/2000 is a graphical user interface provided by 
the traffic analysis agent for Windows NT/2000 to configure the agent 
modules and parameters and to diagnose the agent. You can use LANZCON 
to obtain information about network segments monitored by the agent to help 
you troubleshoot problems.

To open the LANZCON utility, do one of the following: 

� From the Windows NT/2000 Programs menu, click LANalyzer Agent for 
Windows NT > LANZCON.

� Double-click the LANZCON icon  on your desktop.

You can perform the following tasks with LANZCON:

� “Viewing Network Adapters” on page 290

� “Enabling or Disabling Network Adapter Monitoring” on page 290

� “Viewing the Agent Log” on page 291
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� “Viewing the Agent Status” on page 291

� “Viewing RMON Tables” on page 291

� “Viewing SNMP Traps” on page 292

Viewing Network Adapters

On loading LANZCON, you will see the Network Adapters window. The 
Network Adapters window displays information about monitored adapters in 
two panes.

The following table describes the two panes in the Network Adapters window:

Enabling or Disabling Network Adapter Monitoring

The traffic analysis agent for Windows NT/2000 collects information about 
monitored adapters and displays it in the right pane of the Network Adapters 
window.

By default, adapter monitoring is enabled. LANZCON lets you disable 
adapter monitoring. If you disable adapter monitoring, the traffic analysis 

Pane Displays Description

Left pane Adapter Tree view Displays a list of network adapters 
discovered by the traffic analysis agent for 
Windows NT/2000.

The default view displays a collapsed tree. 
You can expand each network adapter in the 
tree to view the list of RMON tables for the 
selected adapter.

Right pane Table view Displays details about the object you select 
in the left pane.

If you select an adapter in the left pane, 
interface table (RFC 1213 (http://
www.isi.edu/in-notes/rfc1213.txt)) details 
such as media type, MAC address, and 
description of the selected adapter are 
displayed in the right pane.

If you select an RMON table in the left pane, 
table data is displayed in the right pane.
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agent for Windows NT/2000 will stop collecting data for the adapter and the 
RMON tables for the adapter will be deleted.

,03257$17��You cannot disable monitoring FDDI adapters through LANZCON.

To enable adapter monitoring:

� Select an adapter in the left pane of the Network Adapters window.

� Click View > NetWork Adapters > Enable.

To disable adapter monitoring:

� Select an adapter in the left pane of the Network Adapters window.

� Click View > NetWork Adapters > Disable.

Viewing the Agent Log

The traffic analysis agent for Windows NT/2000 logs significant events and 
error messages that occurred during a session.

To view the agent log:

� From the LANZCON main menu, click View > Agent Log.

Viewing the Agent Status

You can view the status of the agent from the LANalyzer Agent Status 
window. The agent status window indicates whether the agent modules are 
loaded or not loaded.

To view the agent status:

� From the LANZCON main menu, click View > Agent Status.

Viewing RMON Tables

RMON tables are listed under each network adapter. You can view the RMON 
tables by selecting a table in the left pane of the Network Adapters window. 
RMON table data is displayed in the right pane.

The Network Adapter tree displays the following RMON tables:

� Statistics

� History Control

� History Data
Traffic Analysis ���
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� Host Control

� Host Entry

� Host TopN Control

� Host TopN Entry

� Matrix Control

� Matrix SD Entry

� Filter, Channel, and Buffer

The Alarm Information tree displays the following RMON tables:

� Alarm

� Event

� Log

Viewing SNMP Traps

The traffic analysis agent for Windows NT/2000 monitors network segments 
and sends traps to the management server. The management console displays 
the alarm when it receives the trap from the management server.

Trap information is displayed in the SNMP Traps window. For each trap, the 
table shows trap data that can be obtained.

,03257$17��LANZCON will receive trap notifications if you have ensured that 
Windows NT/2000 SNMP has been configured to send traps to a loopback trap 
destination address. For details, see “Specifying the SNMP Trap Community Name 
and Trap Destination Address” on page 284.

To view SNMP traps:

� From the LANZCON main menu, click View > SNMP Traps.

Statistic Explanation

Receive Time Displays the time when the trap occurred

Trap Summary Displays a description of the trap
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Server Inventory

ZENworksTM for Servers (ZfS) uses the inventory scan programs to scan the 
inventory for the servers. From the console, you can view the complete 
hardware and software inventory for the managed servers. You can also query 
the centralized database of the managed servers. This section contains the 
following tasks:

� “Scanning Inventory for Servers” on page 293 

� “Inventory Server Components” on page 299

� “Customizing the Software Application List for Software Scanning” on 
page 306 

� “Displaying Inventory Scan and Query Information” on page 312 

See Chapter 8, “Server Inventory,” on page 293 for more information about 
generating an inventory report for servers.

Scanning Inventory for Servers

ZfS inventory scan programs let you collect hardware and software 
information on NetWare® and Windows* NT* servers. The following 
sections discuss scanning inventory on both types of servers, and discuss the 
type of information you can collect. 

� “Scanning Inventory on NetWare Servers” on page 294

� “Scanning Inventory on Windows NT/2000 Servers” on page 295

� “Scan Information Collected by the Scan Programs” on page 296
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Scanning Inventory on NetWare Servers

The scan program, INVSCAN.NLM, collects the hardware and software 
information for NetWare 4.x and NetWare 5.x servers and sends the inventory 
information to the inventory server components.

INVSCAN.NLM is a NetWare Loadable ModuleTM (NLMTM) program on the 
Inventory server.

The scan program is loaded at server startup time. Based on the settings in 
INVSCAN.INI and the software list description file SWAPPL.INI, the scan 
program collects the inventory information from the servers.

127(��The NetWare Management AgentTM (NMATM) (including HOSTMIB.NLM) 
must be installed in order to scan for the following inventory items: hard disk model 
name, hard disk size, CD-ROM model name, and software registered in the 
PRODUCTS.DAT file.

On the server, the AUTOEXEC.NCF file loads the SCANNER.NCF file, 
which runs the INVSCAN.NLM scan program. 

The scan program reads the settings in INVSCAN.INI in the SYS:\SYSTEM 
directory. The settings of this file are as follows:

After collecting the data from the servers, the scan program sends the scan 
data report to the inventory components on the inventory server. 

Each managed server is identified by the distinguished name (DN) and the tree 
name sent by the scan program. The scan data is saved in the inventory 
database. 

Setting Description

inv_serv=server_name Indicates the inventory server.

file=location_of_the_software_
description_file>

Identifies the path to the software description 
file, SWAPPL.INI.

The default location of SWAPPL.INI is in the 
SYS:\SYSTEM directory on the server. 

protocols=IP_or_IPX Determines the protocol that INVSCAN.NLM 
will use to communicate with the Inventory 
Gatherer.
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You can use the Inventory Summary window to display the hardware and 
software information for the servers. You can also use the Inventory Query 
window to query the inventory information for the servers.

Scanning Inventory on Windows NT/2000 Servers

The Windows NT scan program, NTSCAN32.EXE, collects the hardware and 
software information on Windows NT 3.5, Windows NT 4.0, and Windows 
2000 servers and sends the inventory information to the inventory server 
components.

The scan program reads the settings in the NTSCAN32.INI file in the 
Windows directory. The contents of this file are as follows, where 
server_name identifies the inventory server (Windows NT server):

[Inventory]

InvServer=server_name

InvPath=directory_where_NTSCAN.EXE_is_installed

The ZFS Inventory service launches the scan program. This inventory service 
runs at startup by default; it can also be stopped and restarted to run the scan 
program at required times.

After collecting the data from the servers, the scan program sends the scan 
data report to the inventory components on the inventory server. 

The Windows NT scan program for servers also includes scanning based on 
the industry-standard Desktop Management Interface (DMI) specification 
Version 2.0. The scan program uses the Management Interface (MI) of DMI 
to look for the hardware and software components installed on the server. It 
also uses the instrumentation available to check any additional information 
available. Refer to the Distributed Management Task Force (DMTF)  (http://
www.dtmf.org) for more information on DMI standards.

Each managed server is identified by the DN and the tree name sent by the 
scan program. The scan data is saved in the inventory database. 

You can use the Inventory Summary window to display the hardware and 
software information for the servers. You can also use the Inventory Query 
window to query the inventory information of the servers. See “Displaying 
Inventory Scan and Query Information” on page 312 for more information.
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Scan Information Collected by the Scan Programs

The scan program collects the following hardware information for NetWare 
servers:

Inventory Hardware: Volumes (volume name, total size)

Memory (Physical Memory Size): Memory (physical memory size), 
processor (family, current clock speed)

Inventory Software: Operating system (OS type, version, number of licensed 
users, number of users), MaxNumberOfConnections (maximum number of 
volumes, revision level, SFT level, TTS level, peak connections used, 
accounting version, VAP version, queuing version, print server version, 
virtual console version, security restriction level, Internet bridge support)

Network: IP address, IPXTM address, MAC address

Scanned Inventory: Computer type (NetWare file server)

The scan program collects the following hardware information for Windows 
NT servers:

Inventory Hardware: Mouse, keyboard, display, BIOS, processor, memory, 
disk drive, hard disk, mapped drive, CD-ROM drive, serial ports, parallel 
ports, bus, modem

Inventory Software: Drivers, packages, operating system, scanner 
information

Network: Adapter, IP address, DNS, IPX address, NIC card, subnet mask

Server Connection 

Miscellaneous: Configuration files, environment, Windows NT services

DMI Components: DMI data, other DMI components

The functions of the scan programs for software scanning include the 
following:

� Checking the existence of the software at the servers.

� Collecting the information about the application file.

� Reporting information about the scanned software, such as the name of 
the software and the file size.

� Customizing software scanning using the Custom Scan Editor.
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� Collecting configuration file information and reporting the details and 
contents of the system files for Windows NT servers.

The configuration file entries are in the software description file, 
SWAPPL.INI. By default, the following entries are in the SWAPPL.INI 
file:

CfgFiles1=c:\config.sys c:\autoexec.bat
CfgFiles2=\windows\win.ini\windows\system.ini
CfgFiles3=c:\nwclient\startnet.bat c:\nwclient\net.cfg

� Report information about the installed services.

Scanning for Supplemental Inventory Information

The NetWare scanner reports supplemental inventory information such as 
BIOS, ports, bus, mouse, keyboard, floppy drive, display, and modem. The 
NetWare scanner reads these items from the supplemental inventory text file, 
INVINC.INI. 

The INVINC.INI template file is installed with the NetWare scanner in the 
SYS:\SYSTEM directory. This template version does not contain any 
inventory values. The administrator must update the INVINC.INI file with 
relevant inventory information.

You must follow the format specified in INVINC.INI to modify the file. The 
INVINC.INI file contains sections enclosed within square brackets [ ]. Each 
section contains inventory attributes identified by unique text descriptions. 

The contents of the INVINC.INI file, with examples for the entries, are as 
follows:

#Update the Supplemental inventory information on the right 
hand side of the "=".

#Caution : Refer to documentation to modify the left hand side 
of the "=" as 

#this is used by the NetWare Scanner internally.

[BIOS]

BIOSDate=02/08/99

BIOSType=Phoenix

[Serial Port]
Server Inventory ���
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0.SerialPortName=COM1

0.SerialPortAddress=3F8H

1.SerialPortName=COM2

1.SerialPortAddress=2F8H

[Parallel Port]

0.ParallelPortName=LPT1

0.ParallelPortAddress=378H

1.ParallelPortName=LPT2

1.ParallelPortAddress=0H

[Bus]

BusType=PCI

[Mouse]

MouseNumberOfButtons=2

[Keyboard]

KeyboardLayout=Enhanced 101/102-key

KeyboardSubType=0

KeyboardNumberOfFunctionKeys=12

[Floppy Drive]

DisketteDriveDescription=3.5" 1.44 MB

DisketteDriveMaxNumberofCylinders=80

DisketteDriveSectors=18

[Display]

DisplayAdapterType=VGA Color

MonitorHorizontalResolution=800

MonitorVerticalResolution=600

[Modem]

0.ModemName=D-LINK DFM-560E

0.ModemDescription=56000bps Data/Fax/Voice
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0.ModemVendor=D-LINK

0.Port=COM2

Follow these guidelines for updating the INVINC.INI file: 

� Each section name is enclosed by brackets [ and ]. Do not modify 
inventory section names. 

� Each inventory attribute name has a text description, followed by an 
equals (=) character. The value for the inventory attribute is assigned after 
the = character. Do not alter inventory attribute names under each section. 

:$51,1*��The NetWare scanner uses the section names and text descriptions; 
do not modify these entries. 

� Inventory attributes in the sections: [Serial Port], [Parallel Port], and 
[Modem] can grow according to requirements. These inventory attributes 
are typically in the format number.text_description. 

Where number refers any number within the range 0 to 9. This number 
identifies each entry for the inventory attribute. You can add one or more 
entries for the inventory attributes. 

� Adhere to the grouping for each entry for successful storage into the 
Inventory Database. 

� You cannot add new sections to the INVINC.INI file.

� You cannot add new inventory attributes to the INVINC.INI file.

Inventory Server Components 

To collate and store the inventory information, the following inventory 
components are used:

� Inventory Gatherer

� Inventory Storer

� Inventory database

The Inventory Gatherer and Inventory Storer must be loaded on the inventory 
server to scan the servers.

The inventory database functions as a repository of hardware and software 
information for all managed servers. This database is a relational database 
management system (RDBMS) maintained in Sybase*. ZfS installs the 
inventory database.
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The following illustration shows the inventory server components.

This section describes how to load the inventory components on the inventory 
server to scan the managed servers.

Inventory Gatherer

The Inventory Gatherer (ZENINV.NLM) transmits the collected information 
from the scan programs to the Inventory Storer. 

The Inventory Gatherer on the inventory server collates the hardware and 
software information which the scan programs collect from the managed 
servers. It receives inventory information from the scan programs over IP or 
IPX. 

The Inventory Gatherer collects the inventory data in a temporary file for each 
inventory scan. GATHERER.NCF on the inventory server contains the 
location of the temporary files. In this file, the command line option STR_DIR 
contains the directory path location. If you do not specify the directory 
location for the temporary files while loading the Inventory Gatherer, the 
default location is SYS:SYSTEM\STRFILES.

ZENINV.NLM is an NLM program and must be loaded from the file server 
console. The Inventory Gatherer logs the information and error messages in 
the SYS:ETC\ZENINV.LOG file.

Inventory Storer

The Inventory Storer on the inventory server transmits the collected inventory 
information from the Inventory Gatherer in the inventory database. The 
Inventory Storer takes the inventory files from the server and organizes the 
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information as objects in the inventory database. After storing the files in the 
database, the Storer deletes the inventory files from the server.

The inventory files are stored in the location that you specify for the TEMP 
command line option in the Property file (STORER.PROPERTIES) on the 
inventory server.

You must specify the same directory location in STORER.NCF and 
GATHERER.NCF. The Inventory Storer logs the information and error 
messages in the SYS:ETC\STORER.LOG file.

Loading and Unloading Inventory Components

To load the inventory components manually:

� Load the Inventory Gatherer. 

From SYS:\SYSTEM on the file server console, enter GATHERER.

To modify the directory location of the temporary files, edit the following 
line in he GATHERER.NCF file: 

LOAD ZENINV.NLM 
STR_DIR=directory_location_of_the_temporary_
files

� Load the Inventory Storer. 

From MWSERVER\STORER on the file server console, load the 
MASTER.NCF file and the STORER.NCF file.

To modify the directory location of temporary files during scanning, edit 
the following line in the STORER.PROPERTIES file on the inventory 
server:

-temp directory_location_of_the_
temporary_files

To stop the ZfS Inventory Storer in a ZfS setup:

� Identify the NetWare server installed with Site management services.

� From the Site management server console, invoke the Service Manager 
by entering smgrui.ncf.

� Stop the Storer process by doing the following: 

�� In Service Manager, click Connect.
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�� In the Select Host dialog box, enter storer for the Service Manager 
Name > click OK.

If the service is running, the details are displayed in the Service List 
table.

� To stop the Storer service, select the entry in the Service List table > click 
Stop.

	 Stop the Master process by doing the following:

	� In the Service Manager, click Connect,

	� In the Select Host dialog box, enter master for the Service Manager 
Name > click OK.

If the service is running, the details are displayed in the Service List 
table.


 To stop the Master service, select the entry in the Service List table > click 
Stop.

To stop the ZfS Inventory Storer in a ZfS setup over a ZENworks 2 setup:

� Identify the NetWare server installed with ZENworks 2 Inventory 
management components.

� Ensure that the Inventory Storer is not running by doing the following:

�� From the inventory server console, enter java -show

�� At the server console, enter java -kill 
process_number_of_inventory_storer 

The Inventory Storer process name is 
com.novell.zenworks.desktop.inventory.storer.Loader.

�� At the server console, enter java -kill  
process_number_of_master_process 

The Master process name is 
com.novell.zenworks.desktop.inventory.storer.MasterProcess.

About the Inventory Database

The inventory information for the servers is stored in the inventory database, 
ZENINV.DB. See Chapter 12, “Database Administration,” on page 373 for 
more information.
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Deleting ZENworks 2 Inventory Information from the ZfS Inventory Database

The ZfS inventory database uses ZENINV.DB to store the inventory 
information for servers. When you install the ZfS inventory database over an 
existing ZENworks 2 inventory database (ZENINV.DB), inventory 
information for workstations will be stored in the ZENINV.DB. To remove the 
existing inventory information for workstations and provide storage space for 
server inventory, run the RemoveWS tool. This tool uses the 
REMOVEWS.NCF file located in the SYS:\zfs_home\MWSERVER\BIN 
directory on the database server, where zfs_home refers to the directory in 
which ZfS is installed.

To run the RemoveWS tool:

� Edit the REMOVEWS.NCF section in the 
SYS:\zfs_home\MWSERVER\BIN directory on the database server and 
replace STORER with MWLIB.

MWSetEnv.ncf

java -nsac - neh -mx64M -
classpath.;$tmppath;$CLASSPATH;sys:\$insdir\MWServer\MWL
IB\removeWS.jar 
com.novell.managewise.desktop.inventory.delete.DeleteUCS

� At the ZfS Inventory database server, run removeWS.

This removes the existing inventory information of the workstations. This 
tool logs the status in the SYS\ETC\ZENDELWSONLY.LOG file.

Exporting Server Inventory Information to a CSV File

The GPEXPORT tool exports the inventory information for the servers stored 
in the inventory database to a Comma Separated Value (CSV) file.

This Java* tool uses Java Database Connectivity (JDBC) to access the 
inventory database maintained in Sybase.

The following sections will help you use the tool:

� “About CSV Report Files” on page 304

� “CSV Report Configuration Files” on page 304

� “Fields and Format Descriptions of the Output Reports” on page 305

� “Installing and Using the GPEXPORT Tool” on page 305
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About CSV Report Files

The GPEXPORT reporting tool creates the following output reports:

� Hardware Inventory Report 

The HARDWARE.CSV report file contains the hardware information of 
each server, represented as a single row. 

� Software Inventory Report

The SOFTWARE.CSV report contains the software information for each 
server, represented as multiple rows for each server. Each row contains 
the server name and software information for that server.

� DMI Information Report

The DMINFO.CSV report contains the Desktop Management Interface 
(DMI) information for each Windows NT server. 

The DMI information contains the DMI class name, DMI attribute name, 
and its corresponding value.

These files are created in the current directory from where you run the 
GPEXPORT reporting tool. 

CSV Report Configuration Files

The contents of the CSV reports are governed by their corresponding 
configuration files (.CFG). The .CFG files contain the information to generate 
the reports.

The following configuration files are used:

Configuration File File Details

CSVHARDWARE.CFG Generates the hardware report 
HARDWARE.CSV.

CSVSOFTWARE.CFG Generates the software report  
SOFTWARE.CSV.

CSVDMIINFO.CFG Generates the DMI information report  
DMIINFO.CSV.

DEFAULT.CFG Contains query information to access specific 
views containing the inventory data.
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You can fine tune the CSV reports by modifying the .CFG files. Fprmore 
information on the configuration files, refer to the Configuration File Format 
section in the General Purpose Inventory Database Export Tool GPEXPORT 
article at the ZENworks CoolSolutions Web site (http://www.novell.com/
coolsolutions/zenworks).

Fields and Format Descriptions of the Output Reports

The characteristics of each row in the output report are as follows:

� Each record is exported to one newline <NL> terminated row within the 
output file.

� The first header row of the file has column names enclosed in double 
quotes for the values. All rows in the file have the same number of 
columns as the header row.

� Each of the specified fields represents one column in the output files. The 
data of each column is enclosed in double quotes. 

� All columns are separated by a single comma. The last column has a 
newline character representing the end of the record. 

� Empty column values are represented with an empty double quote string 
("") followed by a comma or the newline <NL> separator for the last 
column.

� The data of each column is shown in the double quotes as it is stored in 
the database. If the database fields have commas or the newline character 
as part of the value, the data of the column will show embedded commas 
or the newline characters in the data of the column. 

Installing and Using the GPEXPORT Tool

To install the GPEXPORT reporting tool:

� Map a drive to the ZfS server that has the Inventory Management Agent 
files.

� Change the directory to zfs_directory\MWSERVER\GPCSV, where 
zfs_directory refers to the directory where ZfS is installed.

� Set the environment variable ZFS_START to the path where ZfS 
Management Console is installed.

For example, enter set zfs_start=e:\zfsconsole,, where 
e:\zfsconsole is the ZfS Management Console directory. 
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� Ensure that the variable ZFS_CON in the GPEXPORT.BAT file contains 
the right path to the ZfS Console directory.

For example, the path can be the following: 
set zfs_con=%zfs_start%\consoleone\1.2. On some 
setups, this setting is set zfs_con=%zfs_start%\consoleone.

To run the tool and generate CSV reports:

� After you install the GPEXPORT tool, ensure that the ZENworks 
database is loaded and running.

� Back up the existing CSV files before running this tool as the tool will 
overwrite any existing CSV files. 

The CSV files will be generated in the same directory where the tool is 
running.

� To generate the hardware report, at the server prompt, enter gpexport 
-h ipaddress_of_database_server, where -h is the parameter to 
generate the hardware report HARDWARE.CSV.

� To generate the software report, at the server prompt, enter gpexport 
-s ipaddress_of_database_server, where -s is the parameter to 
generate the software report SOFTWARE.CSV.

	 To generate the DMI Information report, at the server prompt, enter 
gpexport -d ipaddress_of_database_server, where -d is the 
parameter to generate the DMI information report DMIINFO.CSV.

The IP address after the parameter is the IP address of the server, where 
ZENworks Inventory database is loaded and running.

Customizing the Software Application List for Software 
Scanning 

You can customize the list of software applications that you want to scan at the 
managed servers.

The Software Scan Editor, shown in the following figure, displays the list of 
applications for which the scan program will scan at the managed servers.
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From the Software Scan Editor, you can do the following tasks:

� Specify the applications you want to scan.

See “Adding New Applications for Scanning” on page 310 for more 
information.

� Modify the list of file scan extensions that the Scan program will scan at 
the managed servers.

See “Editing the List of File Extensions for Scanning” on page 311 for 
more information.

� Modify the details of the applications listed in the Software Scan Editor. 

� Delete an application from the Software Scan Editor so that the scan 
program will not scan for the application.

Software Description File (SWAPPL.INI)

The Software Scan Editor stores the details of the software list in the software 
description file, SWAPPL.INI. By default, this file is located in 
SYS:\SYSTEM on any managed server (NetWare servers). Otherwise, the 
location of the SWAPPL.INI is specified in the INVSCAN.INI file. The entry 
in the INVSCAN.INI file is as follows:

File=<Directory where SWAPPL.INI is located>

,03257$17��Use the Software Scan Editor to modify the settings in the 
SWAPPL.INI file. Do not edit this file manually.
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The contents of the file are as follows:

[Software Inventory]

ScanExtensions=.EXE .COM .SYS .NLM .LAN .DLL .HLP .DUM .CRH 
.LIB .RUN .PLB .DAT

NumberOfApps=5618

Version=2.0

Update=6.04

; Omission of the drive letter works on all local hard drives

CfgFiles1=c:\config.sys c:\autoexec.bat

CfgFiles2=\windows\win.ini \windows\system.ini

CfgFiles3=c:\nwclient\startnet.bat c:\nwclient\net.cfg

UseDefaultVersion=FALSE

; Default network must be Novell

DefaultNetwork=Novell

[Applications]

<I>,!ASSESS.EXE,594848,WindoWare! Assess It!,4.0

<I>,ABI.EXE,94502,Digital Directory Assistance PhoneDisk 1997 
Business Edition,2.5.7

<I>,WIN.COM,44170,Microsoft Windows,3.1

<I>,BTRIEVE.NLM,220637,Pervasive Software Btrieve for NetWare 
(5 user),6.15.1

The following sections explain the entries of the SWAPPL.INI file:

� “ScanExtensions Entry” on page 309

� “NumberofApps Entry” on page 309

� “File Version and Update Entries” on page 309

� “Configuration File Section” on page 309

� “Applications Section” on page 310
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ScanExtensions Entry

This section in the SWAPPL.INI file defines the file extensions that the scan 
program will scan for at the servers.

The scan program scans the managed servers for certain file extensions, such 
as .EXE, .COM, .CFG, and others. From the Software Scan Editor, you can 
add file extensions that you want to be scanned or you can modify the existing 
list of file extensions. The file extensions you specify determine the types of 
files scanned at the managed servers. By default, the scan program scans for 
the application files with the extensions .EXE, .DLL and .COM on the 
managed servers. 

You can modify the file extension list to specify up to 12 different file 
extensions.

To include the application files for scanning, the file size of the application 
files at the managed server should not exceed 99 bytes.

A sample entry is as follows:

scanextensions=.EXE .COM .SYS .NLM .LAN .DLL .HLP .DUM .CRH 
.LIB .RUN .PLB .DAT

NumberofApps Entry

This entry shows the total number of applications listed in the 
[APPLICATION] section of the file.

A sample entry is as follows:

NumberofApps=8273

File Version and Update Entries

This entry lists the file version and file update of the SWAPPL.INI file.

A sample entry is as follows:

version=2.0

update=6.04

Configuration File Section

This section lists the configuration files that the scan program will scan. 
Software scanning includes scanning of the configuration files at the server.
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A sample entry is as follows:

CfgFiles1=c:\config.sys c:\autoexec.bat

CfgFiles2=\windows\win.ini \windows\system.ini

CfgFiles3=c:\nwclient\startnet.bat c:\nwclient\net.cfg

Applications Section

This section lists the details of the applications.

Each entry in this section is defined as follows: 

ScanMethod,Filename with extension,Filesize in 
Bytes,Application name,Application version

The scan program uses the Scan Method. The Scan Method is defined always 
as <I>.

This section does not have blank entries or comment lines within it.

A sample entry is as follows:

[Applications]

<I>,03985100.COM,27772,Solomon III Support File,7.01

<I>,ADW30.EXE,286192,After Dark Engine,3.2.0

<I>,AGIS.EXE,14464,Atlas Gis,2

,03257$17��If you modify the list of software applications or make any changes 
in the Software Scan Editor, copy the SWAPPL.INI file to all the servers that have 
the inventory scan programs.

Entries in the Applications section must be in the desired format. Each entry 
must be followed by an explicit carriage return and a newline character. We 
recommend that you edit the SWAPPL.INI file using the Software List Editor 
in ConsoleOneTM. Otherwise, if the format of the file is not as expected, the 
scanner may exhibit unpredictable behavior.

Adding New Applications for Scanning

The scan program collects software information about the application you 
selected from the Software Scan Editor window. 

To add a new application, you must provide all the details for the application. 
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� From the console, click a managed server.

You must log in as an administrator of the managed server.

127(��To open the Software Scan Editor on a managed server with management 
agents, you must specify the location of the SWAPPL.INI file. Map a drive to the 
server that contains the SWAPPL.INI file. On a NetWare server, select the 
SWAPPL.INI file from the SYS:\SYSTEM directory. On a Windows NT server, 
select the SWAPPL.INI file from the ZFS_AGNT\INVENTORY directory or from the 
location where the inventory agent has been installed.

� Click File > Actions > Software Scan Editor.

� Click Add to specify the details of the application.

� Fill the following details of the application: Filename, File Size (in 
Bytes), Product Name, and Product Version.

	 Click OK.


 Click OK in the Software Scan Editor dialog box.

Your changes are saved in the SWAPPL.INI file.

Editing the List of File Extensions for Scanning

The scan program scans the managed servers for the file extensions, such as 
.EXE, .COM, .CFG, and others, that you specify in the Software Scan Editor. 

You can add file extensions that you want to be scanned or you can modify the 
existing list of file extensions. The file extensions you specify determine the 
types of files scanned at the managed servers.

By default, the scan programs scan for the application files with the extensions 
.EXE and .COM on the managed servers. You can modify the file extension 
list to specify up to 12 different file extensions by using the Software Scan 
Editor. 

To specify the file extensions for scanning at the managed servers:

� Open the Software Scan Editor window.

� Click Extensions.

� Type the file extension that you want to append. 

� Click OK.

	 Click OK in the Software Scan Editor dialog box.

Your changes are saved in the SWAPPL.INI file.
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To modify the file extensions, edit the line. To remove the listed file 
extensions, delete the file extension from the line.

Displaying Inventory Scan and Query Information

Depending on the type of inventory information you want to view from the 
console, the following options are available:

� Inventory summary for a managed server

Refer to “Inventory Summary for a Managed Server” on page 312 for 
more information.

� Inventory information for managed servers, formed by querying the 
database

Refer to “Querying the Database for Managed Server Information” on 
page 315 for more information.

In addition to these inventory information displays, you can use reports to 
gather the inventory information specific to your needs from the inventory 
database.

Inventory Summary for a Managed Server

You can view the list of hardware and software components found on the 
managed server. The Inventory window displays the inventory information 
from the last inventory scan for the managed server.

To view the inventory information:

� From the console, click a managed server in NDS or Atlas Namespace.

� Click Tools > Server Inventory Summary.

The following sections describe the inventory summary information for both 
NetWare and Windows NT servers:

� “Inventory Summary for a Managed NetWare Server” on page 313

� “Inventory Summary for a Managed Windows NT Server” on page 313

� “DMI Data in Inventory Summary Information” on page 313
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Inventory Summary for a Managed NetWare Server

The inventory summary information of a managed server displays the 
following data for NetWare servers:

Inventory Hardware: Volumes (volume name, total size), memory (physical 
memory size), processor (family, current clock speed)

Inventory Software: Operating system (OS type, version, number of licensed 
users, number of users), MaxNumberOfConnections (maximum number of 
volumes, revision level, SFT level, TTS level, peak connections used, 
accounting version, VAP version, queuing version, print version, server 
version, virtual console version, security restriction level, Internet bridge 
support) 

Network: IP address, IPX address, MAC address

Scanned Inventory: Computer type (NetWare file server)

The Inventory Summary window displays the number of licensed users as -1 
if there are unlimited licenses installed for the server.

Inventory Summary for a Managed Windows NT Server

The inventory summary information of a managed server displays the 
following data for Windows NT servers:

Inventory Hardware: Mouse, keyboard, display, BIOS, processor, memory, 
disk drive, hard disk, mapped drive, CD-ROM drive, serial ports, parallel 
ports, bus, modem

Inventory Software: Drivers, packages, operating system, scanner 
information

Network: Adapter, IP address, DNS, IPX address, NIC card, subnet mask

Server Connection

Miscellaneous: Configuration files, environment, Windows NT services

DMI Components: DMI data, other DMI components

DMI Data in Inventory Summary Information

The following list contains the DMI components that are addressed in the DMI 
Information: 
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� BIOS Characteristics

� Disks

� DMA

� Electrical Current Probe

� IRQ

� Keyboard

� Network Adapter Driver

� Network Adapter Hardware

� Operating System

� Parallel Ports

� Pointing Device

� Power Supply

� Processor

� Serial Ports

� SubComponent Software

� System Cache

� System Contact Information

� System Enclosure

� System Hardware Security

� System Memory Settings

� System Power Controls

� System Resource DMA Info

� System Slot

� Temperature Probe

� Video

� Video BIOS

� Video Output Device

� Voltage Probe
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Refer to the Distributed Management Task Force Web site  (http://
www.dtmf.org) for more information on DMI.

Other DMI components are addressed in Other DMI Information in the 
Inventory Summary window. Other DMI information refers to all DMI 
component information that is not categorized in the main DMI category. 

Querying the Database for Managed Server Information

The inventory database stores inventory data (hardware, memory, and 
environmental information) for each managed server.

From the console, you can query the inventory database to display the 
hardware and software components for the managed servers that you want to 
view. The Inventory Query window displays the information with the criteria 
you specify.

Querying the inventory database helps to create groups of similar devices and 
focus your reports on specific types of machines. For example, you can query 
the database to find machines that have an i486D processor and a VGA card.

You form a query by specifying the component and its attribute for servers 
within a container. You can also combine multiple query groups, in which 
each group defines a set of query criteria. For example, you can run a query to 
discover all devices registered in the database that have 486 processors and 
another query to discover which of these machines has a VGA color video 
adapter.

You can save the results of the query in a file. You can also expand the query 
results to view the inventory information for the server.

To query the inventory database:

� From the console, click an object in NDS or Atlas Namespace.

� Click Tools > Server Inventory Query.

Query Components and Attributes

The components and attributes that you form for querying the managed 
servers are as follows:

Scanned Inventory

Software: Applications, operating systems, scanner information
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Hardware: Mouse, keyboard, processor, display, BIOS, memory, modem, 
disk, ports, bus, NetWare volumes

Network

Miscellaneous: Configuration files, environment, Windows NT service

DMI

127(��To query for an unlimited number of licensed users on NetWare 
servers, specify the value for the attribute as -1.
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MIB Tools

ZENworksTM for Servers (ZfS) provides the tools to manage Simple Network 
Management Protocol (SNMP)-manageable devices on your network. This 
section describes the Management Information Base (MIB) tools, the SNMP 
MIB Compiler and the SNMP MIB Browser. It also explains how to set up and 
use the tools. See the following sections for more information:

� “Understanding MIB Tools” on page 317

� “Configuring MIBs and Setting Up MIB Tools” on page 330

� “Using the MIB Browser” on page 334

� “Maintaining MIBs” on page 347

Understanding MIB Tools

The following sections provide information about the tasks required for 
managing SNMP devices using the MIB Compiler and the MIB Browser. 

� “About MIBs” on page 318

� “Understanding the SNMP MIB Compiler” on page 318

� “Understanding the SNMP MIB Browser” on page 319

� “Managing Devices with MIB Tools” on page 322

� “SNMP-Related Information for Working with MIB Tools” on page 322

� “Trap Definitions” on page 323
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About MIBs

To manage a device, you must obtain a copy of the MIB or MIBs that the 
device supports. A MIB is an ASCII text file, written in a precise format that 
describes the management information available on a particular class of 
devices. If, for example, you have an XYZ router from company X and you 
want to use ZfS for managing the router, company X must provide you with 
the XYZ router MIB. ZENworks for Servers provides many standard and 
vendor-proprietary MIBs, which are found in the MIB Server Pool. By 
default, ZfS compiles the most generally applicable of these MIBs.

If you want to compile any new MIBs, you must store them in the MIB Server 
Pool. The console user can select or remove MIB files from the MIB Server 
Pool. The MIB Compiler compiles the files listed in the MIB Server Pool.

Understanding the SNMP MIB Compiler

The MIB Compiler does the following:

� Parses a set of predefined SNMP MIB files written in ASN.1 and SNMP 
V2 syntax and verifies their syntax.

� Stores the compiled files in the ZfS database, which lets all users access 
these compiled files from a central location.

From the console, you can easily compile and maintain the MIB files 
located in the MIB Server Pool. You can add or remove MIB files from 
the MIB Pool.

� Updates trap definitions in the alarm template database. 

The MIB Compiler lets you introduce new SNMP alarm templates into 
ZfS so they can be recognized and interpreted as alarms when they arrive 
at the console. 

The Alarm Management System (AMS) interprets the annotations to trap 
definitions in a MIB to set the severity level and device status assigned to 
an alarm. The MIB files included with ZfS are already properly 
annotated.

The following figure demonstrates how the MIB Compiler incorporates 
information from the MIB files into the ZfS database:
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
During installation of ZfS, the MIB files that are precompiled using the MIB 
Compiler are also installed. The MIB for any SNMP node you want to manage 
must be compiled with ZfS. You can also integrate third-party MIBs. If you 
obtain a MIB file from a third-party vendor or any MIB file that was not 
installed with ZfS, you must compile the file using the MIB Compiler.

Using Role-Based Services with the MIB Compiler

ZfS role-based services let you assign various roles to users on your network. 
If your role is assigned the Enable MIB Compiler task, you can use the MIB 
Compiler.

See “Role-Based Administration” on page 21 for more information about the 
role-based administration provided by ZfS. 

Understanding the SNMP MIB Browser

The MIB Browser lets you manage SNMP-instrumented devices on the 
network. 

To use this tool, you must have knowledge of SNMP and a good 
understanding of the structure of MIBs. Using the MIB Browser, you can 
manage nodes on the network by setting values of the MIB objects at the target 
nodes.

If you are familiar with the structure of an SNMP MIB, you can use the MIB 
Browser to retrieve data from SNMP-manageable node. 

The MIB Browser lets you communicate with devices through an SNMP 
agent on the network over the User Datagram Protocol (UDP) or the Internet 
Protocol (IP). The results of SNMP commands are displayed in the MIB 
Browser window.
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An SNMP agent is a program that provides access to management data about 
a particular network device and responds to SNMP Manager requests for the 
data. The NetWare® Management Agent software is an example of an SNMP 
agent that resides on a NetWare server. An SNMP agent resides in each 
manageable device on the network.

Although many ZfS windows display data retrieved from SNMP-manageable 
nodes, some administrators prefer the capability the MIB Browser provides 
for specifying the type of data they want to retrieve. Additionally, by using the 
MIB Browser, you can obtain some SNMP data that is not displayed in ZfS 
windows.

The MIB Browser takes the compiled MIB and displays the objects in a tree 
format. The MIB Browser also lets you walk the tree and look for the 
definitions of the selected MIB objects. You can set the community string to 
be used in the conversation between the ZfS console and the SNMP-
manageable node to manage the device. 

The following figure demonstrates the functionality of the MIB Browser:

The MIB Browser does the following:

� Represents the MIB information as a tree. 

You can browse the objects in the MIB tree, which displays the composite 
OID (object identifier) for all compiled MIBs. The OID is the sequence 
of integers labeling each object on the path from the root of the tree to 
every object on the branches. The OID also describes the location of the 
object in the tree. For example, the novell(23) object in the tree is 
described as 1.3.6.1.4.1.23. For more information on the MIB tree, see 
“Browsing the MIB Tree” on page 334.
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� Retrieves specific information about the node using the SNMP GET and 
GETNEXT commands.

The MIB information is displayed as:

� A table display for tabular objects 

You can add new rows to the table and issue SNMP SET commands 
to update the columnar values of the table. For more information, see 
“Modifying Instances of an SNMP Table” on page 339.

� A graph display

If you choose to plot the SNMP requests, the Graph window displays 
the polled data of one or more MIB objects. For more information, 
see “Graphing SNMP Request Results” on page 344.

� A scalar table display 

You can form a scalar table by combining scalar objects. You can 
modify the scalar entries of the table. For more information, see 
“Forming Tables of Scalar Objects” on page 342.

� A TreeWalk display

You can browse the OID values of scalar and tabular objects. For 
more information, see “Viewing the Values of an Object and Its Child 
Nodes” on page 337.

� Changes the information at the target node using the SNMP SET 
command. 

You can retrieve or change the value of MIB objects if the community 
strings match at the target node. The node should also allow remote 
setting of its variables. 

� Creates a profile by saving the properties of the table, scalar table, or 
graph. 

You open the profile to view a table, scalar table, or graph of different 
SNMP-manageable nodes on the segment with the properties specified in 
the profile. For more information, see “Using a Profile for Tables and 
Graphs” on page 346.

For more information on the MIB Browser, see “Using the MIB Browser” on 
page 334.
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Using Role-Based Services with the MIB Browser

ZfS role-based services let you assign various roles to users on your network. 
If your role is assigned the Enable MIB Browser task, you can use the MIB 
Browser.

See “Role-Based Administration” on page 21 for more information about the 
role-based administration provided by ZfS.

Managing Devices with MIB Tools

ZfS lets you manage any SNMP-manageable devices on the network. In 
particular, you can do the following:

� Set alarm templates for receiving alarms, often referred to as SNMP traps, 
for these devices

� Use the MIB Browser to display and set values on these devices

Before using the MIB Browser to manage the devices, you need to perform 
the following tasks:

1. Acquire the necessary MIBs.

2. Add trap annotations, if required.

3. Add or remove MIBs using the MIB Compiler. 

4. Run the MIB Compiler to compile the MIBs in ZfS.

SNMP-Related Information for Working with MIB Tools

This section covers the following topics:

� “Security for SNMP GET and SET Operations” on page 322

� “ASN .1 and SNMP V2 Support” on page 323

Security for SNMP GET and SET Operations

SNMP uses a lightweight security mechanism whereby each protocol data 
unit (PDU) contains a community string. The SET community string is used 
in an SNMP SET operation and the GET community string is used in an 
SNMP GET operation. SNMP community strings provide only a rudimentary 
form of security because they are transmitted in clear text in each SNMP 
request. Therefore, the community strings are exposed to any stations capable 
of monitoring an IP or Internetwork Packet ExchangeTM (IPXTM) network.
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By default, ZfS applications use the public community string for SNMP GET 
and SET operations. The MIB Browser takes the community string from the 
SNMP agent. Otherwise, it uses public as the community string.

When SNMP is installed initially on the NetWare server, the SET community 
string is disabled and the GET community string is set to public. However, 
some products, such as the NetWare LANalyzer® AgentTM, modify the SNMP 
community strings as part of their installation process.

ASN .1 and SNMP V2 Support

The MIB Compiler supports all MIB files written in ASN.1 and SNMP V2 
syntax. The MIB Compiler allows relaxation of ASN.1 syntax.

Trap Definitions

Some SNMP MIBs define the traps that a device can send to the ZfS console 
when an unusual event occurs on the network. When you compile a MIB 
containing traps, information about those traps is added to the ZfS alarm 
database. When ZfS receives a trap, the information in the alarm database is 
retrieved and used by ZfS to generate the alarm summary string and to 
determine the alarm type, alarm severity, state of the affected device, and other 
details.

You can improve the presentation of the alarm information in ZfS by adding 
annotations to the trap definitions in the MIB files. These annotations are 
added as comments to the trap definitions so that the MIB compiles with third-
party MIB compilers.

All Novell® MIBs are annotated. If you choose not to annotate the traps in 
other MIBs, ZfS displays the alarms; however, they are less readable. SNMP 
MIBs use the TRAP-TYPE macro to define traps. 

This section covers the following topics:

� “Keywords for Trap Definitions” on page 324

� “Template Database” on page 324

� “Keywords for Trap Annotations” on page 325

� “Example Trap Definitions” on page 327

� “Displaying Annotated Traps in ZENworks for Servers” on page 328

� “Formatting the SUMMARY String” on page 328
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Keywords for Trap Definitions

The following table explains a trap definition.

Template Database

The MIB Compiler populates the alarm template database with the trap 
definitions in the MIB files. Any traps from the agents are stored in the 
database.

Keyword Example Explanation

dupIpxNetAddr TRAP-TYPE Specifies the name of the trap. 
For example, dupIpxNetAddr 
represents a duplicated IPX 
network address.

ENTERPRISE netware-GA-alert-mib Contains the OBJECT identifier 
of a node in the vendor’s tree, 
which, together with the trap 
number (the 8 following the ::= in 
DESCRIPTION) uniquely 
identifies the trap.

VARIABLES (osName, osLoc, 
tiTrapTime, 
tiEventValue, 
tiEventSeverity, 
tiServer)

Defines an ordered sequence of 
MIB objects that are passed as 
parameters of the trap to provide 
additional information about the 
event. 

For example, osName is a text 
string specifying the name of the 
server sending the trap; osLOC 
is a text string specifying the 
location of the server; tiTrapTime 
is an integer specifying the time 
the event occurred.

DESCRIPTION "Two servers use the 
same IPX Internet 
address."

Provides a textual description of 
the semantics of the trap.

Trap_number : :=8 Defines the trap.
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Keywords for Trap Annotations

The following table lists and explains the keywords you can use to annotate 
traps:

Keyword Explanation

–#TYPE Short name for the alarm. The name can contain a 
maximum of 40 characters. If this annotation is not 
present, the SNMP trap name is used.

--#SUMMARY Description of the alarm with placeholders and 
formatting information for the actual parameters 
passed with the alarm.

See “Formatting the SUMMARY String” on page 
328 for more information.

Without this annotation, the alarm summary string 
lists each SNMP parameter name followed by its 
value.

--#ARGUMENTS List of parameters to substitute in the SUMMARY 
string. Parameters are substituted in the order in 
which they appear in the list. Each element of the 
list is the index (zero-based) of the parameter in the 
VARIABLES clause.

--#SEVERITY Default severity assigned to the trap. This can be 
one of the following:

� INFORMATIONAL

� MINOR

� MAJOR

� CRITICAL

� UNKNOWN

Alarms with a default severity set to CRITICAL are 
displayed in the ticker tape. 

Without this annotation, the severity is displayed as 
UNKNOWN.
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Note the following rules about adding trap annotations:

� Each annotation must be embedded in a comment. Everything from the 
double hyphen to the end of the line is treated as a comment. 

� Each annotation must be on a separate line. 

� Annotations must appear in the order in which they are discussed in “Trap 
Definitions” on page 323.

� All annotations must be inserted after the DESCRIPTION clause and 
before the ::= clause.

� STATE and SEVERITY values are written to the alarm database the first 
time the MIB is compiled, so any changes you make by clicking Fault > 
Alarm Disposition are not overwritten. If you want to overwrite the 
existing values, you must run the SNMP Compiler from the ZfS console.

� The variable filename is the name of the MIB file that you want to 
overwrite. The optional -S switch (silent mode) causes the MIB Compiler 
to run in the background. We recommend that third-party developers use 
silent mode. 

--#TIMEINDEX Index of the variable in the VARIABLES clause. 
This index contains the time when the alarm was 
generated. The time is expected to be an integer 
representing the number of seconds since 1970 
(UNIX* time). If such a variable does not exist in the 
VARIABLES clause, use an index greater than the 
total number of variables in the VARIABLE clause.

--#STATE Default state of the object when the alarm was 
generated. This can be one of the following:

� OPERATIONAL

� NONOPERATIONAL

� DEGRADED

� UNKNOWN

Without this annotation, the state is UNKNOWN.

Keyword Explanation
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Example Trap Definitions

The following sections explain a trap description in an SNMP before and after 
annotation:

� “Example Trap Definition Before Annotation” on page 327

� “Example Trap Definition After Annotation” on page 327

Example Trap Definition Before Annotation

dupIPXNetAddr     TRAP-TYPE

ENTERPRISE netware-GA-alert-mib

VARIABLES{osName, osLoc, tiTrapTime, tiEventValue, tiEventSeverity, 
tiServer}

DESCRIPTION"Two servers use the same IPX internetwork address."

::=8

Example Trap Definition After Annotation

dupIPXNetAddr     TRAP-TYPE

ENTERPRISE netware-GA-alert-mib

VARIABLES{osName, osLoc, tiTrapTime, tiEventValue, tiEventSeverity, 
tiServer}

DESCRIPTION"Two servers use the same IPX internetwork address."

::=8

– Trap annotations are as follows:

--#TYPE"Duplicate IPX address"

--#SUMMARY "%s at %s and %s are using the same IPX address"

--#ARGUMENTS{0,1,5}

--#SEVERITYCRITICAL

--#TIMEINDEX2

--#HELP "MYHELP.HLP"

--#HELPTAG 60004
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--#STATEDEGRADED

::=8

Displaying Annotated Traps in ZENworks for Servers

Assume that the dupIpxNetAddr trap shown in “Keywords for Trap 
Definitions” on page 324 was received by ZfS with the following variables:

� osName = SJM-JACK

� osLoc = JACK’s CORNER

� tiTrapTime = ~700000000

� tiServer = SJM-TIM

To display a trap, use the Alarm Monitor or Alarm Disposition table. The 
following example shows the result:

Receive Time:03/04/99 09:15:45

Alarm Type: Duplicate IPX address

Summary: SJM-JACK at JACK’s Corner and SJM-TIM are using the same 
IPX address

Severity: Critical

State: Degraded

When you select the alarm on the Alarm Report table and click the NetWare 
Expert button, ZfS displays help information for this alarm.

Formatting the SUMMARY String

The SUMMARY keyword in the trap annotation lets you provide the actual 
wording of the alarm summary. This wording is used by ZENworks for 
Servers when the alarm occurs. 

Placeholders within the string are replaced by actual parameters of the trap 
before the string is displayed by ZENworks for Servers. Each placeholder 
format string begins with a percentage sign (%) and tells ZENworks for 
Servers how to format the parameter that will be substituted for the 
placeholder in the final string. See “Trap Definitions” on page 323 for a list of 
all available format strings for each parameter type and the printed form for 
each value.
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The placeholder format strings are substituted, in order, by the parameters 
specified in the ARGUMENTS keyword. The ARGUMENTS keyword lists 
the (zero-based) index of each trap parameter as specified in the VARIABLES 
clause. The indexes are listed in the order in which you want them to be 
substituted in the SUMMARY string. 

ZENworks for Servers can display a maximum of 140 characters in the 
SUMMARY string. Use the characters to display the most relevant 
information about the alarm. If you have a long SUMMARY string and want 
to keep the line length of the MIB file reasonable, you can insert multiple, 
consecutive SUMMARY annotations and the strings will be concatenated. For 
example, the following annotations below yield the same string:

–#SUMMARY  “%s at %s and %s are using the same”

–#SUMMARY  “IPX address”

–#SUMMARY  “%s at %s”

–#SUMMARY  “and %s are”

–#SUMMARY  “using the same IPX address” 

The following table lists the format strings and parameter types.

Parameter Type Format String Printed Form

BOOLEAN %s

%d

True or False.

1 or 0.

INTEGER %x

%d

%t

HEX.

DECIMAL.

Prints the integer or a date 
and time (Greenwich Mean 
Time). The integer 
represents seconds since 
1970.
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Configuring MIBs and Setting Up MIB Tools

This section describes the procedural tasks for configuring MIBs and setting 
up the community strings for SNMP operations on an individual node. After 
you complete these tasks, you can perform SNMP operations using MIB 
Tools.

This section covers the following topics:

� “Annotating Third-Party MIBs for Integration with ZfS” on page 331

� “Compiling MIBs for SNMP-Manageable Nodes” on page 332

� “Setting Community Strings for an Individual Node” on page 333

OCTET STRING %s

%m

%x

Prints the text string with all 
control characters taken out.

Prints the first 6 bytes of 
data as a hyphen-separated 
MAC address. For example, 
00-00-07-00-07.

Prints the octet string in 
hexadecimal. For example, 
0000070007.

NULL %d

%s

Prints the number 0.

Prints the string NULL.

OBJECT IDENTIFIER %s Prints dot-separated 
decimal values. For 
example, 1.3.6.5.4.

IP Address %s

%x

Prints dot-separated IP 
address. For example, 
13.56.56.56.

Prints a long hexadecimal 
value.

BIT STRING %s Prints each byte as decimal. 

Parameter Type Format String Printed Form
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Annotating Third-Party MIBs for Integration with ZfS

When you compile a MIB containing SNMP traps (alarms), information about 
those traps is added to the ZfS alarm database. This information can then be 
displayed in the ZfS console. 

All Novell MIBs are annotated so that the alarm information displayed in the 
ZfS console is easily readable. This alarm information includes a summary 
describing the alarm, the alarm severity, and the state of the affected node. 
Third-party MIB files do not necessarily contain this same information. 
Therefore, the information about the traps in third-party MIBs is not as 
meaningful when displayed on the ZfS console.

You can add annotations to third-party MIB files for the trap definitions so that 
the alarm information displayed in ZfS for those traps is more readable than if 
you compile the MIB as is. Any annotations you add to a third-party MIB are 
added as comments to the trap definitions. This ensures that the MIB still 
compiles with third-party MIB compilers.

If you do not annotate the traps in third-party MIBs, ZfS will display the 
alarms. The MIB Compiler displays warnings in the status display about the 
missing annotations.

To add annotations to a third-party MIB:

� Open the MIB in a text editor.

� Add any of the annotations shown in “Keywords for Trap Annotations” 
on page 325, by following these rules:

� Enter annotations only between the DESCRIPTION and the "::=" 
clause.

� Each annotation must be on a separate line.

� Annotations must be in the order shown in “Keywords for Trap 
Annotations” on page 325.

� Embed each annotation as a comment. Precede each annotation with 
two hyphens and a pound sign (#). 

For example: --#Type "type_description"

For a full example, see “Example Trap Definitions” on page 327.

� When you finish annotating trap definitions, save your changes and exit 
the text file.
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Compile the MIB, as described in “Compiling MIBs for SNMP-
Manageable Nodes” on page 332.

Use the ZfS Console Alarm Disposition table to change the values for the 
alarm severity level and alarm state from the default values in the SNMP 
MIBs. (An administrator might do this, for example, because the administrator 
considers an alarm’s severity to be different from the default severity assigned 
in a Novell MIB.) If you change the value for an alarm’s severity or state after 
you compile the MIB, you must recompile the MIB for those changes to 
overwrite any changes made through the Alarm Disposition table.

Compiling MIBs for SNMP-Manageable Nodes

The MIB Compiler lets you manage the MIB Server Pool and also compile 
the.MIB files contained in the MIB Server Pool. The information in the 
compiled files is placed in the database on the ZfS server. The MIB Browser 
and the SNMP protocol decoder use this database.

The MIB Compiler also adds or updates any trap definitions to the alarm 
template database for use by the ZfS Alarm Management System (AMS).

The MIB Server Pool contains the list of MIB files. You can add or remove 
the MIB files from the MIB Server Pool.

To compile the MIBs:

� From the ZfS console, click the ZfS server node.

� Right-click the node > click Properties > click the MIB Pool tab.

The current MIB Pool lists the compiled MIB files present in the 
database.

� Choose your options.

� To add MIBs, click the Add button. The selected files are collected 
in the MIB Pool list. 

When you add MIBs, you choose to integrate or exclude the trap 
information while compiling MIBs. If you do not integrate traps with 
the MIBs, only the MIB information is stored in the database on 
successful compilation of the MIBs. Click Advanced > select the 
Trap Integration check box to integrate the trap information with the 
MIBs. 

� To remove files from the MIB Pool list, click the Remove button.
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� To compile the MIBs with less strict adherence to ASN.1 syntax, 
click Advanced > select the ASN.1 Syntax Relaxation option.

� Click Compile.

The MIB Compiler compiles all files with the .MIB extension that you 
have added, and updates the database.

The Compiler Results window displays the status for the compilation.

	 Click Close.

,03257$17��If the SNMP MIB is not set up correctly, or an imported Request for 
Comments (RFC) is not available during compilation of the MIB, an error message 
is generated in the MIB Compiler window. For detailed information on MIB 
Compiler errors, see “Troubleshooting MIB Compiler Error Messages” on page 
411. 

Setting Community Strings for an Individual Node

This section describes the procedure to set up the community strings for 
SNMP SET and GET operations on an individual node.

Typically, community strings are configured to be identical over all nodes in 
a network, or at least over a portion of the network. The default value for both 
SET and GET is public. The community strings are case-sensitive.

By default, ZfS uses the public community string for SNMP GET and SET 
operations. You can configure a community string other than public on a node-
by-node basis, or you can configure a community string globally on all 
SNMP-managed nodes. The community string that ZfS uses must match the 
string expected by the SNMP agent in the managed node; otherwise, the 
operation will fail.

The MIB Browser lets you configure different community strings for each 
device on the network. After this information is entered for a device, it is used 
instead of the defaults whenever ZfS uses SNMP to communicate with that 
device.

To set up the community strings for SET and GET operations for an individual 
node:

� From the ZfS console, click the target SNMP-manageable node.

� Click File > Action > SNMP MIB Browser.

� Type the community string. 
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ZfS uses this community string for SET and GET operations when 
communicating with the device. 

� Click OK.

You can also change the community string for a node from within the SNMP 
MIB Browser or from other windows and dialog boxes in ZfS.

Using the MIB Browser

This section acquaints you with using the MIB Browser to manage SNMP-
manageable nodes. 

This section includes the following topics:

� “Browsing the MIB Tree” on page 334

� “Viewing the Values of an Object and Its Child Nodes” on page 337

� “Configuring a Node by Setting Object Values” on page 338

� “Modifying SNMP Preferences” on page 339

� “Modifying Instances of an SNMP Table” on page 339

� “Forming Tables of Scalar Objects” on page 342

� “Graphing SNMP Request Results” on page 344

� “Using a Profile for Tables and Graphs” on page 346

Browsing the MIB Tree

The MIB Browser lets you select the objects you want to display, and it sends 
SNMP queries to the node to obtain the data objects that you requested. It also 
allows SNMP operations such as GET, GETNEXT, and SET requests on a 
particular object in the MIB of an SNMP-managed node. 

The MIB Browser periodically polls the node and continually updates the 
display. You can view and modify scalar and tabular data objects.

MIB Tree Browser

The MIB Tree Browser is a collection of management data that consists of 
numerous objects.
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The MIB Browser displays a composite OID tree for all compiled MIBs. 
Analogous to a file system, the MIB Browser shows leaf objects, which are 
the SNMP data objects. 

The MIB Browser spans the selected node with its subtree and leaf objects and 
displays the name of the objects in the MIB Tree Browser. You browse from 
the highest level of the tree and view the leaf object values.

The top pane displays the tree with the selected object. Each object is 
displayed as a file folder icon, followed by its SNMP name with the SubId 
appended in parentheses. If the object is a non-leaf node, the MIB Browser 
also displays its children.

The bottom pane describes the selected object. The description is derived from 
the compiled MIB file. The format of the description is as follows: textual 
description of the object, full numeric OID and object name, ASN.1 type, size, 
textual convention, access, Index clause taken from the Entry object, status, 
and description. 

For example, for an internal node SYSTEM with child nodes, the child nodes 
describe the properties of the SYSTEM. The OID of SYSTEM is 
iso(1).org(3).dod(6).internet(1).mgmt(2).mib-2(1).system(1). Another 
equivalent representation of this OID is 1.3.6.1.2.1.1. Note that the parent 
node does not have information, and the child nodes contain the properties.

The child nodes of SYSTEM are sysDescr OID(1.3.6.1.2.1.1.1), sysObjectID 
OID(1.3.6.1.2.1.1.2), sysUpTime OID(1.3.6.1.2.1.1.3), sysContact 
OID(1.3.6.1.2.1.1.4), sysName OID(1.3.6.1.2.1.1.5), sysLocation 
OID(1.3.6.1.2.1.1.6), and sysServices OID(1.3.6.1.2.1.1.7).

The following figure shows the MIB Browser window.
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To browse the MIB objects:

� From the ZfS console, click the target SNMP-manageable node. 

� Click File > Action > MIB Browser.

Alternatively, invoke the SNMP MIB Browser and enter the address for 
the node in the SNMP MIB Browser window.

� Click the object whose values you want to view from the MIB Tree 
Browser.

� To select an object, click the name text or the icon in the MIB 
Browser tree.
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� To expand or collapse the next level in the tree display, double-click 
the object.

Viewing the Values of an Object and Its Child Nodes

The MIB Browser spans the selected node with its subtree and leaf objects and 
displays its values in the TreeWalk Query Results window. You can browse 
the OID values of scalar and tabular objects.

To view the values of the instances of a MIB object:

� From the ZfS console, click the target SNMP-manageable node. 

� Click File > Action > MIB Browser.

� Click the object > Perform TreeWalk for the node button. 

The following figure shows the TreeWalk Query Results window.

If you select a leaf object, you can view the values for each instance of this 
object. For non-leaf objects, this window will display all the values of the 
child node of this object. For example, if you want to view the values of the 
child nodes for the object system, click the parent object system.

The display process in the Treewalk Query Results window continues 
recursively for all the non-leaf objects of the selected object.You can pause 
and resume this display in the window.
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Customizing the Display of TreeWalk Query Results Window

The TreeWalk Query Results window displays the number of lines based on 
the settings specified in the TREEWALK.PROPERTIES file. 

This file located in \CONSOLEONE\version\BIN\SAVED-
VIEWS\GENERIC directory contains the following setting: 
MaximumNumberofLine=number_of_lines_for_display 

where, number_of_lines_for_display is the number of lines that will be 
displayed at a time. The default setting is 10,000 lines.

You can modify this setting. The settings will apply only if you restart 
ConsoleOne and bring up the TreeWalk Query Results window.

When the text buffer is full, to clear the display in the TreeWalk Query Results 
window, click the Clear button. 

There may be some out of memory problems, if you specify a large line setting 
in the TREEWALK.PROPERTIES file. 

Configuring a Node by Setting Object Values

Using the SNMP MIB Browser, you can issue an SNMP SET command to 
change information at an SNMP-manageable node if you have the appropriate 
privileges. You select a scalar object from the MIB Browser and set its value.

You can modify the values for an integer, enumerated integer, object identifier, 
string, and IP address object types.

To issue an SNMP SET command for a scalar object:

� From the ZfS console, click the target SNMP-manageable node.

� Click File > Action > MIB Browser.

� Click a scalar object whose values you want to view > click Display Data 
As a Scalar Table.

� Specify the object value for the scalar object.

	 Click OK.

To modify columnar values of an SNMP table, see “Modifying Instances of an 
SNMP Table” on page 339.
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Modifying SNMP Preferences

SNMP parameters are used to communicate with the target device. The MIB 
Browser lets you change the SNMP community strings or specify the transport 
address of a new target device.

Any SNMP operation requires these values to be set. After starting an SNMP 
operation, such as polling a table, changing the SNMP preferences does not 
affect the operation.

You can modify the following parameters:

Agent Address: You can specify the IP or IPX address and the Domain Name 
System (DNS) name of the SNMP-manageable node to which you want to 
send an SNMP request. This node should have an SNMP agent.

SET and GET Community Strings: The community string that ZfS uses 
must match the one expected by the SNMP agent in the managed node or the 
SNMP operations will fail. If the SNMP agent on the node expects a 
community string for SET and GET operations that is different from public 
(the default), you can specify the expected community string to override the 
default community or those community strings you set previously. You can 
use Unicode* or International characters for the community string.

To modify the SNMP preferences:

� From the ZfS console, click the target SNMP-manageable node. 

� Click File > Action > SNMP MIB Browser.

� Click Modify SNMP Preferences.

� Specify the parameters > click Close.

Modifying Instances of an SNMP Table

A table in an SNMP MIB is an SNMP construct derived from the structure of 
the MIB. Each row in the table corresponds to a row in the SNMP table. 

The MIB Browser provides the Table Display window to display tabular 
objects you select. This window displays one or more rows from an SNMP 
table in a two-dimensional grid and follows the SNMP index order to display 
rows.

The table shows each column in the SNMP table as columns. Each column 
heading is derived from the SNMP table columns. The Table Display window 
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displays the columns with their values as single or multiple rows for the MIB 
you selected.

SNMP allows operations on individual table entries only. The OID identifies 
the column and row. 

From the MIB Browser, you can perform the following operations:

� Add rows to an SNMP table

For more information, see “Adding Rows to an SNMP Table” on page 
341.

� Modify a row of an editable table

For more information about adding or modifying rows, see “Adding 
Rows to an SNMP Table” on page 341.

� Save the table as a profile

For more information about saving a table as a profile, see “Using a 
Profile for Tables and Graphs” on page 346.

Viewing the SNMP Table

To view the SNMP table:

� From the ZfS console, click the target SNMP-manageable node. 

� Click File > Action > SNMP MIB Browser.

� Click a tabular object whose values you want to view > Display Data As 
a Table.

From the Table Display window, you can add rows or modify the rows of the 
SNMP table and input values for each column. For more information about 
adding or modifying rows of an SNMP table, see “Adding Rows to an SNMP 
Table” on page 341.

The following figure shows the MIB Browser Table Display window.
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The MIB Browser periodically sends SNMP queries to the node to obtain the 
data objects you request. When you provide new values for writable objects, 
the MIB Browser writes these values to the node. The MIB Browser 
periodically polls the node and continually updates the display. You can 
change the polling interval by suspending the SNMP interaction or by 
canceling the SNMP interaction.

Adding Rows to an SNMP Table

When you add a new row to an SNMP Table, the MIB Browser generates the 
SNMP SET request.

Before generating the SNMP Set request, the MIB Browser sends a GET 
command to the node that you selected in the MIB Browser table and retrieves 
the value of the object. On adding rows with the specified values for the 
objects, the MIB Browser issues multiple SNMP SET commands to update 
the SNMP table.

To add a row to an SNMP table:

� Click the table object from the MIB Browser window > Add a New Row 
to the Table. 

For more information about selecting the table object, see “Modifying 
Instances of an SNMP Table” on page 339.

The following figure shows the Add Row to Table window.
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� Double-click the row.

� Modify the value > click OK > click OK.

To add rows in an SNMP table, you must input the values for all the index 
rows, which are denoted by asterisks.

To modify a row of an editable table: 

� Open the Table window.

� Click the row whose values you want to modify > click Issue SNMP Set 
request for a column button. 

� Double-click the row.

� Modify the value of the object > click OK > click OK.

Forming Tables of Scalar Objects

You can make a scalar table by combining the scalar objects from the MIB 
Browser. A scalar table is a two-column table with the name and value of the 
scalar object entries. To create a scalar table, you select a group node with 
scalar child nodes or a group of scalar objects. For example, you add one or 
more scalar objects such as ipInDelives and SysUpTime to make a new scalar 
table labeled ipInDeliversTable.
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If you want to view the scalar tables that you create, save the scalar table as a 
profile. You can load the scalar table profiles when required.

The following figure shows the Scalar Table window.

To combine scalar objects as a scalar table and view the table:

� Create a new scalar table.

� Add to or modify the existing table by adding scalar entries or by 
removing entries from the table.

� Save the scalar table as a profile.

� Launch the profile.

To create a new scalar table:

� From the ZfS console, click the target SNMP-manageable node. 

� Click File > Action > SNMP MIB Browser.

� Right-click a scalar group or a scalar object > click New > click Scalar 
Table.

To add or remove scalar entries to an existing table: 
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� Open an existing scalar table.

� Toggle to the MIB Browser window > click Add to > click 
Scalar_table_name.

Alternatively, click the scalar entry in the MIB Browser window, and 
from the Scalar Table window, click Add Node Selected from Browser 
Window. 

To remove the scalar entry, click the scalar entry in the Scalar Table window, 
and click Remove the Node Selected in This Window.

Graphing SNMP Request Results

You can plot the SNMP request results in a graph that displays the polled data 
of the MIB objects. Only attributes of ASN.1 type Integer, Counter, Time 
Ticker, and Unsigned Integer are plotted as current absolute values.

You can plot more than one object in the same graph, add more objects, or 
remove the MIB objects from the existing graph. If you want to view the 
graphs that you create, save the graph as a profile. You can then load the graph 
profiles when required.

To graph SNMP request results of one or more nodes:

� Click the target SNMP-manageable node from the console.

� Click File > Action > SNMP MIB Browser.

� Click the MIB object whose values you want to plot. 

� Right-click the object > click New > click Graph.

The MIB Browser plots the graph with the values of the selected object and its 
leaf object values dynamically in the Graph pane of the window.

The following figure shows the Graph window.
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To graphically plot the values of more than one object:

� Toggle to the MIB Browser window.

� Click the MIB object you want to plot > click Add To > click the Graph.

You add these objects to any of the active graph windows you want.

Alternatively, you can click the MIB object from the MIB Browser window 
and then click the Add button in the MIB Browser Graph. Remove the objects 
from the list that you do not want by selecting the node from the list and 
clicking the Delete button.

From the Graph window, you can perform the following operations:

� Rescale the Y-axis of the graph

� Set the period to display 

� Set the polling interval and refresh rate of the display
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By default, the values plotted in the graph are absolute. If you want to 
view the rate of change of values per second with respect to sysUpTime, 
you must click the Rate option. For example, if you click ipInPackets and 
choose the Rate option, you can view the values per second.

Using a Profile for Tables and Graphs

A profile contains information about the properties of the graph, table, or 
scalar table. You use a profile to specify the information, such as the method 
of display (table or graph) and polling interval. 

You create a profile by saving the properties of the table, scalar table, or graph 
as a profile. You open the profile to view a table, scalar table, or graph of 
different SNMP-manageable nodes on the segment with the same properties 
specified in the profile. You can modify or delete the profile.

To form a profile:

� Save the properties of the display window.

� Open the profile. 

� Modify the properties of the profile as required.

To save a profile: 

� Click the Save button from the Scalar table window, Graph window, or 
Table window.

� Type the details of the profile.

Specify the name, description, and properties of the objects.

� Click OK.

To open a profile:

� From the MIB Browser window, click the profile you want from the drop-
down list.

� Click Launch This Profile. 

To modify the selected profile:

� Click View/Edit Profile Contents for the selected profile in the MIB 
Browser window.

To delete a selected profile:

� Click Delete This Profile.
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Maintaining MIBs

This section provides information about where to obtain Novell MIBs and also 
MIBs from third-party vendors.

� “Updating ZfS MIBs” on page 347

� “Updating Vendor MIBs” on page 347

Updating ZfS MIBs

To manage a particular server, you must obtain a copy of the MIB or MIBs that 
the server supports. The ZfS folder, \SNMPMIBS\ALLMIBS, contains some 
of the widely encountered MIBs.

Updating Vendor MIBs

Standard MIBs, which are published as Requests for Comments (RFCs), can 
be obtained by anonymous FTP to host ftp.nisc.sri.com (192.33.33.22). The 
RFC directory contains all published RFCs. The INTERNETWORK-
DRAFTS directory contains the latest working documents that have not yet 
reached standards status.

Vendor-proprietary MIBs are often posted on host venera.isi.edu (128.9.0.32), 
and can be obtained through anonymous FTP.

Adding or Removing MIBs

Depending on your need to add MIBs for managing nodes, you must compile 
the MIBs.

To delete a particular MIB from ZfS, remove the appropriate MIB text file 
from the MIB Server Pool and rerun the MIB Compiler. If the MIB you delete 
contains traps, you must remove the alarm definitions before you rerun the 
MIB Compiler.

When you add MIBs, you choose to integrate or exclude the trap information 
while compiling MIBs. If you disallow trap integration with the MIBs, only 
the MIB information is stored in the database on successful compilation of the 
MIBs.

For more information about how to add or remove MIBs, refer to “Compiling 
MIBs for SNMP-Manageable Nodes” on page 332.
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Monitoring Services 

ZENworksTM for Servers (ZfS) lets you test the connectivity and availability 
of a service on a network device. This test checks and measures the response 
by sending diagnostic packets. This test also notifies the console whenever the 
status of the service changes.

This section provides an overview of the testing facility, lists the services that 
can be monitored on the nodes, and discusses the test options. See the 
following sections for more information:

� “Understanding Monitoring Services” on page 349

� “Monitoring Services on Target Nodes” on page 351

Understanding Monitoring Services

Using the Monitoring Services facility, you test connectivity of services on 
one or more critical network devices, such as servers or routers. For example, 
you can monitor services because you want to be alerted immediately if the 
connectivity between the console and critical nodes is disrupted. 

This test facility enables testing of the following services: 

� Domain Name System (DNS)

� Dynamic Host Configuration Protocol (DHCP)

� Echo

� File Transfer Protocol (FTP)

� Hypertext Transfer Protocol (HTTP)

� Hypertext Transfer Protocol Secure (HTTPS)

� Internet Packet ExchangeTM (IPXTM)
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� Internet Protocol (IP)

� Network File System (NFS)

� Network News Transfer Protocol (NNTP) 

� Simple Mail Transfer Protocol (SMTP)

� Simple Network Management Protocol (SNMP)

� Time Service

� Trivial File Transfer Protocol (TFTP)

The test facility uses the ZfS server as the remote ping server. When you select 
the service on the node for testing, the console interacts with the remote ping 
server on the ZfS server and displays the results of the test on the console.

The following figure shows a graphical representation of Monitoring 
Services.

To monitor nodes, you choose the nodes and enable the monitoring session for 
the duration you require. 

From the console, you monitor the services in the following ways:

� Test connectivity of the services on a node one time only when you 
suspect a problem with the connectivity.

� Continuously monitor connectivity of the services on a critical node until 
you close the test facility.

� Continuously poll the services of the nodes on the segment (for example, 
connectivity testing of the services on the target nodes runs uninterrupted 
until you disable monitoring). If you do not disable monitoring, this test 
facility continues even after you close the console.
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For testing connectivity of services on the target nodes you select, you set the 
following options:

� Specify the services on the selected target nodes.

If you need to test any TCP based services, you add the service to the 
existing list of services. 

� Define the test interval between two successive tests.

� Define the timeout value.

The timeout value determines the time duration that the remote ping 
server waits to receive the response from the target node.

You can view the status of the connectivity and measure diagnostics, such as 
round trip delays or number of packets sent and received from the console.

Role-Based Services for Using the Monitoring Services

Role-based services (RBS) defines the task for Monitoring Services as Enable 
Remote Ping. If this task is assigned to your role, you can use the Monitoring 
Services facility.

For general information about creating RBS role objects or specifying tasks 
that RBS roles can perform, see "Configuring Role-Based Administration" in 
the ConsoleOne User Guide (http://www.novell.com/documentation/lg/
consol12c/docui/index.html). For information about role-based traffic 
analysis tasks, see “Role-Based Traffic Analysis Tasks” on page 190. 

Monitoring Services on Target Nodes

This section guides you through the tasks involved in using the Monitoring 
Services facility.

From the console, you can monitor critical nodes on the network and manage 
potential connectivity problems before they affect the network. You define the 
services to test on the selected nodes, then view the test results and other data 
for each listed target. To perform the testing, complete the following general 
steps:

1. Define the targets to be monitored.

See “Defining the Targets for Monitoring Services” on page 352 for 
information about specifying the services on the target nodes.
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2. On a per-node basis or on multiple nodes, change the test interval or 
timeout value.

These tests use default values for the test interval between two successive 
tests on the target and to determine the time duration that the remote ping 
server waits to receive the response from the target node. You can change 
these values for the test. 

See “Changing the Test Options for a Node” on page 355 for information 
about editing the test options.

3. View the test results.

The nodes are monitored continuously, at the defined test interval for the 
node. Depending on the Monitoring Services test that you choose, the 
corresponding test results are displayed. 

See “Displaying Test Results Data” on page 354 for information about 
test results data.

Defining the Targets for Monitoring Services

Monitoring Services requires that you specify the targets for the tests. You can 
choose from the following test options:

� “Test the Services on the Target Node One Time Only” on page 352

� “Continuously Monitor the Services on the Target Nodes” on page 353

� “Continuously Poll the Services of the Target Nodes on a Segment Until 
the Test Is Disabled” on page 353

127(��You can monitor approximately 50 critical services simultaneously on the 
servers. Monitoring more than 50 services may overload the server memory and 
result in performance degradation.

Test the Services on the Target Node One Time Only

If you suspect a problem with a node in the network, you can ping the node 
once for monitoring services. When you select the target node for testing the 
services and specify the IP or IPX address, this address will determine the 
service that will be tested at the node. For example, if you type the IPX 
address, the default IPX service is tested on the target node. 

The results of the test will display the status of the target node and details of 
the round trip delay in the Ping window.

To test the services on a node once:
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� From the console, right-click the selected node > click Ping.

� Type the ping target details.

� Click OK. 

Continuously Monitor the Services on the Target Nodes

To specify the services for continuous monitoring, add the targets and choose 
the services on the node and other options. The target node will be added to 
the list of targets in the Connectivity Test Results window and the test results 
data will be displayed. Monitoring of services continues until you close this 
window. 

To define the targets for testing services on the node: 

� Click Action > Connectivity Test from the console.

� Click Add.

� Specify the details for the target nodes in the Add Ping Target dialog box.

Refer to “Adding Services for Monitoring” on page 356 for more 
information about adding services.

� Click OK.

The target node will be added to the list of targets in the Connectivity Test 
Results window.

Continuously Poll the Services of the Target Nodes on a Segment Until the Test Is 
Disabled

For polling the services on the nodes of a segment, select the nodes on a 
segment with the list of services you want to test. Enable the test in the 
Monitor Tab Services window and view the results of the test in the Polling 
view.

If you do not disable the test, polling of the services continues after you close 
the console.

To define the services on the nodes for polling: 

� From ConsoleOne, right-click the node of a segment > click Properties > 
click the Monitor Services tab. 

The List of Segment dialog box displays the different addresses of the 
same node on different segments if the node is connected to more than 
one segment. Click the node on the segment that you want to add. 
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� Specify the details for the target nodes in the Monitor Services Tab 
window. 

Refer to “Adding Services for Monitoring” on page 356 for more 
information about adding services.

� Click OK. 

Displaying Test Results Data

After defining the services for testing on the target node, you can view the 
results from the console.

Depending on the test you choose, the test results are displayed in the 
corresponding window. 

If you choose to test the services on the node one time only, the test results will 
be displayed in the Ping Status window of the Ping window. This target will 
not be tested in the Connectivity Test Results window.

If you choose to continuously monitor the services, the test continues until you 
close the window. You can view the results in the Connectivity Test window.

If you choose to continuously poll the services until you disable the test, you 
can view the test results in the Polling view. 

The following test data is available when you monitor the services on the 
target nodes:

Ping Target: Name or address (IP or IPX) of the network device for which 
services are being tested.   

Service: Monitored services that are being tested on the target. 

Port: Port number that the service uses.

Status of the Target: Up Status means that the service is available on the node 
and can be reached from the remote ping server. Down Status means that the 
service is down and cannot be reached from the server. 

RoundTrip Delay: Time interval (in milliseconds) between the instant the 
remote ping server sends the test packet to the target and the instant the 
response is received from the target.

Packets Sent: Number of packets sent from the remote ping server to the 
target node.
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Packets Received: Number of packets received by the remote ping server 
from the target node.

Packets Lost: Number and percentage of packets lost during the testing of the 
target node.

Interval: Displays the test interval value, in seconds. This value determines 
the time duration between two successive tests on the target.

Timeout: Displays the timeout value, in milliseconds. This value determines 
the time duration that the remote ping server waits to receive the response 
from the target node.

To view the Connectivity Test Results window:

� Click File > Action > Connectivity Test from the Console. 

If you select one or more target nodes from the right pane of the console, 
the list of nodes that you want to test for connectivity will be shown in the 
Connectivity Test Results window. 

To view the results of the polling:

� From the console, click a segment > View > Polling. 

127(��To delete a target node from the list, from the Polling view, click the target 
node > click Delete.

Changing the Test Options for a Node

You can modify the test options, such as the test interval and timeout options, 
that you set earlier on an individual node or on multiple nodes. To modify 
multiple nodes, click more than one node from the Connectivity Test Results 
window; the test options apply to all selected target nodes.

To view the Connectivity Test Results window:

� Click the target row from the Connectivity Test Results window > click 
the Edit button. 

� Type values for the Ping Interval and Timeout. 

� Click OK. 

If you want to roll back to the default setting, click Apply Defaults. 
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Adding Services for Monitoring

Monitoring Services lets you test services on the nodes. If you need to test any 
TCP-based service that is not listed in the default services list, you add the 
details of the service when you are adding the targets.

You specify the name of the service in the Add Service dialog box. Ensure that 
the service name you add is a unique name. Also, you must specify the port 
number for the service. 

You can add the details of the service under the following circumstances:

� “Continuously Monitor the Services on the Target Nodes” on page 353

� “Continuously Poll the Services of the Target Nodes on a Segment Until 
the Test Is Disabled” on page 353

The services that you add are stored in a file on the server.
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Reporting in ZENworks for Servers

The ZENworksTM for Servers (ZfS) Management and Monitoring Services 
provide the following predefined reports:

� Server Inventory Reports

� Topology Reports

� Health Reports

The following sections describe the available reports and provide procedures 
for customizing and generating the reports:

� “Navigating the ZfS Namespace” on page 25

� “Managing Reporting” on page 364

Understanding the ZfS Reports

The following sections describe each predefined report available in ZfS:

� “About the Server Inventory Reports” on page 357

� “About the Topology Reports” on page 359

� “About the Health Reports” on page 362

About the Server Inventory Reports

You can generate the following types of inventory reports:

� “Simple Inventory Lists” on page 358

� “Comprehensive Inventory Reports” on page 359
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Simple Inventory Lists

These reports provide information on individual aspects of server inventory, 
such as the operating system. They take less time to generate than the 
comprehensive inventory reports.

Report Name Information Provided

Server Scan Time Listing Date and time of the last inventory scan on each 
server.

Server Operating System 
Listing

List of all servers with the specified OS version 
and OS type and the total number of such 
servers.

Server BIOS Listing List of all servers with BIOS release date and the 
total number of such servers.

Server Processor Family 
Listing

List of all servers with processor family (such as 
Pentium* Pro) and the total number of such 
servers.

Server Processor Speed 
Greater than Listing

List of all servers whose processor speed is 
greater than or equal to a specified MHz value 
(such as 400), and the total number of such 
servers.

Server Processor Speed 
Less than Listing

List of all servers with processor speed less than 
or equal to a specified MHz value (such as 200 
MHz), and the total number of such servers.

Server Memory More than 
Listing

List of all servers with memory greater than or 
equal to a specified MB value, such as 0.

Server Memory Less than 
Listing

List of all servers with memory less than or equal 
to a specified MB value, such as 128.

Server Video Adapter Listing List of all servers with video adapter (such as 
MGA 2064W), and the total number of such 
servers.

Server Network Adapter 
Listing

List of all servers with network interface card 
(such as 3Com* Fast EtherLink*), and the total 
number of such servers.

Server Software Listing by 
Software

List of all servers with software installed on the 
server, and the total number of such servers.
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Comprehensive Inventory Reports

These reports combine several aspects of server inventory into each report, 
such as memory, hard disk, and processor. They take longer to generate than 
the simple inventory lists, but you can limit (by name) the servers to be 
included in each report.

About the Topology Reports

The topology reports provide information about the topology of a selected ZfS 
site or segment. There are two types of topology reports you can generate: site-
level reports and segment-level reports. The site-level reports provide details 
about the discovered devices on each segment in the ZfS site. The segment-
level reports provide information about the discovered devices on the selected 
network segment. 

There are five predefined topology reports:

� “Computer Systems by Segment Report” on page 360

Server Software Listing by 
Server

List of all software installed on the server.

Software Summary Listing List of the number of servers with a particular 
software and version.

Report Name Information Provided

General Server Inventory 
Report

BIOS, system description, OS description, 
processor, video type, display details, NIC type, 
hard disk, IP address, and MAC address for each 
server.

Hardware Inventory Report Conventional memory, extended memory, 
processor, hard disk, video type, and modem for 
each server.

Asset Management Report BIOS, computer description, processor, and OS 
description for each server.

Networking Information 
Report

OS description, MAC address, NIC type, IP 
address, and network drive mappings for each 
server.

Report Name Information Provided
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� “NCP Servers Report” on page 360

� “Router Report” on page 361

� “Segment Report” on page 361

� “Segment Topology Report” on page 361

Note that the NCP Servers report is available only at the site level.

Computer Systems by Segment Report

This report lists the number of computer systems on the selected segment. If 
the report is generated at the site level, the report lists the number of systems 
on each segment. For each segment, the report provides the following 
information about each connected computer system:

� System Name

� MAC Address

� IP Address

� IPX Address

� Services

� MIB Services

� Community String

NCP Servers Report

This report lists the following information for each NetWare® server on the 
selected ZfS site:

� Server Name

� MAC Address

� IP Address

� IPX Address

� Labels (other names by which the server is known)

� MIB servers

� Services

� Community Strings
�
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Router Report

This report provides the following information for each router on the selected 
ZfS segment or site:

� IPX Address

� IP Address

� MAC Address

Segment Report

This report lists the number of computer systems on the selected segment 
(segment level) or on all segments in the ZfS site (site level). For each 
segment, the report provides the following information about the systems 
connected to the segment:

� IP Address

� IPX Address

Segment Topology Report

This report provides information about the routers and bridges on a selected 
ZfS segment or site.

For each router, the report provides the following information:

� Router Name

� MAC Address

� IP Address

� IPX Address

� MIB Services

� Community Strings

For each bridge, the report provides the following information:

� Bridge Name

� Bridge Type

� IP Address

� Number of Ports

� Port Number: Attached Address
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� IPX Address

� MAC Address

� MIB Services

� Community Strings

About the Health Reports

The Health Reports provide information about the overall health of a specified 
ZfS site or network segment. Each health report is based on a predefined 
health profile. The health profiles define the trend parameters that are used to 
calculate the overall health of the segment or site. There are five predefined 
health profiles:

� “NetWare Server Profile” on page 362

� “Microsoft Windows Profile” on page 362

� “Ethernet Network Profile” on page 363

� “Token Ring Network Profile” on page 363

� “FDDI Network Profile” on page 363

In addition, you can modify any of the existing profiles or create your own 
health report profiles. See “Customizing a Health Profile” on page 367 or 
“Adding a New Health Profile” on page 368.

NetWare Server Profile

Reports generated using this profile provide graphs of the following trend 
parameters and use these parameters to calculate the overall health of the 
NetWare servers in the selected ZfS site or segment:

� Cache Buffers

� Cache Hits

� CPU Utilization

� Volume Free Space

Microsoft Windows Profile

Reports generated using this profile use the following trend parameters to 
calculate health:
�
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� Cache Hits

� CPU Utilization

� Disk Free Space

� Available Memory

In addition, reports generated using this profile contain trend graphs for the 
following parameters:

� Cache Hits

� CPU Utilization

� Available Memory

Ethernet Network Profile

Reports generated using this profile use the following trend parameters to 
calculate overall health:

� Total Errors

� Network Utilization

In addition, reports generated using this profile contain trend graphs for the 
following parameters:

� Total Errors

� Good Packets

� Network Utilization

� Total Packets

Token Ring Network Profile

Reports generated using this profile use the following trend parameters to 
calculate overall health. In addition, reports generated using this profile 
contain also contain trend graphs for the following parameters:

� Network Utilization

� Total Errors

FDDI Network Profile

Reports generated using this profile use the following trend parameters to 
calculate overall health:
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� Total Errors

� Network Utilization

In addition, reports generated using this profile contain trend graphs for the 
following parameters:

� Total Errors

� Network Utilization

� Total Packets

Managing Reporting

The following sections provide procedures for customizing, generating, 
printing, and exporting the ZfS reports:

� “Managing the Server Inventory Reports” on page 364

� “Managing the Topology Reports” on page 366

� “Managing the Server Management Health Reports” on page 367

Managing the Server Inventory Reports

The inventory reporting tool lets you generate reports from the inventory 
database. The reporting tool is accessed through the Tools menu from 
ConsoleOneTM. This tool always uses the inventory database that is installed 
as the data source for your reports.

You can select from a predefined set of report forms to generate a report. The 
reporting tool queries the inventory database, then formats the results in its 
viewer window. You can then page through, print, or export the report as 
desired. Remember that any reports you generate will be empty if you have 
not configured to start populating the inventory database with the data you 
want.

This section contains the following tasks:

� “Generating and Viewing an Inventory Report” on page 365

� “Specifying Filters for Reports” on page 365

� “Printing the Inventory Reports” on page 365

� “Exporting the Inventory Reports” on page 366
�
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Generating and Viewing an Inventory Report

To generate and view an inventory report:

� From the Console, click an object in NDS® or Atlas Namespaces.

� Click Tools > Server Inventory Reports.

� Select a report category.

� Specify the options.

If you are prompted to specify a filter on the items to be included in the 
report, enter a value (in most cases, wildcards are allowed) as explained 
in “Specifying Filters for Reports” on page 365 > click OK.

	 Click OK.

A status box appears displaying the progress of the report generation. 
When the report is generated, it appears in the viewer. Use the buttons on 
the toolbar to page through, print, or export the report.

Specifying Filters for Reports

You can specify a filter on the items to be included in your inventory report. 
To include all items, click OK. Otherwise, type a value in each field 
(depending on the type of report you are generating, there may be more than 
one field you can filter). If the dialog box says that wildcards are allowed, you 
can use an asterisk (*) and question mark (?), or their SQL equivalents, 
percent (%) and underscore (_). The wildcard characters can be used for 
character data only.

Printing the Inventory Reports

To print an inventory report:

� Generate and view the report. 

Example Specifies to Include

% All items

wNT% All items starting with "wNT"

wNT_cpq All items starting with "wNT" followed by any 
character and "cpq"

wNTcpq.xcorp The single named item, in this case a server
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See “Generating and Viewing an Inventory Report” on page 365 for more 
information.

� On the toolbar, click the printer icon.

� In the Print dialog box, select the print options you want > click OK.

� In the next Print dialog box, click OK to print in default orientation mode. 

To change the mode, click Properties > Orientation > select the mode 
(Landscape/Portrait) > OK > OK.

The Inventory Lists are designed to be printed in portrait mode, but all the 
other reports are designed to be printed in landscape mode. 

Exporting the Inventory Reports 

To export a report to a file:

� Generate and view the report.

See “Generating and Viewing an Inventory Report” on page 365 for more 
information.

� On the toolbar, click the Export Report icon.

� In the dialog box, specify the location and file format > click OK.

Managing the Topology Reports

You can generate two types of topology reports: site-level reports and 
segment-level reports. The site-level reports provide details about the 
discovered devices on each segment in the ZfS site. The segment-level reports 
provide information about the managed devices on the selected network 
segment. Note that the NCP Servers report is available only at the site level.

The following section describes how to generate, print, and export a topology 
report.

Generating a Topology Report 

To generate a topology report:

� Select the ZfS site object (to generate a site-level report) or a network 
segment object (to generate a segment-level report) > click Reports. 

� Select the report you want to generate > click Run Selected Report.

� To print the report, click File > Print.
�
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or

To export the report, click File > Export.

Managing the Server Management Health Reports

The server management component provides five standard profiles that you 
can use to generate health reports. You can set up reports based on these 
standard profiles or you can customize these profiles or create your own 
profiles on which to base your reports. For information about the standard 
health profiles, see “About the Health Reports” on page 362.

This section contains the following tasks:

� “Customizing a Health Profile” on page 367

� “Adding a New Health Profile” on page 368

� “Creating and Scheduling Health Reports” on page 369

� “Viewing and Printing a Health Report” on page 369

� “Running a Health Report” on page 371

Customizing a Health Profile

To customize a health profile:

� Right-click the ZfS site object > click Properties.

� Select the Health Profiles tab.

� Select the health profile you want to customize > click Edit.

The Edit Profile dialog box is displayed. This dialog box contains a list of 
the parameters that can be used to calculate the overall health of the 
device or segment to which the profile is applied.

� Specify the directory location to which reports generated using this 
profile should be published by entering a value in the Publish Directory 
field. 

To browse for a directory, click the Browse button (...). 

	 Modify the parameters that are used to calculate health by checking or 
unchecking the In Health Calculation check box next to each parameter.


 Rank the importance of each trend parameter in calculating health by 
entering a number in the Weight field for each parameter you checked to 
include in the health calculation. 
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You can enter any whole number in the Weight field. The system will use 
the weights to determine how important the parameter is in calculating 
overall health. The larger the number, the more weight the parameter is 
given in calculating health.

� Modify which parameters to render graphically in the health report by 
checking or unchecking the Show Trend on Report check box next to 
each parameter.

� To save your changes, click OK.

Adding a New Health Profile

To add a new health profile:

� Right-click the ZfS site object > click Properties.

� Select the Health Profiles tab.

� Click New.

The New Profile dialog box is displayed.

� Enter a name for the new profile in the Name field.

	 Select the type of device or segment to which the profile applies from the 
Type drop-down list > click OK.

The Edit Profile dialog box is displayed.


 Specify the directory location to which reports generated using this 
profile should be published by entering a value in the Publish Directory 
field. 

To browse for a directory, click the Browse button (...). 

� Select the parameters you want to use to calculate health for reports 
generated using this profile by clicking the In Health Calculation check 
box next to the appropriate parameters.

� For each parameter you selected to include in the health calculation, 
indicate how important the parameter is in calculating overall health by 
entering a value in the Weight column.

You can enter any whole number in the Weight field. The system will use 
the weights to determine how important the parameter is in calculating 
overall health. The larger the number, the more weight the parameter is 
given in calculating health.
�
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 For each parameter that you want to be represented graphically in 
associated health reports, click the Show Trend on Report check box.

�� Click OK.

Creating and Scheduling Health Reports

To create and schedule a health report:

� Right-click the ZfS site object or a container object > click Properties.

� Select the Health Reports tab.

� Click New.

The Edit Report dialog box is displayed.

� Enter a name for the report in the Name field.

	 Select the profile to use when generating the report by selecting a value 
from the Profile drop-down list.


 Indicate how often you want to generate the reports by selecting a value 
from the Period drop-down list.

You can choose to generate reports daily, weekly, or monthly. 

� Set the time and date you want the reports generated by selecting or 
entering the appropriate values in the Start Time, Day of the Week, and/
or Day of the Month fields.

The available fields will depend on the period you selected.

� Click OK.

The report will be generated at the date and time you entered and stored 
in the directory specified in the associated report profile. For information 
on viewing the reports, see “Viewing and Printing a Health Report” on 
page 369.

Viewing and Printing a Health Report

After you create a health report, the report will be automatically generated on 
the day and time you specified. You can view the reports using a Web browser 
to open the INDEX.HTM file in the directory that is designated as the publish 
directory in the associated report profile. 

,03257$17��Before you can view the health reports you must install Java* 
plug-in 1.1.2. You can get this plug-in from Sun Microsystems, Inc.
Reporting in ZENworks for Servers �
�

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
To view a health report:

� Browse to the directory where the health reports for the associated profile 
are stored.

�  Use your browser to open the INDEX.HTM file.

The INDEX.HTM file is a Java file containing all reports that are stored 
in the directory. The left column of the INDEX.HTM file lists report 
hierarchy. 

� Click the plus sign next to the profile that is associated with the reports 
you want to view.

The profile object expands to display a list of container objects.

� Click the plus sign next to the container object associated with the reports 
you want to view.

The object expands to display a list of report names associated with the 
object. 

	 Click the plus sign next to the report you want to view.

The object expands to display a list of individual report instances. For 
example, a report that is scheduled to run daily will have a report instance 
for each day. The reports are named by date and time. For example, 
2000.09.09_11.15.10_PDT is the name assigned to a report generated on 
September 9, 2000 at 11:15:10 Pacific daylight time.


 Click the plus sign next to the report name to display a list of individual 
report pages.

The number of individual report pages depends on what report profile you 
selected and the object where you generated the report. For example, if 
you generated a report at the segment level using the Ethernet Network 
profile, there will only be one report page for the segment. If you 
generated a report at the site level using the Ethernet Network profile, 
there will be a report page for each Ethernet segment within the site. If 
you generated a report at the segment level using the NetWare Server 
profile, there will be a separate report page for each NetWare server on 
the segment.

� Click an individual report page to display the health report in the right 
frame. 

The top of the report displays statistical information about the segment or 
server and provides a calculation of overall health. The parameters used 
to determine overall health are defined in the associated health report 
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profile. The bottom of the profile displays trend graphs depicting the 
overall performance of the server or segment. See “About the Health 
Reports” on page 362 for a list of the parameters tracked and graphed in 
each of the standard profiles. 

� To print the report, click the Print Report button at the bottom of the left 
frame.

Running a Health Report

Although Health Reports are usually scheduled to run at a specified time of 
the day, week, or month, you may occasionally want to generate a Health 
Report on demand. To generate a Health Report on demand:

� Right-click the ZfS site object or a container object > click Properties.

� Select the Health Reports tab.

� Select the report you want to generate > click Now.

The report is saved to the directory specified in the report profile. See 
“Viewing and Printing a Health Report” on page 369.
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Database Administration

ZENworksTM for Servers (ZfS) provides a centralized Common Information 
Model (CIM)-compliant Sybase* database on the Management and 
Monitoring Services management server. The database serves as a repository 
for server and network data that can be displayed or formatted in various ways 
to provide you with exactly the information you need to manage your network. 

The following sections provide information on understanding and using the 
ZENworks database:

� “Understanding the ZfS Database” on page 373

� “Understanding the ZfS Inventory Database Schema” on page 374

� “Backing Up the Database” on page 386

� “Changing Database Passwords” on page 387

Understanding the ZfS Database

The ZfS database consists of six files located in the \ZFS\DB directory on the 
management server. It has an NDS® Database object associated with it. The 
ZfS data is stored in two logical databases:

� Topology/alarm database containing topology, alarms, and map 
information associated with the following files: 

� MW.DB

� MW1.DB

� MW2.DB

� MW3.DB
Database Administration ���
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The MW.LOG file in the \ZFS\DB subdirectory saves your transaction 
information with the database files.

The topology/alarm database can be installed on multiple management 
servers. Each database file has a size limitation of 2 GB.

� Inventory database containing server inventory data associated with the 
ZENINV.DB file.

The inventory database file has a limitation of 2 GB.

To increase the performance of the database, use separate disk controllers to 
access the database files using Sybase Administration.

The ZENINV.LOGfile in the \ZFS\DB subdirectory saves the transaction 
information with the database files. This file is not available when ZfS is 
installed on a ZENworks 2 setup.

Running the Database

The database is run using the MGMTDBS.NCF file (located in the \SYSTEM 
directory on a server volume), which is executed from AUTOEXEC.NCF.

Database Caching

Database files can become very large, which is why a 48-MB cache is 
recommended on the server on which you are running the database. Caching 
will improve server performance because of how frequently information can 
be logged to the database.

Understanding the ZfS Inventory Database Schema

This section describes the design of the ZfS Inventory database schema 
implemented using the Common Information Model (CIM). To understand 
this document effectively, you should be familiar with terminology such as 
CIM. You should also have a solid understanding of Relation Database Based 
Managed Systems (RDBMS) and database concepts.

The following sections provide in-depth information:

� “What Is CIM?” on page 375

� “Implementation of the CIM Model Using the Relational Database 
Model” on page 376
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What Is CIM?

This document describes the design of ZfS Inventory database schema 
implemented using the CIM of the Distributed Management Task Force 
(DMTF).

The DMTF is the industry organization that is leading the development, 
adoption, and unification of management standards and initiatives for desktop, 
enterprise, and Internet environments. For more information on DMTF, see 
the  Distributed Management Task Force Web site at (www.dmtf.org/cim).

The DMTF CIM is an approach to the management of systems and networks 
that applies the basic structuring and conceptualization techniques of the 
object-oriented paradigm. The approach uses a uniform modeling formalism 
that, together with the basic repertoire of object-oriented constructs, supports 
the cooperative development of an object-oriented schema across multiple 
organizations. 

A management schema is provided to establish a common conceptual 
framework at the level of a fundamental typology—both with respect to 
classification and association, and with respect to a basic set of classes 
intended to establish a common framework for a description of the managed 
environment. The management schema is divided into the following 
conceptual layers:

� Core model

An information model that captures notions that are applicable to all areas 
of management.

� Common model

An information model that captures notions that are common to particular 
management areas, but independent of a particular technology or 
implementation. The common areas are systems, applications, databases, 
networks, and devices. The information model is specific enough to 
provide a basis for the development of management applications. This 
model provides a set of base classes for extension into the area of 
technology-specific schemas. The core and common models together are 
expressed as the CIM schema.

� Extension schemas

Represents technology-specific extensions of the common model.  These 
schemas are specific to environments, such as operating systems, for 
example, UNIX* or Microsoft* Windows*.
Database Administration ��	
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CIM is comprised of a specification and a schema. The specification defines 
the meta-schema plus a concrete representation language called managed 
Object Format (MOF) for schema representation.

Implementation of the CIM Model Using the Relational Database 
Model

Every CIM class (core or extended) has a corresponding table with the same 
name as that of the CIM class, created in the database. All attributes of this 
class also correspond to the attributes of the table with same name.  Rows in 
CIM tables correspond to the instances of the CIM classes. Also, every CIM 
table has a special attribute called ID$, which is the primary key of that table.  
This attribute uniquely identifies the rows of the table. Every CIM row or CIM 
object is accessed using its primary key.

For example, the core CIM class CIM_ManagedSystemElement is mapped to 
a relational view, ManagedSystemElement.  Similarly, the class attributes 
caption, description, and others are also created as attributes of the view.

In the following association, CIM_SystemDevice is an association class 
which associates the CIM_UnitaryComputerSystem class with that of the 
Managewise_MWProcessor class.  This is shown in the following illustration:

The ManageWise_MWProcessor represents the processors on the server, and 
the CIM_UnitaryComputerSystem represents the managed server. This 
association is called 1..m (1 to many relation) as a server may have more than 
one processor.  Thus, there may be one or more processor objects associated 
with one UnitaryComputerSystem object using the SystemDevice association. 
This is modeled in the relational database as follows.

Managewise_MWprocessor

PartComponent 

GroupComponent

m

1

CIM_UnitaryComputerSystem

CIM_SystemDevice

10  Pentium III 450
25  Pentium III 400

3  SERVER_ABC
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The UnitaryComputerSystem table has a row with ID 3, and the Processor 
table has two rows with ID 10 and 25. Assuming that these two processors 
reside on the same server, this is modeled in the following manner. 

A row in the SystemDevice table has two attributes, namely GroupComponent 
and PartComponent, with GroupComponent with value 3 and PartComponent 
with value 10.  Another row in the SystemDevice table will have 
GroupComponent assigned to 3 and PartComponent assigned to 10, indicating 
that the server server-abc has two processors.

An SQL query can be formed easily to get the processor information based on 
the server name or ID. This query is as follows :

SELECT UnitaryComputerSystem.name, MWProcessor.* from 
MWProcessor,UnitaryComputerSystem,SystemDevice WHERE 
UnitaryComputerSystem.id$=3 AND  
SystemDevice.GroupComponent=UnitaryComputerSystem.id$ AND 
SystemDevice.PartComponent=MWProcessor.id$

Modify the above query to accept the name of the server in place of the ID. 
This query is as follows:

SELECT UnitaryComputerSystem.name, MWProcessor.* from 
MWProcessor,UnitaryComputerSystem,SystemDevice WHERE 
UnitaryComputerSystem.id$=
(SELECT id$ FROM  UnitaryComputerSystem where name=’SERVER-
ABC’)AND 
SystemDevice.GroupComponent=UnitaryComputerSystem.id$ AND 
SystemDevice.PartComponent=MWProcessor.id$

The tables MWProcessor, UnitaryComputerSystem, and SystemDevice are 
joined in a single query with their key join conditions. The required tables 
must be joined to provide the necessary keys (in this case, id$) for getting the 
correct data from the database. 

Inventory Tables in the Database

The list of tables that ZfS Inventory uses is as follows.

CIM Class Name Details

InventoryScanner Details of the inventory scan that was 
executed on the server. This includes the 
scan date and the name of the inventory 
server to which the scan was sent.
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MWDesktopMonitor Monitor details of the servers, such as 
type, resolution, and so on.

EnvironmentVariableSetting Servers’s environment variable name 
and the value set for Windows NT 
servers.

BIOS Hardware BIOS information of the 
machine, including release date, ID 
bytes, copyright string, model, and so on.

ConfigurationFile Information about the configuration files 
on the machine. This includes 
AUTOEXEC.BAT, CONFIG.SYS, 
WIN.INI, SYSTEM.INI, and so on. 
Attributes used are the name and 
contents to store the name of the 
configuration file and the contents in it, 
respectively. This is stored only for 
Windows NT* servers.

MWKeyboard Server’s keyboard details, including the 
number of keys, number of function keys, 
type, subtype, typematic rate, and delay.

Bus Type of bus used in the system, including 
PCI, version, and so on.

SerialPort Same as Port Class, also stores serial 
port information, such as COM1 and 
COM2.

ParallelPort Same as Port Class, also stores parallel 
port information, such as LPT1 and LPT2.

VideoAdapter Installed video adapter information, such 
as type, chipset, and DACtype.

MWDiskDrive Installed disk information, including disk 
type (floppy disk, hard disk, tape, CD-
ROM), cylinders, sectors, tracks, and 
partitions.

CIM Class Name Details
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MWLocalFileSystem Local file system on the Winsdows NT 
server, such as C:, D:, and so on.   The 
attributes used are sectorspertrack, 
filesystemtype (FAT, NTFS, and so on), 
and volumeserialnumber.

LogicalDisk This class stores information about the 
volumes mounted on the NetWare® 
server.

MWRemoteFileSystem Mapped drives on the server, including 
the name of the mapped drive and the 
directory path. This is stored only on the 
Windows NT server.

NTService Name and status (running or stopped) of 
the services running on Windows NT 
servers.

MWPointingDevice Attached mouse on the system,  
including the number of buttons, port, and 
IRQ.

MWOperatingSystem Installed operating system on the system, 
including the OS type and version. This is 
stored only for the Windows NT server.

NetWareOperatingSystem Stored only for NetWare servers. This 
class has attributes specific to the 
NetWare operating system.

MWProcessor Processor details, including the current 
clock speed, family, stepping, and so on.

ComponentID A separate class created to store the 
name and details of the instrumented 
DMI components. These details include 
the identifying number, install date, 
name, and vendor. This is stored only on 
the Windows NT server.

EthernetProtocolEndPoint MAC address of the server.

IPProtocolEndPoint IP address of the server.

IPXProtocolEndpoint IPXTM address of the server.

CIM Class Name Details
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Association Classes and Attributes

An association is a class that acts as a referencing entity, which associates one 
class with another. In ZfS Inventory, the CIM_UnitaryComputerSystem class 
is a focal point of reference. This means that all servers in the database have a 
unique row with a unique ID in it. It describes the name and properties of the 
server that is scanned and stored in the database. All other classes have an 
association with this class. 

To summarize, every class used in ZfS Inventory associates itself to the 
UnitaryComputerSystem either directly or indirectly. 

For example, a server’s processor information is represented in the database 
in the following way. The name of the server is stored in a 
UnitaryComputerSystem class table and the processor information is stored in 
a MWProcessor class table. These two tables are associated using another 
class table, SystemDevice. SystemDevice has two attributes called 
GroupComponent and PartComponent. GroupComponent refers to the 

WsUser Name of the user logged in to the server. 
This is stored only on the Windows NT 
server.

CDROMDrive Installed CD-ROM. Drive information on 
the server  includes the name, 
description, mapped drive, manufacturer, 
and product ID.

DnsName DNS name of the server.

NetworkAdapter NIC type and name of the card installed 
on the server. This is stored the 
description field.

IPNetwork Subnet mask.

Product Installed software details, such as name, 
description, and version.

POTSModem Name, description, and serial port 
connected to the attached modem 
device.

CIM Class Name Details
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UnitaryComputerSystem and the PartComponent refers to the MWProcessor. 
This is known as direct association. This is shown in the following illustration.

There are a few other associations called indirect associations. They refer to 
UnitaryComputerSystem using other associations. 

For example, the MonitorResolution table contains the resolution of the 
desktop monitor. Other details of the desktop monitor, such as type and mode, 
are in the MWDesktopMonitor table. MWDesktopMonitor is associated to 
UnitaryComputerSystem through the SystemDevice association and 
MonitorResolution is associated to MWDesktopMonitor using the 
MonitorSetting association. By joining MWDesktopMonitor and 
MonitorResolution, it is possible to get the resolution details of the monitor of 
the server.

Managewise_MWprocessor

PartComponent 

GroupComponent

m

1

CIM_UnitaryComputerSystem

CIM_SystemDevice
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The following table provides the details about the associations that ZfS 
Inventory uses.

Lookup Class Target Class Association Class Attribute 1 Attribute 2

MWProcessor UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

MWDesktop-
Monitor

UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

DesktopMonitor UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

ParallelPort UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

SerialPort UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

PartComponent 

UnitaryComputerSystem

GroupComponent  

MWDesktopMonitor

Setting  

MonitorResolution

CIM_SystemDevice

MonitorSetting

Element
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ConfigurationFile MWLocalFile-
System

FileStorage PartComponent GroupComponent

MWSCSICon-
troller

UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

MWKeyboard UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

MWPointing-
Device

UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

Bus UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

MWDiskDrive UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

CDROMDrive UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

Server UnitaryComputer-
System

SystemCompo-
nent

PartComponent GroupComponent

BIOS UnitaryComputer-
System

InstalledBIOS PartComponent GroupComponent

MonitorResolu-
tion

MWDesktopMoni-
tor

MonitorSetting Setting Element

NTService UnitaryComputer-
System

HostedService Dependent Antecedent

OperatingSys-
tem

UnitaryComputer-
System

InstalledOS PartComponent GroupComponent

OperatingSys-
temSetting

MWOperatingSys-
tem

OSElementSetting Setting Element

DOSOperating-
System

UnitaryComputer-
System

InstalledOS PartComponent GroupComponent

DOSStyleMem-
orySetting

UnitaryComputer-
System

InstalledOS PartComponent GroupComponent

Lookup Class Target Class Association Class Attribute 1 Attribute 2
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ExtendedMem-
orySetting

DOSOperating-
System

DOSMemoryEl-
ementSetting

Setting Element

ExpandedMem-
orySetting

DOSOperating-
System

DOSMemoryEl-
ementSetting

Setting Element

MWOperating-
System

UnitaryComputer-
System

InstalledOS PartComponent GroupComponent

NetwareOpera-
tingSystem

UnitaryComputer-
System

InstalledOS PartComponent GroupComponent

MWPhysical-
Memory

UnitaryComputer-
System

SystemPhysical-
device

PartComponent GroupComponent

Memory UnitaryComputer-
System

ComputerSystem-
Memory

PartComponent GroupComponent

MWLocalFile-
System

UnitaryComputer-
System

HostedFileSystem PartComponent GroupComponent

MWRemoteFile-
System

UnitaryComputer-
System

HostedFileSystem PartComponent GroupComponent

MWDiskette-
Drive

UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

CDROMDrive UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

IPProtocolEnd-
point

UnitaryComputer-
System

HostedAccess-
Point

Dependent Antecedent

IPXProtocolEnd-
point

UnitaryComputer-
System

HostedAccess-
Point

Dependent Antecedent

EthernetProto-
colEndpoint

UnitaryComputer-
System

HostedAccess-
Point

Dependent Antecedent

DNSName UnitaryComputer-
System

Designates Designation Host

EnvironmentVa-
riableSetting

MWOperatingSys-
tem

EnvironmentEl-
ementSetting

Setting Element

Lookup Class Target Class Association Class Attribute 1 Attribute 2
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To read the table, follow these instructions:

� Lookup Class is the class that provides the inventory attributes, for 
example, Product. 

� Target Class is the class to which it is associated. This class is 
UnitaryComputerSystem for direct associations.

� Association Class is the class that associates the Lookup Class with 
Target Class.

� Association Attribute 1 refers to the Lookup Class.

� Association Attribute 2 refers to the Target Class.

To get all software products installed on a server, form the following query 
using the above table:

Product UnitaryComputer-
System

InstalledProduct Product ComputerSystem

InventoryScan-
ner

UnitaryComputer-
System

InstalledProduct Product ComputerSystem

ComponentID UnitaryComputer-
System

ComponentSys-
tem

PartComponent GroupComponent

MWPCVideo-
Controller

UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

VideoAdapter UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

MWCacheMe-
mory

UnitaryComputer-
System

ComputerSystem
Memory

PartComponent GroupComponent

PhysicalCompo-
nent

UnitaryComputer-
System

SystemPhysical-
Device

PartComponent GroupComponent

WsUser UnitaryComputer-
System

WsUsedBy WsUser Computer

NetworkAdapter UnitaryComputer-
System

SystemDevice PartComponent GroupComponent

IPNetwork ipprotocolendpoint InIPNetwork GroupComponent PartComponent

Lookup Class Target Class Association Class Attribute 1 Attribute 2
Database Administration ��	

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a25 22 March 00
SELECT Product.name, Product.version FROM Product, 
UnitaryComputerSystem,InstalledProduct WHERE 
Product.id$=InstalledProduct.Product AND 
UnitaryComputerSystem.id$=InstalledProduct.ComputerSystem 
AND UnitaryComputerSystem.id$ = (SELECT id$ FROM 
UnitaryComputerSystem WHERE Name=?)

By replacing ? with the name of the server, the query provides the name and 
version of the products installed on the server.

Similarly, build different queries to get other inventory information. Follow 
this format:

SELECT Lookupclass.* FROM LookupClass, TargetClass, 
AssociationClass WHERE 
LookupClass.id$=AssociationClass.Attribute1 AND
TargetClass.id$=AssociationClass.Attribute2 AND 
UnitaryComputerSystem.id$ = (SELECT id$ FROM 
UnitaryComputerSystem WHERE Name=?)

Substitute the variables in angle brackets with values from the table.

Backing Up the Database

You can back up the following:

� “Backing Up the Topology/Alarm Database” on page 386

� “Backing Up the Inventory Database” on page 387

Backing Up the Topology/Alarm Database

From the management console, follow this procedure to back up the topology/
alarm database:

� Right-click the Site Server object and select Properties. 

� Select the Database Administration tab.

� Enter the path of the directory to back up.

You can back up the database files to any volume on the management 
server only.

� Click Apply. 

ZfS sends a remote SQL command to store the files. The four MW*.DB 
and MW.LOG files are copied to the backup directory.
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Backing Up the Inventory Database

Ensure that the Inventory database is loaded and running. From the 
management console, follow this procedure to back up the Inventory database:

� Right-click the Site Server object and select Properties.

� Select the Database Administration tab > click Inventory Database 
backup.

� Enter the path of the directory to back up the Inventory database.

You can back up the database file to any volume on the management 
server only.

� Click OK.

The database (ZENINV.DB) and the database log file (ZENINV.LOG) are 
copied to the backup directory.

Changing Database Passwords

ZfS allows you to access the topology/alarm and server inventory databases at 
three different levels: Administrator account, Updater account, and Reader 
account. You can set passwords for the three different user accounts. This 
change of passwords will not affect the ZENINV.DB inventory database.

From the management console, follow this procedure to modify the database 
passwords: 

� Right-click on the Site Server object and select Properties. 

� Select the Change Database Passwords tab.

� Enter the new passwords and confirm.

� Click Apply. 
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Troubleshooting

The following sections provide troubleshooting help for ZENworksTM for 
Servers (ZFS) Management and Monitoring Services:

� “Troubleshooting Tools” on page 390

� “Troubleshooting Issues” on page 392

� “Troubleshooting ZENworks for Servers” on page 394

� “Troubleshooting Server Policies” on page 398

� “Troubleshooting Tiered Electronic Distribution” on page 400

� “Troubleshooting Server Software Packages” on page 402

� “Troubleshooting the Traffic Analysis Agent for NetWare” on page 404

� “Troubleshooting the Traffic Analysis Agent for Windows NT” on page 
408

� “Troubleshooting the Traffic Analysis Agent for Windows 2000” on page 
411

� “Troubleshooting MIB Compiler Error Messages” on page 411

� “Troubleshooting Traffic Analysis” on page 440

� “Troubleshooting Inventory Server” on page 451

� “Troubleshooting Remote Control for NetWare Servers” on page 454

� “Server Inventory Error Messages on NetWare Servers” on page 455

� “Server Inventory Error Messages on Windows NT/2000 Servers” on 
page 466

� “Remote Management Console Error Messages” on page 473

� “Remote Management Agent Error Messages” on page 475
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� “Troubleshooting a ZENworks 2 Installation over ZENworks for 
Servers” on page 476

Troubleshooting Tools

There are several methods you can use to troubleshoot ZfS:

� “Running Reports” on page 390

� “Using Remote Console” on page 390

� “Using Log Files” on page 391

� “Setting Trace Output Levels” on page 391

� “Using ConsoleOne” on page 392

Running Reports

Reporting gives a high-level overview of which nodes succeeded. All known 
error conditions are caught and error conditions are reported to the database. 
However, when a process status is in-process, errors can occur or failures can 
occur on the node that are not caught (for example, the machine went down or 
the process was killed).

The distribution-level reports show the view from the distributor side and are 
very useful for checking which subscribers succeeded or failed to receive a 
particular distribution. The subscriber reports are used to determine which 
distributions a single subscriber has received.

Subscribers that did not attempt to receive the distribution (because they were 
not set up correctly, or are not running) will not have information displayed 
on the report. You can compare the number expected against the actual 
numbers and look for missing subscribers on the report. Once subscribers are 
set up and functioning, this should not be a common problem.

Using Remote Console

The remote console can be used to view the current activity and status of a 
node. You can access the remote console from the context menu on a 
Distributor, Subscriber, or Proxy object in Novell® ConsoleOneTM.

The information level will usually be set low for remote console; therefore, 
you will not receive much detail. You can use the SETREMOTELEVEL 6 
��� Place Book Title Here
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command to get maximum detail printing to the remote console. Set it back to 
a lower level (usually 4) after you have finished so that the node will run at 
maximum performance.

Using Log Files

The log file can be used to view previous failures and other important 
information. You can temporarily increase the level of information going to 
the log file using the SETFILELEVEL 6 command.

The output for most console commands that you enter is not usually written to 
the log file. If you want this information to go to the log temporarily, enter 
logconsoleoutputon. Then, if you enter another command, such as 
THREADS, the information will be written to the log file. Enter 
logconsoleoutputoff to disable logging when you have finished.

Java* caches the log contents as it is written, so the latest entries will not show 
unless the node is exited. To write all entries to the log without exiting the 
node, enter flushlog at the prompt.

The log file can be viewed remotely through the file system, or sent to Novell 
Technical ServicesSM for debug information. This is a common debugging 
tool.

Setting Trace Output Levels

Messaging is an option for all ZfS objects. Messaging can be set at several 
levels, Trace being the most detailed.

Trace messages are output at various levels to various locations. Trace-level 
messaging should only be used for debugging. It is configured on each node 
object in ConsoleOne from the General/Messages tab.

You may want to set up e-mail or SNMP to be notified of errors or warnings. 
All other output should be set to the display information level for normal 
production.

ZfS will run approximately 20 times slower when putting trace statements out 
at trace level. The trace level can be set on the fly for console, remote console, 
and the log file as needed for debugging.
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Using ConsoleOne

Most administration will be done through ConsoleOne. If there are problems 
with a snap-in, such as it is not saving when you click OK, the snap-in won’t 
show for an object. You may need to print the trace messages for ConsoleOne 
to find out what is wrong.

You can enable these messages by adding -DEBUG -WINDOWOUT to the 
command line in the shortcut that runs ConsoleOne (or type it at the console 
prompt). This works on version 1.2c of ConsoleOne.

You can use the batch file provided to launch ConsoleOne from the \BIN 
directory in the ConsoleOne installation area.

Another feature of ConsoleOne that is useful is the Other tab. This tab lists all 
attributes that are not handled or displayed by the remaining tabs. This allows 
a view of some of the underlying data that is used by ZfS in the NDS® schema 
that is not typically viewed by administrators (such as closest proxy, network 
address, and so on).

Troubleshooting Issues

Exceptions and the Novell Simple Naming Service should be considered 
when troubleshooting:

� “Exceptions” on page 392

� “Novell Simple Naming Service” on page 393

Exceptions

An attempt is made to display meaningful messages to the user when 
something goes wrong. However, because of the nature of the Java language, 
and because ZfS does not handle every exceptional condition possible, you 
will inevitably encounter a Java exception while using ZfS.

With each exception that occurs, ZfS will typically print an entire stack trace 
to help Novell Technical Services understand how ZfS arrived in its current 
state. The following is an example Java exception that was forced in the Tiered 
Electronic Distribution (TED) system:

*** Exception: java.io.FileNotFoundException: File to
distribute was not found: sys:\notthere.txt
java.io.FileNotFoundException: File to distribute was not
found: sys:\notthere.txt at
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om.novell.application.zenworks.ssd.agents.distributor.
FileDistributorAgent.elements(FileDistributorAgent.java:11)
at com.novell.application.zenworks.ssd.core.distribution.
Update.updateArchive(Update.java:209) at
com.novell.application.zenworks.ssd.core.distribution.
Update.run(Update.java:84)

The type of exception is printed first:

java.io.FileNotFoundException

Exception object names are usually descriptive and may provide a clue to what 
is failing.

Following the exception type, there will usually be a string that tells you what 
went wrong. In this case, it is "File to distribute was not found: 
SYS:\NOTTHERE.TXT." This should provide the most useful information to 
you for troubleshooting.

Following that string is the call stack that shows which methods were invoked 
on which objects (and the Java source filename and line number), in the order 
they were called from where the thread started to where the exception was 
thrown.

Novell Simple Naming Service

ZfS requires the Novell Simple Naming Service for CORBA* to be running 
before the Server Software Packages components will continue to load. This 
naming service is used to resolve names to remote CORBA objects that are 
used by ZfS Server Management. It is used in place of the Visigenic* OS 
Agent for name resolution because it does UDP broadcasts.

The Novell naming service relies on NDS for service location, which saves all 
of the chatter. It is listening on port 2544, which has been reserved with IANA, 
but can be changed to use another port (use the -p #### switch on the 
command line).

All communication between nodes, such as events and remote object calls, 
relies on the naming service. If you do not see trace messages on the naming 
service, such as attempting to resolve x, then you can turn it on by adding the 
-D switch to the command line in the .NCF or batch file that runs the naming 
service (SYS:\TED\NS.NCF).
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You can also run NSSTATUS.NCF to print the status of the currently-
registered naming service, and NSEXIT.NCF to shut down the currently-
registered naming service.

Troubleshooting ZENworks for Servers

This section gives solutions to problems you might encounter that are general 
to ZENworks for Servers.

� “ConsoleOne won’t start” on page 394

� “HTTP411.NLM won’t load on my NetWare 4.11 server” on page 394

� “I get the message "Removing files 
SYS:\ZFS2\MWSERVER\NMDISK\dat\netxplor*.dat"” on page 395

� “I receive errors about not connecting to the database” on page 395

� “My browser won’t load the ZfS page” on page 395

� “On the server console, the ZfS, Distributor, Proxy, and Subscriber Java 
processes do not use my local time zone” on page 396

� “ZfS Policies and TED components are taking too long to come up” on 
page 398

ConsoleOne won’t start

Explanation: ConsoleOne will not start. You click the ConsoleOne shortcut (which points 
to the server where ConsoleOne was installed) and it will not launch.

Action: The workstation you are starting ConsoleOne on may not have the required 
drive mapping or Novell ClientTM .DLL files. You must install the appropriate 
updates to the Novell Client and map a drive to the directory on the server 
where the ConsoleOne software exists.

HTTP411.NLM won’t load on my NetWare 4.11 server

Explanation: The HTTP stack fails to load on your NetWare 4.11 server.

Action: On NetWare 4.11 servers, you must first install Winsock for HTTP411.NLM 
to load successfully. Winsock can be installed from NW4SP8a, located on the 
CD under the \TOOLS\NETWARE.411 directory. The Winsock files are 
located in the \TOOLS\COREDUMP directory contained in the Support Pack 
file structure. See the DBNET.TXT file contained in that directory for 
instructions.
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I get the message "Removing files 
SYS:\ZFS2\MWSERVER\NMDISK\dat\netxplor*.dat"

Explanation: This message appears if there is a lock on the files listed in the message. This 
occurs if you run NETXPLOR and SLOADER, stop NETXPLOR without 
stopping SLOADER, then attempt to restart NETXPLOR.

Action: If you need to stop and restart NETXPLOR, stop SLOADER as well. The 
restart SLOADER after you restart NETXPLOR. If you just want to stop 
NETXPLOR without restarting, you can keep SLOADER running without a 
problem.

I receive errors about not connecting to the database

Explanation: You needed to re-create the Database object. However, you’re now receiving 
error messages about the ZfS Java process not being able to connect to the 
database, or the ZfS Java process cannot read the ZENworks for Servers 
policy.

Action: When re-creating the Database object, you must also assign a trustee to the 
object. 

My browser won’t load the ZfS page

Explanation: The ZENworks for Servers option (Web access to the ZfS console) that is 
displayed on the Context menu of a server object does not work, even if the 
ZfS Java process is running. The browser comes up, but doesn’t display the 
ZfS page.

Action: For this to work, the HTTP Stack must be loaded prior to running ZFS.NCF. 
If the ZfS Java process was loaded first, unload the HTTP Stack, unload the 
ZfS Java process, then reload the HTTP Stack first.

For NetWare® 5.x, the HTTP Stack file is HTTPSTK.NLM. For NetWare 4.x, 
the HTTP Stack file is HTTP411.NLM. These NetWare Loadable ModuleTM 
(NLMTM) files must be loaded before ZFS.NCF is loaded.

Also check the AUTOEXEC.NCF file to make sure the correct order is 
followed there.

The ZfS installation program installs the HTTP Stack. However, you can 
install it manually from the installation CD. Copy the HTTPSTK.NLM or 
HTTP411.NLM file and the MIMTYP.TXT file to the SYS:\SYSTEM 
directory on the server. Then make sure the AUTOEXEC.NCF is updated.
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,03257$17��Do not change the HTTP Stack default port number, or run a Web 
server at port numbers 8008 or 8009. If you do, ZENworks for Servers Web-based 
functionality will not work. Port numbers will be dynamic in a future release.

On the server console, the ZfS, Distributor, Proxy, and Subscriber Java processes do 
not use my local time zone

Explanation: You are receiving incorrect time stamps when running ConsoleOne.

Action: If the TZ environment variable isn’t set, ConsoleOne displays times in 
Greenwich Mean Time (GMT) and interprets any time information you enter 
as GMT.

To set ConsoleOne to the correct time zone:

� Exit ConsoleOne.

� To set the TZ environment variable, do one of the following:

� To set the TZ environment variable in Windows* 95/98, add a SET 
command to the AUTOEXEC.BAT file > restart the workstation.

� To set the TZ environment variable in Windows NT*, add the 
variable on the Environment tab in the System control panel. For 
example:

SET TZ=MST 7MDT

The first three characters of the value specify your time zone and are 
required. For example, MST means mountain standard time (U.S. 
and Canada), EST means eastern standard time (U.S. and Canada), 
GST means german standard time, and so on. They must be in 
uppercase.

,03257$17��The GMT time and the time zone set on the server are used 
to calculate the local time. Please check the time setting on the server. For a 
list of time zone acronyms that are valid for Java, see the table after Step 3.

The fourth character specifies the number of hours offset from GMT, 
and is optional. It doesn't matter whether the offset is the number of 
hours before or after GMT. Either way, you can use an unsigned 
number.

The last three characters specify whether Daylight Saving Time is in 
effect, and are optional. For example, MDT means mountain 
daylight time.

� Run ConsoleOne again.
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Acronym Time Zone (listed going eastward from Greenwich, England)

GMT Greenwich Mean Time

ECT European Central Time

EET Eastern European Time

ART (Arabic) Egypt Standard Time

EAT Eastern Filtrating Time

MET Middle East Time

NET Near East Time

PLT Pakistan Lahore Time

IST India Standard Time

BST Bangladesh Standard Time

VST Vietnam Standard Time

CTT China Taiwan Time

JST Japan Standard Time

ACT Australia Central Time

AET Australia Eastern Time

SST Solomon Standard Time

NST New Zealand Standard Time

MIT Midway Islands Time

HST Hawaii Standard Time

AST Alaska Standard Time

PST Pacific Standard Time

PNT Phoenix Standard Time

MST Mountain Standard Time
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ZfS Policies and TED components are taking too long to come up

Explanation: It seems to take the ZfS Java process and each TED Java process a long time 
to come up. The following message may display on your server console during 
this wait:

We are returning a DirContext whose class is: Javax.naming.
directory.InitialDirContext

Action: If you have a DNS server entry specified in the RESOLV.CFG file on your 
server, and for some reason the server cannot connect to the DNS server, the 
ZfS Java process can take 26 minutes to start and an additional 4 or more 
minutes to read in and action the policies, and the TED components can take 
about three or more minutes for each DNS server entry before they load. 
Check the RESOLV.CFG file for invalid DNS server addresses. Make sure 
the server with the RESOLVE.CFG file can see all DNS servers listed in the 
file.

Troubleshooting Server Policies

This section gives solutions to problems you might encounter when setting up 
and using Server policies.

� “I get errors in gathering SET parameters” on page 399

� “The SMTP Host attributes and SNMP Trap Target addresses cannot 
resolve the NetWare server DNS name” on page 399

CST Central Standard Time

EST Eastern Standard Time

IET Indiana Eastern Standard Time

PRT Puerto Rico and Virgin Islands Time

CNT Canada Newfoundland Time

AGT Argentina Standard Time

BET Brazil Eastern Time

CAT Central African Time

Acronym Time Zone (listed going eastward from Greenwich, England)
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� “The ZfS Java processes won’t load (and I have partitions and WAN 
links)” on page 399

I get errors in gathering SET parameters

Explanation: When you try to access the SET parameters on your server when setting up the 
NetWare Set Parameters policy, you receive an error.

Action: Make sure the ZfS Java process is running on the server.

Action: Make sure the server is running the IP protocol.

Action: Make sure the IP address is visible in the server object:

� You may need to run INETCFG to get the server object updated if you 
have manually added IP services.

� On a NetWare 4.2 server, you may need to enter the following at the 
serve’s console prompt:

set dstrace = limber ip on

This will make the IP address visible in the server object.

The SMTP Host attributes and SNMP Trap Target addresses cannot resolve the 
NetWare server DNS name

Explanation: NetWare servers cannot resolve DNS names unless a RESOLV.CFG file is 
created and configured in the SYS:\ETC directory. The NetWare server's 
domain name and DNS server address must be configured in this file. Consult 
your NetWare documentation for help on setting up a RESOLV.CFG file.

Action: A workaround is using IP addresses for these two policy settings, because 
server names cannot currently be resolved.

SMTP Host: Use the IP address of the mail server.

SNMP Traps - New Target: Use the IP address of the server.

The ZfS Java processes won’t load (and I have partitions and WAN links)

Explanation: You cannot load ZENworks for Servers when policies are in another partition 
that is accessed across a WAN link.

Action: To ensure that the ZfS processes will load for partitions that are accessed 
across a WAN, make sure that the Server Policies Package objects are in the 
same partition as the Server object. Also make sure that the Search policy does 
not require searching outside the partition where the Server object exists.
Troubleshooting ���

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
Troubleshooting Tiered Electronic Distribution

This section gives solutions to problems you might encounter when setting up 
and using TED.

� “A distribution does not load” on page 400

� “A distribution is not distributed” on page 400

� “Distributions are not being sent after I moved a Proxy object in the tree” 
on page 401

� “I get a "file not found" exception on my NetWare 4.x server” on page 401

� “Performance is sluggish” on page 401

� “The distributor cannot distribute a Server Software Package” on page 
401

� “The subscriber suddenly stops extracting” on page 402

A distribution does not load

Explanation: You cannot get your distribution to load to send it to the subscribers.

Action: Distribution names cannot contain a period (.). Instead, use dashes (-) or 
underscores (_) as word separators. If you use a period in the distribution 
name, the distribution will not load for sending to subscribers.

A distribution is not distributed

Explanation: You assigned a distribution to a channel that does not belong to the 
distribution’s distributor. For example:

� Distributor 1 contains Channel 1 and Distribution 1

� Distributor 2 contains Channel 2 and Distribution 2

� Subscriber 1 has Subscription 1

� Subscription 1 is assigned to Channel 1

� Channel 1 has been associated with Distributions 1 and 2

Distribution 2 doesn’t get distributed from Channel 1 to Subscriber 1.

Action: Channels should only contain distributions from the distributor that owns the 
channel. For example, Distribution 2 in the above example cannot be 
associated with Channel 1, because Channel 1 belongs to Distributor 1, and 
Distribution 2 belongs to Distributor 2, which uses Channel 2.
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Distributions are not being sent after I moved a Proxy object in the tree

Explanation: After you moved the Proxy object to another location in the tree, distributions 
are no longer being sent to the subscribers. You have seen the following 
symptoms:

� The Proxy objects that are children of the Proxy object that was moved 
do not receive or send distributions.

� The Proxy objects that are children of the Proxy object that was moved 
continuously send an "Auto Authenticating..." message.

Action: If you use the Move option to move a Proxy object to a different container, 
distributions can no longer be sent to any subscribers using the proxy or any 
of the proxies listed on the Proxies tab of the Proxy object.

,03257$17��If, after you follow the steps to create a new Proxy object and the 
Proxy object displays an error -601 when it is loaded, the proxy’s .NCF file was not 
modified to reflect the new DN of the Proxy object. It still contains a reference to 
the Proxy object that was deleted.

I get a "file not found" exception on my NetWare 4.x server

Explanation: Your NetWare 4.x server sends an exception when it tries to negotiate the 
closest proxy when sending a distribution.

Action: NetWare 4.x servers can run out of file handles. Therefore, for 4.x servers, 
disable file locking in the distribution properties (for more information, see 
"Configuring the Distributions").

Performance is sluggish

Explanation: Performance is sluggish when running TED Java processes.

Action: This is often due to a memory problem. At present, Java programs generally 
use more memory than comparable native programs.

Make sure the workstation where ConsoleOne is running has sufficient RAM.

The distributor cannot distribute a Server Software Package

Explanation: The distributor was unable to distribute a software package.

The distributor’s command line picks up the Loop Back Address from the 
ETC\HOSTS file. However, the ETC\HOSTS file contained an invalid IP 
address. IP addresses are added to the ETC\HOSTS file during installation of 
NetWare.
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Action: Normally, the IP address of a server does not change. However, if it does, you 
must manually edit the alias entry in the ETC\HOSTS file and restart the 
server.

The subscriber suddenly stops extracting

Explanation: Your subscriber suddenly stopped extracting the distribution.

Action: If you down the distributor that the distribution was coming from, the 
subscriber’s extraction process will stop. However, it will resume from the 
beginning once the distributor’s server comes back up.

Troubleshooting Server Software Packages

This section gives solutions to problems you might encounter when setting up 
and using Server Software Packages.

� “I can see only one tree when adding set commands” on page 402

� “The content of a software package is no longer available” on page 403

� “The server abends when processing a software package” on page 403

� “Where are software package installation errors logged?” on page 404

� “Why did my attempt to recompile a software package fail?” on page 404

I can see only one tree when adding set commands

Explanation: If you try to add SET commands in either the software package or the package 
component, you can browse only the current tree where you are logged in.

Action: To see all available trees in software package properties:

� In ConsoleOne, click the Network object (the level just above the highest 
tree objects).

This sets your browsing level.

� Right-click a software package object > click Properties.

� Click the Requirements tab > Add > Set Commands.

You should now be able to browse all of the trees in your network.

To see all available trees in software package properties:

� In ConsoleOne, click the Network object (the level just above the highest 
tree objects).
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This sets your browsing level.

� Right-click a package component object > click Properties.

� Click the Set Commands tab > Add.

You should now be able to browse all of the trees in your network.

The content of a software package is no longer available

Explanation: In ConsoleOne, the software package name has changed to 
C:\path\filename.SPK and you can no longer access the software package or 
its components. This is because the .SPK file referenced by the software 
package has been renamed or is no longer in its original location.

Action: An .SPK file is a link to all of the components that make up the associated 
software package. If someone deletes or renames an .SPK file, none of the 
components of the software package will be accessible. To resolve a missing 
.SPK file, do one of the following:

� Rename the .SPK file. If the .SPK file was renamed, simply rename it 
back to its original name as displayed in the right pane when clicking the 
software package object.

� Locate the missing .SPK file. Replace the .SPK file in the path that is 
displayed in the right pane when clicking the software package object.

� Insert a software package that links to the .SPK file. In ConsoleOne, 
right-click the Server Software Packages name space > click Insert 
Software Package > browse to the location of the missing .SPK file > 
select the .SPK file > delete the software package object that now displays 
the incorrect path as part of its object name. (The correct software 
package object will display the same name as before.)

� Re-create the software package. If the .SPK file cannot be recovered, 
you must re-create the software package and its components.

The server abends when processing a software package

Explanation: A NetWare 4.x server abends when processing a Server Software Package.

Action: If the software package contains instructions to run an NCF script that displays 
text on the server console, expecting user input at the keyboard, a NetWare 4.x 
server will abend.

See the Novell Technical Services TID #2955452 (http://support.novell.com) 
on this subject for instructions on obtaining a fix for this problem.
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Where are software package installation errors logged?

Explanation: By default, they are logged in ZFSLOG.TXT, unless you specify otherwise in 
the ZENworks for Servers policy. You can also send the error messages to a 
server console, a log file, or as an e-mail message. 

Why did my attempt to recompile a software package fail?

Explanation: You created a software package that included copying some files from a 
specific server that is mapped to a network drive, such as G:. Later, that server 
is no longer mapped to G:. When you attempt to recompile the package, it 
fails.

Action: The failure occurred because the software package was created to copy files 
from a server mapped to G:, while the recompile effort was directed in an 
environment where G: was not mapped to that server.

You should create, edit, and compile Server Software Packages, both the .SPK 
and .CPK files, in the same environment (in other words, using the same drive 
mappings).

Troubleshooting the Traffic Analysis Agent for NetWare

The following sections provide information about troubleshooting the.

� “After the traffic analysis agent for NetWare is installed, the NE2-
32.LAN driver cannot be loaded” on page 405

� “After the traffic analysis agent for NetWare is installed, the 
NE3200.LAN driver cannot be loaded” on page 405

� “After the traffic analysis agent for NetWare is installed, the 
SMART386.LAN driver cannot be loaded” on page 405

� “LANZCON does not load” on page 406

� “The LANalyzer - Adapter [MAC address] is not monitored because it is 
not a supported media type” on page 406

� “The LANalyzer - Adapter [MAC address] is not monitored because the 
driver's promiscuous mode cannot be turned on” on page 406

� “The LANalyzer - Adapter [MAC address] is not monitored because the 
traffic analysis agent for NetWare cannot allocate memory” on page 406

� “The LANalyzer - Ethernet adapter [MAC address] is not monitored 
because it is a pipelined adapter.” on page 407
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� “The LANalyzer - Ethernet adapter [MAC address] is not monitored 
because the driver does not support promiscuous mode” on page 407

� “The LANalyzer - Token Ring adapter [MAC address] is not monitored 
because it is a pipelined adapter” on page 407

� “The LANalyzer - Token Ring adapter [MAC address] is not monitored 
because the driver does not support raw send” on page 408

� “The LANalyzer - Token Ring/FDDI adapter [MAC address] is not 
monitored because the driver does not support promiscuous mode” on 
page 408

� “Your server abended when you backed it up after installing the traffic 
analysis agent for NetWare” on page 408

After the traffic analysis agent for NetWare is installed, the NE2-32.LAN driver cannot 
be loaded

Explanation: When you installed the traffic analysis agent for NetWare, the NE2-32.LAN 
driver was updated with a driver named NE2_32.LAN. Because the driver 
name was changed, you need to update the files that load drivers.

Action: Modify the files that load the adapter drivers to call the NE2-32.LAN driver, 
and then load the NE2_32.LAN driver.

After the traffic analysis agent for NetWare is installed, the NE3200.LAN driver cannot 
be loaded

Explanation: When you installed the traffic analysis agent for NetWare, the NE3200.LAN 
driver was updated with a driver named NE3200P.LAN. Because the driver 
name was changed, you need to update the files that load drivers.

Action: Modify the files that load the adapter drivers to load the NE3200P.LAN 
driver.

After the traffic analysis agent for NetWare is installed, the SMART386.LAN driver 
cannot be loaded

Explanation: When you installed the traffic analysis agent for NetWare, the 
SMART386.LAN driver was updated with a driver named 
MADGEODI.LAN. Because the driver name was changed, you need to 
update the files that load drivers.

Action: Modify the files that load the adapter drivers to load the MADGEODI.LAN 
driver.
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LANZCON does not load

Explanation: This message may be displayed due to the change in the community string 
parameter of SNMP.

Action: Enter the control community string as a command line parameter at the 
NetWare console prompt while loading LANZCON.

LOAD LANZCON ControlCommunity = <control community string>

If LANZCON is launched without any command line argument, then the 
default control community string is PUBLIC.

The LANalyzer - Adapter [MAC address] is not monitored because it is not a 
supported media type

Explanation: The traffic analysis agent for NetWare supports Ethernet, token ring, and 
FDDI, and 100BaseT and 100VG-AnyLAN are considered Ethernet media 
types. Any other adapter media types are not supported.

Action: Use an Ethernet, token ring, or FDDI adapter for traffic analysis agent for 
NetWare operations.

The LANalyzer - Adapter [MAC address] is not monitored because the driver’s 
promiscuous mode cannot be turned on

Explanation: The driver is corrupted or the adapter is damaged.

Action: Replace the adapter. If the problem persists, call your Novell Authorized 
Reseller.

The LANalyzer - Adapter [MAC address] is not monitored because the traffic analysis 
agent for NetWare cannot allocate memory

Explanation: The traffic analysis agent for NetWare does not have adequate RAM available 
for it to build the internal data structures required to monitor the adapter.

Action: Do one or both of the following:

� Unload any unnecessary NLM files

� Add additional memory to your server
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The LANalyzer - Ethernet adapter [MAC address] is not monitored because it is a 
pipelined adapter.

Explanation: A pipelined adapter is one that begins to send received data to the driver before 
the entire packet has been received. The traffic analysis agent for NetWare 
cannot support this method of data reception because it must tally all the 
information in a packet before the information is sent to its destination.

Action: If the adapter lets you switch from pipelined mode to non-pipelined mode, do 
so. If the adapter cannot switch modes, use a non-pipelined adapter for traffic 
analysis agent for NetWare transactions. Check the Novell Technical Services 
Web site (http://support.novell.com) for information regarding availability of 
the recommended adapters. You might have to contact your adapter vendor for 
the appropriate adapter.

The LANalyzer - Ethernet adapter [MAC address] is not monitored because the driver 
does not support promiscuous mode

Explanation: A promiscuous mode driver receives all the packets and errors on the network 
it is attached to. The traffic analysis agent for NetWare requires promiscuous 
mode to function properly, and does not support non-promiscuous mode 
Ethernet or token ring adapters.

Action: Install a promiscuous mode driver on the server. Check the Novell Technical 
Services Web site (http://support.novell.com) for information regarding 
availability of the latest promiscuous mode drivers. You might have to contact 
your adapter vendor for the appropriate driver.

The LANalyzer - Token Ring adapter [MAC address] is not monitored because it is a 
pipelined adapter

Explanation: A pipelined adapter begins to send received data to the driver before the entire 
packet has been received. The traffic analysis agent for NetWare cannot 
support this method of data reception because it must tally all the information 
in a packet before the information is sent to its destination.

Action: If the adapter lets you switch from pipelined mode to non-pipelined mode, do 
so. If the adapter cannot switch modes, use a non-pipelined adapter for traffic 
analysis agent for NetWare transactions. Check the Novell Technical Services 
Web site (http://support.novell.com) for information regarding availability of 
the recommended adapters. You might have to contact your adapter vendor for 
the appropriate adapter.
Troubleshooting ���

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
The LANalyzer - Token Ring adapter [MAC address] is not monitored because the 
driver does not support raw send

Explanation: The traffic analysis agent for NetWare requires an adapter driver that supports 
the raw send feature. An adapter driver that supports raw send allows 
applications to build both the header and data components of a frame. The 
driver then receives the packet and sends it to its destination.

Action: Install an adapter driver on the server that supports raw send. Check the Novell 
Technical Services Web site (http://support.novell.com) for information 
regarding availability of the recommended drivers. You might have to contact 
your adapter vendor for the appropriate driver.

The LANalyzer - Token Ring/FDDI adapter [MAC address] is not monitored because 
the driver does not support promiscuous mode

Explanation: A promiscuous mode driver receives all the packets and errors on the network 
it is attached to. The traffic analysis agent for NetWare requires promiscuous 
mode to function properly, and does not support non-promiscuous mode 
Ethernet, token ring, or FDDI adapters.

Action: Install a promiscuous mode driver on the server. Check the Novell Technical 
Services Web site (http://support.novell.com) for information regarding 
availability of the latest promiscuous mode drivers. You might have to contact 
your adapter vendor for the appropriate driver.

Your server abended when you backed it up after installing the traffic analysis agent 
for NetWare

Explanation: This problem is not related to the installation process. However, some traffic 
analysis agent for NetWare files were loaded and probably were open when 
you backed up the server. Depending on the backup software you use, backing 
up the LANZ.CFG file when it is open can abend the server.

Action: Do not back up the LANZ.CFG file when you back up the server.

Troubleshooting the Traffic Analysis Agent for Windows 
NT

The following sections provide information about troubleshooting the traffic 
analysis agent for Windows NT error messages.

� “Adapter is not monitored because it is not a supported media type” on 
page 409
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� “Broadcast and multicast addresses are displayed in the stations and 
conversations view on the Console” on page 409

� “False duplicate IP address alarm generated in a DHCP environment” on 
page 409

� “Installed network adapter not listed in Network Adapters screen” on 
page 410

� “Management Console reports "No Response"” on page 410

� “NetExplorer fails to discover the traffic analysis agent for Windows NT” 
on page 410

� “No SNMP Response” on page 410

� “RMON tables are not listed for the selected adapter” on page 410

Adapter is not monitored because it is not a supported media type

Explanation: Traffic analysis agent for Windows NT supports adapters on Ethernet, FDDI 
ring, and token ring media.

Action: Use the adapter of the supported media type for traffic analysis agent for 
Windows NT operations.

Broadcast and multicast addresses are displayed in the stations and conversations 
view on the Console

Explanation: Broadcast and multicast addresses are displayed to count the number of 
broadcast frames per station.

Action: No action is required.

False duplicate IP address alarm generated in a DHCP environment

Explanation: In a DHCP environment, the DHCP server assigns an IP address to a client 
when the client requests one. The IP address is released when the client is shut 
down. During the process of releasing the IP address to the DHCP server, the 
client sends a DHCPRELEASE packet. If this packet does not reach the 
DHCP server, false duplicate IP address alarms will be generated.

Action: Use LANZCON to disable generation of duplicate IP address alarms. For 
details, see “Configuring the Parameters of the Traffic Analysis Agent for 
Windows NT/2000” on page 287.
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Installed network adapter not listed in Network Adapters screen

Explanation: Installed network adapters are not listed on the Network Adapters screen if the 
adapter is not on a segment of a supported media type or if TCP/IP is not 
bound to the adapter.

Action: Ensure that TCP/IP is bound to the selected adapter.

Management Console reports "No Response"

Explanation: Adapter monitoring may be disabled.

Action: Use LANZCON to enable adapter monitoring. For details, see “Enabling or 
Disabling Network Adapter Monitoring” on page 290.

NetExplorer fails to discover the traffic analysis agent for Windows NT

Explanation: NetExplorerTM uses the Service Location Protocol (SLP) to discover the agent 
on a network. The Novell Client for Windows NT supports SLP. If the Novell 
Client for Windows NT has not been installed on the agent server or 
workstation, NetExplorer will not be able to discover the traffic analysis agent 
for Windows NT on the network.

Action: Ensure that you have installed the latest Novell Client for Windows NT.

No SNMP Response

Explanation: The machine is not on the network.

Action: Try to ping to some other hosts from Windows NT. If they do not respond, 
contact your system administrator.

Explanation: SNMP will not respond if the SNMP service for Windows NT is not running.

Action: Start the SNMP service by entering net start snmp at the command 
prompt.

Explanation: The SNMP service on Windows NT is not configured

Action: Check the community string of SNMP for read/write access.

RMON tables are not listed for the selected adapter

Explanation: RMON tables for a network adapter are displayed only if adapter monitoring 
has been enabled. RMON tables are not displayed if they have been deleted.

Action: Enable adapter monitoring using LANZCON. For details, see “Enabling or 
Disabling Network Adapter Monitoring” on page 290.
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Troubleshooting the Traffic Analysis Agent for Windows 
2000

� “The LANZCON utlility does not start” on page 411

� “The SNMP service does not start” on page 411

The LANZCON utlility does not start

Action: Delete MGMTAPI.DLL from the directory where LANZCON is installed. 

Action: Restart the LANZCON utility.

The SNMP service does not start 

Explanation: The Windows NT Management agent when installed, stops the SNMP 
service. 

Possible Cause: Windows NT Management agent is not supported on Windows 2000. 

Action: Uninstall Windows NT Management agent. 

To uninstall the Windows NT Management agent:

� Select Start>Programs>ZFS>Uninstall NTAgent.

� Click Yes to uninstall.

Action: Start the Traffic Analysis agent.

,03257$17��You can use the Windows NT server MIBs, bundled with Windows 
2000 SNMP service, instead of Windows NT Management agent. But you can 
obtain only the basic information about the server. The enhanced features of 
Windows NT Management agent like trending are not supported.

Troubleshooting MIB Compiler Error Messages

� “MIBCERR102: Error in the INDEX clause” on page 415

� “MIBCERR103: Unknown or aggregate type. Value can not be 
interpreted” on page 416

� “MIBCERR104: Number repeated in an enumerated list (named number 
list)” on page 416

� “MIBCERR105: Incorrect syntax: In enumeration list, expected '('” on 
page 416
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� “MIBCERR106: Incorrect syntax: In enumeration list, expected ')'” on 
page 417

� “MIBCERR107: Incorrect syntax: Expected ',' or '}'” on page 417

� “MIBCERR108: Incorrect syntax: Expected '{' after DEFVAL” on page 
417

� “MIBCERR109: Incorrect syntax: Expected '{' after VARIABLES” on 
page 418

� “MIBCERR110: Incorrect syntax: In SEQUENCE clause: Expected '{'” 
on page 418

� “MIBCERR111: Incorrect syntax: Expected a non-negative integer” on 
page 418

� “MIBCERR112: Incorrect syntax: Expected a type” on page 418

� “MIBCERR113: Incorrect syntax: Expected an integer” on page 419

� “MIBCERR114: Incorrect syntax: Expected an octet string” on page 419

� “MIBCERR115: Incorrect syntax: Expected a filename after HELP” on 
page 419

� “MIBCERR116: Incorrect syntax: Expected HELPTAG number after 
#HELPTAG” on page 419

� “MIBCERR117: Incorrect syntax: Expected identifier after ACCESS” on 
page 419

� “MIBCERR118: Incorrect syntax: Expected identifier after STATUS” on 
page 420

� “MIBCERR119: Incorrect syntax: Expected identifier” on page 420

� “MIBCERR120: Incorrect syntax: Expected an index object or index 
type” on page 421

� “MIBCERR121: Incorrect syntax: Expected module reference” on page 
421

� “MIBCERR122: Incorrect syntax: Expected number” on page 421

� “MIBCERR123: Incorrect syntax: Expected a string after 
DESCRIPTION” on page 421

� “MIBCERR124: Incorrect syntax: Expected string after REFERENCE” 
on page 422
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� “MIBCERR125: Incorrect trap annotation: Expected string after 
SUMMARY” on page 422

� “MIBCERR126: Incorrect trap annotation: Expected string after TYPE” 
on page 422

� “MIBCERR127: Incorrect trap annotation: Expected time index number 
after \#TIMEINDEX” on page 423

� “MIBCERR128: Incorrect syntax: In INDEX clause: Expected ... , 
INTEGER OPTIONAL” on page 423

� “MIBCERR129: Incorrect syntax: Expected ::=” on page 423

� “MIBCERR130: Incorrect syntax: Expected ACCESS” on page 423

� “MIBCERR131: Incorrect syntax: Expected BEGIN” on page 424

� “MIBCERR132: Incorrect syntax: Expected DEFINITIONS” on page 
424

� “MIBCERR133: Incorrect syntax: Expected ENTERPRISE” on page 424

� “MIBCERR134: Incorrect syntax: Expected HELPTAG item after 
HELP” on page 425

� “MIBCERR135: Incorrect syntax: Expected NULL” on page 425

� “MIBCERR136: Incorrect syntax: Expected identifier after STATUS” on 
page 426

� “MIBCERR137: Incorrect syntax: Expected SYNTAX” on page 426

� “MIBCERR138: Incorrect syntax: Expected ',' or FROM” on page 426

� “MIBCERR139: Incorrect syntax: Import clause: Expected symbol” on 
page 427

� “MIBCERR140: Illegal type in IndexPart” on page 427

� “MIBCERR141: Out of memory” on page 427

� “MIBCERR142: Premature end of file” on page 427

� “MIBCERR143: Syntax error in object ID” on page 428

� “MIBCERR144: Encountered unexpectedly long word” on page 428

� “MIBCERR147: Incorrect alarm trap annotation: Too many arguments 
after ARGUMENTS” on page 428

� “MIBCERR148: Linking error: Undefined identifier found” on page 428
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� “MIBCERR149: Linking error: Undefined type” on page 429

� “MIBCERR150: Linking error: IMPORT MIB module not found” on 
page 430

� “MIBCERR151: Linking error: Attempt to redefine this name” on page 
430

� “MIBCERR152: Linking error: Unexpected term in the definition” on 
page 430

� “MIBCERR153: Invalid characters found in the word” on page 431

� “MIBCERR154: Unexpected type after SEQUENCE OF” on page 431

� “MIBCERR155: Unrecognized type after SYNTAX” on page 431

� “MIBCERR156: Unrecognized value for SEVERITY” on page 431

� “MIBCERR157: Print operation cancelled, either due to operator cancel 
or operation cannot be completed” on page 432

� “MIBCERR158: Incorrect syntax: Expected a string after DISPLAY-
HINT” on page 432

� “MIBCERR159: Incorrect syntax: Expected STATUS” on page 432

� “MIBCERR202: Incorrect syntax: Expected MAX-ACCESS” on page 
433

� “MIBCERR203: Incorrect syntax: Expected identifier after MAX-
ACCESS, read” on page 433

� “MIBCERR204: Error in the ARGUMENT clause” on page 434

� “MIBCERR205: Incorrect syntax: Expected OBJECTS” on page 434

� “MIBCERR206: Error in the OBJECT clause” on page 434

� “MIBCERR207: Error in the MANDATORY-GROUPS clause” on page 
434

� “MIBCERR208: Incorrect syntax: Expected identifier after GROUP” on 
page 435

� “MIBCERR209: Incorrect syntax: Expected identifier after OBJECT” on 
page 435

� “MIBCERR210: Incorrect syntax: Expected enumeration or BITS after 
WRITE-SYNTAX” on page 435
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� “MIBCERR211: Incorrect syntax: Expected identifier after MIN-
ACCESS” on page 436

� “MIBCERR212: Incorrect syntax: Expected LAST-UPDATED” on page 
436

� “MIBCERR213: Incorrect syntax: Expected a string after LAST-
UPDATED” on page 436

� “MIBCERR214: Incorrect syntax: Expected ORGANIZATION” on page 
437

� “MIBCERR215: Incorrect syntax: Expected string after 
ORGANIZATION” on page 437

� “MIBCERR216: Incorrect syntax: Expected a string after CONTACT-
INFO” on page 437

� “MIBCERR217: Incorrect syntax: Expected a string after REVISION” 
on page 438

� “MIBCERR218: Incorrect syntax: Expected CONTACT-INFO” on page 
438

� “MIBCERR219: Incorrect syntax: Expected DESCRIPTION” on page 
438

� “MIBCWAR001: Unrecognized ACCESS type” on page 439

� “MIBCWAR002: Unrecognized STATUS type” on page 439

� “MIBCWAR003: Ignoring named number, since value exceeds 32767” 
on page 439

� “MIBCWAR004: Trap(s) missing supplemental NMS annotation” on 
page 440

MIBCERR102: Error in the INDEX clause

Explanation: The required syntax for the INDEX clause is: 

INDEX List of ObjectNames

The list of object names should be separated by commas. 

Example (taken from nwserver.mib) 

nwUserVolUsageEntry OBJECT-TYPE 

INDEX nwUserVolUserID, nwUserVolVolID

The object names in this example are nwUserVolUserID and 
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nwUserVolVolID.

Possible Cause: The syntax in the INDEX clause is incorrect. 

Action: Check the syntax of the INDEX clause.

MIBCERR103: Unknown or aggregate type. Value can not be interpreted

Explanation: The MIB Compiler attempts to understand a value through the type that is 
referenced. If that type is not known, the MIB Compiler cannot interpret the 
value.

Possible Cause: The type is unknown and the MIB Compiler cannot interpret the value.

Action: Make sure the spelling and format of the type are correct. 

Action: Delete any invalid non-white-space characters (characters other than the white 
space characters such as tab or space).

MIBCERR104: Number repeated in an enumerated list (named number list)

Explanation: The named number lists contain elements consisting of a label and an 
associated number. The labels provide meaning to the assigned numbers. The 
numbers must be unique in a named number list.

Possible Cause: The same number has been incorrectly assigned to multiple list entries.

Action: Ensure that the numbers are unique.

MIBCERR105: Incorrect syntax: In enumeration list, expected ’(’

Explanation: The enumerated list consists of name strings and the associated integer value. 
The integers should be enclosed in parentheses.

Possible Cause: The MIB file has invalid characters or characters between the name string and 
the opening parenthesis. 

Action: Make sure the name string is made up of one word exactly and does not 
contain white space. 

Possible Cause: The name string may be incorrectly made up of spaces, or other white space 
characters. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space) between the name string and the integer value. 

Possible Cause: The integer value may be missing entirely, or the enclosing parentheses may 
be missing or replaced by braces. 
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Action: Enclose the integer value in parentheses. 

MIBCERR106: Incorrect syntax: In enumeration list, expected ’)’

Explanation: The integer value should be enclosed in parentheses. The closing right 
parenthesis was not found.

Possible Cause: Some non-numerical or non-white-space characters (characters other than the 
white space characters such as tab or space) may have been inserted between 
the integer and the closing parentheses. 

Possible Cause: The closing parenthesis for the integer value is missing.

Possible Cause: The value may have non-numerical invalid characters inserted between digits.

Action: Ensure that there are no non-white-space characters between the integer value 
and that the closing parenthesis is present.

MIBCERR107: Incorrect syntax: Expected ’,’ or ’}’

Explanation: The possible lists are either an enumerated list or a variable list. The lists 
should be made up of list items, enclosed within opening and closing braces, 
and commas are used to separate the list items. This error is declared when this 
format is not present. 

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) are present between the list items and the separating 
comma.

Possible Cause: The closing braces may be missing. 

Action: Delete any non-white-space characters between items in the list or between 
the last item and the closing braces.

Action: Separate list items with commas. 

MIBCERR108: Incorrect syntax: Expected ’{’ after DEFVAL

Explanation: DEFVAL defines a predefined value for a variable. The value to be used 
should be enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present between the DEFVAL and the opening 
brace. 

Action: Delete any non-white-space characters. 

Action: Enclose characters within opening and closing braces. 
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MIBCERR109: Incorrect syntax: Expected ’{’ after VARIABLES

Explanation: The keyword VARIABLES is followed by a list of object names in the MIB. 
The names should be separated by commas and enclosed within opening and 
closing braces.

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) may be present between the VARIABLES and the 
opening braces.

Action: Delete any non-white-space characters. 

Possible Cause: The opening brace may be missing completely. 

Action: Enclose characters within opening and closing braces.

MIBCERR110: Incorrect syntax: In SEQUENCE clause: Expected ’{’

Explanation: The keyword SEQUENCE is followed by a list of items making up a 
sequence. Each item of the list is made up of an object name and an object 
value pair. The list items should be separated by commas and enclosed within 
opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present between the keyword SEQUENCE and 
the opening brace.

Action: Delete any invalid characters between the keyword SEQUENCE and the 
opening brace.

Possible Cause: The opening brace may be missing entirely. 

Action: Make sure that the opening brace is not missing. 

MIBCERR111: Incorrect syntax: Expected a non-negative integer

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros.

Possible Cause: The specified integer value may be incorrect.

Action: Check that the integer value is expressed in the expected format. 

MIBCERR112: Incorrect syntax: Expected a type

Explanation: The type can either be a built-in standard SMI type or a user-defined type. 

Possible Cause: The type does not refer to a built-in standard SMI type or a user-defined type.

Action: Ensure that the type is of the expected format.
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MIBCERR113: Incorrect syntax: Expected an integer

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros 
and a sign (optional). White space may exist between the sign and the digits.

Possible Cause: The specified integer value may be incorrect.

Action: Ensure that the integer value is expressed in the expected format. 

MIBCERR114: Incorrect syntax: Expected an octet string

Explanation: The string should be enclosed in quotes. It can be standard text 
(alphanumerical with punctuation characters), binary string (0s and 1s), or 
hexadecimal string (all digits, A,B,C,D,E,F, a, b, c, d, e, f).

Possible Cause: The required string is not present.

Action: Ensure that the string is provided and is expressed in the expected format.

MIBCERR115: Incorrect syntax: Expected a filename after HELP

Explanation: The HELP clause is optional. The keyword HELP should be followed by a 
filename, which is used for the alarm system on the ZENworks for Servers 
console. 

Possible Cause: The expected filename may be missing after the HELP keyword.

Action: Check that a filename is provided after the HELP keyword.

MIBCERR116: Incorrect syntax: Expected HELPTAG number after #HELPTAG

Explanation: The integer number corresponds to the appropriate offset in the online help file 
named in the HELP clause.

Possible Cause: No number was found after the HELPTAG keyword.

Action: Delete the non-negative integer after the HELPTAG keyword. 

Possible Cause: The number was not in the expected integer format. 

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space).

MIBCERR117: Incorrect syntax: Expected identifier after ACCESS

Explanation: The ACCESS clause defines the access levels in terms of identifiers. The 
identifiers can be:     

� Read-only 
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� Read-write 

� Write-only 

� Not-accessible 

Possible Cause: The keyword in the ACCESS clause may not belong to the defined set. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space).

Action: Specify a valid identifier.

MIBCERR118: Incorrect syntax: Expected identifier after STATUS

Explanation: The STATUS clause defines the implementation support required for this 
object using identifiers. The supported values are:

� MANDATORY, OPTIONAL (support is mandatory or optional) 

� DEPRECATED (must be supported, but may be removed from the next 
version) 

� OBSOLETE (the managed nodes no longer need to support this object) 

Possible Cause: The identifier may be absent completely. 

Action: Specify a valid identifier.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present between the STATUS and the identifier. 

Action: Delete any non-white-space characters. 

MIBCERR119: Incorrect syntax: Expected identifier

Explanation: The TRAP-TYPE macro contains either an enumerated list or a variable list. 
The list should be made up of items separated with commas and enclosed 
within opening and closing braces.

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) may be present before the name.

Action: Delete any non-white-space characters between the list items.

Possible Cause: The name was not found. 

Action: Enclose list items within opening and closing braces, without any invalid non-
white-space characters.
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
MIBCERR120: Incorrect syntax: Expected an index object or index type

Explanation: The INDEX clause contains a list of object names separated by commas. The 
list of object names should be enclosed within opening and closing braces.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present.

Action: Delete any non-white-space characters in the clause. 

Possible Cause: The Index Object type or Index type is not the name of an object in the MIB.

Action: Express names in the proper format. 

MIBCERR121: Incorrect syntax: Expected module reference

Explanation: When the MIB Compiler applies strict ASN.1 syntax, by convention, the 
module names should begin with an uppercase letter.

Possible Cause: The name of the module starts with a lowercase letter. 

Action: Ensure that the module name begins with an uppercase letter. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space).

MIBCERR122: Incorrect syntax: Expected number

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros 
and a sign (optional). White space can be between the sign and the digits.

Possible Cause: The integer value is incorrect. 

Action: Check that the integer value is expressed in the expected format.

MIBCERR123: Incorrect syntax: Expected a string after DESCRIPTION

Explanation: The DESCRIPTION clause has a quoted string, which is the description for 
that particular object in the MIB.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string quoted to avoid confusion with the 
closing quote. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present before the beginning of the string. 
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Action: Ensure that non-white-space characters do not precede the string.

MIBCERR124: Incorrect syntax: Expected string after REFERENCE

Explanation: The REFERENCE clause has a quoted string, which is the description for that 
particular object in the MIB.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote.

Possible Cause: Non-white-space characters may be present before the beginning of the string.

Action: Ensure that non-white-space characters do not precede the string. 

MIBCERR125: Incorrect trap annotation: Expected string after SUMMARY

Explanation: The SUMMARY clause has a quoted string, which is the description for that 
particular object in the MIB.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Non-white-space (characters other than the white space characters such as tab 
or space) may be present before the beginning of the string. 

Action: Ensure that non-white-space characters do not precede the string. 

MIBCERR126: Incorrect trap annotation: Expected string after TYPE

Explanation: In the TRAP-TYPE macro, the TRAP TYPE clause has a quoted string, which 
is the description for that particular trap in the MIB.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Non-white-space characters may be present before the beginning of the string. 

Action: Ensure that non-white-space characters do not precede the string. 
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MIBCERR127: Incorrect trap annotation: Expected time index number after 
\#TIMEINDEX

Explanation: The integer can be digits from 0 to 9 only. The format allows for leading zeros 
and a sign (optional). White space may exist between the sign and the digits.

Possible Cause: The non-negative integer value is incorrect or is not present.

Action: Check that the integer value is expressed in the expected format. 

MIBCERR128: Incorrect syntax: In INDEX clause: Expected ... , INTEGER OPTIONAL

Explanation: The OPTIONAL keyword signifies that the preceding term in the INDEX 
clause is not mandatory. It must be the last term in the clause and must be 
preceded by an INTEGER only.

Possible Cause: The keyword OPTIONAL may not be the last term in the INDEX clause. 

Action: Ensure that the keyword is the last term in the clause. 

Possible Cause: The keyword OPTIONAL may be preceded by a type other than INTEGER. 

Action: Ensure that the term preceding the keyword OPTIONAL is INTEGER. 

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space).

MIBCERR129: Incorrect syntax: Expected ::=

Explanation: The symbol ::= has multiple uses, such as in object definitions, textual 
conventions, and demarcation of MIB modules. 

Possible Cause: The ::= symbol may be missing. 

Action: Ensure that the expression has the correct form. This is especially important 
for object definitions when macros are being used. 

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) may be present between the previous term and the ::= 
symbol. 

Action: Delete any non-white-space characters in the expression. 

MIBCERR130: Incorrect syntax: Expected ACCESS

Explanation: In ASN.1 syntax, the ACCESS keyword forms part of the OBJECT-TYPE 
macro, which defines the access level of that particular object.

Possible Cause: The ACCESS keyword is missing. 
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Action: Ensure that the keyword ACCESS is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present in the place of the ACCESS keyword. 

Action: Delete any non-white-space characters. 

MIBCERR131: Incorrect syntax: Expected BEGIN

Explanation: The ASN.1 syntax notation allows for objects to be defined within a separate 
module. A MIB file can contain one or more modules. These modules, by 
definition, begin with module_name DEFINITIONS::=BEGIN.

Possible Cause: The keyword BEGIN may be missing.

Action: Ensure that the keyword BEGIN is present. 

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space) before the keyword BEGIN.

MIBCERR132: Incorrect syntax: Expected DEFINITIONS

Explanation: The ASN.1 syntax notation allows for objects to be defined within a separate 
module. A MIB file can contain one or more modules. These modules, by 
definition, begin with module_name DEFINITIONS::=BEGIN.

Possible Cause: The keyword DEFINITIONS may be missing.

Action: Ensure that the keyword DEFINITIONS is present. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space) before the keyword DEFINITIONS. 

MIBCERR133: Incorrect syntax: Expected ENTERPRISE

Explanation: The keyword ENTERPRISE forms part of the TRAP-TYPE macro and 
describes to which ENTERPRISE the trap belongs. The ENTERPRISE is 
usually the group that defines that particular MIB.

Possible Cause: The ENTERPRISE keyword is missing. 

Action: Ensure that the keyword ENTERPRISE is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present in the place of the ENTERPRISE 
keyword.

Action: Delete any non-white-space characters before the keyword ENTERPRISE. 
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MIBCERR134: Incorrect syntax: Expected HELPTAG item after HELP

Explanation: The HELPTAG and HELP items form part of the trap definition. The item 
HELP defines the Help files to be used for the alarm system on the console. 
The HELPTAG refers to a particular offset in that file, pertaining to this 
particular trap.

Possible Cause: The HELPTAG item is not present. 

Possible Cause: The keyword may been spelled incorrectly or is not present. 

Action: Ensure that the keyword is present and is spelled correctly. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) are present.

Action: Delete any non-white-space characters between the two items. 

MIBCERR135: Incorrect syntax: Expected NULL

Explanation: The MIB Compiler understands the following ASN.1 types:           

� INTEGER

� OBJECT IDENTIFIER

� OCTET STRING

It also has built-in support for the following standard SMI types: 

� Counter 

� Gauge 

� TimeTicks 

� NetAddress

� IPAddress

� Opaque

Possible Cause: Attempting to use an undefined type results in this error.

Action: Ensure that the type is one of those supported by the MIB Compiler.

Action: Ensure that the type is spelled correctly. 

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space) before the declared type. 
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MIBCERR136: Incorrect syntax: Expected identifier after STATUS

Explanation: The STATUS keyword forms part of the OBJECT-TYPE macro, defining the 
implementation support required for that particular object, whether it is 
Mandatory, Optional, Deprecated, or Obsolete.

Possible Cause: The STATUS keyword is missing. 

Action: Ensure that the keyword STATUS is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) are present in the place of the STATUS keyword. 

Action: Delete any non-white-space characters.

MIBCERR137: Incorrect syntax: Expected SYNTAX

Explanation: In ASN.1 syntax, the SYNTAX keyword forms part of the OBJECT-TYPE 
macro, defining the format of the value taken by the object.

In SNMP Version 2 syntax, the SYNTAX keyword forms part of the 
OBJECT-TYPE and TEXTUAL-CONVENTIONS macro, describing any of 
these types.

Possible Cause: The SYNTAX keyword is missing. 

Action: Ensure that the keyword SYNTAX is present.

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) are present in the place of the SYNTAX keyword. 

Action: Delete any non-white-space characters.

MIBCERR138: Incorrect syntax: Expected ’,’ or FROM

Explanation: The FROM keyword refers to objects defined in other MIB modules.

Possible Cause: The FROM token keyword is missing or is spelled incorrectly.

Action: Check that the keyword is present and is spelled correctly.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) are present where the word was expected. 

Action: Delete any non-white-space characters.
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MIBCERR139: Incorrect syntax: Import clause: Expected symbol

Explanation: Terms defined in other MIB modules can be referenced with the IMPORT 
clause. Only identifiers, types, and object identifiers can be used with the 
IMPORT clause.

Possible Cause: The term present in the IMPORT clause is neither an identifier nor a type.

Action: Check that the items with the IMPORT clause are either identifiers or types. 
Standard SMI macros such as OBJECT-TYPE and TRAP-TYPE can also be 
imported.

MIBCERR140: Illegal type in IndexPart

Explanation: In an INDEX clause, the following types of objects are supported:

� Integers 

� Octet strings 

� Object identifiers

� Net addresses

� IP addresses

Possible Cause: The type may not be one of those supported by the INDEX clause.

Action: Ensure that the types of the objects named in the INDEX clause are supported 
by the INDEX clause.

MIBCERR141: Out of memory

Explanation: This error occurs when the operating system is incapable of supplying 
required memory to this application.

Possible Cause: There are too many active applications.

Action: Close some open applications. Retry the operation. You may need to shut 
down and restart the operating system.

MIBCERR142: Premature end of file

Explanation: The end of the file was reached while the compilation was in an incomplete 
state. Each MIB source file contains one or more modules. Each module 
contains related object definitions. If the end of the file was found before the 
MIB Compiler finished compiling the current module, this error is generated. 

The keyword END, which denotes the end of a MIB module, must be found 
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before the end of the file occurs. 

Possible Cause: The file may be truncated or is incomplete.

Action: Check that the MIB source file was not truncated or incomplete by checking 
the original version. If the file was downloaded from the Internet, it may be 
incomplete. You must download the file again.

MIBCERR143: Syntax error in object ID

Explanation: The object ID may be in the form of the name of the node, by itself, or with 
references to its parents, in their named form. For example, the following are 
allowed:

dodiso(1) org (3) dod (6)

Possible Cause: The object ID may be improperly formed or is nonexistent.

Action: Ensure that the object ID is correctly formed.

Action: Delete any invalid non-white-space characters (characters other than the white 
space characters such as tab or space).

MIBCERR144: Encountered unexpectedly long word

Explanation: The MIB Compiler sets a limit on the largest size that it can handle. This limit 
is based on the review of many existing MIB source files, and is designed to 
handle most strings. 

Possible Cause: The word that the MIB Compiler is currently considering is too large to be 
handled.

Action: Specify a shorter name.

MIBCERR147: Incorrect alarm trap annotation: Too many arguments after 
ARGUMENTS

Explanation: There is a limit on the number of arguments that may be declared.

Possible Cause: There are too many arguments declared after the ARGUMENTS keyword.

Action: Ensure that the number of arguments does not exceed the maximum number 
of arguments allowed.

MIBCERR148: Linking error: Undefined identifier found

Explanation: Each MIB module is made up of a collection of definitions of objects that 
make up a portion of the MIB tree. Each definition relates the current 
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definition to some other existing object in the MIB. Either the referred object 
is defined within the same MIB, or it is referenced from an external module 
using the IMPORT statement.

Possible Cause: The identifier may not be defined in the current MIB. 

Action: Ensure that the referred identifier has been spelled correctly. 

Action: Ensure that the referred identifier exists within the module. 

Possible Cause: The identifier may not be correctly imported from the appropriate MIB, or the 
spelling may be incorrect. 

Action: Ensure that the referred identifier is referenced correctly from an external 
module using the IMPORT statement, and that the MIB is being compiled. 

Action: Delete any invalid non-white-space characters (characters other than the white 
space characters such as tab or space) where the identifier is expected.

Action: Ensure that the identifier is included in the MIB in which it is accessed, or is 
included among the imported MIBs.

MIBCERR149: Linking error: Undefined type

Explanation: Each MIB module is made up of a collection of definitions of objects that 
make up a portion of the MIB tree. Each definition includes some type 
information. ASN.1 provides basic types, but user-defined types can be added. 
These types are either defined within the same MIB, or else they are 
referenced from an external module using the IMPORT statement.

Possible Cause: The type may not be defined in the current MIB. 

Action: Ensure that the referred type exists within the module. 

Possible Cause: The type may not be correctly imported from the appropriate MIB.

Action: Ensure that the referred type is referenced correctly from an external module 
using the IMPORT statement, and that the MIB is being compiled. 

Possible Cause: The spelling may be incorrect.

Action: Ensure that the referred type has been spelled correctly,

Action: Delete any invalid non-white-space characters (characters other than the white 
space characters such as tab or space) where the identifier is expected. 
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MIBCERR150: Linking error: IMPORT MIB module not found

Explanation: Identifiers and types may be referenced from other MIB modules using the 
IMPORT statement. This error is generated if a module named in the 
IMPORT statement is missing.

Possible Cause: The MIB source file may not be available for compilation.

Action: The MIB source file containing the referenced MIB module is being compiled 
currently. It should be present in the MIB Server Pool. 

Possible Cause: The name of the module may be missing or may be incorrectly spelled.

Action: Ensure that the name of the module is spelled correctly.

Action: Ensure that invalid non-white-space characters  (characters other than the 
white space characters such as tab or space) are not present in the name.

MIBCERR151: Linking error: Attempt to redefine this name 

Explanation: There is a single namespace for the symbols being defined in each MIB 
module of the MIB tree. This means that there cannot be more than one object 
of the same name in the same MIB module.

Possible Cause: This name may have already been used as the name of some other identifier 
or type in the MIB module. 

Action: Ensure that there are no other occurrences of the name in the MIB.

MIBCERR152: Linking error: Unexpected term in the definition

Explanation: The definition of an object should be terminated with the following: 

::= {<reference to parent in MIB tree child number>} 

The reference to the parent can either be qualified as the name of the parent, 
or in terms of its parents. 

For example, the following would be accepted: 

::= {iso org(3) dod (6) 1}

The child number describes the object being described in terms of its parent, 
as in the first child of parent node dod.

Possible Cause: The child number of the node being defined is not found. 

Possible Cause: The reference to the parent token is incorrect. 

Action: Ensure that the reference to the parent is correct, and that the child number is 
unique to the parent.
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MIBCERR153: Invalid characters found in the word 

Explanation: The MIB Compiler allows only the following characters for use in names: 
alphanumeric and underscore ([a-zA-Z0-9_]). These characters may occur in 
any order.

Possible Cause: The word contains invalid characters.

Action: Ensure that the word used is made up only of valid characters.

MIBCERR154: Unexpected type after SEQUENCE OF

Explanation: The SEQUENCE OF keywords must be followed by a type name, which 
defines the objects in the SEQUENCE.

Possible Cause: The SEQUENCE OF keywords were not followed by a type name or were 
followed by an invalid type name.

Action: Ensure that a valid type name occurs after the SEQUENCE OF keywords.

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space).

MIBCERR155: Unrecognized type after SYNTAX

Explanation: The name referenced by the SYNTAX clause should define the abstract 
syntax for the object, either in terms of the universal types or user-supplied 
types.

Possible Cause: The type referenced after the SYNTAX command was not found.

Action: Ensure that the type referenced in the SYNTAX clause is either a universal 
type or a user-defined type.

Action: Delete any non-white-space characters after the SYNTAX keyword.

MIBCERR156: Unrecognized value for SEVERITY

Explanation: The standard annotations for the TRAP-TYPE macro include a field for 
SEVERITY. This field can include any of the following four defined values:

� CRITICAL

� MAJOR

� MINOR

� INFORMATIONAL
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Possible Cause: The value listed after the SEVERITY keyword is not one of the four defined 
values.

Action: Ensure that the value for SEVERITY is one of the four values as listed in the 
Explanation section. 

MIBCERR157: Print operation cancelled, either due to operator cancel or operation 
cannot be completed

Explanation: This error is generated when the user interrupts the printing or when the 
printer is unable to execute the command. 

Possible Cause: The printer may not be connected. 

Possible Cause: The printer may be offline.

Possible Cause: The user may have canceled the command. 

Action: Correct the printer problem and reissue the command.

MIBCERR158: Incorrect syntax: Expected a string after DISPLAY-HINT 

Explanation: The DISPLAY-HINT clause has a quoted string, which is the description for 
that particular object in the MIB.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes.

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 

MIBCERR159: Incorrect syntax: Expected STATUS

Explanation: In ASN.1 syntax, the STATUS keyword forms part of the OBJECT-TYPE 
macro, defining the implementation support required for that particular object, 
whether it be Mandatory, Optional, Deprecated, or Obsolete. 

In SNMP Version 2 syntax, the STATUS keyword forms part of the OBJECT-
TYPE, TEXTUAL-CONVENTION, OBJECT-IDENTITY, 
NOTIFICATION-TYPE, and OBJECT-GROUP macro, describing any of 
these types.

Possible Cause: The STATUS keyword is missing. 
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Action: Ensure that the STATUS keyword is present. 

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) are present in the place of the STATUS keyword. 

Action: Delete any non-white-space characters.

MIBCERR201: Incorrect syntax: Expected a string after UNITS

Explanation: The UNITS clause defines the units for the OBJECT-TYPE, such as minutes 
and seconds.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present before the beginning of the string.

Action: Delete any non-white-space characters before the string. 

MIBCERR202: Incorrect syntax: Expected MAX-ACCESS

Explanation: The MAX-ACCESS keyword forms part of the OBJECT-TYPE macro, 
defining the access level of that particular object.

Possible Cause: The MAX-ACCESS keyword is missing. 

Action: Ensure that the keyword MAX-ACCESS is present. 

Possible Cause: Non-white-space characters  (characters other than the white space characters 
such as tab or space) are present in the place of the MAX-ACCESS keyword.

Action: Delete any non-white-space characters.

MIBCERR203: Incorrect syntax: Expected identifier after MAX-ACCESS, read 

Explanation: The MAX-ACCESS clause defines the access levels in terms of identifiers.

The identifiers can include the following:

� Not-accessible 

� Accessible-for-notify 

� Read-only

� Read-write
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� Read-create 

Possible Cause: The keyword in the MAX-ACCESS clause may not belong to the defined set. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space).

Action: Specify a valid identifier.

MIBCERR204: Error in the ARGUMENT clause

Explanation: The required syntax for the ARGUMENT clause is 

argument list_of_Objectnames

The object name represents a row from the base table.

Possible Cause: The syntax in the ARGUMENT clause is incorrect. 

Action: Check the syntax of the ARGUMENT clause.

MIBCERR205: Incorrect syntax: Expected OBJECTS 

Explanation: The OBJECTS keyword forms part of the OBJECT-GROUP and 
NOTIFICATION-TYPE macro, defining the members of the group.

Possible Cause: The keyword OBJECTS may be missing.

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space) before the OBJECTS keyword. 

Action: Make sure the keyword OBJECTS is present. 

MIBCERR206: Error in the OBJECT clause

Explanation: The required syntax for the OBJECT clause is 

object list_of_object_names

Example:

{prtGeneralCurrentOperator,prtGeneralServicePerson}

Possible Cause: The syntax in the OBJECT clause is incorrect. 

Action: Check the syntax of the OBJECT clause.

MIBCERR207: Error in the MANDATORY-GROUPS clause

Explanation: The required syntax for the MANDATORY-GROUPS clause is:
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mandatory_groups list_of_object_names

Example:

{prtGeneralGroup, prtInputGroup}

Possible Cause: The syntax in the MANDATORY-GROUPS clause is incorrect. 

Action: Check the syntax of the MANDATORY-GROUPS clause.

MIBCERR208: Incorrect syntax: Expected identifier after GROUP

Explanation: The GROUP clause defines the name of the GROUP, which is conditionally 
required. 

Possible Cause: An identifier after the GROUP clause is not present. 

Action: Specify a valid identifier.

Action: Delete non-white-space characters.

MIBCERR209: Incorrect syntax: Expected identifier after OBJECT 

Explanation: The OBJECT clause defines the exception for an object type in the MODULE-
COMPLIANCE macro. The object type is defined in the MIB module.

Possible Cause: The keyword in the OBJECT clause may not be a valid identifier.

Action: Specify a valid identifier.

Action: Delete any non-white-space characters.

MIBCERR210: Incorrect syntax: Expected enumeration or BITS after WRITE-SYNTAX

Explanation: The WRITE-SYNTAX is defined to allow a reduction in the behavior of an 
object in the MODULE-COMPLIANCE macro.

Possible Cause: The keyword INTEGER or BITS is missing. 

Action: Ensure that the keywords are present. 

Possible Cause: The opening or closing braces may be missing completely. 

Action: Enclose characters within opening and closing braces. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space).
Troubleshooting ��	

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
MIBCERR211: Incorrect syntax: Expected identifier after MIN-ACCESS

Explanation: The MIN-ACCESS clause defines the access levels in terms of identifiers.

The identifiers can include the following:

� Not-accessible 

� Accessible-for-notify 

� Read-only 

� Read-write

Possible Cause: The keyword in the MIN-ACCESS clause may not belong to the defined set. 

Action: Specify a valid identifier.

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space).

MIBCERR212: Incorrect syntax: Expected LAST-UPDATED

Explanation: In the MODULE-IDENTITY macro, the LAST-UPDATED clause describes 
the date and time when the module was last updated. The date and time are 
expressed in universal time format (UTC).

Possible Cause: The LAST-UPDATED keyword may be missing.

Action: Ensure that the keyword LAST-UPDATED is present. 

Action: Delete any non-white-space characters  (characters other than the white space 
characters such as tab or space) before the LAST-UPDATED keyword. 

MIBCERR213: Incorrect syntax: Expected a string after LAST-UPDATED

Explanation: The LAST-UPDATED clause has a quoted string, which contains the date and 
time expressed in universal time format (UTC).

Possible Cause: The enclosing quotes for the string may be missing.

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Invalid non-white-space characters (characters other than the white space 
characters such as tab or space) are present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 
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MIBCERR214: Incorrect syntax: Expected ORGANIZATION

Explanation: The ORGANIZATION clause gives the name of the organization which 
created the module.

Possible Cause: The keyword ORGANIZATION may be missing.

Action: Ensure that the keyword ORGANIZATION is present. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space) between the quoted string after LAST-
UPDATED and ORGANIZATION. 

MIBCERR215: Incorrect syntax: Expected string after ORGANIZATION

Explanation: The ORGANIZATION clause has a quoted string, which gives the name of 
the organization that created the module.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Invalid non-white-space characters (characters other than the white space 
characters such as tab or space) are present before the beginning of the string. 

Action: Delete any non-white-space characters before the string. 

MIBCERR216: Incorrect syntax: Expected a string after CONTACT-INFO

Explanation: The CONTACT-INFO clause has a quoted string, which gives the information 
about the contact for any queries for this MIB module.

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Invalid non-white-space characters  (characters other than the white space 
characters such as tab or space) are present between the quoted string after the  
ORGANIZATION and CONTACT-INFO keywords.

Action: Delete any non-white-space characters between the quoted string after the 
ORGANIZATION and CONTACT-INFO keywords. 
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MIBCERR217: Incorrect syntax: Expected a string after REVISION

Explanation: The REVISION clause has a quoted string, which is the date and time 
expressed in universal time format (UTC).

Possible Cause: The enclosing quotes for the string may be missing. 

Action: Enclose the string within quotes. 

Action: Double quote (" ") any quotes in the string to avoid confusion with the closing 
quote. 

Possible Cause: Invalid non-white-space characters (characters other than the white space 
characters such as tab or space) are present between the quoted string after the 
keyword CONTACT-INFO and the keyword REVISION.

Action: Delete any non-white-space characters between the quoted string after the 
keywords CONTACT-INFO and REVISION. 

MIBCERR218: Incorrect syntax: Expected CONTACT-INFO

Explanation: The CONTACT-INFO keyword forms part of the MODULE-IDENTITY 
macro, and gives the information about the contact for any queries for this 
MIB module.

Possible Cause: The keyword CONTACT-INFO may be missing.

Action: Ensure that the keyword CONTACT-INFO is present. 

Action: Delete any non-white-space characters (characters other than the white space 
characters such as tab or space) before the CONTACT-INFO keyword. 

MIBCERR219: Incorrect syntax: Expected DESCRIPTION

Explanation: In ASN.1 syntax, the DESCRIPTION keyword forms part of the OBJECT-
TYPE macro, defining the implementation support required for that particular 
object, whether it be Mandatory, Optional, Deprecated, or Obsolete. 

In SNMP Version 2 syntax, the DESCRIPTION keyword forms part of the 
OBJECT-TYPE, TEXTUAL-CONVENTION, OBJECT-IDENTITY, 
NOTIFICATION-TYPE, OBJECT-GROUP, and MODULE-IDENTITY 
macros, describing any of these types. 

Possible Cause: The DESCRIPTION keyword is missing. 

Action: Ensure that the keyword DESCRIPTION is present.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) are present in the place of the DESCRIPTION keyword.
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Action: Delete any non-white-space characters.

MIBCWAR001: Unrecognized ACCESS type

Explanation: The ACCESS clause defines the access levels in terms of identifiers.  The 
identifiers can include the following: 

� Read-only 

� Read-write 

� Write-only

� Not-accessible

Possible Cause: The identifier is not found. 

Action: Specify a valid identifier.

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present between ACCESS and the identifier.

Action: Delete any non-white-space characters.

MIBCWAR002: Unrecognized STATUS type

Explanation: The STATUS keyword forms part of the OBJECT-TYPE macro, defining the 
implementation support required for that particular object, whether it be 
Mandatory, Optional, Deprecated, or Obsolete. 

Possible Cause: The term to define the STATUS is not recognized.

Possible Cause: The term may be spelled incorrectly.

Action: Ensure that the term is present. 

Possible Cause: Non-white-space characters (characters other than the white space characters 
such as tab or space) may be present where this word was expected.

Action: Delete any invalid non-white-space characters.

MIBCWAR003: Ignoring named number, since value exceeds 32767

Explanation: The MIB Compiler works with the largest integer that can be represented as 
32767. If a named number occurs that has a value larger than 32767, the MIB 
Compiler generates this error.

Possible Cause: The value of the named number is greater than that which can be represented 
on this machine. 
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Action: Ensure that numbers used in named number lists are correctly listed with 
values less than 32767.

MIBCWAR004: Trap(s) missing supplemental NMS annotation

Explanation: The definition of the TRAP-TYPE macro requires supplemental information, 
which takes the following form:

–#TYPE "FileSys: Directory write err (no vol)" 

–#SUMMARY "Error occurred writing to "–#SUMMARY "extended 
directory space on server %s." 

–#ARGUMENTS {0}

–#SEVERITY CRITICAL

–#TIMEINDEX 1

–#HELP "nwalarm.hlp"

–#HELPTAG 2

–#STATE DEGRADED

These annotations are used by the Alarm Manager System of ZENworks for 
Servers.

,03257$17��These annotations are prefixed with –#, and are ignored by other 
compilers incapable of understanding them. However, they are relevant to this MIB 
Compiler and should not be removed or mistaken as comments because these 
annotations start with a –.

Possible Cause: The standard defined trap annotation is missing.

Action: Ensure that the annotations are present for the TRAP-TYPE definitions and 
that they have meaningful values.

Troubleshooting Traffic Analysis

This section provides information that will help you troubleshoot traffic 
analysis error messages.

� “Add protocol operation failed” on page 442

� “Agent not reachable” on page 442

� “Cannot turn on promiscuous mode” on page 442

� “Connecting” on page 443
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� “Console views display abnormal values for segment bandwidth 
utilization.” on page 443

� “Constraints in addition of new protocols” on page 443

� “Edit protocol operation failed” on page 443

� “Initializing” on page 444

� “Insufficient rights to modify protocol attributes” on page 444

� “Interface driver not loaded” on page 444

� “Interface error” on page 444

� “Interface not found” on page 444

� “Interface not licensed” on page 445

� “Irrecoverable error” on page 445

� “LSM screens display irrecoverable or Console errors randomly.” on 
page 445

� “Management server not responding” on page 445

� “Media not supported” on page 446

� “MIB-2 not found” on page 446

� “No SNMP Response” on page 446

� “No statistics” on page 447

� “Not promiscuous driver” on page 447

� “Not raw send driver” on page 447

� “Obtaining data” on page 448

� “Pipelined adapter” on page 448

� “Remove protocol operation failed” on page 448

� “RMON not present on switch” on page 448

� “RMON2 service is not available on this node” on page 448

� “SNMP / Console error displayed by LSM.” on page 449

� “SNMP Error” on page 449

� “Suspended” on page 449

� “Switch not responding” on page 449
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� “Table(s) not found” on page 449

� “This segment does not have an RMON Agent connected to it” on page 
450

Add protocol operation failed

Explanation: This error is displayed if the addition of a protocol to the Protocol Directory 
fails.

Possible Cause: The agent may not allow certain protocols to be added.

Action: Add only the protocols that the agent allows you to add.

Possible Cause: An internal error occurred at the agent.

Action: If this error occurs multiple times, unload and reload the agent.

Possible Cause: The ZfS server is not responding.

Action: Restart the server.

Agent not reachable

Explanation: This message displays if the management server is down or if the connection 
between the agent and the management server is down.

Action: Ensure that the management server is up and running and check the 
connection between the agent and the server.

Cannot turn on promiscuous mode

Explanation: The traffic analysis agent requires promiscuous mode to function 
appropriately. 

Possible Cause: The traffic analysis agent software failed to turn on the promiscuous mode for 
the interface.

Possible Cause: The board or the driver is not functioning.

Possible Cause: The server on which the traffic analysis agent is installed is running out of 
resources. 

Action: Try unloading the promiscuous mode driver and reloading it. If that does not 
solve the problem, see the driver's documentation or “Resolving Server 
Memory Problems” on page 450 for details.
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Connecting

Explanation: This message displays when the management console is in the process of 
connecting to the monitoring agent.

Action: None required.

Console views display abnormal values for segment bandwidth utilization.

Explanation: One of the parameters in calculating the bandwidth utilization is the interface 
speed (ifSpeed in MIB-2 RFC1158). On some NICs, the ifSpeed may not 
reflect the actual value due to some problem in querying the driver. The 
following is the list of drivers known to have this problem:

3Com EtherLink PCI (NT server)

3Com Fast EtherLink 3C59X  (NetWare server)

Action: Upgrade to the latest drivers.

Constraints in addition of new protocols

Explanation: The agent does not allow the user to add new protocols over certain 
encapsulations like ETHER2, ETHER2.IP, ETHER2.IPX.NCP. However, 
new protocols can be added over ETHER2.IP.UDP, ETHER.IP.TCP or 
ETHER2.IPX.

Action: None.

Edit protocol operation failed

Explanation: This error is displayed if changes to a protocol fail.

Possible Cause: The Edit operation involves deleting the existing entry and adding a new one. 
The agent may disallow deletion of some protocols. The deletion may succeed 
but the addition may fail.

Action: See “Adding Custom Protocols to a Supported Protocol Tree” on page 236 for 
Novell agents, and respective vendor documentation for other agents, for the 
restrictions on changing protocol information. If you change the protocol ID, 
avoid using an existing ID or a standard one.

Possible Cause: An internal error occurred at the agent.

Action: If this error occurs multiple times, unload and reload the agent.

Possible Cause: The ZfS server is not responding.

Action: Restart the server.
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Initializing

Explanation: This message displays when a view is being initialized. After this is complete, 
the management console begins communication with the monitoring agent.

Action: None required.

Insufficient rights to modify protocol attributes

Explanation: You do not have the rights to perform operations on the Protocol directory.

Action: Contact your system administrator regarding granting of rights.

Interface driver not loaded

Explanation: An interface driver is required by the traffic analysis agent in order for it to 
start monitoring segments, nodes, or devices on your network.

Action: Load the interface driver at the agent.

Interface error

Explanation: This message displays if you have not loaded the appropriate driver or if the 
driver is not loaded properly.

Action: Load the appropriate driver or check that the driver has been loaded 
successfully.

Interface not found

Explanation: The management console is unable to find a particular interface on the server 
on which the monitoring agent is loaded. 

Possible Cause: The LAN driver for the adapter related to this interface is not loaded.

Action: If the LAN driver is not loaded, load it. You can use the Remote Console 
utility in the management console to access the server console session. Refer 
to the vendor’s documentation for information about what command to enter 
to load the driver. 

Possible Cause: The network board was removed from the server on which the monitoring 
agent is loaded or exchanged for a new one.

Action: If you removed or changed a network board, wait until NetExplorer completes 
its next cycle and NetExplorer Manager runs on the management console. 
NetExplorer will detect that a network board is removed or changed and 
update the ZfS database accordingly.
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Possible Cause: A new server is added to the network on which the monitoring agent is loaded, 
and it is assigned an Internetwork Packet ExchangeTM (IPXTM) or IP address 
that has been used previously.

Action: If you assigned a previously-used IPX or IP address to a new server, reassign 
an IP or IPX address that was not assigned previously and run NetExplorer 
and NetExplorer Manager.

Interface not licensed

Explanation: The installed driver is not licensed. 

Action: Load a licensed driver.

Irrecoverable error

Explanation: An unknown error occurred when the management console tried to obtain 
information from the server on which the monitoring agent is loaded. 

This error will not occur under typical conditions.

Action: If other management consoles on the segment are able to communicate with 
the monitoring agent, this indicates that the agent is functioning. Try to free 
memory on the management console.

If no other management console can communicate with the agent, try to free 
memory on the agent as follows:

� Refer to “Resolving Server Memory Problems” on page 450 for details 
about how to resolve memory problems on a server.

� Try restarting the management console.

LSM screens display irrecoverable or Console errors randomly.

Possible Cause: Atlas notifications coming to the console and the Atlas database have not 
reached a stable state.

Action: Exit and open the view or refresh the view.

Management server not responding

Explanation: The management server needs sufficient memory to respond to requests from 
the management console.

Possible Cause: The server is down.

Action: Ensure that the server is up and running.
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Possible Cause: The server is out of memory.

Action: Restart the server if it is out of memory. For details, refer to “Resolving Server 
Memory Problems” on page 450.

Possible Cause: There is a network error in communicating with the management server.

Action: Check the network connections and try again.

Media not supported

Explanation: This message displays if the selected media is not supported by the monitoring 
agent.

Action: Use an adapter of the supported media type.

MIB-2 not found

Explanation: MIB-2 is the information base within which the RMON agent resides.

Action: Reload the agent.

No SNMP Response

Explanation: The machine is not on the network.

Action: Try to ping to some other hosts from Windows NT. If they do not respond, 
contact your system administrator.

Explanation: SNMP will not respond if the SNMP service for Windows NT is not running.

Action: Start the SNMP service by entering net start snmp at the command 
prompt.

Explanation: The SNMP service on Windows NT is not configured.

Action: Check the community string of SNMP for read / write access.

Explanation: The NetWare servers with default settings for SNMP Set operations do not 
respond to the community string PUBLIC, although the same is not true for 
SNMP Get operations. As a result, the LSM operations that involve setting 
SNMP entries, like Stations and Dashboard (top n) and Capture packets will 
display no SNMP response.

Action: Set the community string to PUBLIC.
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No statistics

Possible Cause: The monitoring agent is not running on the segment. The interface cannot be 
monitored because the driver is not supported. 

Possible Cause: You disabled monitoring on the agent. 

Possible Cause: You deleted the statistics entry on the agent. 

Action: If you are running traffic analysis agent for NetWare 1.0/1.1/1.2, upgrade to 
version 1.3, which is available as part of ZfS or on the Novell Support 
Connection (http://support.novell.com) Web page.

Install a promiscuous mode driver for the interface on the server. The driver 
must also support the raw send feature. Check the Novell Support 
Connection® (http://support.novell.com) Web page for information regarding 
availability of the latest promiscuous mode drivers. You might have to contact 
your adapter vendor for the appropriate driver.

If a promiscuous driver already exists, try unloading the driver and reloading 
it. If that does not solve the problem, refer to “Resolving Server Memory 
Problems” on page 450 for details. 

Not promiscuous driver

Explanation: Traffic analysis agent requires promiscuous mode to function properly. 

Possible Cause: The driver is not a promiscuous mode driver.

Action: Install a promiscuous mode driver on the server. Check the Novell Support 
Connection (http://support.novell.com) Web page for information regarding 
availability of the latest promiscuous mode drivers. You might have to contact 
your adapter vendor for the appropriate driver. 

Not raw send driver

Explanation: Traffic analysis agent requires an adapter driver that supports the raw send 
feature. 

Possible Cause: The driver does not support the raw send feature. 

Action: Install on the server an adapter driver that supports the raw send feature. 
Check the Novell Support Connection (http://support.novell.com) Web page 
for information regarding availability of the latest promiscuous mode drivers 
that support the raw send feature. You might have to contact your adapter 
vendor for the appropriate driver. 
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Obtaining data

Explanation: The management console successfully communicated with the server on 
which the monitoring agent is loaded. The management console sent (or is 
waiting to send) additional SNMP requests to obtain statistics.

Action: None required.

Pipelined adapter

Explanation: Traffic analysis agent supports non-pipelined adapters. 

Possible Cause: The adapter is a pipelined adapter. 

Action: If the adapter allows you to switch from pipelined mode to non-pipelined 
mode, do so. If the adapter cannot switch modes, replace the adapter with an 
adapter of the supported media type for traffic analysis agent operations. 

Remove protocol operation failed

Explanation: This error is displayed if deletion of a protocol to the Protocol directory failed.

Possible Cause: The agent may not allow certain protocols to be deleted.

Action: Remove only those protocols that the agent allows you to remove.

Possible Cause: An internal error occurred at the agent.

Action: If this error occurs multiple times, unload and reload the agent.

Possible Cause: The ZfS server is not responding.

Action: Restart the server.

RMON not present on switch

Explanation: The RMON groups are not found on the switch.

Possible Cause: The RMON groups are not loaded.

Action: Load the RMON groups.

Possible Cause: The switch does not support RMON.

Action: None.

RMON2 service is not available on this node

Explanation: The RMON2 group is not available at the agent.
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
Possible Cause: Discovery has not yet discovered sufficient information about the agent.

Action: Ensure that the Discovery component of ZfS is up and running. Allow it to run 
for a sufficient time to enable it to discover objects in your network.

Possible Cause: The agent does not implement the RMON2 group.

Action: None.

SNMP / Console error displayed by LSM.

Possible Cause: If the SNMP communication to the primary agent is over NCP, it requires the 
user to log into this server. If the authentication is not done, LSM will report 
an SNMP error.

Action: Select the primary agent and launch the Probe Manageability button to force 
the user to authenticate to the server. LSM will also work after this 
authentication.

SNMP Error

Explanation: This message displays if an internal error occurs at the agent.

Action: If this message displays multiple times, unload and reload the agent.

Suspended

Explanation: This message displays when you choose to stop updating the information 
displayed in the view.

Action: None required.

Switch not responding

Explanation: The switch is not responding to the SNMP requests or the switch may not be 
configured to accept SNMP requests from the selected host.

Action: Enable SNMP on the switch.

Action: Use the community string accepted by the switch.

Table(s) not found

Explanation: You will not be able to view tables for an interface if the agent is not loaded.

Action: Ensure that the agent is loaded. If you are still unable to view the required 
information, ensure that the table is implemented by the agent that is used for 
monitoring.
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This segment does not have an RMON Agent connected to it

Explanation: The segment is not an Ethernet, token ring, or FDDI ring segment, or an 
RMON agent is not installed on the segment.

"Segment Not Monitored" has the same meaning as this message.

Action: If you want the Ethernet, token ring, or FDDI ring segment to be monitored, 
install the traffic analysis agent for NetWare or the traffic analysis agent for 
Windows NT on a server on the segment.

Resolving Server Memory Problems

To free up server memory temporarily (until you can add more memory to the 
server), do one or more of the following: 

� Use the FILER or the NetWare Administrator utility to purge deleted files 
on the specified directory that cannot be purged automatically. (Deleted 
files are using up directory table space.)

� Use the REMOVE DOS or the SECURE CONSOLE commands to free 
the memory in the server that was reserved for DOS.

� Unload NetWare Loadable ModuleTM (NLMTM) file programs, such as 
INSTALL or MONITOR, that are not currently needed.

� Dismount volumes that are not being used.

� Reduce the size or number of volumes that the server supports.

� Delete unused files and directories on the specified volume.

� As a last resort, back up all files in your volume, bring down your server, 
and use the INSTALL command to reinitialize the volume. Specify a 
block size of 64 KB and turn the Block Suballocation option to Off. (This 
setting uses a lot of disk space but increases the amount of memory 
available.)

� Change the Minimum File Delete Wait Time SET parameter in the 
AUTOEXEC.NCF file so that files can be purged immediately rather 
than being retained in a salvageable state on the volume. 

For servers running NetWare Management Agent 2.1: 

� Select View > All > NetWare File Servers.

� Double-click the specific server.

� Select Configure > Set NetWare Server Parameters.

� Select the File System parameter.
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	 Change the parameter so that files can be purged immediately by 
selecting the AUTOEXEC.NCF check box listed in the Set From section 
of the dialog box.

For servers running NetWare Management Agent 1.5/1.6, use Remote 
Console (Tools > Remote Console) to change server parameters.

Troubleshooting Inventory Server

This section describes the troubleshooting procedures that you can use to 
solve inventory scanning problems on the inventory server. An inventory 
server refers to the server on which the site management services and 
databases are installed.

The following sections contain detailed information to help you troubleshoot 
problems:

� “Inventory Scanning Problems on NetWare Servers” on page 451

� “Inventory Scanning Problems on Windows NT/2000” on page 452

� “Inventory Summary for a managed server is not displayed” on page 453

� “Generating Inventory Reports displays error messages” on page 454

Inventory Scanning Problems on NetWare Servers

Problem: There are many NetWare servers on the network and the inventory data is 
visible for only a few of them.

Action: To isolate and resolve the problems while scanning inventory for Netware 
servers, verify the following:

� Is inventory management installed?

On the NetWare server, verify that the Inventory Scanner for NetWare 
(INVSCAN.NLM) is installed on the server in the SYS:\SYSTEM 
directory. Otherwise, install the Server Inventory component. See 
ZENworks for Servers Installation and Setup. 

� Is the installation on the NetWare server done properly?

Verify the contents of the INVSCAN.INI file in the SYS:\SYSTEM 
directory. Check whether the INV_SERV parameter refers to the correct 
inventory server. Also, verify the protocol configured in the 
INVSCAN.INI file. The default protocol is IP.
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� Are the Inventory Gatherer and the Inventory Storer loaded on the 
inventory server?

Verify the list of NetWare Loadable Modules (NLM) and Java* programs 
on the server to make sure that the Inventory Gatherer and the Inventory 
Storer are loaded. Also, verify that the Inventory Gatherer and the 
Inventory Storer are referring to the same STRDIR location. Verify that 
you can ping the inventory server over IP from the managed server.

� Are successful scans not reaching the database?

If the Inventory Gatherer and the Inventory Storer are running and 
inventory scans are being sent successfully, verify whether the Inventory 
Gatherer and the Inventory Storer are referring to the same STRDIR 
location. Verify the following parameters on the inventory server:

� The STR_DIR parameter in the GATHERER.NCF file

� The -temp parameter in the STORER.PROPERTIES file for a ZfS 
installation, or the -temp parameter in the STORER.NCF for a ZfS 
on ZENworks 2 Support Pack 1 installation

� Is information for the inventory scan available?

The inventory scanner creates a log file (INVSCAN.LOG) in the 
SYS:\ETC directory. This log file records the results of the scanner 
execution.

� Do you want to run the inventory scanner?

The inventory scanner runs automatically upon startup of the NetWare 
server. To manually run the scanner, run SCANNER.NCF.

Inventory Scanning Problems on Windows NT/2000

Problem: There are many Windows NT/2000 servers on the network and the inventory 
data is visible for only a few of them.

Action: To isolate and resolve the problems while scanning inventory of Windows 
NT/2000 servers, verify the following:

� Is inventory management installed?

On the Windows NT/2000 server, verify that the Inventory Scanner, 
(NTSCAN32.EXE) is installed on the server. Otherwise, install the 
Server Inventory component. See ZENworks for Servers Installation and 
Setup.

� Is the installation on the Windows NT/2000 server done properly?
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Verify the contents of the NTSCAN32.INI file in the Windows directory. 
Check whether the INVSERVER parameter refers to the correct 
inventory server. Check whether the ZfS inventory service is running.

� Are the Inventory Gatherer and the Inventory Storer loaded on the 
inventory server?

Verify the list of NLM programs and Java programs on the server to make 
sure that the Inventory Gatherer and the Inventory Storer are loaded. Also 
verify that the Inventory Gatherer and the Inventory Storer are referring 
to the same STRDIR location.

Verify that you can ping the inventory server over IP from the Windows 
NT/2000 server.

� Are the scans stored in the database?

If the Inventory Gatherer and the Inventory Storer combination is running 
and scans are being sent successfully, verify whether the Inventory 
Gatherer and the Inventory Storer are referring to the same STRDIR 
location. Verify the following on the inventory server:

� The STR_DIR parameter in the GATHERER.NCF file.

� The -temp parameter in the STORER.PROPERTIES file for a ZfS 
installation, or the -temp parameter in the STORER.NCF file for a 
ZfS on ZENworks 2 Support Pack 1installation

� Is information regarding the inventory scan available?

The inventory scanner creates a log file (INVERRORS.LOG) in the 
TEMP directory. This log file records the results of the scanner execution.

� Do you want to manually run the inventory scanner?

The inventory scanner runs automatically upon startup of the Windows 
NT/2000 server. To manually run the scanner, stop the ZfS Inventory 
service and restart it. Restarting the service will scan the inventory on the 
servers.

Inventory Summary for a managed server is not displayed

Problem: From ConsoleOne, when you select a managed server, the Tools > Server 
Inventory Summary option is not displayed.

Action: To view the Inventory Summary of the selected managed server:

� Open the Inventory Query window, click any managed server, click Tools 
> Inventory Query.
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� Specify the criteria for the query.

For example, specify Processor.Processor Family <Not Equal to> 
’Other’. Make sure that you specify the criteria that will display the 
selected managed server.

� From the Query results window, double-click the managed server. 

The Inventory Summary of the selected managed server is displayed.

Generating Inventory Reports displays error messages

Explanation: When you run inventory reports from ConsoleOne installed on the NetWare 
Server, the following message is displayed:

An error prevented report generation.

Error class: java.io.FileNotFoundException. The 
process cannot access the file because it is being 
used by another process.

Action: On the NetWare server, increase the limit on the maximum number of files 
that can be opened per connection by 50 connections. To modify the limit 
using Monitor utility on the server, click Monitor > Available Options > 
Server Parameters > Locks > Maximum File Locks Per Connection.

Alternatively, from the server console prompt, type set maximum file 
locks per connection=number_of_connections.

where, number_of_connections refers to the maximum number of files that 
can be opened per connection. 

Troubleshooting Remote Control for NetWare Servers

This section describes an error you may encounter while using Remote 
Control for NetWare servers.

� “The remote proxy server’s list is incomplete or empty.” on page 454

The remote proxy server’s list is incomplete or empty.

Explanation: When you click the Proxy button to select a proxy server, the list of proxy 
servers is incomplete or empty.

Possible Cause: The Directory agents are not configured correctly.
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Action: Check whether the Directory agents are configured correctly and are running 
on the network.

Server Inventory Error Messages on NetWare Servers

This section lists the error messages you may encounter while using Server 
Inventory, along with explanations and courses of action to follow to resolve 
the problems:

� “INVSCAN.NLM: Error in getting read status for the IP socket. Verify 
the IP services on the server” on page 457

� “INVSCAN.NLM: Error in getting the IP address of the server. Inventory 
will not be sent” on page 457

� “INVSCAN.NLM: Error in getting write status for the IP socket. Verify 
the IP services on the server” on page 457

� “INVSCAN.NLM: Error in opening IP socket. Verify the IP services on 
the server” on page 458

� “INVSCAN.NLM: Error in sending scan request while initiating scan” on 
page 458

� “INVSCAN.NLM: Improper specification for Inventory server name in 
the INVSCAN.INI file” on page 458

� “INVSCAN.NLM: Invalid protocol option in the INVSCAN.INI file” on 
page 458

� “INVSCAN.NLM: Ipaddress is not a valid IP address.Inventory will not 
be sent” on page 459

� “INVSCAN.NLM: Ipxaddress is not a valid IPX address.Inventory will 
not be sent” on page 459

� “INVSCAN.NLM: IpxGetLocalTarget - No local target identified. Verify 
the IPX services on the server” on page 459

� “INVSCAN.NLM: IpxGetLocalTarget - Unknown completion code = 
errornumber. Verify the IPX services on the server” on page 459

� “INVSCAN.NLM: IpxOpenSocket - IPX is not installed on the server” 
on page 460

� “INVSCAN.NLM: IpxOpenSocket - Socket already open, unable to close 
and reopen socket” on page 460
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� “INVSCAN.NLM: IpxOpenSocket - Socket table full, verify the IPX 
services on the server” on page 460

� “INVSCAN.NLM: IpxOpenSocket - Unknown error = errornumber. 
Verify the IPX services on the server” on page 460

� “INVSCAN.NLM: IpxReceive failed error code = errornumber, retry 
count = errornumber.Verify the IPX services on the server” on page 461

� “INVSCAN.NLM: IpxSend failed error code = errornumber, retry count 
= errornumber. Verify the IPX services on the server” on page 461

� “INVSCAN.NLM: Need the IPX address of the Remote Inventory server 
for inventory to be sent” on page 461

� “INVSCAN.NLM: Packet overflow encountered. Complete inventory 
will not be sent” on page 461

� “INVSCAN.NLM: Pathname is not a valid path to the Software 
Dictionary file, SWAPPL.INI” on page 462

� “INVSCAN.NLM: Scanner version major_version.minor_version will 
not run with the Software Dictionary file, SWAPPL.INI version 
major_version.minor_version” on page 462

� “INVSCAN.NLM: Servername failed in the scan request. Inventory will 
not be sent” on page 462

� “INVSCAN.NLM: Servername is currently not a valid Host, inventory 
will not be sent” on page 462

� “INVSCAN.NLM: Servername is currently not a valid Inventory Server. 
Inventory will not be sent” on page 463

� “INVSCAN.NLM: SNMP Manager Interface Entity Layer information, 
scan status = errornumber” on page 463

� “INVSCAN.NLM: SNMP Manager Interface Entity Layer registration 
failed, error = errornumber. Ensure that SNMP.NLM is loaded and 
operational” on page 463

� “INVSCAN.NLM: The initialization file, INVSCAN.INI, is not found” 
on page 463

� “INVSCAN.NLM: Unable to bind the IP socket. Verify the IP services on 
the server” on page 464

� “INVSCAN.NLM: Unable to open the file filename” on page 464
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� “INVSCAN.NLM: Unable to open the logfile filename, error 
errornumber” on page 464

� “INVSCAN.NLM: Unable to open the Supplemental Inventory file 
pathname_filename.” on page 464

� “INVSCAN.NLM: Unable to read file Software Dictionary file 
SWAPPL.INI. Software scan will not be done” on page 465

� “INVSCAN.NLM: Unable to set the IP socket to non-blocking mode. 
Verify the IP services on the server” on page 465

� “INVSCAN.NLM: Unable to set the receive buffer size for the IP socket. 
Verify the IP services on the server” on page 465

� “INVSCAN.NLM: ZENINV.NLM on servername is an incompatible 
version” on page 465

INVSCAN.NLM: Error in getting read status for the IP socket. Verify the IP services on 
the server

Source: Server Inventory Management - IP Communication Errors 

Severity: Warning.

Explanation: This error occurs if the IP stack is not functional.

Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Error in getting the IP address of the server. Inventory will not be sent

Source: Server Inventory Management 

Severity: Warning.

Explanation: The IP address of the server is not available. 

Action: Verify that the IP configuration is proper. 

INVSCAN.NLM: Error in getting write status for the IP socket. Verify the IP services on 
the server

Source: Server Inventory Management - IP Communication Errors 

Severity: Warning.

Explanation: There is an internal error in communication using the IP settings.
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Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Error in opening IP socket. Verify the IP services on the server

Source: Server Inventory Management - IP Communication Errors 

Severity: Critical.

Explanation: There is an internal error in communication using the IP settings.

Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Error in sending scan request while initiating scan

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Explanation: This error occurs if there is an error in sending request to the inventory server. 

Action: Verify that IP or IPX services as specified in the INVSCAN.INI are running. 
Run the Inventory scanner, SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Improper specification for Inventory server name in the INVSCAN.INI 
file

Source: Server Inventory Management - Configuration & Settings 

Severity: Critical.

Explanation: The specified inventory server does not exist.

Action: Specify a valid server name and ensure that the DNS contains the inventory 
server name entry. Run the Inventory scanner, SCANNER.NCF, to initiate the 
inventory scan.

INVSCAN.NLM: Invalid protocol option in the INVSCAN.INI file

Source: Server Inventory Management - Configuration & Settings

Severity: Critical.

Explanation: The protocol options in INVSCAN.INI do not specify the protocol as IP or 
IPX.
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Action: Ensure that the INVSCAN.INI file contains either an IP or IPX protocol 
setting. Run the Inventory scanner, SCANNER.NCF, to initiate the inventory 
scan.

INVSCAN.NLM: Ipaddress is not a valid IP address.Inventory will not be sent

Source: Server Inventory Management - Configuration & Settings 

Severity: Critical.

Explanation: The inventory server cannot be contacted because the IP address is invalid.

Action: Verify the IP address. 

Ensure that you can ping the inventory server using the IP address. Run the 
Inventory scanner, SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Ipxaddress is not a valid IPX address.Inventory will not be sent

Source: Server Inventory Management - Configuration & Settings 

Severity: Critical.

Explanation: The inventory server can not be contacted because the IPX address is invalid.

Action: Verify the IPX address. 

Ensure that you can ping the inventory server using the IPX address. Run the 
Inventory scanner, SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxGetLocalTarget - No local target identified. Verify the IPX services 
on the server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Critical.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxGetLocalTarget - Unknown completion code = errornumber. Verify 
the IPX services on the server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Warning.
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Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxOpenSocket - IPX is not installed on the server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxOpenSocket - Socket already open, unable to close and reopen 
socket 

Source: Server Inventory Management - IPX Communication Errors

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. 

Action: Run the Inventory scanner, SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxOpenSocket - Socket table full, verify the IPX services on the 
server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. If the problem persists, contact Novell 
Technical Services.

INVSCAN.NLM: IpxOpenSocket - Unknown error = errornumber. Verify the IPX 
services on the server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.
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Action: Verify the IPX services on the server. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxReceive failed error code = errornumber, retry count = 
errornumber.Verify the IPX services on the server

Source: Server Inventory Management - IPX Communication Errors 

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: IpxSend failed error code = errornumber, retry count = errornumber.  
Verify the IPX services on the server

Source: Server Inventory Management - IPX Communication Errors

Severity: Warning.

Explanation: There is a communication failure using the IPX settings.

Action: Verify the IPX services on the server. If the problem persists, contact Novell 
Technical Services.

INVSCAN.NLM: Need the IPX address of the Remote Inventory server for inventory to 
be sent

Source: Server Inventory Management - Configuration & Settings 

Severity: Critical.

Explanation: For a remote inventory server, if the selected protocol is IPX, you need to 
specify the IPX address. 

Action: Verify that you can ping the server with the IPX address. Run the Inventory 
scanner, SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Packet overflow encountered. Complete inventory will not be sent

Source: Server Inventory Management 

Severity: Warning.

Explanation: This error occurs when there is an internal buffer overflow. 
Troubleshooting �
�

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
Action: Customize the Software Dictionary, SWAPPL.INI to scan the required files 
only.

INVSCAN.NLM: Pathname is not a valid path to the Software Dictionary file, 
SWAPPL.INI

Source: Inventory Management - Configuration & Settings 

Severity: Critical.

Explanation: The file is not in the location specified in the INVSCAN.INI file.

Action: Verify the file location in the INVSCAN.INI file. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Scanner version major_version.minor_version will not run with the 
Software Dictionary file, SWAPPL.INI version major_version.minor_version

Source: Server Inventory Management - Software Dictionary SWAPPL.INI 

Severity: Warning.

Explanation: A wrong version of the SWAPPL.INI file exists on the server.

Action: Ensure that you are use the file shipped with ZENworks for Servers.

INVSCAN.NLM: Servername failed in the scan request. Inventory will not be sent

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Explanation: ZENINV.NLM is not loaded on the inventory server.

Action: Ensure that ZENINV.NLM is loaded on the inventory server. 

INVSCAN.NLM: Servername is currently not a valid Host, inventory will not be sent

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Explanation: This error occurs due to an improper IP address in the INVSCAN.INI file. 

Action: Verify whether you can ping the inventory server using the IP address.
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INVSCAN.NLM: Servername is currently not a valid Inventory Server. Inventory will 
not be sent

Source: Server Inventory Management - Specification of Inventory Server

Severity: Critical.

Possible Cause: ZENINV.NLM is not running. 

Possible Cause: The DNS entry for the inventory server does not exist.

Action: Load ZENINV.NLM on the inventory server. Ensure that you can ping the 
inventory server with the name.

INVSCAN.NLM: SNMP Manager Interface Entity Layer information, scan status = 
errornumber

Source: Server Inventory Management - SMILE Services Errors 

Severity: Warning.

Explanation: This error occurs while using the SMILE services. If this error occurs, some 
of the following inventory items will not be reported: adapter description, 
MAC address, subnet mask, hard disk model name, hard disk model name, 
hard disk size, CD-ROM model name, product name, and version.

Action: Ensure that SNMP.NLM is loaded and operational.

INVSCAN.NLM: SNMP Manager Interface Entity Layer registration failed, error = 
errornumber. Ensure that SNMP.NLM is loaded and operational

Source: Server Inventory Management - SMILE Services Errors

Severity: Critical.

Explanation: The SNMP Manager Interface Layer Entity (SMILE) services are not 
operational. If this error occurs, the following inventory items will not be 
reported: adapter description, MAC address, subnet mask, hard disk model 
name, hard disk model name, hard disk size, CD-ROM model name, product 
name, and version.

Action: Ensure that SNMP.NLM is loaded and operational.

INVSCAN.NLM: The initialization file, INVSCAN.INI, is not found

Source: Server Inventory Management - Configuration & Settings 

Severity: Critical.
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Action: Reinstall the Server Inventory agent.

INVSCAN.NLM: Unable to bind the IP socket. Verify the IP services on the server

Source: Server Inventory Management - IP Communication Errors

Severity: Critical.

Explanation: There is an internal error in communication using the IP settings.

Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Unable to open the file filename

Source: Server Inventory Management - Software Dictionary SWAPPL.INI 

Severity: Warning.

Explanation: An internal error has occurred and software scanning will not be done.

Action: Ensure that the SWAPPL.INI file exists and it is not corrupted. Run the 
Software Scan editor from ConsoleOne to customize the applications.

INVSCAN.NLM: Unable to open the logfile filename, error errornumber

Source: Server Inventory Management 

Severity: Warning

Explanation: An internal error has occurred.

Possible Cause: The disk is full.

Action: Ensure there is free disk space.

Possible Cause: You do not have Write privileges for the SYS:\ETC folder at the server.

Action: Ensure you have Write privileges for the folder.

INVSCAN.NLM: Unable to open the Supplemental Inventory file pathname_filename.

Severity: Informational

Explanation: Supplemental inventory information such as BIOS, ports, bus, mouse, 
keyboard, floppy drive, display, and modem will not be reported. This error 
occurs if the file does not exist.

Action: Install the ZfS Server Inventory Management Agent so that the INVINC.INI 
file is installed. Update the values in the INVINC.INI file. Rerun the scanner.
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INVSCAN.NLM: Unable to read file Software Dictionary file SWAPPL.INI. Software 
scan will not be done

Source: Server Inventory Management - Software Dictionary SWAPPL.INI 

Severity: Warning.

Explanation: When this errors occurs, software scanning will not be done. 

Action: Ensure that the SWAPPL.INI file is in the correct location. Look up the 
contents of the INVSCAN.INI file for the file location. 

INVSCAN.NLM: Unable to set the IP socket to non-blocking mode. Verify the IP 
services on the server

Source: Server Inventory Management - IP Communication Errors 

Severity: Critical.

Explanation: There is an internal error in communication using the IP settings.

Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: Unable to set the receive buffer size for the IP socket. Verify the IP 
services on the server

Source: Server Inventory Management - IP Communication Errors 

Severity: Warning.

Explanation: There is an internal error in communication using the IP settings.

Action: Verify that the IP services are functional. Run the Inventory scanner, 
SCANNER.NCF, to initiate the inventory scan.

INVSCAN.NLM: ZENINV.NLM on servername is an incompatible version

Source: Server Inventory Management - Specification of Inventory Server

Severity: Critical.

Explanation: The correct version of the ZENINV.NLM file does not exist.

Action: Ensure that you use the file shipped with ZENworks for Servers.
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Server Inventory Error Messages on Windows NT/2000 
Servers 

This section lists the error messages you may encounter while using Server 
Inventory, along with explanations and courses of action to follow to resolve 
the problems:

� “ZID001: The Inventory server name could not be obtained from the 
NTSCAN32.INI file” on page 467

� “ZID002: Unable to find or create the TEMP directory” on page 467

� “ZID003: Unable to find the WINDOWS directory” on page 467

� “ZID004: Unable to load DMISCAN.EXE” on page 468

� “ZID005: DMI scanning is unable to get the Windows TEMP directory” 
on page 468

� “ZID006: Unable to resolve the Inventory server name” on page 468

� “ZID007: NDS Tree or DN Name of the Inventory server is not available” 
on page 468

� “ZID008: Unable to send data over IP/IPX. Check the IP/IPX 
Configuration” on page 469

� “ZID009: Lost connection. Ensure that ZENINV.NLM is loaded on the 
Inventory server” on page 469

� “ZID010: Device ID is not found” on page 469

� “ZID011: Failed to perform Software Scan” on page 469

� “ZID012: Unable to register in to the DMI Service Layer” on page 470

� “ZID013: DMI scanning related configuration files are not found” on 
page 470

� “ZID014: DMI scanning related Class files is not found” on page 470

� “ZID015: No DMI Components found during the scan” on page 470

� “ZID016: Unable to open the temporary file for logging errors” on page 
470

� “ZID017: Unable to open the internal output file” on page 471

� “ZID018: Unable to open the DMISTAT.INI file” on page 471

� “ZID019: Unable to open the MINFO.INI file” on page 471
�
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� “ZID021: Unable to get the IP address due to a WinSock failure” on page 
472

� “ZID022: Unable to send DMI data to the Inventory server” on page 472

� “ZID023: NDS information like Tree or DN Name is not available” on 
page 472

� “ZID024: Unable to read Machine name” on page 472

� “ZID025: Unable to read MAC address” on page 473

ZID001: The Inventory server name could not be obtained from the NTSCAN32.INI file

Source: Server Inventory Management - Configuration and Settings

Severity: Critical.

Explanation: The installation of the Inventory Management agent is not completely done or 
the NTSCAN32.INI file may have been changed.

Action: Ensure that the NTSCAN32.INI file includes the inventory server name or 
address.

ZID002: Unable to find or create the TEMP directory

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Possible Cause: The Windows temporary directory does not exist.

Action: Ensure that the directory exists.

Possible Cause: The Windows environment variable (TMP or TEMP) has not been initialized.

Action: Ensure that the Windows environment variable TMP or TEMP has been 
initialized.

ZID003: Unable to find the WINDOWS directory

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Explanation: Windows is not properly installed.

Action: Ensure that Windows is properly installed.
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ZID004: Unable to load DMISCAN.EXE

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Explanation: An internal error has occurred. The file may be corrupted or does not exist.

Action: Reinstall Server Inventory. If the problem persists, contact Novell Technical 
Services.

ZID005: DMI scanning is unable to get the Windows TEMP directory

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Possible Cause: The Windows temporary directory does not exist.

Action: Ensure that the directory exists.

Possible Cause: The Windows environment variable (TMP or TEMP) has not been initialized.

Action: Ensure that the Windows environment variable TMP or TEMP has been 
initialized.

ZID006: Unable to resolve the Inventory server name

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Possible Cause: The IP or IPX stack configuration may not be operational on the server. 

Possible Cause: There may not be an active entry for the inventory server in the DNS.

Action: Ensure that you can ping the inventory server using the inventory server name.

ZID007: NDS Tree or DN Name of the Inventory server is not available

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Explanation: The scanner is unable to resolve the inventory server name to the appropriate 
NDS references. 

Action: Make sure that the inventory server is up and running.

Log in to the inventory server to make sure that the Novell Client is functional.

We recommend that in a pure IPX environment on a Windows NT server, you 
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should resolve this error by explicitly mapping a drive to the inventory server 
and running the scanner again.

ZID008: Unable to send data over IP/IPX. Check the IP/IPX Configuration

Source: Server Inventory Management - General Scanning 

Severity: Critical.

Possible Cause: The IP or IPX stack configuration may not be operational on the server.

Action: Verify the IP or IPX configuration of the server.

ZID009: Lost connection. Ensure that ZENINV.NLM is loaded on the Inventory server

Source: Server Inventory Management - Specification of Inventory Server 

Severity: Critical.

Possible Cause: The message is displayed if the network traffic is heavy.

Action: Ensure the Inventory Gatherer, ZENINV.NLM, is loaded on the inventory 
server. Look up the NTSCAN32.INI file for the inventory server name or 
address.

ZID010: Device ID is not found

Source: Server Inventory Management - General Scanning 

Severity: Critical.

Possible Cause: The temporary file, LDISCAN.CFG, created by the scanner, may be 
corrupted, or there may be a failure in creating the .CFG file.

Possible Cause: The Inventory Scanner is not resolvable.

Action: Check if the Inventory Server has multiple IP addresses. Ensure that you can 
ping using these IP addresses.

Action: Run the scanner again by stopping the ZFS Inventory service and restarting it.

ZID011: Failed to perform Software Scan

Source: Server Inventory Management - Software Scan 

Severity: Warning.

Possible Cause: The Software Dictionary file, SWAPPL.INI, is not found on the server.

Action: Ensure that the SWAPPL.INI file exists in the inventory agent directory.
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Action: Ensure that the contents of the SWAPPL.INI file are not corrupted. 

Run the Software List Editor from ConsoleOne to customize the applications 
that will be scanned.

ZID012: Unable to register in to the DMI Service Layer

Source: Server Inventory Management - DMI Scan 

Severity: Informational.

Possible Cause: The DMI 2.0 service layer is not operational on the system.

Action: Ensure that the DMI 2.0 service layer exists and is operational on the system.

ZID013: DMI scanning related configuration files are not found

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Action: Reinstall the Inventory Server Management Agent. 

ZID014: DMI scanning related Class files is not found

Source: Server Inventory Management - Configuration and Settings 

Severity: Critical.

Action: Reinstall the Inventory Server Management Agent. 

ZID015: No DMI Components found during the scan

Source: Server Inventory Management - DMI Scan 

Severity: Informational.

Possible Cause: The DMI service layer is not active in the system.

Possible Cause: No DMI components are registered to the DMI service layer.

Possible Cause: DMI components existing in the service layer do not implement DMTF 
classes.

Action: Ensure the existence of an active DMI 2.0 service layer on the system.

ZID016: Unable to open the temporary file for logging errors

Source: Server Inventory Management - General Errors 
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Severity: Warning.

Explanation: The scanner reports the various status information to a log file 
INVERRORS.LOG. These temporary files are created in the Windows 
directory or the Windows TEMP directory. 

Possible Cause: There is insufficient disk space for creating files in the Windows directory or 
the Windows temporary directory.

Action: Ensure that there is free disk space.

ZID017: Unable to open the internal output file

Source: Server Inventory Management - General Errors

Severity: Critical.

Possible Cause: The disk is full.

Action: Ensure that there is free disk space.

Possible Cause: You do not have Write privileges for the Windows temporary directory at the 
server.

Action: Ensure that you have Write privileges for the folder.

Action: Run the Inventory scanner again.

ZID018: Unable to open the DMISTAT.INI file

Source: Server Inventory Management - General Errors 

Severity: Warning.

Possible Cause: The DMISTAT.INI file was not found or it is corrupted.

Explanation: This file is created during the scanning process. It is located in the Windows 
directory or Windows TEMP directory. When this error occurs, the inventory 
information may be incomplete.

Action: Run the Inventory scanner again.

ZID019: Unable to open the MINFO.INI file

Source: Inventory Management - General Errors 

Severity: Warning.

Possible Cause: The MINFO.INI file was not found or it is corrupted.
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Explanation: This file is created during the scanning process. It is located in the Windows 
directory or Windows TEMP directory.

Action: Run the inventory scanner again.

ZID021: Unable to get the IP address due to a WinSock failure

Source: Server Inventory Management - DMI Scan

Severity: Warning.

Explanation: There is an internal error in WinSock installation.

Action: Verify if you can ping the inventory server with the name or address. Run the 
Inventory scanner again.

ZID022: Unable to send DMI data to the Inventory server

Source: Server Inventory Management - DMI Scan

Severity: Warning.

Possible Cause: The message is displayed if the network traffic is heavy.

Explanation: Ensure that the server communication over IP/IPX does not have problems.

ZID023: NDS information like Tree or DN Name is not available

Source: Server Inventory Management - General Errors

Severity: Warning.

Explanation: If NDS for NT is not installed, the inventory scanner will report the machine 
name for DN and the MAC address for the tree name.

Action: Install NDS for NT on the server if you require the NDS DN and tree name 
information.

ZID024: Unable to read Machine name

Source: Server Inventory Management - General Errors

Severity: Critical.

Explanation: The information may not be available.

Action: Enter the host name of the server. From the desktop console, click Start > 
Settings > Control Panel > Network > Identification > enter the Computer 
Name.
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ZID025: Unable to read MAC address

Source: Server Inventory Management - General Errors

Severity: Critical.

Explanation: The LAN adapter may not be installed properly.

Action: Check the network configuration of the server.

Remote Management Console Error Messages

This section contains detailed explanations of the following error messages 
you may encounter using the ZfS Remote Management console session:

� “Could not establish a Remote Management session with target.” on page 
473

� “Incompatible Remote Management Agent detected on the target 
Windows NT server <IP/IPX address>.” on page 474

� “Socket Error. Check network status and IP protocol configuration.” on 
page 474

� “Socket Error. Check network status and IPX protocol configuration.” on 
page 474

� “Status: Remote Management agent not found on the target Windows NT 
server <IP/IPX address>.” on page 474

� “The remote workstation did not respond to session establishing request.” 
on page 475

Could not establish a Remote Management session with target.

Source: Remote Management Console

Severity: Important

Explanation: This message is displayed if the target server is down or the ZfS Remote 
Management service is not running.

Action: Make sure the target server is up and ZfS Remote Management service is 
running.
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Incompatible Remote Management Agent detected on the target Windows NT server 
<IP/IPX address>.

Source: Remote Management Console

Severity: Critical

Possible Cause: The agent installed on the managed Windows NT server is not a ZfS agent.

Action: Uninstall any third-party remote control agent or remote control application 
running on the managed Windows NT server.

Action: Install the Remote Management Agent that ships with ZfS.

Socket Error. Check network status and IP protocol configuration.

Source: Remote Management Console

Severity: Important

Possible Cause: Protocol stack (IP, IPX, IP/CMD) is corrupted.

Action: Ensure that the protocol stack is installed and configured correctly.

Possible Cause: Network error.

Action: Ensure that the network is functioning.

Socket Error. Check network status and IPX protocol configuration.

Source: Remote Management Console

Severity: Important

Possible Cause: Protocol stack (IP, IPX, IP/CMD) is corrupted.

Action: Ensure that the protocol stack is installed and configured correctly.

Possible Cause: Network error.

Action: Ensure that the network is functioning.

Status: Remote Management agent not found on the target Windows NT server <IP/
IPX address>. 

Source: Remote Management Console

Severity: Important

Explanation: This message is displayed if the target server is down or the ZfS Remote 
Management service is not running
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Action: Make sure the target server is up and ZfS Remote Management service is 
running

The remote workstation did not respond to session establishing request.

Source: Remote Management Console

Severity: Important

Possible Cause: The Remote Management Agent is not responding to authentication requests 
from the management console or the network is down.

Action: The network is functioning.

Remote Management Agent Error Messages

This section contains detailed explanations of the following error message you 
may encounter using the ZfS Remote Management agent:

� “Failed to initialize the network. Check if another instance of agent is 
running. Contact the system administrator.” on page 475

Failed to initialize the network. Check if another instance of agent is running. Contact 
the system administrator.

Source: Remote Management Agent

Severity: Critical

Possible Cause: The Remote Management Agent is unable to bind to the IPX or IP port that is 
being used for Remote Management service, or if the ports are being used by 
some other application running on the managed workstation.

Action: Uninstall any third-party remote control agent or remote control application 
using these ports from the managed workstation.

Possible Cause: The protocol stack is corrupted.

Action: Reinstall the protocol stack.

Possible Cause: The managed workstation is not connected to the network, or the network is 
down.

Action: Connect the managed workstation to the network.
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Troubleshooting a ZENworks 2 Installation over 
ZENworks for Servers

The following sections describe the troubleshooting procedures that you can 
use to solve potential problems that may affect the interoperability of 
ZENworks 2 and ZENworks for Servers (ZfS) products. For more information 
about ZENworks 2 installation, see ZENworks for Servers Installation and 
Setup.

� “Database startup problems” on page 476

� “Inventory problems” on page 477

Database startup problems

Problem: Two database startup files, SYBASE.NCF and MGMTDBS.NCF, are 
included in the AUTOEXEC.NCF file.

Action: To isolate and resolve the problems while starting databases in such 
installations, verify the following:

� Is ZENworks 2 Support Pack 1 installed with the Update the Database 
option selected? 

Verify the presence of the SYBASE.NCF file on the server in the 
SYS:\SYSTEM directory. If the file exists, then ZENworks 2 Support 
Pack 1 has not been properly installed. 

Proceed to install ZENworks 2 Support Pack 1. This is necessary to have 
the right versions of modules available and for interoperability with ZfS.

� Is the ZENworks Support Pack 1 installation on the NetWare Server done 
properly?

Verify the contents of the AUTOEXEC.NCF file in the SYS:\SYSTEM 
directory. It should not contain references to SYBASE.NCF; otherwise 
install ZENworks Support Pack 1 with the Update the Database option 
selected.

� Are the right versions of Inventory Gatherer and the Inventory Storer 
being loaded on the ZfS inventory server?

Verify the contents of the AUTOEXEC.NCF in the SYS:\SYSTEM 
directory. Ensure that the following lines are commented out:

SYS:\SYSTEM\GATHERER.NCF

SYS:\PUBLIC\ZENWORKS\JAVA\MASTER.NCF
��
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SYS:\PUBLIC\ZENWORKS\JAVA\STORER.NCF

Inventory problems

Problem: There are many workstations on the network and the inventory data is 
displayed for only a few workstations.

Action: To isolate and resolve the problems while scanning inventory of workstations, 
verify the following:

� Are the Inventory Gatherer and the Inventory Storer loaded on the ZfS 
inventory server?

Verify the list of NLMs and Java programs on the server to see if the 
Inventory Gatherer and the Inventory Storer are loaded. The Inventory 
Storer screen should display "Starting Inventory Storer. (C)Copyright 
1999-2000 Novell Inc." Also verify that the Inventory Gatherer and the 
Inventory Storer refer to the same STRDIR location.

� Are successful scans not reaching the database?

If the Inventory Gatherer and the Inventory Storer combination is 
executing and scans are being sent successfully, verify whether the 
Inventory Gatherer and the Inventory Storer refer to the same STRDIR 
location. Verify the following on the ZfS inventory server:

� STR_DIR parameters in the GATHERER.NCF file located in 
SYS:\zfs_directory\MWSERVER\BIN.

� -temp parameter in STORER.PROPERTIES located in  
SYS:\zfs_directory\MWSERVER\PROPERTIES.
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Customizing Agent Configuration

The ZENworksTM for Servers (ZfS) server management SNMP agents run on 
NetWare® and Windows* NT* servers in your network. The agents monitor 
servers, collecting historical data and dynamic data in response to requests 
from the management console. An administrator at the ZfS management 
console can request data simply by clicking a representative icon for any 
device, operating system, or service discovered on a server.

After the management agent for NetWare and management agent for Windows 
NT have been installed on your network NetWare and Windows NT servers, 
they are ready to operate with the default settings. In most cases, this 
configuration is sufficient; however, you can customize the agent settings to 
enhance management functionality.

This appendix contains the following sections:

� “Agent Files” on page 479

� “Customizing the Management Agent for NetWare” on page 483

� “Customizing the Management Agent for Windows NT Server” on page 
486

Agent Files

The following sections describe the agent files that are installed on each 
managed server:

� “Management Agent for NetWare Files” on page 480

� “Management Agent for Windows NT Server Files” on page 482
Customizing Agent Configuration ���
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Management Agent for NetWare Files

The following table describes the management agent for NetWare NLMTM 
files installed on a NetWare server:

The following table provides a brief description of the enterprise MIBs 
associated with the management agent for NetWare:

Management Agent for 
NetWare NLM Files

Description

SERVINST.NLM Implements the NetWare server MIB 
(NWSERVER.MIB).

HOSTMIB.NLM Implements the standard Host Resources MIB 
[RFC 1514] and Novell® extensions to that MIB 
(NWHOSTX.MIB). 

NTREND.NLM Implements the Threshold and Trend MIB 
(NWTREND.MIB). When loaded, 
NTREND.NLM sets trends and thresholds for 
each monitored attribute according to the 
server’s configuration. The NTREND.INI file 
contains configuration parameters for 
NTREND.NLM.

NWTRAP.NLM Implements the NetWare Server Trap MIB 
(NWALARM.MIB). The NWTRAP.CFG file 
contains configuration parameters for 
NWTRAP.NLM.

FINDNMS.NLM Used by NetWare servers running the 
management agent for NetWare. Employ 
FINDNMS.NLM to listen for management 
consoles advertising themselves using the 
Service Advertising Protocol (SAP) number 
0x026a. FINDNMS.NLM then adds the 
Internetwork Packet ExchangeTM (IPXTM) 
address of each management console 
discovered to the list of stations that receive 
traps. 

NDSTRAP.NLM Implements the NDSTRAP.MIB to capture and 
forward NDS® events to SNMP management 
consoles.

MONDATA.NLM Allows you to monitor NetWare servers.
��� Management and Monitoring Services
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MIB Name Description

NDSTRAP.MIB A Novell proprietary MIB designed to capture 
NDS events and forward them to SNMP 
management consoles as SNMP traps. There 
are more than 130 traps currently in the MIB and 
new ones are being added as they are identified.

NWALARM.MIB A Novell proprietary MIB that handles all the 
NetWare Core OS alerts and forwards them as 
SNMP traps. It currently supports more than 375 
traps and new ones are being added as they are  
identified.

NWHOSTX.MIB A Novell extension to RFC1514 (the Host 
Resources MIB). It adds devices and 
components that are specific to NetWare that 
were not directly included in RFC1514.

NWSERVER.MIB A Novell proprietary MIB that is the basis for 
NetWare Core OS management. More than 300 
objects are identified in this MIB. Access to the 
console-settable parameters for both GET and 
SET is defined. The MIB has several groups and 
tables for users, file systems, volumes, queues, 
Open Data-Link InterfaceTM (ODITM), set 
parameters, and so forth.

NWTMSYNC.MIB A Novell proprietary MIB that allows for SNMP 
management of TIMESYNC.NLM. It provides 
access to the list of time sources as well as time 
clients. You may also access the clock structure 
through this MIB.

NWTREND.MIB A Novell proprietary MIB that keeps track of 
objects that are most useful when tracked over a 
period of time. For example, CPU utilization and 
packets received have limited value as static 
numbers, but when monitored at regular 
intervals for a period of time, they tell a great 
deal about what is happening on a server. This 
MIB also lets you set user-definable thresholds 
for the managed objects and will send SNMP 
traps when a threshold is exceeded.
Customizing Agent Configuration ���
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Management Agent for Windows NT Server Files

Following is a list of files that can be manually configured with a text editor 
to modify default results of the management agent for Windows NT: 

The following table provides a brief description of the enterprise MIBs 
associated with the management agent for Windows NT. In addition, the 
management agent for Windows NT converts all Windows NT system, 
security, and application events to SNMP traps. 

RFC1514.MIB The Internet Standard Host Resources MIB. It 
defines general categories about a host 
machine, including physical components of the 
system such as disks, memory, CPU, printers, 
adapter cards, and so forth.

Management Agent for 
Windows NT Server .INI Files

Description

N_NTTREN.INI Specifies the initial values for the trends and 
thresholds supported by the management agent 
for Windows NT.

NTTRAP.INI Specifies settings to troubleshoot your Windows 
NT server that runs the management agent for 
Windows NT and settings to enable you to send 
Windows NT events to the management system 
as SNMP traps.

NTHOST.INI Specifies the SNMP settings supported by the 
management agent for Windows NT.

N_NTFMW.INI Allows you to specify IPX addresses that will be 
ignored and will not receive SNMP traps.

MIB Name Description

HOST.MIB A generic MIB based on RFC1514. Windows NT 
events that are converted into traps are 
forwarded to the ZfS network management 
system.

MIB Name Description
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Customizing the Management Agent for NetWare

The management agent for NetWare installation process creates the 
NMA2.NCF file (NetWare 3.x and 4.x servers) or the NMA5.NCF file 
(NetWare 5.x servers) in the SYS:\ZFS_AGNT\NMA directory. When the 
NetWare server is started, this file automatically loads all the NLM files 
required for the management agent for NetWare in a default configuration 
state. There are, however, several LOAD parameters that you can configure 
for each of the NLM files used with the agent.

You can configure your server to use these options by editing the NMA2.NCF 
or NMA5.NCF file on your server. Also, if your server is already running, you 
can unload any of these NLM files and then load them at the NetWare server 
console using any of the configuration parameters. You can configure these 
parameters at the NetWare server console or by using the NetWare remote 
console utility, RCONSOLEJ.

The sections that follow describe each of the command-line parameters that 
you can configure for the management agent for NetWare.

� “SERVINST.NLM Load Parameters” on page 484

� “HOSTMIB.NLM Load Parameters” on page 484

� “NTREND.NLM Load Parameters” on page 485

RFC1514.MIB The Internet Standard Host Resources MIB. It 
defines general categories about a host 
machine, including physical components of the 
system such as disks, memory, CPU, printers, 
adapter cards, and so forth.

NTTREND.MIB A Novell proprietary MIB that keeps track of 
objects that are most useful when tracked over a 
period of time. For example, CPU utilization and 
packets received have limited value as static 
numbers, but when monitored at regular 
intervals for a period of time, they tell a great 
deal about what is happening on a server. This 
MIB also lets you set user-definable thresholds 
for the managed objects and will send SNMP 
traps when a threshold is exceeded.

MIB Name Description
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SERVINST.NLM Load Parameters

SERVINST.NLM implements the NWSERVER.MIB NetWare Server MIB. 
You can load SERVINST.NLM at the command line with any or all of the 
following parameters:

LOAD SERVINST D, U=n, V, B=n H

HOSTMIB.NLM Load Parameters

HOSTMIB.NLM implements both the standard Host Resources MIB 
(RFC 1514) and the Novell extensions to the Host Resources MIB 

Parameter Description

D DisableSets: If this parameter is present, SERVINST.NLM 
does not allow SNMP SET commands for objects in 
NWSERVER.MIB.

Default: SETS enabled (subject to SNMP security).

U=n UpdateInterval=n: Sets the list update interval to n (n is a 
value in seconds). This determines how often certain internal 
lists kept by SERVINST.NLM (such as volumes and queues) 
are updated. Set this parameter higher to minimize the 
number of CPU cycles used by SERVINST.NLM, or lower to 
guarantee immediate reporting of server status changes that 
affect the lists.

Default: 300 seconds.

V Verbose: Displays informational messages.

Default: Off.

B=n BuildUserListHour=n: The local time each day on a 24-hour 
clock (0 to 23) at which the SERVINST.NLM software builds a 
list of users that have access to the server.

Default: 2 (2:00 AM).

H Help: Displays help on command line parameters. If you use 
the H parameter, SERVINST.NLM displays the help 
messages and then exits. It does not remain loaded even if 
other parameters are entered on the command line.

Default: Off.
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(NWHOSTX.MIB). You can load HOSTMIB.NLM at the command line with 
any or all of the following parameters:

LOAD HOSTMIB.NLM D, U=n, V, H

NTREND.NLM Load Parameters

NTREND.NLM implements the Threshold and Trend MIB 
(NWTREND.MIB).

When first loaded, NTREND.NLM automatically sets trends and thresholds 
for each monitored attribute according to the server’s configuration from 
values stored in the NTREND.INI file (located in the SYS:\ETC directory). 
You can edit this file as described in “Setting Default Trends and Thresholds” 
on page 127.

Thereafter, as configuration changes occur over time, NTREND.NLM adjusts 
to changes in the number and type of physical network interfaces, queues, 
volumes, and disks. Default thresholds are set only for important parameters. 

Parameter Description

D DisableSets: If this parameter is present, HOSTMIB.NLM 
does not allow SNMP SET commands for objects in 
RFC1514.MIB or NWHOSTX.MIB.

Default: SETS enabled (subject to SNMP security).

U=n UpdateInterval=n: Sets the list update interval to n (n is a 
value in seconds). This determines how often certain internal 
lists kept by HOSTMIB.NLM are updated. Set this parameter 
higher to minimize the number of CPU cycles used by 
HOSTMIB.NLM, or lower to guarantee immediate reporting of 
server status changes that affect the lists.

Default: 60 seconds.

V Verbose: Displays informational messages.

Default: Off.

H Help: Displays help on command-line parameters. If you use 
the H parameter, HOSTMIB.NLM displays the help messages 
and then exits. It does not remain loaded even if other 
parameters are entered on the command line.

Default: Off.
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You can later use SNMP SET commands to set thresholds for parameters such 
as files read and packets in.

A trend file is created for each monitored attribute instance, even if trending 
is disabled for that object. The file header contains all the information from 
nwtControlTableEntry, and the rest of the file stores the sample history (if 
any). Once a trend file is created, it exists until explicitly deleted by the 
operator, even if the monitored object (a queue, for example) no longer exists. 
When a monitored object no longer exists, the associated nwtControlStatus is 
recorded as invalid.

You can load NTREND.NLM at the command line with any or all of the 
following parameters:

LOAD NTREND D=dir, R, V, H

Customizing the Management Agent for Windows NT 
Server

You can manually edit the following files to modify the default management 
agent for Windows NT configuration on a managed Windows NT server. 

Parameter Description

D=dir Directory=dir: Enables you to specify the volume and 
directory where NTREND.NLM stores the history data files. 
Example: To use VOL1:\TEST as the directory for trending 
files, enter the following command:

load ntrend D=vol1:\test

Default: SYS:\NTREND.

R Reset: Causes NTREND.NLM to discard all the old trending 
history data and restart the sampling.

V Verbose: Displays informational messages.

Default: Off.

H Help: Displays help on command-line parameters.

Default: Off. 
��
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Configuring the Management Agent for Windows NT Server

By default, the management agent for Windows NT sends traps to all 
management consoles on IPX networks broadcasting the 0x026 Service 
Advertising Protocol (SAP) ID. You can edit the N_NTFMW.INI file to 
include the IPX addresses of management consoles that you do not want to 
include as trap targets. 

To add the IPX address of a management console to omit as an automatic trap 
recipient:

� Open the N_NTFMW.INI file in a text editor.

� Add IPX address for omitted management console using the following 
syntax:

xxxxxxxx.yyyyyyyyyyyy

where xxxxxxxx is the net address and yyyyyyyyyyyy is the node address, 
such as 01014044.00001B4DDAFD.

� Save the file and restart the management agent for Windows NT.

Management Agent for 
Windows NT Server .INI Files

Description

N_NTFMW.INI Allows you to specify IPX addresses that will be 
ignored and will not receive SNMP traps.

NTTRAP.INI Specifies settings to troubleshoot your managed 
Windows NT servers and set trap filters to 
specify which Windows NT events are sent to 
the management system as SNMP traps. 

See “Controlling Alarm Generation” on page 133 
for detailed information on configuring trap filters 
and trap generation.

N_NTTREN.INI Specifies the initial values for the trends and 
thresholds supported by the management agent 
for Windows NT.

See “Setting Default Trends and Thresholds” on 
page 127 for detailed information on modifying 
default trends and thresholds.
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Third-Party Agent Configuration

Third-party SNMP agents require the following tasks to be completed before 
traps are received: 

� “Ensuring Traps Are Received” on page 488

� “Integrating Vendor-Specific SNMP Traps” on page 488

Ensuring Traps Are Received

When configuring the SNMP agent or SNMP Remote Network Monitoring 
(RMON) agent on a network device, configure the agent’s trap destination list 
(trap-target list) to include the ZfS management server station IP address or 
server name. Refer to the agent’s documentation for information on 
configuring this. The management console displays alarms for all devices that 
forward alarms to the management server. 

If your network device is using Management Agent for NetWare, 
Management Agent for Windows NT Server, NetWare LANalyzer® AgentTM, 
or LANalyzer Agent for Windows NT, the agent’s trap destination list is 
automatically configured for you. For information on configuring the trap 
destination list, see “Setting Up Discovery” on page 72 for configuration 
information and Chapter 7, “Traffic Analysis,” on page 177 for information on 
configuring the RMON agents.

Integrating Vendor-Specific SNMP Traps

Before AMS can process the alarm, you must include vendor-specific MIBs 
for the third-party SNMP agents in the management server MIB pool. You can 
further integrate third-party SNMP agents by annotating the trap definitions in 
the vendor MIB. 

AMS interprets ASN.1 annotations to trap definitions in a MIB to set the 
severity level and device status assigned to an alarm. The MIBs included with 
ZfS already include the proper annotations. The annotations provide detail on 
severity levels and device status to the AMS. 

See Chapter 8, “Server Inventory,” on page 293 for information on adding a 
MIB to the management server’s MIB pool and annotating third-party MIBs. 
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Uninstalling the Management Site 
Services and Agents

This section covers uninstalling ZENworks for ServersTM (ZfS) Management 
Site Services and various agents. It includes the following sections:

� “Uninstalling Management Site Services” on page 489

� “Uninstalling the Traffic Analysis Agent” on page 490

� “Uninstalling the Management Agent” on page 492

� “Uninstalling the Server Inventory Management Agent” on page 493

� “Uninstalling the Remote Management Agent” on page 495

� “Uninstalling the Server Inventory Management Services” on page 497

� “Uninstalling the ManageWise 2.7 Components” on page 502

Uninstalling Management Site Services

To uninstall the ZfS Management Site Services: 

� At the management server console prompt, unload the Sybase* database 
engine. 

Switch to the Sybase process (for example, using Ctrl+Esc) > enter q to 
terminate the Sybase database engine. 

� At the server console prompt, enter  unmw to unload the management 
server.

� From the ZfS console, launch the batch file UNINST.BAT in the 
volume:\ZFS\MWSERVER\UNINSTALL folder.
Uninstalling the Management Site Services and Agents ���
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� Delete the ZFS folder on the management server if the processes are in 
use and the uninstall is not complete. 

	 If this server is not the ZENworks 2 Database server, remove the 
following line from SYS:\SYSTEM\MGMTDBS.NCF:

volume:\ZfS_installation_directory\MWServer\db\z
eninv.db

If MGMTDBS.NCF does not load any other databases, delete this file.


 Uninstall does not delete MW and ZENINVdatabases, 
NETEXPLOR.DAT files, and INVENTORY.STR files. If you do not 
plan to use this data, delete the ZfS folder.

Uninstalling the Traffic Analysis Agent

This section contains the following tasks:

� “Uninstalling the Traffic Analysis Agent from a NetWare Server” on page 
490

� “Uninstalling the Traffic Analysis Agent from a Windows NT/2000 
Server” on page 491

Uninstalling the Traffic Analysis Agent from a NetWare Server

Depending on your network configuration, you might have to uninstall the 
Traffic Analysis Agent for NetWare® software to make room for another 
agent or to upgrade to a more recent version of an agent.

You should upgrade all Traffic Analysis Agents for NetWare installed on your 
network to the current version shipping with ZENworks for Servers. You 
should uninstall existing agents before you install new agents. Before 
uninstalling the Traffic Analysis Agent for NetWare, migrate the trend files 
using the TREND utility so that this data can be used by the ZfS console.

127(��LANZDIR is the default directory where the Traffic Analysis Agent is 
installed.

Uninstalling the Traffic Analysis Agent for NetWare does the following:

� Removes all the files in the LANZDIR directory and deletes the directory

� Removes the LANZ.NCF and ULANZ.NCF files from the 
SYS:\SYSTEM directory
��� Place Book Title Here
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� Removes the Traffic Analysis Agent for NetWare statements from the 
AUTOEXEC.NCF file

� Deletes the long-term trend data file from the GTREND directory

To uninstall the Traffic Analysis Agent from a NetWare server:

� Enter ULANZ at the console prompt to load the LANalyzer AgentTM.

� Search for the Traffic Analysis Agent for NetWare statements in the 
AUTOEXEC.NCF file. 

For example, search for statements beginning with Search add LANZDIR 
and LANZ.NCF.

� Delete all the files from the directory where the Traffic Analysis Agent 
for NetWare is installed. 

� Delete the GTREND files from the server. 

Obtain the directory name from the argument to GTREND.NLM in the 
LANZ.NCF file. The default directory name is SYS:\GTREND.

	 Delete the LANZ.NCF and ULANZ.NCF files from the SYS:\SYSTEM 
directory.


 Delete the Traffic Analysis Agent for NetWare statements from the 
AUTOEXEC.NCF file. 

� Delete the LANZTM installation information from PRODUCTS.DAT.

Uninstalling the Traffic Analysis Agent from a Windows NT/2000 
Server

Uninstalling the Traffic Analysis Agent from a Windows* NT* or Windows 
2000 server stops the services provided by the traffic analysis tools.

,03257$17�� Back up the registry before you modify it.

To uninstall the Traffic Analysis Agent from a Windows NT/2000 server:

� Run LANZCON and select Configure > Traffic Analysis Agent for 
Windows NT Parameters > Network Trends to get the name of the trend 
directory. For example, the GTREND directory.

� Enter NET STOP SNMP at the MS-DOS* prompt to stop the SNMP 
service.

� Delete the LANZ*.DLL and GTREND.DLL files from the Systems32 
directory of Windows NT.
Uninstalling the Management Site Services and Agents ���
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� Delete the LANZNDIS.SYS file from System32\drivers directory.

	 Click Start > Run > Regedit to start REGEDIT and delete the following 
entries:

� HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Managewise\L
ANZ-NT key

� All entries with the NOVELL.LANZ value name from 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\S
ervices\SNMP\Parameters\ExtensionAgents


 Delete the trend directory identified in Step 1. The default directory name 
is GTREND.

� Unload the LANZCON application, if loaded.

� Delete the directory containing the LANZCON application. The default 
directory is \ZFS_AGNT\LANZCON.

Uninstalling the Management Agent

This section contains the following tasks:

� “Uninstalling the NetWare Management Agent” on page 492

� “Uninstalling the Windows NT/2000 Management Agent” on page 493

Uninstalling the NetWare Management Agent

To uninstall the NetWare Management AgentTM (NMA):

� Unload any NMA NetWare Loadable ModuleTM (NLMTM) by doing one 
of the following:

� At the NetWare 5.x system console, enter unnma5 and press Enter. 

� At the NetWare 3.x or 4.x system console, enter unnma2 and press 
Enter.

� On the client, delete the SYS:\ZFS_AGNT\nma directory.

� Edit the SYS:\SYSTEM\AUTOEXEC.NCF file and remove the 
following two lines:

search add SYS:\ZFS_AGNT\nma

NMA5.NCF
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Uninstalling the Windows NT/2000 Management Agent

To uninstall the Windows NT/2000 Management Agent:

� On the Windows NT/2000 server, stop the SNMP service by selecting  
Start > Settings > Control Panel > Services > SNMP > Stop.

� Delete the C:\ZFS_AGNT\ntagent directory.

� Select My Computer > Properties > Environment > System Variables > 
Path and remove C:\ZFS_AGNT\ntagent\bin from the path string.

� Clean the Windows Registry by deleting the following entries:

HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ManageWise\Cu
rrentVersion folder (including all subfolders)

HKEY_LOCAL_MACHINE\SYSTEM\ControlSetxxx\services
\Eventlog\Application\NT* (where NT* = NT Diag, NT 
Eval, NT FindMW, NT Host, NT Server, NT Trap, and NT Trend)

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\serv
ices\Eventlog\Application\NT* (where NT* = NT Diag, 
NT Eval, NT FindMW, NT Host, NT Server, NT Trap, and NT Trend)

	 Restart the SNMP service on the Windows NT/2000 server by selecting 
Start > Settings > Control Panel > Services > SNMP > Start.

Uninstalling the Server Inventory Management Agent

When you uninstall the Server Inventory Management Agent, the inventory 
management files are removed from the server. This section includes the 
following tasks:

� “Uninstalling the Server Inventory Management Agent from a NetWare 
Server” on page 493

� “Uninstalling the Server Inventory Management Agent from a Windows 
NT/2000 Server” on page 494

Uninstalling the Server Inventory Management Agent from a NetWare 
Server

To uninstall the Server Inventory Management Agent from a NetWare server:

� From the NetWare server that has the Inventory Management Agent 
installed, enter unload invscan to stop the agent. 
Uninstalling the Management Site Services and Agents ���
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This ensures that the Server Inventory Management Agent is unloaded 
and the inventory information for the NetWare server is not updated in the 
database.

� Delete the following inventory scanner files from the SYS:\SYSTEM 
directory of the server: INVSCAN.NLM, INVSCAN.INI, and 
SCANNER.NCF.

� Make sure that the Software Dictionary file, SWAPPL.INI is not in shared 
usage by other inventory servers. Delete the SWAPPL.INI from the 
SYS:\SYSTEM directory of the NetWare server. 

� Modify the AUTOEXEC.NCF in the SYS:\SYSTEM to delete the 
following reference to the Inventory Scanner:

sys:\system\scanner.ncf

Uninstalling the Server Inventory Management Agent from a 
Windows NT/2000 Server

To uninstall the Server Inventory Management Agent from a Windows NT/
2000 server:

� From the Windows NT/2000 server that has the Server Inventory 
Management Agent installed, stop the Server Inventory Management 
Agent.

�� From the desktop console, select Start > Settings > Control Panel > 
Services > select the Server Inventory Management Agent.

�� Click Stop.

� Delete the directory in which the Inventory Scanner files are installed on 
the server. 

The default directory name is \ZFS_AGNT. This directory contains the 
following files: INVSCAN.EXE, NTSCAN32.EXE and 
DMISCAN.EXE.

Deleting the directory will also delete the inventory-related files, such as 
LOC32VC.DLL, WCDMI.DLL, WDMIUTIL.DLL, SWAPPL.INI, as 
well as other files in the NLS subdirectory.

� Delete the NTSCAN32.INI file from the Windows directory.

� Disable the Server Inventory Management Agent on the server.
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�� From the desktop console, select Start > Settings > Control Panel > 
Services > select the Server Inventory Management Agent. 

�� Set the Server Inventory Management Agent state to Disabled. This 
ensures that the service will not start up on the server

	 Make changes in the registry.

	� Select Start > Run > Regedit.

	� Back up the registry before modifying it. Select Registry > Export 
Registry file > enter a location for backup file > enter a file name > 
click Save.

	� Delete the following Server Inventory Management key: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\S
ervices\ZFS Inventory

Uninstalling the Remote Management Agent

This section contains the following tasks:

� “Uninstalling the Remote Management Agent from a NetWare Server” on 
page 495

� “Uninstalling the Remote Management Agent from a Windows NT/2000 
Server” on page 496

Uninstalling the Remote Management Agent from a NetWare Server

Uninstalling the Remote Management Agent from NetWare server stops the 
NetWare server from being remotely controlled.

To uninstall the Remote Management Agent on NetWare:

� Enter Unload RCONAGP.NLM at the server console prompt.

� Delete the RCONAGP.NLM, LDRCAGNT.NCF and RCONAG6.CFG 
files from the SYS: \ SYSTEM directory.

� Delete the LDRCAGNT entry from the AUTOEXEC.NCF file.

� Restart the NetWare server.
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Uninstalling the Remote Management Agent from a Windows NT/
2000 Server

Uninstalling the Remote Management Agent from a Windows NT/2000 
server stops the remote management service, deletes files from the managed 
server, and deletes the entries from the registry that were added during the 
installation of the Remote Management Agent.

,03257$17��Back up the registry before you modify it.

To uninstall the Remote Management Agent from a Windows NT/2000 
server:

� Select Start > Settings > Control Panel > Services to stop the ZFS Remote 
Management Service.

� Click Start > Run > Regedit to start REGEDIT. Do the following:

� Delete the ZFS Remote Management key from 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\S
ervices\ZfSRemoteManagement.

� Delete the ZENRC Tray Icon string and its value from 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\Run.

� Delete the KBSTUFF key from 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\S
ervices.

� Delete the Palomar key from 
HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Palomar.

� Delete the DRISHTI entry. Do the following:

� Read the data of the \Device\Video0 value from 
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\VIDE
O. The value will be 
\REGISTRY\MACHINE\SYSTEM\<control 
set>\SERVICES\<display driver>\DEVICE0

� Locate for the <display driver> directory in 
HKEY_LOCAL_MACHINE\SYSTEM\<control 
set>\SERVICES

� From the DEVICE0 directory, double-click the  
InstalledDisplayDrivers value.

� Delete the DRISHTI entry.
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On a Windows 2000 server, perform the following additional steps: 

� Read the data of the \Device\Video0 value from 
HKEY_LOCAL_MACHINE\HARDWARE\DEVICEMAP\VIDE
O. The value will be 
\REGISTRY\MACHINE\SYSTEM\<control 
set>\SERVICES\<display driver>\DEVICE0

� Read the data of the 0 value from 
HKEY_LOCAL_MACHINE\SYSTEM\<control 
set>\SERVICES\<display driver>\ENUM

� Locate the <data of the 0 value> directory in  
HKEY_LOCAL_MACHINE\SYSTEM\<control 
set>\ENUM\

� Read the data of the DRVIVERS value in the <data of the 0 
value> directory.

� Locate the <data of the DRIVERS value> directory in 
HKEY_LOCAL_MACHINE\SYSTEM\CONTROLSET001\CO
NTROL\CLASS

� From the SETTINGS directory, double-click the  
InstalledDisplayDrivers value.

� Delete the DRISHTI entry.

� Delete all the files from the directory where the Remote Management 
Agent is installed. For example, remove the C:\ZFS_agent directory if the 
Remote Management Agent was previously installed in that directory.

� Remove the DRISHTI.DLL, YUKTI.DLL and ZENTRAY.EXE files 
from the System32 directory of Windows NT/2000 server.

Uninstalling the Server Inventory Management Services

This section contains the following procedures to uninstall the Server 
Inventory Management Services:

� “Uninstalling the ZfS Inventory Gatherer” on page 497

� “Uninstalling the ZfS Inventory Storer” on page 499

Uninstalling the ZfS Inventory Gatherer

Follow the instructions specified in these sections:
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� “Uninstalling the ZfS Inventory Gatherer in a ZfS Setup” on page 498

� “Uninstalling the ZfS Inventory Gatherer in a ZfS Setup over a 
ZENworks 2 Support Pack 1 Setup” on page 498

Uninstalling the ZfS Inventory Gatherer in a ZfS Setup

Complete the following steps if the ZfS installation is not being shared with a  
ZENworks 2 setup.

To uninstall the ZfS Inventory Gatherer in a ZfS setup:

� Identify the NetWare server installed with Site Management Services.

� Ensure that the Inventory Gatherer is not running.

� To stop the Inventory Gatherer, from the Site Management Server 
console, enter unload zeninv.nlm.

� From a workstation running the Novell ClientTM, log in to the NetWare 
server.

	 Map a drive to the SYS volume of the NetWare server.


 Using the mapped drive, delete the following Inventory Gatherer files 
installed on the NetWare server:

� GATHERER.NCF in the SYS:\zfs_directory\MWSERVER\BIN 
directory

� ZENINV.NLM in the SYS:\SYSTEM directory

� Remove the references to the Inventory Gatherer from the NetWare 
server:

�� Delete the following entries from the INVENTORY.NCF file in the 
SYS:\zfs_directory\MWSERVER\BIN directory. 

gatherer.ncf

This ensures that there the Inventory Gatherer will not be loaded.

Uninstalling the ZfS Inventory Gatherer in a ZfS Setup over a ZENworks 2 Support Pack 1 
Setup

When you install ZENworks 2, the Inventory Gatherer component 
(GATHERER.NCF) is copied to the SYS:\SYSTEM directory on the server. 
If you are planning to use ZENworks 2 and ZENworks for Servers 2, the 
Inventory Gatherer component should not be uninstalled.
��� Place Book Title Here

Place Book Title Here
Place Part Number Here

February 22, 2001



Manual Rev 99a28 22 June 00
To uninstall the ZfS Inventory Gatherer in a ZfS setup over a ZENworks 2 
Support Pack 1 setup:

� Identify the NetWare server installed with ZENworks 2 Inventory 
management components.

� Ensure that the Inventory Gatherer is not running. From the inventory 
server console, enter unload zeninv.nlm.

� Delete the following Inventory Gatherer files installed on the NetWare 
server:

� GATHERER.NCF file in the SYS:\SYSTEM directory

� ZENINV.NLM file in the SYS:\SYSTEM directory.

� To remove the references to the Inventory Gatherer from the NetWare 
server, delete the following lines from the AUTOEXEC.NCF in the 
SYS:\SYSTEM directory:

sys:\system\gatherer.ncf

This ensures that the Inventory Gatherer will not be loaded.

Uninstalling the ZfS Inventory Storer

Follow the instructions specified in these sections:

� “Uninstalling the ZfS Inventory Storer in a ZfS Setup” on page 499

� “Uninstalling the ZfS Inventory Storer in a ZfS Setup over a ZENworks 
2 Setup” on page 501

Uninstalling the ZfS Inventory Storer in a ZfS Setup

To uninstall the ZfS Inventory Storer in a ZfS setup:

� Identify the NetWare server installed with Site Management Services.

� Ensure that the Inventory Storer service is not running.

� From the Site management server console, invoke the Service Manager 
by entering smgrui.ncf.

� To stop the Storer process: 

�� In Service Manager, click Connect.

�� In the Select Host dialog box, enter storer for the Service Manager 
Name > click OK.
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If this service is running, the details are displayed in the Service List 
table.

	 To stop the Storer service, select the entry in the Service List table > click 
Stop.


 To stop the Master process:


� In the Service Manager, click Connect,


� In the Select Host dialog box, enter master for the Service Manager 
Name > click OK.

If this service is running, the details are displayed in the Service List 
table.

� To stop the Master service, select the entry in the Service List table > click 
Stop.

� From a workstation running the Novell Client, log in to the NetWare 
server.

 Map a drive to the SYS volume of the NetWare server.

�� Using the mapped drive, delete the following Inventory Storer files 
installed on the NetWare server: 

� STORER.NCF file in the SYS:\zfs_directory\MWSERVER\BIN 
directory. 

� MASTER.NCF file in the SYS:\zfs_directory\MWSERVER\BIN 
directory. 

� STORER.PROPERTIES file in the 
SYS:\zfs_directory\MWSERVER\PROPERTIES directory. 

� MASTER.PROPERTIES file in the 
SYS:\zfs_directory\MWSERVER\PROPERTIES directory. 

� SYS:\zfs_directory\MWSERVER\STORER directory.

�� To remove the references to the Inventory Storer from the NetWare 
server, delete the following entries from the INVENTORY.NCF file in 
the SYS:\zfs_directory\MWSERVER\BIN directory:

master.ncf

storer.ncf

This ensures that there the Inventory Storer will not be loaded.
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Uninstalling the ZfS Inventory Storer in a ZfS Setup over a ZENworks 2 Setup

To uninstall the ZfS Inventory Storer in a ZfS setup over a ZENworks 2 setup:

� Identify the NetWare server installed with ZENworks 2 Inventory 
management components.

� Ensure that the Inventory Storer is not running.

�� From the inventory server console, enter java -show

�� At the server console, enter java -kill 
process_number_of_inventory_storer 

 The Inventory Storer process name is 
com.novell.zenworks.desktop.inventory.storer.Loader.

�� At the server console, enter java -kill  
process_number_of_master_process 

The Master process name is 
com.novell.zenworks.desktop.inventory.storer.MasterProcess.

� From the workstation running the Novell Client, log in to the NetWare 
server.

� Map a drive to the SYS volume of the NetWare server.

	 Using the mapped drive, delete the following Inventory Storer files 
installed on the NetWare server:

� STORER.NCF file in the SYS:\PUBLIC\ZENWORKS\JAVA 
directory

� MASTER.NCF file in the SYS:\PUBLIC\ZENWORKS\JAVA 
directory. 

� STORER.JAR file in the SYS:\PUBLIC\ZENWORKS\JAVA 
directory.

� All files in the SYS:\PUBLIC\ZENWORKS\JAVA\TXTFILES 
directory.


 To remove the references to the Inventory Storer from the NetWare 
server, delete the following lines from the AUTOEXEC.NCF in the 
SYS:\SYSTEM directory:

sys:\public\zenworks\java\master.ncf

sys:\public\zenworks\java\storer.ncf

This ensures that the Inventory Storer will not be loaded.
Uninstalling the Management Site Services and Agents 	��
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Uninstalling the ManageWise 2.7 Components

Although uninstalling the existing ManageWise® 2.7 components is not 
required, it is recommended that you remove existing LANalyzer® agents 
before installing ZfS. It is also possible, depending on your environment, that 
you may need to free up disk space or want to remove old files that are no 
longer needed.

To uninstall the ManageWise 2.7 primary components and LANalyzer 
Agents, follow the instructions in each of the following sections:

� “Uninstalling the ManageWise 2.7 Server, Console, and Agents” on page 
502

� “Uninstalling and Upgrading the ManageWise 2.7 LANalyzer Agent” on 
page 502

Uninstalling the ManageWise 2.7 Server, Console, and Agents

Although there is no requirement to uninstall the ManageWise 2.7 
components, there are a variety of reasons that you might want to remove the 
old files from your system. The ManageWise 2.7 components consist of the 
following:

� ManageWise Server

� ManageWise Console

� ManageWise AgentTM

Instructions for uninstalling each of these components can be found in the 
Novell Technical Information Document #10011891, which can be accessed 
from the Knowledgebase section of the Support Web site (http://
www.support.novell.com).

For instructions on removing and upgrading from a ManageWise 2.7 
LANalyzer Agent, see “Uninstalling the Traffic Analysis Agent” on page 490.

Uninstalling and Upgrading the ManageWise 2.7 LANalyzer Agent

You do not need to uninstall the previous version of the LANalyzer Agent to 
upgrade to ZfS; however, it is recommended. If you do not remove the 
existing LANalyzer Agent, you must edit the AUTOEXEC.NCF file on each 
NetWare server on which you upgraded the Traffic Analysis Agent to ensure 
that the server runs the new version of the agent.
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Although it is not required, you can save the existing trend data by migrating 
the trend files using the GTREND utility, as described in “Migrating Trend 
Files” on page 279.

This section contains the following procedures:

� “Uninstalling the ManageWise 2.7 LANalyzer Agent” on page 503

� “Upgrading the ManageWise 2.7 LANalyzer Agent” on page 504

Uninstalling the ManageWise 2.7 LANalyzer Agent

Uninstalling the LANalyzer Agent for NetWare (referred to as the Traffic 
Analysis Agent in ZfS) does the following:

� Removes all the files in the SYS:\LANZ directory and deletes the 
directory

� Removes the LANZ.NCF and ULANZ.NCF files from the 
SYS:\SYSTEM directory

� Removes the LANalyzer Agent for NetWare statements from the 
AUTOEXEC.NCF file

� Deletes the long-term trend data file from the GTREND directory

127(��LANZDIR is the default directory where the LANalyzer Agent is installed.

To uninstall the LANalyzer Agent from a NetWare server:

� Enter ULANZ at the console prompt to unload the LANalyzer Agent.

� Search for the LANalyzer Agent for NetWare statements in the 
AUTOEXEC.NCF file. For example, search for statements beginning 
with Search add LANZDIR and LANZ.NCF.

� Delete all the files from the directory where the LANalyzer Agent for 
NetWare is installed. 

� Delete the GTREND files from the server. Obtain the directory name from 
the argument to GTREND.NLM in the LANZ.NCF file. The default 
directory name is SYS:\GTREND.

	 Delete the LANZ.NCF and ULANZ.NCF files from the SYS:\SYSTEM 
directory.


 Delete the LANalyzer Agent for NetWare statements from the 
AUTOEXEC.NCF file. 

� Delete the LANZTM installation information from PRODUCTS.DAT.
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Upgrading the ManageWise 2.7 LANalyzer Agent

If you do not remove the existing LANalyzer Agent, you must ensure that the 
upgraded servers run the new version of the agent.

To ensure that your NetWare servers run the new Traffic Analysis Agent:

� On each NetWare server on which you upgraded the ZfS Traffic Analysis 
Agent, open the AUTOEXEC.NCF file located in the SYS:\SYSTEM 
directory.

� Comment out the following lines by placing a "#" character at the 
beginning of the line as follows:

#Search add <LANZDIR> 
#LANZ.NCF 

The first statement defines the search path, where <LANZDIR> is the 
directory in which the older agent is installed. The second statement loads 
the older agent.

� Save the file and restart the server

The new agent will load and run automatically.
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Protocol Decodes Suite Supported by 
ZfS

ZENworksTM for Servers (ZfS) provides packet capture and decoding tools 
that help you analyze the network activity and identify the source of network 
problems. Capturing and decoding packets can help you troubleshoot network 
problems by giving you detailed information about segment activity. For 
details, see “Capturing Packets” on page 221 and “Displaying Captured 
Packets” on page 225.

This section provides information about decoding support provided by ZfS for 
the following protocol suites:

� “NetWare Protocol Suite” on page 505

� “Network File System Protocol Suite” on page 508

� “Systems Network Architecture Protocol Suite” on page 509

� “AppleTalk Protocol Suite” on page 509

� “TCP/IP Protocol Suite” on page 513

NetWare Protocol Suite

NetWare® contains a group of protocols that perform various functions in a 
NetWare network. Each protocol in the NetWare protocol suite works with the 
IPXTM protocol. ZfS supports the following protocols in the NetWare suite of 
protocols:
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NetWare Protocol Description

BCAST NetWare Broadcast Message Notification. The protocol a 
NetWare server uses to inform an idle workstation that a 
message is pending. This message appears on the top or 
bottom line of the monitor on DOS stations.

DIAG Diagnostic Responder. A protocol used for connectivity testing 
and information gathering. By default, NetWare clients use the 
Diagnostic Responder to reply to diagnostic requests.

IPX Internetwork Packet ExchangeTM. A protocol that routes 
outgoing data packets across a network. Every NetWare 
network has a unique address assigned when its servers are 
configured. IPX routers use this address to route packets 
through an internetwork.

IPX makes routing decisions based on information compiled 
by the Routing Information Protocol (RIP).

LSP NetWare LiteTM Sideband Protocol. A connectionless 
(datagram) oriented protocol that operates as a sideband for 
NetWare Lite Transport Protocol (NLTP) connections.

NBIOS NetBIOS. An emulator that allows workstations to run 
applications that support IBM* NetBIOS calls. NetBIOS is the 
IBM standard protocol for applications developed to run peer-
to-peer communications on token ring networks.

NCP NetWare Core Protocol. A set of procedures that a file server 
operating system follows to accept and respond to 
workstation requests.

NCPs exist for every service a workstation might request from 
a file server. Common requests handled by the NCP protocols 
include creating or deleting a file, manipulating directories and 
files, performing a directory listing, altering the bindery (drive 
mappings and security), and printing.

NDS® Novell Directory Services®. A relational database that is 
distributed across your entire network.
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NLP NetWare Lite Protocol. A protocol that is an integral part of 
NetWare Lite, which operates on top of the Novell® IPX 
protocol. NLP is an application-layer and service-layer 
protocol that performs file system and print functions. NLP 
also uses NLTP, which is similar in function to the transport 
protocol used in NCP.

NLSPTM NetWare Link Services ProtocolTM. A link-state routing 
protocol designed for IPX internetworks.

RIP Routing Information Protocol. A protocol that automates the 
process of updating routing tables. Routing is the process of 
moving network packets between separate networks. With 
RIP, when one router learns about changes in its routes, it 
broadcasts this information to neighboring routers so they can 
update their routing tables. As a result, if a network 
component fails (such as a router or a phone line), the other 
network components can inform each other of alternate 
routes. When the faulty component is repaired, the network 
changes back to the previous condition.

SAP Service Advertising Protocol. A protocol that lets NetWare 
servers advertise their services by name and type. A 
workstation can broadcast a request to find all services 
available or a specific service closest to the client.

SER Novell® Serialization (Copy Protection) Packets. Packets that 
NetWare servers send to other NetWare servers to ensure 
that each server has a unique serial number.

SNMP Simple Network Management Protocol. An application-layer 
protocol designed to facilitate the exchange of management 
information between network devices. By using SNMP to 
access management information data (such as packets per 
second and network error rates), network administrators can 
easily manage network performance and find and solve 
network problems.

NetWare Protocol Description
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Network File System Protocol Suite

The Network File System (NFS) suite of protocols is described in the 
following table.

SPXTM Sequenced Packet ExchangeTM. A connection-oriented 
transport protocol that monitors network transmissions to 
ensure successful delivery of packets. SPX enhances the IPX 
protocol by supervising data sent across the network. SPX 
can track data transmissions consisting of a series of separate 
packets.

SPX also requests acknowledgments from and returns 
acknowledgments to a communications partner, ensuring 
successful data delivery. If an acknowledgment request brings 
no response within a specified time, SPX retransmits the 
request. After a reasonable number of retransmissions fail to 
return a positive acknowledgment, SPX assumes the 
connection has failed and reports the error.

The NetWare print server uses SPX.

WDOG Watchdog. A maintenance protocol provided with NetWare. 
Watchdog monitors stations that are logged in to a NetWare 
server. Watchdog determines whether the NetWare shells are 
still operating and, if not, releases the connection.

Network File System 
Protocol

Description

MOUNT The MOUNT protocol, used in conjunction with NFS, 
performs operating system-specific functions that allow 
NFS clients to attach remote directory trees to a point 
within the local file system.

NFS Network File System. This protocol provides transparent 
remote access to shared file systems across networks. 
NFS uses Remote Procedure Call (RPC) and is machine, 
operating system, network architecture, and transport 
protocol independent.

NetWare Protocol Description
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Systems Network Architecture Protocol Suite

The Systems Network Architecture (SNA) suite of protocols is described in 
the following table.

AppleTalk Protocol Suite

The AppleTalk* and AppleTalk-related suite of protocols is described in the 
following table.

PORTMAP The PORTMAP protocol converts RPC program numbers 
into Transmission Control Protocol/User Datagram 
Protocol (TCP/UDP) port numbers. When a client wants 
to make an RPC call to a given program number, it will first 
contact PORTMAP on the remote machine to determine 
the port number where RPC packets should be sent.

RPC Remote Procedure Call. This protocol allows a program 
on one computer to make a subroutine call on a remote 
computer. Every subroutine or remote procedure is 
identified by a unique program number.

Systems Network 
Architecture Protocol

Description

RH Request/Response Header. This protocol carries the 
SNA Request/Response Units as its payload.

RU Request/Response Unit. An SNA client uses this 
protocol to communicate with an SNA server.

TH Transmission Header. This protocol runs on a data link 
layer and serves as the transmission layer for an SNA 
Path Information Unit.

XID Exchange Station Identification. An SNA node uses this 
protocol to check whether its peer SNA node is ready for 
communication and to exchange its station details with it.

Network File System 
Protocol

Description
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AppleTalk Protocol Description

AARP AppleTalk Address Resolution Protocol. An AppleTalk 
protocol that reconciles addressing differences between a 
data link protocol and the rest of a protocol family. For 
example, by resolving the differences between an Ethernet 
addressing scheme and the AppleTalk addressing scheme, 
AARP facilitates the transport of datagram delivery protocol 
(DDP) packets over a high-speed EtherTalk* connection.

ADSP AppleTalk Data Stream Protocol. A connection-oriented 
protocol that provides a reliable, full-duplex, byte stream 
service between any two sockets in an AppleTalk 
internetwork. ADSP ensures sequential, duplicate-free 
delivery of data over its connections.

AEP AppleTalk Echo Protocol. A simple protocol that allows a 
node to send a packet to any other node in an AppleTalk 
internetwork and receive an echoed copy of that packet in 
return.

AFP AppleTalk Filing Protocol. A presentation layer protocol that 
allows users to share data files and applications that reside 
in an AppleTalk shared resource, such as a file server.

ARI Address Recognized Indicator. In token ring networks, the 
portion of the Frame Status field that indicates whether the 
destination station recognized that the frame was intended 
for it.

ASP AppleTalk Session Protocol. A general, all-purpose protocol 
that uses the services of the AppleTalk Transaction Protocol 
(ATP) to provide session establishment, maintenance, and 
tear-down, along with request sequencing.

ATP AppleTalk Transaction Protocol. A transport protocol that 
provides a loss-free transaction service between sockets. 
This service allows exchanges between two socket clients 
in which one client requests the other to perform a particular 
task and report the results. ATP binds the request and 
response together to ensure the reliable exchange of 
request-response pairs.

E-DDP Extended Datagram Delivery Protocol. A datagram delivery 
protocol that uses an extended header. An extended header 
is required for packets that are transmitted from one 
network to another network within an AppleTalk Internet.
	�� Management and Monitoring Services
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ELAP EtherTalk Link Access Protocol. The link-access protocol 
used in an EtherTalk network. It is built on the top of the 
standard Ethernet data link layer.

NBP Name Binding Protocol. A transport layer protocol that 
translates a character string name into the internetwork 
address of the corresponding socket client. NBP enables 
AppleTalk protocols to understand user-defined zones and 
device names by providing and maintaining translation 
tables that map these names to corresponding socket 
addresses.

PAP Printer Access Protocol. This protocol manages interaction 
between workstations and print servers. It handles 
connection setup, maintenance, and termination. It can also 
handle data transfer.

RTMP Routing Table Maintenance Protocol. This AppleTalk 
protocol establishes and maintains the routing information 
that is required by internetwork routers to route datagrams 
from any source socket to any destination socket in the 
internetwork. Using RTMP, internetwork routers 
dynamically maintain routing tables to reflect changes in 
internetwork topology.

S-DDP Short Datagram Delivery Protocol. A DDP that uses a short 
header. A short header is often used for packets whose 
source and destination sockets are within the boundaries of 
a single AppleTalk network.

ZIP Zone Information Protocol. A protocol that maintains up-to-
date routing information across the internetwork.

AppleTalk Protocol Description
Protocol Decodes Suite Supported by ZfS 	��

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a27 18 April 00
RPC Remote Procedure Call. A protocol that one program can 
use to request a service from a program located in another 
computer in a network without having to understand 
network details. (A procedure call is also known as a 
function call or a subroutine call.) RPC uses the client/
server model. The requesting program is a client and the 
service-providing program is the server. Like a regular or 
local procedure call, an RPC is a synchronous operation 
requiring the requesting program to be suspended until the 
results of the remote procedure are returned.

This protocol establishes a standard method for message-
passing communication between server and client systems. 
The RPC mechanism provides a service to the application 
programmer to allow transparent use of a server to provide 
some activity on behalf of the application.

SLP Service Location Protocol. This protocol provides a scalable 
framework for the discovery and selection of network 
services. Using this protocol, computers using the Internet 
no longer need as many static configurations of network 
services for network-based applications.

This is especially important as computers become more 
portable, and users less tolerant or able to fulfill the 
demands of network system administration.

SMTP Simple Mail Transfer Protocol. This protocol is an 
application-layer protocol that e-mail clients and servers 
use to exchange e-mail messages with each other.

AppleTalk Protocol Description
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TCP/IP Protocol Suite

The TCP/IP suite of protocols is described in the following table.

SNMP Simple Network Management Protocol. This protocol 
enables you to monitor a network from a single network 
management station called an SNMP Manager. From an 
SNMP Manager, you can make inquiries to another network 
device called the SNMP Agent. The SNMP Agent can be a 
TCP/IP host, router, terminal server, or another SNMP 
Manager.

The information you can request from an SNMP Agent is 
contained in the MIB of that TCP/IP host. RFC 1066 (http://
www.isi.edu/in-notes/rfc1066.txt) (Internet standard MIB) 
defines the types of objects that can be in an SNMP Agent 
MIB. These objects include network and hardware 
addresses, counters, and statistics, as well as routing and 
Address Resolution Protocol tables. Different vendors might 
not support all data types within their MIB or might include 
other information not defined within the RFC.

TCP Transmission Control Protocol. This primary Internet 
transport protocol accepts messages of any length from an 
upper-layer protocol and provides full-duplex, 
acknowledged, connection-oriented, flow-controlled 
transport.

TELNET Protocol in the TCP/IP suite that governs character-oriented 
terminal traffic.

TFTP Trivial File Transfer Protocol. TCP/IP protocol commonly 
used for software downloads.

UDP User Datagram Protocol. A protocol similar to TCP that 
provides connectionless, nonguaranteed transport 
services. UDP accepts and transports datagram from an 
upper-layer protocol. Unburdened by the overhead of 
establishing and removing connections, controlling data 
flow, and performing other TCP functions, UDP usually 
provides a faster data conduit than TCP. For these reasons, 
and because it is easier to implement, UDP is the transport 
method of choice for many upper-layer protocols. UDP is 
part of the TCP/IP protocol suite.

AppleTalk Protocol Description
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TCP/IP Protocol Description

ARP Address Resolution Protocol. A protocol used by a host to 
determine the hardware address of another host. A TCP/IP 
system contains a table that maps IP addresses to the 
hardware addresses of the different hosts and routers on the 
internetwork. This table works in much the same way as a host 
table, translating an IP address to an Ethernet address. Unlike 
the host table, however, the ARP table is not usually 
maintained by you or your network administrator. The ARP 
protocol creates entries in this table as needed.

If the hardware address of the destination is not found in your 
station’s ARP table, a broadcast is sent to every host on the 
network requesting the address. If that host is up and supports 
the ARP protocol, it receives the broadcast from your station 
and responds by sending its hardware address back to your 
station. This address is then added to your station’s ARP table.

DIAG Diagnostic Responder. A Novell protocol used for connectivity 
testing and information gathering. By default, NetWare clients 
use the Diagnostic Responder to reply to diagnostic requests.

BOOTP BootStrap Protocol. This protocol allows a diskless 
workstation to determine its IP address and other information 
without using the Reverse Address Resolution Protocol 
(RARP).

DHCP Dynamic Host Configuration Protocol. This protocol supplies 
hosts with configuration parameters, leases dynamically 
allocated IP addresses, and acts as an enhancement to 
BOOTP.

DNS Domain Name System. The distributed naming service used 
on the Internet. DNS provides a computer’s IP address if 
domain names exist for the computer.

FTP File Transfer Protocol. TCP/IP application-layer protocol that 
supports file transfers.

HTTP Hypertext Transfer Protocol. An application-layer protocol that 
Web browsers and Web servers use to communicate with 
each other.
	�� Management and Monitoring Services
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ICMP Internet Control Message Protocol. A protocol that works with 
IP to provide routing efficiency and error information. ICMP is 
part of the TCP/IP protocol suite. Because IP is 
connectionless, it cannot detect anomalous internetwork 
conditions. ICMP works with IP to provide TCP or other upper-
layer protocols with this information.

IGMP Internet Group Management Protocol. A protocol used by IP 
hosts to report their multicast group memberships to routers. 
The protocol is also used to query routers on memberships 
and to generate reports on group membership. Termination of 
group membership can be quickly reported using this protocol.

IP Internet Protocol. A protocol that provides connectionless, 
nonguaranteed delivery of transport layer packets (also called 
transport protocol data units or TPDUs) across an 
internetwork. IP is part of the TCP/IP protocol suite.

IP can fragment TPDUs into smaller parts, if necessary, and 
then reassemble them at an intermediate station (usually a 
router) or at their destination host.

Each TPDU or fragment is fitted with an IP header and 
transmitted as a packet by lower-layer protocols. IP moves 
datagrams through the internetwork, one hop at a time. If a 
TPDU fragment arrives at its destination out of order, IP 
reassembles the fragments, in sequence, at the destination.

LDAP Lightweight Directory Access Protocol. This protocol provides 
access to the x.500 Directory while not incurring the resource 
requirements of the Directory Access Protocol (DAP). LDAP is 
specifically targeted at simple management applications and 
browser applications that provide read/write interactive access 
to the x.500 Directory, and is intended to be a complement to 
the DAP itself.

TCP/IP Protocol Description
Protocol Decodes Suite Supported by ZfS 	�	

Management and Monitoring Services
100-004631-001

February 22, 2001



Manual Rev 99a27 18 April 00
NCP NetWare Core Protocol. Collectively, the set of routines and 
primitives that drive NetWare.

NCP protocols exist for every service a workstation might 
request from a file server. Common requests handled by the 
NCP protocols include creating or deleting a file, manipulating 
directories and files, performing a directory listing, altering the 
bindery (drive mappings and security), and printing.

NetWare uses an underlying network message delivery 
system such as IPX/SPX or UDP/TCP for communication 
between the client and the server.

NTP Network Time Protocol. A protocol used to synchronize 
timekeeping among a set of distributed time servers and 
clients. It is used to convey timekeeping information in a 
hierarchical method from servers to clients. It is also used to 
cross-check clocks and control errors due to equipment or 
propagation failures.

NWIP NetWare/IPTM. Allows total or partial replacement of the IPX 
transport subsystem with the industry-standard TCP/IP 
subsystem, in a NetWare network. The following constitute the 
core components of the technology:

� Communication between the NetWare/IP server and the 
Domain SAP/RIP Service (DSS) for
- Retrieval of configuration parameters
- Registration of SAP and RIP information
- SAP/RIP database synchronization

� Synchronization of the NetWare/IP server with the DSS 
database with respect to SAP/RIP information

� Communication between secondary DSS and primary DSS 
to synchronize the SAP/RIP database on the two servers

OSPF Open Shortest Path First. A protocol in the TCP/IP protocol 
suite is an interior gateway protocol algorithm and is proposed 
as a standard for the Internet. OSPF incorporates least-cost 
routing, multipath routing, load balancing, and efficient 
bandwidth utilization.

TCP/IP Protocol Description
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POP3 Post Office Protocol 3. A protocol used for interacting with a 
central mailbox server. It is a client-server protocol used to 
receive e-mail. The protocol holds the e-mail messages in the 
Internet server. Periodically, you can download the messages 
from the server.

RARP Reverse Address Resolution Protocol. A protocol in the TCP/
IP protocol suite that is used to determine a software address 
based on a hardware address. This protocol is often used by 
diskless workstations during startup.

RIP Routing Information Protocol. A protocol in the NetWare 
protocol suite that automates the process of updating routing 
tables. Routing is the process of moving network packets 
between separate networks. With RIP, when one router learns 
about changes in its routes, it broadcasts this information to 
neighboring routers so they can update their routing tables. As 
a result of RIP, if a network component fails (such as a router 
or a phone line), the other network components can inform 
each other of alternate routes. When the faulty component is 
repaired, the network changes back to the previous condition.

RPC Remote Procedure Call. A protocol that one program can use 
to request a service from a program located in another 
computer in a network without having to understand network 
details. (A procedure call is also sometimes known as a 
function call or a subroutine call.) RPC uses the client/server 
model. The requesting program is a client and the service-
providing program is the server. Like a regular or local 
procedure call, an RPC is a synchronous operation requiring 
the requesting program to be suspended until the results of the 
remote procedure are returned.

The RPC establishes a standard method for message-passing 
communication between server and client systems. The RPC 
mechanism provides a service to the application programmer 
to allow transparent use of a server to provide some activity on 
behalf of the application.

TCP/IP Protocol Description
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SLP Service Location Protocol. This protocol provides a scalable 
framework for the discovery and selection of network services. 
Using this protocol, computers using the Internet no longer 
need as many static configurations of network services for 
network-based applications.

This is especially important as computers become more 
portable and users less tolerant or able to fulfill the demands 
of network system administration.

SMTP Simple Mail Transfer Protocol. The application layer protocol 
that e-mail clients and servers use to exchange e-mail 
messages with each other.

SNMP Simple Network Management Protocol. A protocol in the TCP/
IP protocol suite that enables you to monitor a network from a 
single network management station called an SNMP Manager. 
From an SNMP Manager, you can make inquiries to another 
network device called the SNMP Agent. The SNMP Agent can 
be a TCP/IP host, router, terminal server, or another SNMP 
Manager.

The information you can request from an SNMP Agent is 
contained in the MIB of that TCP/IP host. RFC 1066  (http://
www.isi.edu/in-notes/rfc1066.txt) (Internet standard MIB) 
defines the types of objects that can be in an SNMP Agent 
MIB. These objects include network and hardware addresses, 
counters, and statistics, as well as routing and Address 
Resolution Protocol tables. Different vendors might not 
support all data types within their MIB or might include other 
information not defined within the RFC.

TCP Transmission Control Protocol. This primary Internet transport 
protocol accepts messages of any length from an upper-layer 
protocol and provides full-duplex, acknowledged, connection-
oriented, flow-controlled transport.

TELNET Protocol in the TCP/IP suite that governs character-oriented 
terminal traffic.

TFTP Trivial File Transfer Protocol. TCP/IP protocol commonly used 
for software downloads.

TCP/IP Protocol Description
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UDP User Datagram Protocol. A protocol similar to TCP that 
provides connectionless, nonguaranteed transport services. 
UDP accepts and transports datagrams from an upper-layer 
protocol. Unburdened by the overhead of establishing and 
removing connections, controlling data flow, and performing 
other TCP functions, UDP usually provides a faster data 
conduit than TCP. For these reasons, and because it is easier 
to implement, UDP is the transport method of choice for many 
upper-layer protocols. UDP is part of the TCP/IP protocol suite.

TCP/IP Protocol Description
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Interoperability of ZfS2 with ZfD3 and 
ZENworks 2 SP1

If you are planning to install ZENworksTM for Servers 2 (ZfS2) in the same 
environment as ZENworks for Desktops 3 (ZfD3) or ZENworks 2 SP1, you 
must first understand and plan for the compatibility issues described in this 
section. Then you must follow the specific installation instructions provided 
to ensure success.

This section contains the following topics:

� “Installing ZfS2 with ZfD3” on page 521

� “Installing ZfS2 with ZENworks 2 SP1” on page 522

� “Installing ZfS2 Support Pack 1” on page 526

Installing ZfS2 with ZfD3

It is possible to run ZfS2 Management and Monitoring Services and ZfD3 in 
the same environment, but you cannot install ZfS2 Management Site Services 
and the ZfD3 inventory components (Workstation Inventory and Sybase) on 
the same server. Although the inventory databases provided with these 
products will not function correctly on the same server, it is possible to install 
ZfS2 Management Site Services and the ZfD3 non-inventory related services 
on the same machine. For example, you can use the ZfD3 custom install 
option to install Application Management, Automatic Workstation Import, 
Imaging, Remote Management Tools, and Workstation Management on a 
server that is running ZfS2 Management Site Services.

For ZfS2 to co-exist and function with ZfD3 (Workstation Inventory and 
Sybase) on the same server, install ZfS2 SP1. ZfS2 SP1 supports the 
coexistence of ZfS2 and ZfD3. ZfS2 uses Sybase 7.0.0.462 database on 
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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NetWare and ZfD3 uses Sybase 7.0.0.313. See “Installing ZfS2 Support Pack 
1” on page 526.

Installing ZfS2 with ZENworks 2 SP1

This section describes the different scenarios in which ZfS2 Server Inventory 
can interoperate with ZENworks 2 SP1 Workstation Inventory.

To understand the compatibility issues between these products, it is important 
to understand the terminology definitions associated with each product. Both 
ZfS2 and ZENworks 2 SP1 use the same Inventory database (ZENINV.DB). 
In ZfS2, the inventory server is the NetWare® server on which site 
management services and databases are installed. In ZENworks 2 SP1, the 
inventory server is the server on which the inventory components are installed, 
and the database server is the server on which the Inventory database 
(ZENINV.DB) is installed. It is possible, however, that a ZENworks 2 SP1 
server can be both an inventory server and a database server.

If the database has been installed during ZENworks 2 or ZfS2 installation, 
then subsequently, the database will not be installed again.

The following sections provide instructions for interoperability between ZfS2 
and ZENworks 2 SP1:

� “Installing ZfS2 over ZENworks 2 SP1” on page 522

� “Installing ZENworks 2 SP1 over ZfS2” on page 524

If you are installing ZfS2 SP1, see “Installing ZfS2 Support Pack 1” on page 
526 for more information.

Installing ZfS2 over ZENworks 2 SP1

This section provides information on installing ZfS2 over ZENworks 2 SP1 
and contains the following topics:

� “Preparing to Install ZfS2 over ZENworks 2 SP1” on page 522

� “Installing ZfS2 on the ZENworks 2 SP1 Server” on page 523

� “Verifying ZfS2 Installation over ZENworks 2 SP1” on page 523

Preparing to Install ZfS2 over ZENworks 2 SP1

Before installing ZfS2 on a ZENworks 2 SP1 server:
	�� Management and Monitoring Services
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� Ensure that the target NetWare server is a ZENworks 2 SP1 database 
server.

� Install ZENworks 2 SP1 on the target NetWare server.

� Stop the ZENworks 2 SP1 services on the target server.

� Update the TRAPMON.NLM on the target server.

TRAPMON.NLM in ZENworks 2 SP1 is incompatible with the 
SNMP.NLM and SNMPLOG.NLM provided with ZfS2. Therefore, you 
must ensure that the target server has a new version of TRAPMON.NLM 
as follows:

�� Obtain the new version of TRAPMON.NLM.

Information on how to download the new TRAPMON.NLM can be 
found in TID #2957612 in the Novell Technical Support 
Knowledgebase.

�� Manually copy the new TRAPMON.NLM to the target server.

,03257$17��Do not restart the ZENworks 2 SP1 services until after installing 
ZfS2 as described in “Installing ZfS2 on the ZENworks 2 SP1 Server” on page 523.

Installing ZfS2 on the ZENworks 2 SP1 Server

After completing the prerequisites listed in “Preparing to Install ZfS2 over 
ZENworks 2 SP1” on page 522, install ZFS2 over ZENworks 2 SP1 as 
follows:

� If the target server is also a ZENworks 2 SP1 inventory server running the 
Inventory Storer, stop the Storer services. See the ZENworks 2 SP1 
Documentation Web site  (http://www.novell.com/documentation/lg/
zen2/docui/index.html) for more information.

� Install ZfS2.

� Bring up the ZfS2 services, then start the ZENworks 2 SP1 services.

� Verify the installation as described in “Verifying ZfS2 Installation over 
ZENworks 2 SP1” on page 523.

Verifying ZfS2 Installation over ZENworks 2 SP1

After you install ZfS2 over ZENworks 2 SP1, do the following to verify a 
successful installation:
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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� Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM directory was 
updated correctly. 

Ensure that the reference to ZENINV.DB refers to the ZENworks 2 SP1 
setting. For example, in ZENworks 2 SP1, ZENINV.DB is located in the 
volume on which the ZENworks 2 SP1 database is installed (by default, 
SYS:\ZENWORKS\DATABASE). Therefore, the following parameter 
should exist in the MGMTDBS.NCF file: 

volume_name:\zenworks\database\zeninv.db

� If the target NetWare server is also a ZENworks 2 SP1 inventory server, 
make sure the following files (located in the 
SYS:PUBLIC\ZENWORKS\JAVA\TXTFILES directory) have been 
updated with a year 2000 time stamp:

MAP.SER

ASSOCIATION.SER 

,03257$17��If the target NetWare server is a ZENworks 2 SP1 inventory server, 
the Storer will display the following message: 

"Storing system with DN"

This message confirms that the Server Inventory will be stored in the Inventory 
database (ZENINV.DB).

Installing ZENworks 2 SP1 over ZfS2

This section provides information on installing ZENworks 2 SP1 over ZfS2 
and contains the following topics:

� “Preparing to Install ZENworks 2 SP1 over ZfS2” on page 524

� “Installing ZENworks 2 SP1 on the ZfS2 Server” on page 525

� “Verifying ZENworks 2 SP1 Installation over ZfS2” on page 525

For troubleshooting installation problems, see “Troubleshooting a ZENworks 
2 Installation over ZENworks for Servers” on page 476.

Preparing to Install ZENworks 2 SP1 over ZfS2

Before installing ZENworks 2 SP1 on a ZfS2 server, do the following:

� Create a backup copy of the MGMTDBS.NCF file in the SYS:\SYSTEM 
directory (for example, MGMTDBSOLD.NCF). 
	�� Management and Monitoring Services
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This file loads the ZfS2 databases and contains several relevant 
parameters. Creating a backup copy ensures that you can return to your 
current configuration if database problems arise after installation.

� Install ZENworks 2 SP1 on the target NetWare server. This ensures that 
the latest versions of the ZENworks 2 SP1 modules are installed. 

Installing ZENworks 2 SP1 on the ZfS2 Server

After completing the prerequisites listed in “Preparing to Install ZENworks 2 
SP1 over ZfS2” on page 524, install ZENworks 2 SP1 over ZfS2:

� Install ZENworks 2 SP1.

� Comment the following lines in the SYS:\SYSTEM\AUTOEXEC.NCF 
file as follows:

# SYS:\SYSTEM\GATHERER.NCF

# SYS:\PUBLIC\ZENWORKS\JAVA\MASTER.NCF

# SYS:\PUBLIC\ZENWORKS\JAVA\STORER.NCF

This is necessary to ensure that the ZENworks 2 SP1 inventory modules 
do not load and that ZfS2 inventory management services are used. For 
example, the Inventory Storer screen should display the following: 

Starting Inventory Storer. (c) Copyright 1999-2000. Novell 
Inc.

� Verify the installation as described in “Verifying ZENworks 2 SP1 
Installation over ZfS2” on page 525.

Verifying ZENworks 2 SP1 Installation over ZfS2

After you install ZENworks 2 SP1 over ZfS2, ensure a successful installation:

� Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM directory was 
not modified and also ensure that ZENINV.DB refers to the ZfS2 setting.

For example, you should see the following entry:

SYS:\zfs_directory\MWSERVER\DB\ZENINV.DB

� If the file has been changed in any way, you should use the backup version 
of the MGMTDBS.NCF file.
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	�	
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Installing ZfS2 Support Pack 1 

The following section provides information on installing ZfS2 Support Pack 
1 (ZfS2 SP1) over ZENworks 2 SP1 and ZfD3: 

In a co-existence setup, where ZfS2 exists with ZENworks 2 SP1 or ZfD3, if 
you need to identify whether ZfS2 or ZfD3 is installed, see the following table: 

To identify whether... Action

ZfS2 Site Management Services 
are installed on a NetWare server

SYS:\SYSTEM\AUTOEXEC.NCF file 
should contain the MWSERVER.NCF entry.

ZfD3 components are installed on 
a NetWare server

SYS:\SYSTEM\AUTOEXEC.NCF file 
should contain ZFDSTART.NCF entry.

ZENworks 2 Inventory 
components are installed on 
NetWare

AUTOEXEC.NCF file should contain the 
following entries: 

sys:\system\gatherer.ncf

sys:\public\zenworks\java\master
.ncf

sys:\public\zenworks\java\storer
.ncf

ZENworks 2 database 
components are installed on 
NetWare

SYS:\SYSTEM directory should contain the 
SYBASE.NCF file.

ZENworks 2 SP1 database 
components are installed on 
NetWare

SYS:\SYSTEM directory should contain the 
MGMTDBS.NCF file.

Ensure that the reference to ZENINV.DB 
refers to the ZENworks 2 SP1 setting. For 
example, in ZENworks 2 SP1, ZENINV.DB 
is located in the volume on which the 
ZENworks 2 SP1 database is installed. 

By default, the database file is in the 
SYS:\ZENWORKS\DATABASE directory. 

The following parameter should exist in the 
MGMTDBS.NCF file: 
volume_name\ZENWORKS\DATABASE\Z
ENINV.DB.
	�
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127(��When you start ZfS2 or ZfD3, if the following message Java: 
Environment variable tmppath, not found is displayed, then from the 
NetWare server prompt, type setzenpath. Start ZfS2 or ZfD3 again.

The following table lists the various scenarios for ZfS2 co-existence with 
ZENworks 2 SP1 and ZfD3: 

ZfS2 components are invoked 
before ZfD3 components

In the SYS:\SYSTEM\AUTOEXEC.NCF file, 
the MWSERVER.NCF entry should precede 
the ZFDSTART.NCF entry.

ZfD3 components are invoked 
before ZfS2 components

In the SYS:\SYSTEM\AUTOEXEC.NCF file, 
the ZFDSTART.NCF entry should precede 
the MWSERVER.NCF entry.

No. Scenario Action

1. ZfS2 SP1 is installed over ZENworks 2 SP1 Follow the steps in “ZfS2 SP1 is installed over 
ZENworks 2 SP1” on page 529

2. ZENworks 2 SP1 (Inventory and Database 
Server) is installed over ZfS2

Follow the steps in “ZENworks 2 SP1 
(Inventory and Database Server) is installed 
over ZfS2” on page 530

3. ZENworks 2 SP1 (Inventory and Database 
Server) is installed over ZfS2 SP1

Follow the steps in “ZENworks 2 SP1 
(Inventory and Database Server) is installed 
over ZfS2 SP1” on page 531

4. ZfD3 over ZfS2 installed over ZENworks 2 SP1 Follow the steps in “ZfD3 over ZfS2 installed 
over ZENworks 2 SP1” on page 532

5. ZfD3 (Database Server) is installed over ZfS2 Follow the steps in “ZfD3 (Database Server) is 
installed over ZfS2” on page 533

6. ZfD3 (Inventory and Database Server) is installed 
over ZfS2

Follow the steps in “ZfD3 (Inventory and 
Database Server) is installed over ZfS2” on 
page 534

7. ZfD3 (Inventory Server) is installed over ZfS2 Follow the steps in “ZfD3 (Inventory Server) is 
installed over ZfS2” on page 535

8. ZfD3 (Inventory and Database Server) over ZfS2 
SP1 

Follow the steps in “ZfD3 (Inventory and 
Database Server) is installed over ZfS2 SP1” 
on page 536

To identify whether... Action
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Follow the instructions covered in these scenarios:

9. ZfD3 (Database Server) is installed over ZfS2 SP1 Follow the steps in “ZfD3 (Database Server) is 
installed over ZfS2 SP1” on page 537

10. ZfD3 (Inventory Server) is installed over ZfS2 SP1 Follow the steps in “ZfD3 (Inventory Server) is 
installed over ZfS2 SP1” on page 537

10. ZfS2 is installed over ZfD3 Inventory Server Follow the steps in “ZfS2 is installed over ZfD3 
Inventory Server” on page 538

11. ZfS2 is installed over ZfD3 (Inventory and 
Database Server) 

Follow the steps in “ZfS2 is installed over ZfD3 
(Inventory and Database Server)” on page 538

12. ZfS2 is installed over ZfD3 (Database Server) Follow the steps in “ZfS2 is installed over ZfD3 
(Database Server)” on page 538

13. ZfS2 over ZfD3 installed over ZENworks 2 SP1 
(Inventory and Database Server)

Follow the steps in “ZfS2 over ZfD3 installed 
over ZENworks 2 SP1 (Inventory and 
Database Server)” on page 539

No. Scenario Action
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Scenario Action

ZfS2 SP1 is installed over 
ZENworks 2 SP1

In this scenario, ZfS2 is installed over the ZENworks 2 SP1 
Inventory-Database server. See “Installing ZfS2 over ZENworks 
2 SP1” on page 522.

In this setup, follow these steps:

1. Install ZfS2 SP1. To install ZfS2 SP1, see the Readme 
document. Before running the INVREMTF.CPK, unload the 
following NLMs: ORBCMD.NLM and TRAPMON.NLM.

2. Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM 
directory has been updated correctly. Ensure that the 
reference to ZENINV.DB refers to the ZENworks 2 SP1 
setting. For example, in ZENworks 2 SP1, ZENINV.DB is 
located in the volume on which the ZENworks 2 SP1 
database is installed. By default, the database file is in the 
SYS:\ZENWORKS\DATABASE directory. The following 
parameter should exist in the MGMTDBS.NCF file: 
volume_name\ZENWORKS\DATABASE\ZENINV.DB.

3. The Inventory Storer screen should display the following on 
the server console: "Starting Inventory Storer. (c) 
Copyright 1999-2000. Novell Inc."

If you have the ZENworks 2 SP1 inventory and database 
installed on different servers, to interoperate with ZfS2, follow 
one of the following procedures:

� In the scenario where ZfS2 is installed over the ZENworks 2 
inventory server, replace ZENINV.DB from the ZENworks 2 
SP1 Database server in 
SYS:\zfs_home_directory\MWSERVER\DB on the ZfS2 Site 
Server. In this case, the inventory server also functions as the 
database server. Also, the ZfS2 server inventory information 
will be lost from the database. Rescan the servers again.

� Install ZfS2 Site Management Services on the ZENworks 2 
SP1 Database server.

After installation, do not start ZENworks 2 services separately. 
ZfS2 services interoperate with ZENworks 2 automatically.

If ZfS2 is installed over ZENworks 2 SP1, besides displaying the 
workstation inventory information in the Inventory Query window, 
the server inventory information is also displayed. 
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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ZENworks 2 SP1 (Inventory 
and Database Server) is 
installed over ZfS2

In this scenario, ZENworks 2 SP1 is installed over the ZfS2 
server. See “Installing ZENworks 2 SP1 on the ZfS2 Server” on 
page 525. In this setup, follow these steps:

,03257$17��For the products to coexist and function properly, 
it is necessary to follow the order of products installation.

1. Before running the INVREMTF.CPK, unload the following 
NLMs: ORBCMD.NLM and TRAPMON.NLM.

2. Install ZfS2 SP1. See the Readme document for more 
information. 

3. Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM 
directory was not modified and also ensure that ZENINV.DB 
refers to the ZfS2 setting. For example, the following entry 
should exist: 
sys:\zfs_directory\mwserver\db\zeninv.db

4. Verify that the following lines in the 
SYS:\SYSTEM\AUTOEXEC.NCF file are removed: 
sys:\system\gatherer.ncf
sys:\public\zenworks\java\master.ncf
sys:\public\zenworks\java\storer.ncf 

5. The Inventory Storer screen displays the following on the 
server console: "Starting Inventory Storer. (c) 
Copyright 1999-2000. Novell Inc."

After installation, do not start ZENworks 2 services separately. 
ZfS2 services interoperate with ZENworks 2 automatically.

Scenario Action
	�� Management and Monitoring Services
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ZENworks 2 SP1 (Inventory 
and Database Server) is 
installed over ZfS2 SP1

In this scenario, ZENworks 2 SP1 is installed over ZfS2 SP1. In 
this setup, follow these steps:

1. Install ZfS2 SP1 again. See the Readme document for more 
information. You need to run the INVREMTF.CPK. This is 
necessary for both ZfS2 and ZENworks 2 SP1 to coexist.
Before running the INVREMTF.CPK, unload the following 
NLMs: ORBCMD.NLM and TRAPMON.NLM.

2. Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM 
directory was not modified and also ensure that ZENINV.DB 
refers to the ZfS2 setting. For example, the following entry 
should exist: 
sys:\zfs_directory\mwserver\db\zeninv.db

3. Verify that the following lines in the 
SYS:\SYSTEM\AUTOEXEC.NCF file are removed: 
sys:\system\gatherer.ncf
sys:\public\zenworks\java\master.ncf
sys:\public\zenworks\java\storer.ncf 

4. Remove the following lines in the 
zfs_home_directory\MWSERVER\BIN\INVENTORY.NCF: 
gatherer.ncf
master.ncf
storer.ncf 

5. Remove search path to SYS:\PUBLIC\ZENWORKS\JAVA 
and SYS:\ZENWORKS\DATABASE.

6. Start ZfS2 services.

7. The Inventory Storer screen displays the following on the 
server console: "Starting Inventory Storer. (c) 
Copyright 1999-2000. Novell Inc."

After installation, do not start ZENworks 2 services separately. 
ZfS2 services interoperate with ZENworks 2 automatically.

Scenario Action
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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ZfD3 over ZfS2 installed over 
ZENworks 2 SP1

During the ZfD3 installation, you must choose to overwrite the 
Sybase database files.

In this setup, follow these steps:

1. Edit the path to DBSRV7.NLM entry in the 
SYS:\SYSTEM\MGMTDBS.NCF file: 
sys:\zfs_home_directory\mwserver\db\dbsrv7.n
lm
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

2. In the SYS:\SYSTEM\MGMTDBS.NCF file, add the following 
entries: 
sys:\zfs_home_directory\mwserver\db\mw.db sys 
:\zfs_home_directory\mwserver\db\zeninv.db  
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

3. Install ZfS2 SP1. See the Readme document for more 
information. 

4. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

5. Comment the following entry in the 
SYS:\SYSTEM\INVENV.NCF file: envset tmppath=.\ 

6. Uncomment the following entry in the 
SYS:\zfs_directory\MWSERVER\BIN\MWSETENV.NCF: 
envset tmppath=.\

,03257$17��After ZfS2 SP1 installation, follow this order to 
start ZfS2 and ZfD3: at the server prompt, type mwserver. Type 
zfdstart.

Scenario Action
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ZfD3 (Database Server) is 
installed over ZfS2

In this scenario, the ZfD3 Database Server is installed over ZfS2. 
ZfD3 and ZfS2 use different Sybase versions. During the ZfD3 
installation, you must choose to overwrite the Sybase database 
files.

In this setup, follow these steps:

1. After completing the installation, edit the path to 
DBSRV7.NLM entry in the SYS:\SYSTEM\MGMTDBS.NCF 
file: 
sys:\zfs_home_directory\mwserver\db\dbsrv7.n
lm
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

In the SYS:\SYSTEM\MGMTDBS.NCF file, add the following 
entries: 
sys:\zfs_home_directory\mwserver\db\mw.db sys
:\zfs_home_directory\mwserver\db\zeninv.db
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

2. Install ZfS2 SP1. See the Readme document for more 
information.

3. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

Scenario Action
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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ZfD3 (Inventory and Database 
Server) is installed over ZfS2

During the ZfD3 installation, you must choose to overwrite the 
Sybase database files.

In this setup, follow these steps:

1. Edit the path to DBSRV7.NLM entry in the 
SYS:\SYSTEM\MGMTDBS.NCF file: 
sys:\zfs_home_directory\mwserver\db\dbsrv7.n
lm
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

2. In the SYS:\SYSTEM\MGMTDBS.NCF file, add the following 
entries: 
sys:\zfs_home_directory\mwserver\db\mw.db sys 
:\zfs_home_directory\mwserver\db\zeninv.db  
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

3. Install ZfS2 SP1. See the Readme document for more 
information. 

4. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

5. Comment the following entry in the 
SYS:\SYSTEM\INVENV.NCF file: envset tmppath=.\ 

6. Uncomment the following entry in the 
SYS:\zfs_directory\MWSERVER\BIN\MWSETENV.NCF: 
envset tmppath=.\

,03257$17��After ZfS2 SP1 installation, follow this order to 
start ZfS2 and ZfD3: at the server prompt, type mwserver. Type 
zfdstart.

Scenario Action
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ZfD3 (Inventory Server) is 
installed over ZfS2

In this scenario, ZfD3 Inventory Server is installed over ZfS2.

Follow these steps:

1. Install ZfS2 SP1. See the Readme document for more 
information. 

2. Comment the following entry in the 
SYS:\SYSTEM\INVENV.NCF file: envset tmppath=.\ 

3. Uncomment the following entry in the 
SYS:\zfs_directory\MWSERVER\BIN\MWSETENV.NCF:env
set tmppath=.\ 

,03257$17��After ZfS2 SP1 installation, follow this order to 
start ZfS2 and ZfD3: at the server prompt, type mwserver. Type 
zfdstart.

Scenario Action
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	�	
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ZfD3 (Inventory and Database 
Server) is installed over ZfS2 
SP1 

During the ZfD3 installation, you must choose to overwrite the 
Sybase database files.

In this setup where ZfD3 is installed over ZfS2 SP1, follow these 
steps:

1. Edit the path to DBSRV7.NLM entry in the 
SYS:\SYSTEM\MGMTDBS.NCF file: 
sys:\zfs_home_directory\mwserver\db\dbsrv7.n
lm
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

2. In the SYS:\SYSTEM\MGMTDBS.NCF file, add the following 
entries: 
sys:\zfs_home_directory\mwserver\db\mw.db sys 
:\zfs_home_directory\mwserver\db\zeninv.db  
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

3. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

4. Comment the following entry in the 
SYS:\SYSTEM\INVENV.NCF file: envset tmppath=.\ 

5. Uncomment the following entry in the 
SYS:\zfs_directory\MWSERVER\BIN\MWSETENV.NCF: 
envset tmppath=.\

,03257$17��Follow this order to start ZfS2 and ZfD3: at the 
server prompt, type mwserver. Type zfdstart.

Scenario Action
	�
 Management and Monitoring Services
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ZfD3 (Database Server) is 
installed over ZfS2 SP1

In this scenario, the ZfD3 Database Server is installed over ZfS2 
SP1. ZfD3 and ZfS2 use different Sybase versions. During the 
ZfD3 installation, you must choose to overwrite the Sybase 
database files.

In this setup where ZfD3 is installed over ZfS2 SP1, follow these 
steps:

1. After completing the installation, edit the path to 
DBSRV7.NLM entry in the SYS:\SYSTEM\MGMTDBS.NCF 
file: 
sys:\zfs_home_directory\mwserver\db\dbsrv7.n
lm
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

In the SYS:\SYSTEM\MGMTDBS.NCF file, add the following 
entries: 
sys:\zfs_home_directory\mwserver\db\mw.db sys
:\zfs_home_directory\mwserver\db\zeninv.db
where, zfs_home_directory refers to the directory where ZfS2 
is installed.

2. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

ZfD3 (Inventory Server) is 
installed over ZfS2 SP1

In this scenario, ZfD3 Inventory Server is installed over ZfS2 
SP1.

Follow this step:

1. Comment the following entry in the 
SYS:\SYSTEM\INVENV.NCF file: envset tmppath=.\ 

,03257$17��Follow this order to start ZfS2 and ZfD3: at the 
server prompt, type mwserver. Type zfdstart.

Scenario Action
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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ZfS2 is installed over ZfD3 
Inventory Server

In this setup, follow these steps:

1. Install ZfS2 SP1. See the Readme document for more 
information. 

2. Ensure that SYS:\SYSTEM\MGMTDBS.NCF contains 
MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB entries.

127(��After ZfS2 SP1 installation, follow this order to start ZfS2 
and ZfD3: at the server prompt, type zfdstart. Type 
mwserver.

ZfS2 is installed over ZfD3 
(Inventory and Database 
Server) 

In this setup, follow these steps:

1. Install ZfS2 SP1. See the Readme document for more 
information. 

2. Ensure that SYS:\SYSTEM\MGMTDBS.NCF contains 
MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB entries.

127(��After ZfS2 SP1 installation, follow this order to start ZfS2 
and ZfD3: at the server prompt, type zfdstart. Type 
mwserver.

ZfS2 is installed over ZfD3 
(Database Server)

In this setup, follow these steps:

1. Install ZfS2 SP1. See the Readme document for more 
information. 

2. Ensure that SYS:\SYSTEM\MGMTDBS.NCF contains 
MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB entries.

127(��After ZfS2 SP1 installation, follow this order to start ZfS2 
and ZfD3: at the server prompt, type zfdstart. Type 
mwserver.

Scenario Action
	�� Management and Monitoring Services
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ZfS2 over ZfD3 installed over 
ZENworks 2 SP1 (Inventory 
and Database Server)

In this scenario, ZfD3 has been installed over ZENworks 2 SP1 
Inventory-Database Server. Over this setup, ZfS2 is installed 
over ZfD3.

In this setup, follow these steps:

1. Ensure that you do not run the ZEN2Remove Tool. Running 
this tool removes all the inventory data of all servers and 
workstations from the database, ZENINV.DB.

2. Install ZfS2 SP1. See the Readme document for more 
information.

3. Ensure that the SYS:\SYSTEM\MGMTDBS.NCF file contains 
the MW.DB, ZENINV.DB, MGMTDB.DB, and NAL.DB 
entries.

4. Verify that the MGMTDBS.NCF file in the SYS:\SYSTEM 
directory has been updated correctly. Ensure that the 
reference to ZENINV.DB refers to the ZENworks 2 SP1 
setting. For example, in ZENworks 2 SP1, ZENINV.DB is 
located in the volume on which the ZENworks 2 SP1 
database is installed. By default, the database file is in the 
SYS:\ZENWORKS\DATABASE directory. The following 
parameter should exist in the MGMTDBS.NCF file: 
volume_name\\ZENWORKS\DATABASE\ZENINV.DB.

,03257$17��After ZfS2 SP1 installation, follow this order to 
start ZfS2 and ZfD3: at the server prompt, type zfdstart. Type 
mwserver.

Scenario Action
Interoperability of ZfS2 with ZfD3 and ZENworks 2 SP1 	��
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